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IMPORTANT NOTE: Refer to the unit’s rear panel for your Model #.

Model Number:

1600PCn

1601PCn

1602PCn

Description:

OPTIMOD-PCn Digital Audio Processor and Loudness Controller Software running
natively on an Intel®-based Windows® computer. Optionally includes Modulation
Index StreamS streaming software for netcasting.

Lower-cost version of software with certain features omitted.
See 1601PCn Features on page 1-12.

Lowest-cost version of software with certain features omitted.
See 1602PCn Features on page 1-12.

CAUTION

RISK OF ELECTRIC SHOCK

DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE COVER (OR BACK).
NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK,
DO NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

This symbol, wherever it appears, alerts you to

This symbol, wherever it appears, alerts you to important

the presence of uninsulated dangerous voltage

operating and maintenance instructions in the accompa-

inside the enclosure — voltage that may be

nying literature. Read the manual.

sufficient to constitute a risk of shock.

In accordance to the WEEE (waste electrical and electronic equipment) di-
rective of the European Parliament, this product must not be discarded into

the municipal waste stream in any of the Member States. This product may be
sent back to your Orban dealer at end of life where it will be reused or recy-
cled at no cost to you.

If this product is discarded into an approved municipal WEEE collection site or
turned over to an approved WEEE recycler at end of life, your Orban dealer
must be notified and supplied with model, serial number and the name and
location of site/facility.

Please contact your dealer for further assistance.

www.orban.com
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AUDIO PROCESSING

PLEASE READ BEFORE PROCEEDING!

Manual

Please review the Manual, especially the installation section, before installing the unit in your computer.

Trial Period Precautions

If your unit has been provided on a trial basis:

You should observe the following precautions to avoid reconditioning charges in case you later wish to return the unit to
your dealer.

(1) Note the packing technique and save all packing materials. It is not wise to ship in other than the factory carton. (Re-
placements cost $35.00).

(2) Avoid scratching the plating. Set the unit on soft, clean surfaces.

(4) Use care and proper tools in removing and tightening screws to avoid burring the heads.

Packing
When you pack the unit for shipping:

(1) Wrap the unit in its original plastic bag to avoid marring the unit.
(2) Seal the carton with tape.

If you are returning the unit permanently (for credit), be sure to enclose:

The Manual(s)
The Registration/Warranty Card

Your dealer may charge you for any missing items.

If you are returning a unit for repair, do not enclose any of the above items.

Further advice on proper packing and shipping is included in the Manual (see Table of Contents).
Trouble

If you have problems with installation or operation:

(1) Check everything you have done so far against the instructions in the Manual. The information contained therein is
based on our years of experience with OPTIMOD and broadcast stations.

(2) Check the other sections of the Manual (consult the Table of Contents) and search the text to see if there might be
some suggestions regarding your problem.

(3) After reading the section on Factory Assistance, you may call Customer Service for advice during normal California
business hours. The number is +1 909.860.6760.



IMPORTANT SAFETY INSTRUCTIONS

All the safety and operating instructions should be read before the appliance is operated.

Retain Instructions: The safety and operation instructions should be retained for future reference.
Heed Warnings: All warnings on the appliance and in the operating instructions should be adhered to.
Follow Instructions: All operation and user instructions should be followed.

Water and Moisture: The appliance should not be used near water (e.g., near a bathtub, washbowl, kitchen sink, laundry tub, in a wet base-
ment, or near a swimming pool, etc.).

Ventilation: The appliance should be situated so that its location or position does not interfere with its proper ventilation. For example, the appli-
ance should not be situated on a bed, sofa, rug, or similar surface that may block the ventilation openings; or, placed in a built-in installation, such as a
bookcase or cabinet that may impede the flow of air through the ventilation openings.

Heat: The appliance should be situated away from heat sources such as radiators, heat registers, stoves, or other appliances (including amplifiers)
that produce heat.

Power Sources: The appliance should be connected to a power supply only of the type described in the operating instructions or as marked on
the appliance.

Grounding or Polarization: Precautions should be taken so that the grounding or polarization means of an appliance is not defeated.

Power-Cord Protection: Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or
against them, paying particular attention to cords at plugs, convenience receptacles, and the point where they exit from the appliance.

Cleaning: The appliance should be cleaned only as recommended by the manufacturer.
Non-Use Periods: The power cord of the appliance should be unplugged from the outlet when left unused for a long period of time.
Object and Liquid Entry: Care should be taken so that objects do not fall and liquids are not spilled into the enclosure through openings.

Damage Requiring Service: The appliance should be serviced by qualified service personnel when: The power supply cord or the plug has
been damaged; or Objects have fallen, or liquid has been spilled into the appliance; or The appliance has been exposed to rain; or The appliance
does not appear to operate normally or exhibits a marked change in performance; or The appliance has been dropped, or the enclosure damaged.

Servicing: The user should not attempt to service the appliance beyond that described in the operating instructions. All other servicing should be
referred to qualified service personnel.

The Appliance should be used only with a cart or stand that is recommended by the manufacturer.

Safety Instructions (European)

Notice For U.K. Customers If Your Unit Is Equipped With A Power Cord.

WARNING: THIS APPLIANCE MUST BE EARTHED.

The cores in the mains lead are coloured in accordance with the following code:
GREEN and YELLOW - Earth BLUE - Neutral BROWN - Live

As colours of the cores in the mains lead of this appliance may not correspond with the coloured markings identifying the terminals in your plug, pro-
ceed as follows:

The core which is coloured green and yellow must be connected to the terminal in the plug marked with the letter E, or with the earth symbol, or col-
oured green, or green and yellow.

The core which is coloured blue must be connected to the terminal marked N or coloured black.
The core which is coloured brown must be connected to the terminal marked L or coloured red.

The power cord is terminated in a CEE7/7 plug (Continental Europe). The green/yellow wire is connected directly to the unit's chassis. If you need to
change the plug and if you are qualified to do so, refer to the table below.

WARNING: If the ground is defeated, certain fault conditions in the unit or in the system to which it is connected can result in full line voltage between
chassis and earth ground. Severe injury or death can then result if the chassis and earth ground are touched simultaneously.

Conductor WIRE COLOR
Normal Alt
L LIVE BROWN BLACK
NEUTRAL BLUE WHITE
E EARTH GND GREEN-YELLOW GREEN

AC Power Cord Color Coding




Safety Instructions (German)

Geréat nur an der am Leistungsschild vermerkten Spannung und Stromart betreiben.

Sicherungen nur durch solche, gleicher Stromstarke und gleichen Abschaltverhaltens ersetzen. Sicherungen nie Uberbriicken.
Jedwede Beschadigung des Netzkabels vermeiden. Netzkabel nicht knicken oder quetschen. Beim Abziehen des Netzkabels den
Stecker und nicht das Kabel enfassen. Beschadigte Netzkabel sofort auswechseln.

Gerat und Netzkabel keinen tbertriebenen mechanischen Beaspruchungen aussetzen.

Um Berlihrung gefahrlicher elektrischer Spannungen zu vermeiden, darf das Gerét nicht gedffnet werden. Im Fall von Betriebsstérun-
gen darf das Geréat nur Von befugten Servicestellen instandgesetzt werden. Im Gerét befinden sich keine, durch den Benutzer
reparierbare Teile.

Zur Vermeidung von elektrischen Schlagen und Feuer ist das Gerat vor Nasse zu schitzen. Eindringen von Feuchtigkeit und
Flussigkeiten in das Gerat vermeiden.

Bei Betriebsstdrungen bzw. nach Eindringen von Fliissigkeiten oder anderen Gegensténden, das Gerat sofort vom Netz trennen und
eine qualifizierte Servicestelle kontaktieren.

Safety Instructions (French)

On s'assurera toujours que la tension et la nature du courant utilisé correspondent bien a ceux indiqués sur la plaque de I'appareil.
N'utiliser que des fusibles de méme intensité et du méme principe de mise hors circuit que les fusibles d'origine. Ne jamais
shunter les fusibles.

Eviter tout ce qui risque d'endommager le cable seceur. On ne devra ni le plier, ni I'aplatir. Lorsqu'on débranche I'appareil,

tirer la fiche et non le cable. Si un cable est endommagé, le remplacer immédiatement.

Ne jamais exposer |'appareil ou le cable & une contrainte mécanique excessive.

Pour éviter tout contact averc une tension électrique dangereuse, on n'oouvrira jamais I'appareil. En cas de dysfonctionnement,
I'appareil ne peut étre réparé que dans un atelier autorisé. Aucun élément de cet appareil ne peut étre réparé par I'utilisateur.
Pour éviter les risques de décharge électrique et d'incendie, protéger I'appareil de I'numidité. Eviter toute pénétration
d'humidité ou fr liquide dans I'appareil.

En cas de dysfonctionnement ou si un liquide ou tout autre objet a pénétré dans I'appareil couper aussitot I'appareil

de son alimentation et s'adresser a un point de service aprésvente autorisé.

Safety Instructions (Spanish)

Hacer funcionar el aparato sélo con la tensién y clase de corriente sefialadas en la placa indicadora de caracteristicas.

Reemplazar los fusibles s6lo por otros de la misma intensidad de corriente y sistema de desconexion. No poner nunca los fusibles en
puente.

Proteger el cable de alimentacion contra toda clase de dafios. No doblar o apretar el cable. Al desenchufar, asir el enchufe y no el
cable. Sustituir inmediatamente cables dafiados.

No someter el aparato y el cable de alimentacién a esfuerzo mecénico excesivo.

Para evitar el contacto con tensiones eléctricas peligrosas, el aparato no debe abrirse. En caso de producirse fallos de funcionamiento,
debe ser reparado solo por talleres de servicio autorizados. En el aparato no se encuentra ninguna pieza que pudiera ser reparada por
el usuario.

Para evitar descargas eléctricas e incendios, el aparato debe protegerse contra la humedad, impidiendo que penetren ésta o liquidos
en el mismo.

En caso de producirse fallas de funcionamiento como consecuencia de la penetracién de liquidos u otros objetos en el aparato,

hay que desconectarlo inmediatamente de la red y ponerse en contacto con un taller de servicio autorizado.

Safety Instructions (Italian)

Far funzionare I'apparecchio solo con la tensione e il tipo di corrente indicati sulla targa riportante i dati sulle prestazioni.

Sostituire i dispositivi di protezione (valvole, fusibili ecc.) solo con dispositivi aventi lo stesso amperaggio e lo stesso comportamento

di interruzione. Non cavallottare mai i dispositivi di protezione.

Evitare qualsiasi danno al cavo di collegamento alla rete. Non piegare o schiacciare il cavo. Per staccare il cavo, tirare la presa e mai

il cavo. Sostituire subito i cavi danneggiati.

Non esporre I'apparecchio e il cavo ad esagerate sollecitazioni meccaniche.

Per evitare il contatto con le tensioni elettriche pericolose, I'apparecchio non deve venir aperto. In caso di anomalie di funzionamento
I'apparecchio deve venir riparato solo da centri di servizio autorizzati. Nell'apparecchio non si trovano parti che possano essere riparate
dall'utente.

Per evitare scosse elettriche o incendi, I'apparecchio va protetto dall'umidita. Evitare che umidita o liquidi entrino nell'apparecchio.

In caso di anomalie di funzionamento rispettivamente dopo la penetrazione di liquidi o oggetti nell'apparecchio, staccare immediatamente
I'apparecchio dalla rete e contattare un centro di servizio qualificato.




WARNING

This equipment generates, uses, and can radiate radio-frequency energy. If it is not installed
and used as directed by this manual, it may cause interference to radio communication. This
equipment complies with the limits for a Class A computing device, as specified by FCC
Rules, Part 15, subject J, which are designed to provide reasonable protection against such
interference when this type of equipment is operated in a commercial environment. Operation
of this equipment in a residential area is likely to cause interference. If it does, the user will be
required to eliminate the interference at the user’s expense.

WARNING

This digital apparatus does not exceed the Class A limits for radio noise emissions from digi-
tal apparatus set out in the radio Interference Regulations of the Canadian Department of
Communications. (Le present appareil numerique n’emet pas de bruits radioelectriques de-
passant les limites applicables aux appareils numeriques [de las class A] prescrites dans le
Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du
Canada.)

IMPORTANT

Perform the installation under static control conditions. Simply walking across a rug can gen-
erate a static charge of 20,000 volts. This is the spark or shock you may have felt when
touching a doorknob or some other conductive surface. A much smaller static discharge is
likely to destroy one or more of the CMOS semiconductors employed in OPTIMOD. Static
damage will not be covered under warranty.

There are many common sources of static. Most involve some type of friction between two
dissimilar materials. Some examples are combing your hair, sliding across a seat cover or
rolling a cart across the floor. Since the threshold of human perception for a static discharge
is 3000 volts, you will not even notice many damaging discharges.

Basic damage prevention consists of minimizing generation, discharging any accumulated
static charge on your body or workstation, and preventing that discharge from being sent to or
through an electronic component. You should use a static grounding strap (grounded through
a protective resistor) and a static safe workbench with a conductive surface. This will prevent
any buildup or damaging static.

Software © copyright Orban Labs Inc..

Orban® and Optimod® PreCode™, and Optimix™ are trademarks of Orban Labs Inc..

Published June 2021.

This manual © copyright Orban Labs Inc. This manual may be freely printed out and distributed if this copyright notice is
Rgtmr(;n;(r)gtlagé-However, no derivative works may be made from the contents of this manual without written permission

Thanks go to Greg Ogonowski of Modulation Index LLC for many of the tutorial diagrams in this manual.

—orban
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This product exclusively distributed and supported by:
Modulation Index LLC
1249 Diamond Bar Blvd Suite #314
Diamond Bar CA 91765-4122 USA

Phone: +1 909.860.6760; E-Mail: info@indexcom.com; Site: www.indexcom.com
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OPTIMOD-PCn INTRODUCTION 1 - 1

Section 1

Introduction

CAUTION: To enable the 1600 to exploit the full power of its Intel CPU while ensur-
ing smooth, uninterrupted operation, hardware products incorporating OPTIMOD-
PCn ship from the factory with a specific Windows operating system and software
configuration. DO NOT RECONFIGURE THE OPERATING SYSTEM AND/OR INSTALL
ADDITIONAL SOFTWARE UNLESS INSTRUCTED TO DO SO BY THE VENDOR OF YOUR
SYSTEM OR BY SPECIFIC INSTRUCTIONS IN THIS MANUAL. Doing so may cause the

system to operate improperly and will make Technical Support unavailable to you
because we cannot support non-tested OS configurations and third-party software.

If you have purchased the software-only version of 1600 PC, we strongly recom-
mend running it on a clean Windows installation and using our recommended sound
I/0 hardware. Other software can compete for CPU cycles, causing audio glitches
and interruptions. We can recommend software (like playout systems) that is
known to play well with 1600 PC. Other hardware may have driver problems that
prevent glitch-free operation.

About this Manual

The Adobe pdf form of this manual contains numerous hyperlinks and bookmarks. A
reference to a numbered step or a page number (except in the Index) is a live hyper-
link; click on it to go immediately to that reference.

To help you find the information you need, this manual has an index (starting on
page 7-1) and a Table of Contents. To search for a specific word or phrase, you can
also use the Adobe Acrobat Reader’s text search function.

e Section 1 contains general information about OPTIMOD-PCn and describes how
to use it in your specific application. The most important material for typical us-
ers appears first. OPTIMOD-PCn uses the contemporary concept of “target loud-
ness” (per ITU-R BS.1770), so the output level control works differently than you
might expect (it adjusts output peak headroom but not loudness), and the ex-
planation of target loudness (Setting Loudness starting on page 1-20) is im-
portant to understand.

e Section 2 explains how to install and set up OPTIMOD-PCn.

e Section 3 explains how to customize OPTIMOD-PCn’s sound to your requirements
and contains descriptions of all tuning controls for the audio processing.
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e Section 4 describes the software that implements OPTIMOD-PCn’s functionality.
e Section 5 documents OPTIMOD-PCn'’s control API.
e Section 6 contains OPTIMOD-PCn’s specifications.

e Section 7 is the Index.

The OPTIMOD-PCn 1600 Digital Audio Processor

For a list of features, see Summary of OPTIMOD-PCn’s Features starting on page 1-7.

The Model 1600 OPTIMOD-PCn is audio processing software that is available both as
a software-only product for approved Windows® computers and pre-installed on a
computer that can be configured at the factory to run advanced audio processing
software (called OPTIMOD-PCn in this manual) and MPEG-4 AAC/HE-AACv2 stream-
ing audio codecs supplied by Modulation Index (StreamS Live Encoder®') software
natively on its Intel processor. Depending on its ordered configuration, the 1600 can
run multiples instances of monophonic, stereo, 5.1, or 7.1 processing, and these can
be mixed and matched as required. The 1600 is equally suited for mastering, netcasts
and digital radio broadcasting.

While OPTIMOD-PCn can be used for video applications, video applica-
tions in SDI or video-over-IP facilities require de-embedding and re-
embedding audio. In all applications, you must apply a video delay that
matches the delay of the audio processed through OPTIMOD-PCn, which
may be a much as 1 second. OPTIMOD-PCn ships with a full complement
of sound-for-picture presets, and this manual includes instructions for us-
ing the OPTIMOD-PCn in video applications.

From the ground up, OPTIMOD-PCn 1600 was designed for professionals. It offers
broadcast-quality digital signal processing that is suitable for both live streaming
and on-demand programming. OPTIMOD-PCn uses the power of Intel’s x86 architec-
ture provide a consistent, well-produced sound to the consumer by performing
phase skew correction, stereo enhancement, automatic gain control (AGC), equaliza-
tion, multiband gain control, stereo-to-surround upmixing, peak-level control, and
automatic loudness control.

OPTIMOD-PCn'’s setup, metering, and subjective loudness control incorporate con-
temporary concepts of “target loudness” based on the ITU-R BS.1770 loudness
measurement algorithm (see About Target Loudness and ITU-R BS.1770 starting on
page 1-16) and on our third-generation refinements to the CBS (Jones & Torick)
loudness controller and loudness metering technology. (See Level and Subjective
Loudness Metering in OPTIMOD-PCn starting on page 1-25.)

' https://www.indexcom.com/products/encoder/
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OPTIMOD-PCn supports audio-over-IP via any standard that provides a Windows
sound device driver, such as RAVENNA and Dante. An optional sound card provides
digital AES3 inputs and outputs that are compatible with industrial and broadcast
equipment, and that work with consumer electronics too. OPTIMOD-PCn also in-
cludes mixers and software Wave 1/O that interfaces directly with audio encoders
running on the same computer as OPTIMOD-PCn.

OPTIMOD-PCn was designed to deliver a high-quality sound while simultaneously
increasing the average level on the channel substantially beyond that achievable by
“recording studio”-style compressors and limiters. Because such processing can ex-
aggerate flaws in the source material, it is very important that the source audio be as
clean as possible.

For best results, feed OPTIMOD-PCn unprocessed audio. No other audio processing is
necessary or desirable.

In digital radio applications, if you wish to place level protection prior to your stu-

dioftransmitter link (STL), we suggest using another OPTIMOD-PCn, running an
"AGC"” preset. Other types of AGC systems may adversely affect the audio.

Hardware and Software Requirements

The OPTIMOD-PCn system consists of a core audio processing engine and a graphical
interface application (called 1600PC) to control the audio processing engine. The
core audio processing engine is a Windows Service (called OptimodService3) that can
spawn up to 16 independent audio processors, depending on the number of proces-
sors you have purchased.

1600PC is an application that can run on the same computer as the OPTIMOD-PCn
Service or on any computer connected to the same network. Only the Service is
copy-protected; your software license allows you to install as many copies of 1600PC
on as many computers as you wish. Only one instance of 1600PC can be connected
to a given audio processor at any one time, although when a given Service spawns
more than one audio processor, each such processor may be connected to its own
1600PC instance.

OPTIMOD-PCn requires a substantial amount of computing power. To achieve most
reliable, glitch-free operation, it must be used with carefully selected and config-

ured hardware.

Operating System
Windows 7 /8.1 /10, Professional edition or higher.

e Do not run general-purpose programs (like Microsoft Office) on the same com-
puter.

e Turn off Windows Defender or other anti-malware software.
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Do not use the computer running the OPTIMOD-PCn Service for web
browsing or email.

e You may run approved audio playout systems (like Modulation Index’s RadioDJ)
and approved streaming encoder software (like StreamS Live Encoder).

e Within the limits described below, you may interconnect the playout software,
OPTIMOD-PCn, and the encoder via Virtual Audio Cable2. To achieve highest au-
dio quality, it is important to configure VAC as specifically as possible in terms of
sample rate, number of audio channels, and word length.

To avoid glitches or delay build-up, the input and output sample rate of a given
application must be precisely locked together, but the VAC clock frequency can-
not be locked to a hardware sound device. Moreover, older versions of VAC did
not support locking multiple VAC “cables” to the same (internal) clock. Hence
VAC can only be used safely with a given application if that application uses VAC
for both input and output and you are using the current version of VAC.

e In Windows CONTROL PANEL > ALL CONTROL PANEL ITEMS > PERFORMANCE
INFORMATION AND TOOLS > PERFORMANCE OPTIONS, choose ADJUST FOR BEST
PERFORMANCE.

e Turn off Windows Automatic Updates, as these can force the computer to re-
boot and interrupt audio.

e Turn off Windows Sounds.

e In Windows 8 and higher, turn off Fast Startup.

CPU

OPTIMOD-PCn requires a genuine Intel Core2® (3 GHz or faster using Intel’s 45 nm
manufacturing process), i3, i5, or i7, CPU of any generation. OPTIMOD-PCn uses Intel
vector floating point instructions to achieve the required computational efficiency.
The baseline OPTIMOD-PCn code requires the SSE4.1 vector instruction set. Core 2
and all i-series processors support SSE4.1. You may also use an Intel Xeon processor if
it supports SSE4.1.

Compared to the i-series, Intel processors like the Pentium and Celeron
series, even if they support SSE4.1, have substantially lower computing
power for a given clock speed and are insufficiently powerful to support
all of OPTIMOD-PCn'’s features.

2 http://software.muzychenko.net/eng/vac.htm

3 Older model Core 2 processors using Intel’s 65 nm manufacturing process do not
support SSE4.1 and cannot be used with OPTIMOD-PCn. Before installing OPTIMOD-
PCn on a PC with a Core 2 CPU, do an Internet search to see if its specific model of
processor supports SSE4.1.
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OPTIMOD-PCn is not optimized for AMD processors, and we have not
tested it on these processors.

We recommend sixth-generation i7 CPUs or higher. These are approximately 1.7
times as efficient than the first generation because they have a more efficient archi-
tecture and support the Intel AVX2 vector instruction set, which OPTIMOD-PCn ex-
ploits if available. When you run the OPTIMOD-PCn installer, it automatically detects
the vector instruction set that the computer’'s CPU supports and installs the correct
software. Attempting to run OPTIMOD-PCn for AVX2 on a CPU that does not sup-
port it will cause OPTIMOD-PCn to crash.

Although the operating system may quickly switch a given audio Processor between
CPU cores, each Processor spawned by the Service cannot exploit more CPU resources
than are available for a single core, which may be a Hyperthreaded core. On the
other hand, several Processors can share one core if that core has enough resources
to run them all smoothly.

In addition to the number of audio processors specified in your purchased license, a
further limitation is the computational capacity of the i-series CPU, which depends
mainly on its clock speed. Different configurations of an audio processor use differ-
ent amounts of CPU. The main determining factors are whether the output is
upmixed to 5.1 surround, whether the MX peak limiter is activated, and whether the
MX limiter (if activated) uses SOFT or HARD overshoot compensation.

HARD is only beneficial when you are trying to achieve BS.1770 loudness
levels higher than —6 LUFS. This is rarely desired and usually a bad idea
anyway because loudness this high compromises audio quality.

Table 1-1 on page 1-5 shows the theoretical minimum CPU clock speed for various

Processing Configuration Per-core ‘ Clock (GHz) for 100% utilization
[Note: requirements are approximate and 1%-gen i7 6"-gen i7
can vary with system configuration.] (SSE4.1) (AVX2)
5.1 surround + one downmix (no MX) 1.7 GHz 1.3 GHz
5.1 surround + one downmix (soft MX) 3.5GHz 2.2 GHz
5.1 surround (no MX) 1.7 GHz 1.2 GHz
5.1 surround (soft MX) 3.5GHz 2.2 GHz
Stereo + upmix (no MX) 1.8 GHz 1.1 GHz
Stereo + upmix (soft MX) 2.8 GHz 1.8 GHz
Stereo + upmix (hard MX) 3.6 GHz 2.5GHz
stereo (no MX) 1.5GHz 0.8 GHz
stereo (soft MX) 2.3 GHz 1.3 GHz
stereo (hard MX) 2.6 GHz 1.6 GHz
mono (no MX) 0.6 GHz 0.3 GHz
mono (soft MX) 1.5 GHz 0.7 GHz
mono (hard MX) 1.7 GHz 0.8 GHz

Table 1-1: CPU hardware requirements for one Intel i-series processor hardware core.
Requirements intermediate-generation i-series can be interpolated.
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combinations of features in 1%-generation and 6™-generation i-series processors. In
practice, it is wise to allow at least 20% headroom above these speeds to accommo-
date other demands that the operating system makes on the CPU.

To calculate the number of instances that you can run per core, calculate the ratio of
the “clock” shown in Table 1-1 and the clock speed of your processor. If it is less
than 0.5, you can run two instances; if it is less than 0.33, you can run three instanc-
es. For example, a 2.6 GHz 6t™-generation processor could theoretically run two in-
stances of stereo in each core with soft MX limiting (2 x 1.3 GHz = 2.6 GHz). A good
choice would be a 3.3 GHz processor, which provides a comfortable amount of
headroom. A four-core 6t"-generation 3.6 GHz i7 could run 8 instances of stereo/soft
MX or 12 instances of stereo/no MX with enough processing power left over to run
the operating system, playout systems, and streaming encoders.

If you use Hyperthreading (which we recommend), be aware that one physical CPU
core divides its available resources between two Hyperthreaded cores, and Table 1-1
indicates the physical resources that are required.

Intel claims that two Hyperthreaded cores can provide as much as 1.3
times the processing power available from their host physical core in non-
Hyperthreaded mode. As this is application- and OS-dependent, you will
have to experiment to see how much (if any) performance bonus you get
from Hyperthreading in your hardware.

When you are running four or more processors, the CPU requirements are slightly
higher (by about 8%) to compensate for the fact that the CPU’s memory cache is
shared among the various processors.

When heavily loaded by multiple OPTIMOD-PCn Processors, the CPU will generate a
significant amount of heat. This is particularly true of first and second-generation
Intel i7 CPUs, which may dissipate as much as 130 watts. Be sure that the CPU has
adequate heat sinking, the chassis has adequate forced-air cooling, and the com-
puter is located in a temperature-controlled environment. Insufficient cooling can
shorten the life of the CPU and can cause its clock speed to be throttled back auto-
matically and unexpectedly, limiting the number of Processors than it can run with-
out glitching. When first setting up OPTIMOD-PCn, It is wise to verify that your
computer has adequate cooling by running a utility that can indicate CPU core tem-
perature.

Audio I/0 Devices

For multichannel I/O, we recommend and use Lynx® sound cards* because these
cards tend to have stable drivers and are designed for professional users.

If you need low-latency headphone monitoring and mono or stereo I/O, we recom-
mend the Orban Optimod-PC 1101e card® which has onboard, low-latency audio

4 https://www.lynxstudio.com/

> https://www.orban.com/optimodpc-1101e/
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processing. While this processing is not as capable or feature-rich as Optimod-PCn, it
is a good choice to drive talent headphones. Functionally, Optimod-PC looks like
two sounds cards to Windows and has versatile mixing and audio routing capabili-
ties.

OPTIMOD-PCn supports audio-over-IP via any standard that provides a Windows
sound device driver, such as RAVENNA and Dante.

Summary of OPTIMOD-PCn'’s Features

The list of features below pertains only to the OPTIMOD-PCn audio processor and
does not include the features of StreamS Live software, which may also be installed
in the 1600 hardware. The features shown are for the full 1600PCn processor. Mod-
els 1601PCn and 1602PCn (at lower cost) remove some features. See 1602PCn Fea-
tures on page 1-12 and 1601PCn Features on page 1-12.

General Features

e Optimod-quality digital audio processing, running natively on an Intel x86 com-
puter, pre-processes audio in real time for consistency and loudness before it is
transmitted or recorded.

e Available in mono/stereo and surround versions (priced separately). One server
computer supports up to 16 audio processors, which may be any combination of
mono/stereo and surround processors.

e Applications include netcasting, DAB and other dedicated digital radio services,
FMExtra™ and other digital subcarriers, sound-for-picture, mastering, audio
production, and many others.

e Can be used as a pre-processor for existing hardware Optimod processors, adding
features like parallel compression and the “Multipath Mitigator” phase corrector.

e Basic offline file processing functionality allows you to apply faster than real-
time Optimod PCn processing to single or multiple wav files.

e Incorporates modern “target loudness” concepts (including those specified in
EBU R128 and ATSC A/85) using the ITU-R BS.1770 loudness model. Allows you to
easily set and verify the target loudness of the output.

e The audio processor runs as a Windows Service on its host computer, so it will
start automatically with Windows and run reliably in the background.

e A responsive, smooth, easy-to-use graphic control application runs on local or
remote PCs and can control any number of OPTIMOD-PCn audio Processors, ei-
ther locally (via a localhost TCP/IP connection) or in other 1600s on your network
via TCP/IP addressing.
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The Control application allows you complete flexibility to create your own cus-
tom presets, to save as many as you want to your local hard drive, and to recall
them at will.

e By use of third party Windows Audio drivers, is compatible with audio-over-IP
input/output (such as Ravenna®, LiveWire®, Dante®, and WheatNet®).

e Compatible with all Windows sound devices with stable drivers supporting the
Windows WASAPI standard. (WASAPI stands for Windows Audio Session APl and
was first introduced in Windows Vista.)

e Precisely controls peak levels to prevent overmodulation or codec overload.
While primarily oriented toward “flat” media, OPTIMOD-PCn can also provide
preemphasis limiting for the two standard preemphasis curves of 50us and 75ps.
This allows it to protect preemphasized satellite uplinks and similar channels
where protection limiting or light processing is required. It can also be used to
process analog television FM aural carriers in television applications because
these are usually processed lightly compared to FM radio.

e PreCode™ technology manipulates several aspects of the audio to minimize arti-
facts caused by low bitrate codecs, ensuring consistent loudness and texture
from one source to the next. PreCode includes special audio band detection al-
gorithms that are energy and spectrum aware. This can improve codec perfor-
mance on some codecs by reducing audio processing induced codec artifacts,
even with program material that has been preprocessed by other processing
than Optimod.

e Controls audio bandwidth as necessary to accommodate the transmitted sam-
pling frequency, obviating the need for extra, overshooting anti-aliasing filters
in downstream equipment. OPTIMOD-PCn’s high frequency bandwidth can be
switched instantly (typically in 1 kHz increments) between 10.0 kHz and 20 kHz.
20 kHz is used for highest-quality systems. 15 kHz codec bandwidth may help
low bitrate lossy codecs sound better than they do when fed full 20 kHz band-
width audio. 15 kHz is well matched to the codec used the iBiquity® HD-AM sys-
tem.

e Intended for program equalization and mastering, a sweepable gentle-slope
lowpass filter (6 to 24 dB / octave) is available in addition to the sharp-cutoff
lowpass filter.

e For specialized purposes like speech processing, a sweepable highpass filter with
four selectable slopes (6 to 24 dB / octave) is available. Music and speech modes
have separate cutoff frequencies and slopes, so the automatic speech/music de-
tector can change filter characteristics.

e The highpass and lowpass filters provide click-free switching of their cutoff fre-
quencies, so they these may be changed in the middle of program material.
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e A DC removal filter with a 0.1 Hz -3 dB low frequency cutoff removes DC offset
from source material without introducing overshoot and tilt into low-frequency
waveforms.

e OPTIMOD-PCn ships with many standard presets, designed to accommodate al-
most any programming format. There are also special-purpose, no-compromise
presets for mastering and pure peak limiting.

e A Bypass Test Mode facilitates broadcast system test and alignment or “proof of
performance” tests.

e Audio processing can be smoothly activated and defeated on-air via a delay-
matched pass-through mode, allowing programs that can benefit from full dy-
namic range to pass through OPTIMOD-PCn without dynamics compression ex-
cept for safety limiting using MX or non-MX limiter modes.

e OPTIMOD-PCn contains a built-in line-up tone generator, facilitating quick and
accurate level setting in any system. Low-distortion sinewave, non-overshooting
squarewave, and high-precision pink noise test signals are available.

¢ Dongle-based copy protection allows the software to be easily moved from one
computer to another without elaborate re-authorization procedures. No Internet
connection is required. The graphic control application is not copy-protected and
can be installed on an unlimited number of computers.

Audio Processing Features

¢ OPTIMOD-PCn can increase the density and loudness of the program material by
multiband compression and sophisticated peak limiting, improving the con-
sistency of the station’s sound and increasing loudness and definition remarka-
bly, without producing unpleasant side effects.

¢ Automatic left/right phase-skew corrector can eliminate comb-filtering artifacts in
a mono downmix. When used as a preprocessor for Optimod-FM, it can reduce
multipath distortion by minimizing energy in the stereo subchannel, which car-
ries the L-R signal.

e AGC can operate in left/right or sum/difference modes.
e Bass can be made monophonic, with crossover frequencies of 80 or 100 Hz.

¢ Two-Band automatic gain control with a phase-linear crossover, adjustable band
coupling, and window gating compensates for widely varying input levels. The
AGC rides gain over an adjustable range of up to 25dB, compressing dynamic
range and compensating for operator gain-riding errors and for gain inconsist-
encies in automated systems
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e Five-Band compression with selectable phase-linear and allpass crossover topolo-
gies provides a consistent, “processed” sound, free from undesirable side effects.

Band-coupling controls allow the gain differences between adjacent bands of
the five-band compressor to be constrained to any desired value, allowing you
to preserve as much of the frequency balance of the original program material as
desired unless doing so would otherwise cause objectionable spectral gain in-
termodulation artifacts. Combined with the phase-linear crossover, this func-
tionality can be used in lieu of the two-band compression found in earlier Opti-
mods.

Parametric soft-knee compression curves with adjustable ratio allow you to fine-
tune the audio to your exact requirements and make OPTIMOD-PCn an excellent
mastering processor.

The five-band compressor can be operated in both inline and parallel modes.
Parallel mode drives downstream processing with the sum of the input and out-
put of the multiband compressor. This increases the loudness of quiet material
while preserving the dynamics and punch of loud material. Typical applications
include preparing classical music for in-flight entertainment or other noisy envi-
ronments, or as preprocessor for Optimod-FM.

e Stereo Enhancer is based on Orban’s patented analog 222 Stereo Enhancer,
which increases the energy in the stereo difference signal (L-R) whenever a tran-
sient is detected in the stereo sum signal (L+R). Gating circuitry prevents over-
enhancement and undesired enhancement on slightly unbalanced mono materi-
al. Complements the Optimix upmixer, increasing the sense of envelopment and
space while maintaining excellent downmix compatibility.

e Shelving bass equalizer and four-band parametric equalizer let you color the au-
dio to your exact requirements. To facilitate A/B comparisons, equalizers can be
bypassed individually and globally.

¢ Dynamic High-Frequency Enhancer constantly monitors the ratio of HF to broad-
band energy in the incoming audio and can automatically re-equalize it to
achieve a target balance between broadband and HF energy.

e Subharmonic Synthesizer generates punchy bass from bass-shy material. It is par-
ticularly useful for older music recordings.

e Orban’s exclusive MX peak limiter technology uses a psychoacoustic model to
achieve an unprecedentedly favorable tradeoff between loudness, transient
punch, and distortion artifacts.

For applications where target loudness is below approximately —12 LkFS/LUFS,
you can reduce CPU load by approximately 50% without compromising audio
quality (compared to full MX limiter operation) by defeating the MX limiter and
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instead using our smooth, low-IM look-ahead limiter for the very light peak limit-
ing required at these low loudness levels. This is the normal mode of operation
for sound-for-picture applications, where target loudness is typically —23 LUFS or
—-24 LUFS and peak limiting rarely occurs at all.

In all modes of operation, the peak limiter offers “true peak” control by over-
sampling the peak limiter's sidechain at 192 kHz or higher. This allows
OPTIMOD-PCn to prevent clipping in a playback device’s analog signal path by
predicting and controlling the analog peak level following the playback device’s
reconstruction filter.

Without true peak control, analog clipping can occur even if all peak values of
the digital samples are below 0 dBFS. This phenomenon has also been termed “0
dBFS+."”

Thanks to true peak control, sample rate conversion, unless it removes high fre-
quency program energy or introduces group delay distortion, cannot cause sam-
ple peaks to increase more than 0.5 dB. For example, sample rate conversion
from 48 kHz to 44.1 kHz is highly unlikely to cause sample peak clipping in the
44.1 kHz audio data.

Accuracy is typically 0.15 dB even with heavy peak limiting, so the output level
can be set to —0.2 dBFS without true peak levels exceeding 0 dBFS.

e Second-generation Optimix™ stereo - 5.0 surround upmixer provides uncolored
automatic upmixing, plus phase correction that ensures that the center channel is
always crisp and intelligible. 5.1-compatible. Provides excellent downmix compat-
ibility. Can wrap the virtual soundstage around the listener (put the listener “in
the middle of the band”) or place the stage primarily in the front (put the listen-
er "in the audience”).

e Orban Stereo Synthesizer with excellent downmix compatibility. “Wide"” and
“narrow” modes (based on Orban’s classic analog 275A Stereo Synthesizer) can
create an attractively spacious stereo or surround output from mono program
material. Synthesis can be invoked manually, or activated automatically by sens-
ing silence in the right channel input.

e OPTIMOD-PCn includes third-generation CBS Loudness Controllers™ for DTV ap-
plications. Separate loudness controllers are available in both the surround and
downmix processing chains. The third-generation improvements reduce annoy-
ance more than simple loudness control alone, doing so without audible gain
pumping. Attack time is fast enough to prevent audible loudness overshoots, so
the control is smooth and unobtrusive. Material processed by the CBS Loudness
Controller has been shown to be well controlled when measured with a long-
term loudness meter using the BS.1770 standard. (See Appendix A: Using the ITU
BS.1770 and CBS Loudness Meters to Measure Loudness Controller Performance
starting on page 3-93.)
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e BS.1770-4 and CBS Loudness Meters™ measure the subjective loudness of the
1600's output and are displayed in the 1600's control application meter window.
When downmix processing is active, there are two independent loudness control-
lers and two loudness meters available.

e A BS.1770 Safety Limiter follows the CBS Loudness Controller, When activated, it
can further improve the measured performance using the BS.1770 meter and
which was added for the benefit of organizations with strict objective limits on
the indication of a BS.1770-2 meter regardless of the actual subjective loudness
as determined by human listeners.

e A pure peak limiting preset is available. It allows OPTIMOD-PCn to perform very
high quality peak limiting in mastering applications.

e OPTIMOD-PCn can be used as a studio AGC (including peak limiting) to protect a
studio-to-transmitter link (STL), optimally using the STL's native dynamic range.

e Uses “multirate” digital signal processing. Internal processing always occurs at
sample rates from 48 kHz to 256 kHz as needed, and provides 20 kHz audio
bandwidth (unless specifically constrained by the user-adjustable lowpass filter).
Built-in high-quality synchronous sample rate converters facilitate interfacing
with 44.1 kHz, 96 kHz and 192 kHz system:s.

e Uses 32-bit or 64-bit floating-point arithmetic as appropriate. Can interface to 16-
bit and 24-bit Windows audio devices.

1601PCn Features

1601PCn does not provide the following features from 1600PCn:

e File encoder

e Optimix/Stereo Synthesizer

e MX Limiter

e Parallel Compression Mode

e Subharmonic Synthesizer

e CBS Loudness Meter (leaving the BS.1770 meter in place)

e Loudness controller

1602PCn Features

1602PCn does not provide the following features from 1600PCn:

e File encoder
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e Optimix/Stereo Synthesizer

e MX Limiter

e Parallel Compression Mode

e Subharmonic Synthesizer

e CBS Loudness Meter (leaving the BS.1770 meter in place)
¢ Loudness controller

¢ High-Frequency Enhancer

e Phase Corrector

e Stereo Enhancer

e Mono Bass

e Crossover Mode (is always ALLPASS)

e Dual-Mono AGC

Why use OPTIMOD-PCn?

Audio Processing: Making Broadcasts/Netcasts Sound Professional

Professional broadcasters would never consider going on the air without audio sig-
nal processing. They consider it a vital aspect of their program content. This carefully
crafted content is what holds listeners and keeps them coming back. Since 1975, Op-
timod algorithms have dominated the world market for professional radio and tele-
vision audio processing and have been improved continuously since then.

To make scenes flow naturally through cuts, all broadcast television and Hollywood
movies have every scene color-corrected by a colorist, who adjusts hue, saturation,
gamma, and gray scale to achieve the “look” that the director intends, whether
natural or stylized. OPTIMOD-PCn processing is like “audio color correction” for your
programming. It subtly and automatically modifies the loudness, spectral balance,
and texture of program elements to ensure that they flow smoothly into one anoth-
er. OPTIMOD-PCn’s various factory presets allow you to choose the sonic "look” of
your programming while ensuring that this texture is maintained throughout your
programming.

OPTIMOD-PCn audio processing is appropriate for all digital transmission media and
channels. It tailors your audio signal to help you compete in audio netcasting, HD
Radio® (both primary and multicast digital channels), DAB, DRM, and other dedicat-
ed digital radio services, FMExtra™ and other digital subcarriers, mastering, audio
production, and many others.
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Video-oriented presets use OPTIMOD-PCn’s built-in CBS Loudness Controller™ to
make OPTIMOD-PCn well suited for sound-for-picture applications, including HDTV,
DVB-x digital television, and audio/video netcasting. OPTIMOD-PCn also includes a
defeatable “BS.1770 Safety Limiter” that follows the CBS Loudness Controller in the
signal path. The BS.1770 Safety Limiter can be set to prevent the indication of a
BS.1770 long-term meter with ten-second or longer integration time from being
higher than a preset threshold value: anywhere from 0 dB to +6 dB, as set by the
BS.1770 THRESHOLD control. For specific instructions on using OPTIMOD-PCn in
sound-for-picture applications, refer to Sound for Picture Applications: Controlling
Dynamic Range on page 2-8 and Sound for Picture Presets on page 3-42.

While primarily oriented toward “flat” media, OPTIMOD-PCn can also provide
preemphasis limiting for the two standard preemphasis curves of 50 ps and 75 ps. It
provides a “light” version of Orban’s exclusive MX peak limiting technology (first
developed for Optimod-FM 8600) to facilitate processing for preemphasized chan-
nels. This allows OPTIMOD-PCn to protect preemphasized analog satellite uplinks
and similar channels where protection limiting or light processing is required, and
makes it ideal for use as a studio AGC driving transmitter-located Optimods. It also
allows OPTIMOD-PCn to process audio for analog television transmission. We pro-
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Figure 1-1: Unprocessed Audio
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Figure 1-2: Same Audio Processed Through OPTIMOD-PCn
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vide a number of factory presets for this purpose.

There are many gain/peak control devices and software available to perform dynam-
ics processing. Many of these tools are designed for recording studio applications as
effects compressors/limiters for individual microphone or instrument tracks. These
devices’ controls need to be tuned carefully for the specific material being pro-
cessed—they are not “set and forget” processors. Moreover, most do not process
mixed program material without introducing objectionable audible artifacts, partic-
ularly when called upon to gain-ride input material having widely varying levels. The
details and implementations are all-important.

A broadcast audio processor should ideally be “seen but not heard.” Optimod pro-
cessing algorithms simultaneously control audio gain, loudness, and peaks, artistical-
ly, musically, and naturally, to give the illusion that processing is not taking place.
Moreover, Optimod algorithms intelligently adapt themselves to the input program
material. Once OPTIMOD-PCn is tuned for the sound texture required for the broad-
cast or netcast format (which is made easy by OPTIMOD-PCn’s many format-specific
presets), it will provide excellent consistency regardless of the level or texture of the
original program material. OPTIMOD-PCn’s automatic gain control and equalization
achieve a consistent sound, while accurate peak control maximizes loudness. Boom-
ing bass is tightened; weak, thin bass is brought up; highs are always present and
consistent in level.

OPTIMOD-PCn is also an excellent mastering processor, offering soft knee multiband
compression with knee and ratio controls available separately for each band. This is
followed by a peak limiter using Orban’s MX technology, which uses a psychoacous-
tic model and can typically achieve more than 12 dB of gain reduction before it pro-
duces objectionable artifacts—this limiter is exceptionally loud, clean, and punchy.
MX limiting is effective with both “flat” and pre-emphasized transmission channels.
See Production and Mastering on ape 3-86.

An APl provides complete remote administration over TCP/IP. The OPTIMOD-PCn
Service application hosts a TCP/IP terminal server to allow external control of the
OPTIMOD-PCn Service from either a Telnet/SSH client or a custom third party appli-
cation. See OPTIMOD 1600PCn Control API starting on page 5-1.

OPTIMOD-PCn comes with many great-sounding presets that make it easy to create
a sonic texture that’s just right for your target audience. If you want to customize a
preset, you can start with an easy LESS-MORE control, and, if that's not enough,
tweak dozens of parameters to hone your sound to perfection. OPTIMOD-PCn’s
deep interface will never hold you back as your processing expertise increases, yet its
carefully crafted design insulates you from the details if you need great sound right
now. See Table 3-1: Protection, AGC and Mastering Presets on page 3-34, Table 3-2:
Radio-Style Presets on page 3-38, and Table 3-3: Sound-For-Picture Presets on page
3-42.

Without OPTIMOD-PCn processing, audio can sound dull, thin, or inconsistent in any
combination. OPTIMOD-PCn’s multiband processing automatically levels and re-
equalizes its input to the “major-market” standards expected by the mass audience.
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Broadcasters have known for decades that this polished, “produced” sound attracts
and holds listeners.

You can expect a considerable increase in loudness from OPTIMOD-PCn processing
compared to unprocessed audio (except for audio from recently mastered CDs,
which are often over-processed in mastering). Broadcasters generally believe that
loudness relative to other stations attracts an audience that perceives the station as
being more powerful than its competition. The same subliminal psychology holds in
netcasting too.

Figure 1-1 on page 1-14 shows a 15-minute snapshot of program audio as it
emerged from the on-air mixer of a major Los Angeles radio station. Source material
included music, speech, and commercials. Notice the large inconsistency in peak and
average level between one program source and the next. Figure 1-2 shows the same
material after being processed through OPTIMOD-PCn. Notice that program levels
are now consistent from source to source

Audio Processing for Netcasts

Professional-grade netcasting requires audio processing similar to FM broadcast, alt-
hough there are some important differences in the peak limiting because of the dif-
ferent characteristics of the pre-emphasized FM channel and the perceptually coded
netcasting channel. In particular, netcasting to mobile devices benefits from audio
processing to overcome external noise.

Your listeners deserve to get the best quality and consistency you can provide. Good
audio processing is one important thing that separates the amateur from the profes-
sional.

Conventional AM, FM, or TV audio processors that employ preemphasis/deemphasis
and/or clipping peak limiters do not work well with perceptual audio coders such as
Modulation Index's SteamS MPEG-4 AAC/HE-AACv2 streaming encoder. The
preemphasis/deemphasis limiting in these processors unnecessarily limits high fre-
quency headroom. Further, their clipping limiters create high frequency compo-
nents—distortion—that the perceptual audio coders would otherwise not encode.
None of these devices have the full set of audio and control features found in
OPTIMOD-PCn.

Peak clipping sounds bad even in uncompressed digital channels because these
channels do not rely on preemphasis/deemphasis to reduce audible distortion. In-
stead of peak clipping, OPTIMOD-PCn uses its advanced MX limiting technology
(which includes look-ahead elements) to protect the following channel from peak
overload.

About Target Loudness and ITU-R BS.1770

OPTIMOD-PCn uses the contemporary concept of “target loudness” to increase lis-
tener satisfaction by minimizing the need for listeners to readjust their volume con-
trols when changing between different broadcast stations or netcast streams. If you
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specify the target loudness (via the TARGET LOUDNESS control), OPTIMOD-PCn will
produce the desired loudness.

The following text explains the concept of “target loudness” and its relationship to
the ITU-R BS.1770 loudness measurement algorithm. Instructions for setting target
loudness start on page 1-20.

The ITU-R BS.1770 Loudness Measurement Algorithm

In 2006, the ITU-R published Recommendation ITU-R BS.1770: “Algorithms to meas-
ure audio programme loudness and true-peak audio level.” In 2011, this was updat-
ed to BS.1770-3.

The original BS.1770 loudness meter used a frequency-weighted RMS
measurement intended to be integrated over several seconds — perhaps
as long as an entire program segment. As such, it is considered a “long-
term” loudness measurement.

A major disadvantage of the BS.1770-1 meter was that it weights silence
and low-loudness material the same as high loudness material. This will
cause the meter to under-read program material (like dialog) having sub-
stantial pauses that contain only low-level ambience, because louder
program material contributes most to a listener’s perception of overall
program loudness.

To address this problem, the BS.1770-2 algorithm (and its successors) use
gating. There are two steps in the gating process: first, an absolute gate
removes silent passages; second, a relative gate weights louder parts of
the program more heavily than quieter parts. The gating causes the me-
ter to ignore silence and to integrate only program material whose loud-
ness falls within a floating window extending from the loudest sounds
within the specified integration period to sounds that are 10 dB quieter
than the loudest sounds.

OPTIMOD-PCn'’s built-in BS.1770 loudness meter computes gated, integrated loud-
ness over both a 3-second and 10-second rolling window of integration, so all pro-
gram material from the current time to 3 or 10 seconds before the current time is

X Keilter Yo | Meansquare |- G,
%5 kfilter | Meansquare [ G, s
X 5 Kdilter | Meansquare <1 G, |—» 10Log, — Gate *Mﬁﬁiﬂiﬁd
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BS.1770-01

Figure 1-3: BS.1770 Loudness Meter Block Diagram (from ITU-R document)
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weighted equally. The 10-second loudness is displayed as a blue bar and the 3-
second loudness is displayed as a single white segment.

The meter is scaled so that “0” corresponds to the active TARGET LOUDNESS value.
Hence, the loudness level at the consumer’s receiver will be correct when OPTIMOD-
PCn’s processing is adjusted to make the dominant program material indicate “0 LU”
on BS.1770 meter and the active Target Loudness value is the same as the receiver’s
target loudness. (The CBS meter will usually peak close to “0 dB” too; see page 1-26
for a discussion of the CBS meter.) Because loudness perception combines the con-
tributions of all acoustic sources, there is only one Loudness Level meter indication
regardless of the number of audio channels

Target Loudness (aka “dialnorm”)

The arrival of the ITU-R BS.1770 loudness measurement standard has changed indus-
try practices by encouraging users to specify “target loudness” based upon this
standard. Target loudness is also known as “dialnorm,” particularly in sound-for-
picture applications.

dialnorm is short for “dialog normalization,” and was first specified by
Dolby Laboratories (long before the creation of BS.1770) as part of the
metadata for their AC3 (later, “Dolby Digital”) codec. dialnorm was orig-
inally intended to allow motion pictures to be exhibited theatrically with
fixed and predictable dialog loudness while allowing other program ele-
ments to be louder or quieter than dialog according to the artistic de-
mands of the material. Dolby has since updated their recommended
loudness measurement practices to use the BS.1770 standard.

Several national and international standards-setting bodies have incorporated
BS.1770 into recommended practices. The advantage of enforcing target loudness is
that it causes the loudness of various program elements in a broadcast or netcast to
be roughly consistent with each other, so that it is less likely that users will need to
adjust their volume controls between program segments. The eventual goal is to
achieve consistent loudness across all media, like FM radio and netcasts, supported
by a given receiver or player device.

In 2008, Optimods first incorporated the concept of target loudness in the context of
processing of sound-for-picture and allowed it to be defeated for audio-only appli-
cations. By specifying a global TARGET LOUDNESS value, the user can be sure that any
processing preset automatically produces the desired target loudness.

For the sake of consistency and because the world is moving in the direction of spec-
ifying target loudness for all deliverables, OPTIMOD-PCn incorporates the concept of
target loudness in all audio processing—it’'s in the processor’s “DNA.” OPTIMOD-PCn
does this in two ways:

e It allows the target loudness to be assigned to each processing preset individual-
ly. This allows “radio-style” presets to be designed in the traditional way by bal-
ancing loudness against distortion, as loudness is specified by a given preset’s lo-
cal TARGET LOUDNESS value. Most “radio-style” factory presets have a target
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loudness of -8 LUFS® (about 5 dB quieter than the loudest, most distorted “hy-
percompressed” CDs), although this can easily be adjusted to suit your goals.

e It allows the target loudness to be assigned globally (as part of the system pa-
rameters) so that it applies to any preset whose Target Loudness value is set to
GLoBAL. When you edit a processing preset so that its Target Loudness value is
GLOBAL, this causes the loudness produced by the preset to be the same as all
other presets with GLOBAL Target Loudness. All of the 1600’s sound-for-picture
presets have GLOBAL Target Loudness, and all radio-style presets can be easily ed-
ited to have GLOBAL Target Loudness.

The 1600’'s loudness meters indicate loudness relative to the active target loudness,
such that “0” on the meter corresponds to the target loudness.

EBU R128

In August 2010, the EBU published its Loudness Recommendation EBU R128. It speci-
fies how broadcasters and netcasters can measure and normalize audio using Loud-
ness meters instead of Peak Meters (PPMs) or VU meters only, as has been common
practice.

EBU R128 is the result of two years of intense work by the audio experts in the EBU
PLOUD Group. The new Recommendation is accompanied by a Loudness Metering
specification (EBU Tech 3341), a Loudness Range descriptor (EBU Tech 3342), Loud-
ness test material (various different sequences) Production Guidelines (EBU Tech
3343) and Distribution Guidelines (EBU Tech 3344). An EBU Technical Review Article
describing the fundamental change in audio in broadcasting is also available: On the
way to Loudness Nirvana.

EBU R128 recommends normalizing audio at =23 LUFS +0.5 LU (x1 LU for live pro-
grams), measured using the BS.1770-2 (gated) algorithm or higher. The metering
approach can be used with virtually all material. To make sure meters from different
manufacturers provide the same reading, EBU Tech 3341 specifies the 'EBU Mode',
which includes a Momentary (400 ms), Short term (3s) and Integrated (from start to
stop) meter.

In our opinion, =23 LUFS is too low for certain applications. For example,
as of 2015 streams normalized to -23 LUFS cannot produce satisfying lis-
tening levels on Apple iPhones because the range of the iPhone’s volume
control is insufficient. We expect that consumer electronics manufactur-
ers will correct this problem in the future, but a decision to set a particu-
lar target loudness should also take into account the presence of legacy
devices. We believe that a more realistic target loudness for current play-

6 The BS.1770 loudness meter indicates in units of LUFS or LkFS (which are identical;
the LUFS nomenclature is typically used in Europe and LkFS elsewhere). A change of
1 LUFS is the same as a change of 1 dB. These measurements are absolute with ref-
erence to digital full-scale. LU or Lk (without the “FS") refers to loudness relative to
the Target Loudness, where the Target Loudness is 0 LU or 0 Lk.
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er devices like iPhones is =16 LUFS. This allows very high subjective quali-
ty while also allowing the program to be played at a level that satisfies
listeners.

ATSC A/85

In 2009, the Advanced Television Systems Committee (ATSC) in the United States re-
leased a Recommended Practice: Techniques for Establishing and Maintaining Audio
Loudness for Digital Television (A/85:2009). This was later updated as A/85:2013.
A/85 specifies use of the latest version of the Integrated ITU BS.1770 algorithm for
measuring the loudness of DTV broadcasts.

In December 2011, the FCC adopted rules implementing the CALM Act’, which, by
law, forbids commercials from being louder than non-commercial program material.
The new FCC rules incorporated ATSC A/85 (and, by implication, the BS.1770 meter)
as an objective means of verifying that the rule was being obeyed.

The most important difference between R128 and A/85 is that R128 recommends
that the target loudness should be measured across all program material, while A/85
recommends that it be measured on the “anchor element,” which is usually dialog.
In addition, R128 suggests a target loudness of —23 LUFS, while A/85 suggests a tar-
get loudness of —24 LUFS.

The ATSC A/85, ITU-R BS.1770, and EBU R128 documents are available as free down-
loads and their current versions can easily be located with a search engine.

Setting Loudness

To make automatic loudness control as straightforward and dependable as possible,
OPTIMOD-PCn operates somewhat differently from other Optimods. Most im-
portant, adjusting the output level control does not change loudness; it only sets the
amount of headroom between 0 dBFS and the maximum peak output level that the
audio processing produces. This allows you to adjust the processing to compensate
for downstream overshoots from codecs without changing loudness. (Instead, the
processing produces more peak limiting.) For example, for the HE-AAC codec it is
wise to allow 1.5 dB of peak headroom by setting the output level control to -1.5
dBFsS.

e Target Loudness/dialnorm: OPTIMOD-PCn works very easily with Dolby Digital®
transmission systems and other systems having a specified target BS.1770 loud-
ness if you do one crucial thing: You must tell the OPTIMOD-PCn what value of
Dolby Digital dialnorm metadata (which is the same as BS.1770 target loudness)
you are transmitting to your audience, or the target loudness of the receiver if it
is not metadata-aware. This will prevent your transmission from being too loud
or quiet compared to other correctly set up transmissions.

7 The CALM Act applies only to U.S. broadcasters. cable providers, and satellite pro-
viders.
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In a bitstream that includes dialnorm metadata, setting TARGET LOUDNESS
to a less negative value automatically turns down the home receiver’s
volume control, so OPTIMOD-PCn'’s output level must be turned up by the
same amount to maintain a constant loudness at the receiver. Because it
is placed before OPTIMOD-PCn’s look-ahead limiter, OPTIMOD-PCn'’s hid-
den Target Loudness gain control achieves this while allowing OPTIMOD-
PCn’s look-ahead limiter to prevent digital clipping in the downstream
transmission chain regardless of OPTIMOD-PCn’s Target Loudness setting.
This arrangement allows the user to set the correct loudness at
OPTIMOD-PCn’s output solely by adjusting OPTIMOD-PCn’s active Target
Loudness value—it is unnecessary to adjust any other controls within a
factory processing preset.

For recommendations regarding player devices that are not Target Loud-
ness-aware, see EBU — TECH 3344: Practical guidelines for distribution sys-
tems in accordance with EBU R128. The document can be easily found
with an Internet search engine.

e Setting Output Loudness: To set the OPTIMOD-PCn’s output loudness, adjust its
TARGET LOUDNESS value (either within the active processing preset or globally),
or adjust the MB LIMITER DRIVE control in the active processing preset.

e Adjusting TARGET LOUDNESS changes output loudness without changing the
indication on OPTIMOD-PCn’s loudness meters (which show loudness relative
to the active TARGET LOUDNESS value) or the amount of gain reduction in the
loudness controller, if turned on. The peak limiter's gain reduction will
change. This is the preferred method if the OPTIMOD-PCn’s loudness control-
ler is active because it has the smallest effect on the sonic texture of the
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OPTIMOD-PCn'’s audio processing.

e Adjusting MB LIMITER DRIVE changes the loudness meters’ indications and the
amount of gain reduction in the loudness controller and peak limiter. If
OPTIMOD-PCn's loudness controllers are turned off (as they are in most ra-
dio-style presets), you may have to tweak the MB LIMITER DRIVE to fine-tune
the loudness to your program material, such that OPTIMOD-PCn’s loudness
meters peak around “0.”

e Your transmission’s loudness will automatically be correct if:

e The LOUDNESS THRESHOLD and BS.1770 SAFETY LIMITER THRESHOLD controls are
set to “0.” (If these are OFF, you may have to tweak the MB LIMITER DRIVE
control as explained above.)

e you have adjusted the OPTIMOD-PCn’s input reference level (in I/O > INPUT) so
that the processing operates with normal amounts of gain reduction (typical-
ly 10 dB of AGC gain reduction) and;

¢ you have adjusted the OPTIMOD-PCn’s TARGET LOUDNESS to match the dial-
norm metadata you are send to your audience or the target loudness on
player devices that do not accept dialnorm metadata.

The OPTIMOD-PCn’s TARGET LOUDNESS value can be set in two places: There
is a global setting in the active I/0O Setup, which can be overridden by a
setting in LEss-MoRE tab of the active processing preset. All sound-for-
picture factory processing presets are configured to use the global Target
Loudness setting specified in the active Setup.

All "radio-style” processing presets have local TARGET LOUDNESS settings,
which makes their loudness/distortion/punch tradeoff independent of the
setting of global TARGET LOUDNESS. You can make any “radio-style” pre-
set produce the global target loudness by setting the preset’s local
TARGET LOUDNESS value to GLoBAL and then saving the result as a User
Preset. Note that a given preset’s LESs-MORE control continues to be
available after you have changed the preset’s Target Loudness.

To better match other streams in “radio-style” applications, you may wish
to set a target loudness that is substantially higher than -23 LUFS. If you
see a substantial amount of gain reduction on OPTIMOD-PCn’s LIMITER GR
meters, we recommend activating the MX limiter (in the DisTORTION tab
of the active processing preset). This can substantially improve subjective-
ly quality by reducing or eliminating audible peak-limiting artifacts.
However, it will approximately double the CPU usage for that Processor.

If you are using a mono-mode Processor, its BS.1770 and CBS loudness
meters will read about 3 dB lower than they do in stereo mode. This is
because there is only one audio channel contributing to the loudness
measurement. However, the mono output is duplicated on the left and
right channels of the output sound device, and if the mono signal is
played out through both channels, this will increase the loudness by 3 dB.
You must use your best judgment as to how to set up loudness in mono;
it depends on listening context.
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e CBS Loudness Controller: OPTIMOD-PCn includes third-generation CBS Loudness
Controllers™ for DTV applications. These use the Jones and Torick loudness me-
ter as a reference for the loudness controller sidechain. In surround mode, sepa-
rate loudness controllers are available in the surround and downmix processing
chains. (See Level and Subjective Loudness Metering in OPTIMOD-PCn on page 1-
25 and Appendix A: Using the ITU BS.1770 and CBS Loudness Meters to Measure
Loudness Controller Performance starting on page 3-93.)

e BS.1770 Safety Limiter: The BS.1770 safety limiter follows the CBS Loudness Con-
troller and will prevent a BS.1770-2 (or higher) loudness meter with a 10-second
integration time from indicating higher loudness than the setting of the
BS.1770 THRESHOLD control. This limiter is active in all “TV" factory presets. See
BS.1770 Safety Limiter on page 3-26 for a discussion of why we included this lim-
iter and why we don't think you should use it.

e Customizing a Factory Preset: If you are processing for a distribution channel
that has a BS.1770 target loudness and you wish to customize a factory preset
while retaining its loudness, you can do this easily. See Customizing Processing
Presets to Achieve Specified Target Loudness starting on page 2-23 for a more
detailed customization procedure for video-oriented presets.

Measuring Studio and Transmission Levels

VU and PPM metering

Studio equipment (like mixers) and transmission equipment (like codecs) typically
use different methods of metering to display audio levels. The VU meter is an aver-
age-responding meter (measuring the approximate RMS level) with a 300ms rise
time and decay time; the VU indication usually under-indicates the true peak level
by 8 to 14 dB. The Peak Program Meter (PPM) indicates a level between RMS and the
actual peak. The PPM has an attack time of 10ms, slow enough to cause the meter
to ignore narrow peaks and under-indicate the true peak level by 5 dB or more. The
absolute peak-sensing meter (the type most common in codecs) shows the true peak
level. It has an instantaneous attack time, and a release time slow enough to allow
the engineer to read the peak level easily. All of OPTIMOD-PCn's level meters are
absolute peak sensing.

Orban offers a free Loudness Meter application for Windows that incor-
porates a true peak-sensing meter, a VU meter, a PPM, and two types of
subjective  loudness meters. It can be downloaded from
www.orban.com/orban/meter/.

Figure 1-6 shows the relative difference between the absolute peak level and the
indications of a VU meter and a PPM for a few seconds of music program.

The studio engineer is primarily concerned with calibrating the equipment to pro-
vide the required input level for proper operation of each device, and so that all de-
vices operate with the same input and output levels. This facilitates patching devices
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in and out without recalibration and ensures that no part of the program chain wiill
clip the audio.

For line-up, the studio engineer uses a calibration tone at a studio standard level,
commonly called line-up level, reference level, or operating level. Metering at the
studio is by a VU meter or PPM. As discussed above, the VU or PPM indication under-
indicates the true peak level. So the studio standardizes on a maximum program in-
dication on the meter that is lower than the clipping level, so those peaks that the
meter does not indicate will not be clipped. Line-up level is usually at this same max-
imum meter indication.

In facilities that use VU meters, this level is usually at 0 VU, which corresponds to the

studio standard level, typically +4 dBu. For facilities using +4 dBu standard level, in-

stantaneous peaks can reach +18 dBu or higher (particularly if the operator over-
0—

-5 —

-10 —

-15 —

Figure 1-6: Absolute Peak Level, VU and PPM Indications
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drives the mixer). OPTIMOD-PCn’s analog input clips at an instantaneous peak level
of +20 dBu, which provides 16 dB of headroom above a +4 dBu line-up level.

In facilities that use the BBC-standard PPM, maximum program level is usually PPM4
for music and PPM6 for speech. Line-up level is usually PPM4, which corresponds to
+4 dBu. Instantaneous peaks will reach +17 dBu or more on voice. In facilities that
use PPMs that indicate level directly in dBu, maximum program and line-up level is
often +6 dBu. Instantaneous peaks will reach +11 dBu or more.

Figure 1-7 on page 1-25 shows various common meter scales (true peak reading, VU,
and four variants of PPM), aligned to show their readings when a —20 dBFS line-up
tone is applied to them.

Level and Subjective Loudness Metering in OPTIMOD-PCn

The meters on OPTIMOD-PCn show peak input levels, the peak output modulation,
and subjective loudness.

e Input levels are displayed using a VU-type scale (0 to —-40dB), but the metering
indicates absolute instantaneous peak (much faster than a standard PPM or VU
meter). The maximum digital word at the input corresponds to the 0 dB point on
the 1600’s input meter.

e The output meter indicates the values of the digital samples at OPTIMOD-PCn'’s
digital outputs, taking into account the setting of OPTIMOD-PCn's output level
control.

Note that this meter does not indicate the reconstructed peak level (aka
“0 dBFS+") per BS.1770. The “Reconstructed Peak” meter in Orban’s free
loudness meter application (www.orban.com/meter) can be used for this
purpose.

Reference
-20 dBFS 0 dBFS

HEADROOM

Figure 1-7: Common Audio Meter Scales, Aligned to the Same Reference Level
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Your Optimod’s base sample rate is 48 kHz; its peak limiters are over-
sampled at 192 kHz or higher. If the output sample rate is converted to a
rate other than 48 kHz and/or passed through a D/A converter, the peak
level of the output may increase up to 0.2 dB because 192 kHz is not
quite an “infinite” sample frequency, which is what would be required to
perfectly predict and control the peak level in these cases.

e The subjective loudness meters, labeled BS1770 and CBS, display loudness meas-
ured by the ITU-R BS.1770-3 standard (see The ITU-R BS.1770 Loudness Meas-
urement Algorithm on page 1-17) and loudness measured using the CBS Tech-
nology Center algorithm developed by Jones and Torick® which is discussed im-
mediately below. The loudness meters indicate loudness relative to the active
TARGET LOUDNESS value, as set either globally or in the active processing preset
(see Target Loudness on page 1-18).

The CBS meter is a “short-term” loudness level meter that displays the
details of moment-to-moment loudness with dynamics slightly faster
than a VU meter. It can indicate the loudness of short-term sounds (like
pistol shots) that may be annoying to TV viewers but that the BS.1770
meter, because of its longer integration time, may not take fully into ac-
count. Created using proprietary modeling software, the DSP implemen-
tation typically matches the original CBS analog meter within 0.5 dB on
sinewaves, tone bursts and noise.

The Jones & Torick algorithm improves upon the original loudness meas-
urement algorithm developed by CBS researchers in 1967. Its foundation
is psychoacoustic studies done at CBS Laboratories over a two year period
by Torick and the late Benjamin Bauer, who built on S. S. Stevens’ '50s-
era work at Harvard University.

After surveying existing equal-loudness contour curves (like the famous
Fletcher-Munson set) and finding them inapplicable to measuring the
loudness of broadcasts, Bauer and Torick organized listening tests that
resulted in a new set of equal-loudness curves based on octave-wide
noise reproduced by calibrated loudspeakers in a semireverberant 16 x 14
x 8 room, which is representative of a room in which broadcasts are nor-
mally heard. They published this work® along with results from other
tests whose goal was to model the loudness integration time constants of
human hearing. These studies concentrated on the moderate sound lev-
els typically preferred by people listening to broadcasts (60 to 80 phons'?)
and did not attempt to characterize loudness perception at very low and
high levels.

8 Jones, Bronwyn L.; Torick, Emil L., “A New Loudness Indicator for Use in Broadcast-
ing,” J. SMPTE September 1981, pp. 772-777.

® Benjamin B. Bauer and Emil L. Torick, “Researches in Loudness Measurement,” |IEEE
Transactions on Audio and Electroacoustics, Volume AU-14, Number 3, September
1966, pp. 141-151

' The phon is a unit of perceived loudness, equal in number to the intensity in deci-
bels of a 1 kHz tone judged to be as loud as the sound being measured.
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According to this research and its predecessors, the four most important
factors that correlate to the subjective loudness of broadcasts are these:

1. The power of the sound.

2. The spectral distribution of the power. The ear’s sensitivity depends
strongly on frequency. It is most sensitive to frequencies between 2 and 8
kHz. Sensitivity falls off fastest below 200 Hz.

3. Whether the power is concentrated in a wide or narrow bandwidth.
For a given total sound power, the sound becomes louder as the power is
spread over a larger number of critical bands (about 1/3 octave). This is
called loudness summation.

4. Temporal integration: As its duration increases, a sound at a given lev-
el appears progressively louder until its duration exceeds about 200 milli-
seconds, at which point no further loudness increase occurs.

Bauer and Torick used the results of this research to create a loudness
level meter with eight octave-wide filters, each of which covers three crit-
ical bands. (B & T did not use one filter per critical band because this
would have made the meter, which was realized using analog circuitry,
prohibitively expensive.) Each filter feeds a full-wave rectifier and each
rectifier feeds a nonlinear lowpass filter that has a 10 ms attack time and
a 200 ms release time, somewhat like the sidechain filter in an AGC. This
models the “instantaneous loudness” perception mechanism in the ear.
Instantaneous loudness is not perceived directly but is an essential part of
the total loudness model.

To map the instantaneous loudness to perceived short-term loudness, the
outputs of each of the nonlinear lowpass filters are arithmetically
summed with gains chosen to follow the 70 phon equal-loudness curves
of the ear as determined by Bauer and Torick’s research. The sum is ap-
plied to a second, slower nonlinear lowpass filter. This has an attack time
of 120 ms and a release time of 730 ms. Along with the eight nonlinear
lowpass filters following the individual filters, this filter models temporal
integration and maps it to the visual display. Meanwhile, the arithmetic
addition models loudness summation.

The internationally accepted unit of subjective loudness is the sone. With
a sinewave, 40 phons = 1 sone. A doubling of sones corresponds to a
doubling of loudness. However, because broadcasters were accustomed
to working in decibel units, Jones and Torick chose to map loudness on a
LED ladder display encompassing —20 to +5 dB in 0.5 dB increments, with
the understanding that the perceived loudness doubles every 10 dB at
loudness levels typically heard by broadcast audiences.

The J & T meter is monophonic. Psychoacoustic studies indicate that when
multiple acoustic sources are present in a room, loudness is most accu-
rately expressed by summing the power in the sources. For example, driv-
ing two loudspeakers with identical program produces 3 dB higher loud-
ness than a single speaker produces. Therefore, to extend the J & T algo-
rithm to multichannel reproduction, we implement one eight-filter fil-
terbank for each channel and compute RMS sums of the outputs of corre-
sponding filters in each channel before these sums are applied to the
eight nonlinear lowpass filters. As in the monophonic J & T algorithm,
the sum of these lowpass filters drives a second nonlinear filter, which
drives the display.
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Presets in OPTIMOD-PCn

There are two kinds of presets in OPTIMOD-PCn: Processing Presets and Setup Pre-
sets. Both can be customized and saved under different names.

Each instance of the processing is identified by a Processor number or us-
er-generated alias and each Processor “owns” its individual customized
presets.

Processing Presets

There are over 50 Factory Processing Presets, written by Greg Ogonowski and Bob
Orban. They are designed to be compatible with almost any program format. See
Table 3-1: Protection, AGC and Mastering Presets on page 3-34, Table 3-2 on page 3-
38, and Table 3-3: Sound-For-Picture Presets on page 3-42. The description of the
presets associates with these tables indicates the style of processing.

Each Factory Processing Preset on the Open Preset list is really a library of 19 sepa-
rate presets, selected by using the LESS-MORE control to adjust OPTIMOD-PCn for
less or more processing.

Factory Processing Presets are stored as text files on the hard drive of the
same computer that runs the OPTIMOD-PCn Service. During installation
of the OPTIMOD-PCn Service, a Presets folder containing all the factory
Preset files is created in the

C:\Program Files (x86)\Orban\Optimod-PCn 1600\presets\
folder.

Each set of Factory Preset files consists on one "master” file and several
“less/more” files. Master files contain the preset data that is first loaded
when you activate a factory preset. Less/more files contain the preset da-
ta that is called up when you edit a factory preset via the Control applica-
tion’s one-knob “less/more” editing procedure. If there is no less/more
file for the specific less-more setting you choose, OPTIMOD-PCn will au-
tomatically generate the data by interpolating between the contents of
the two nearest less/more files.

The suffix of the master Factory preset files is orb1600£. Within the pre-
set folder on your hard drive, there is a corresponding less/more folder
named after the master factory preset file. The Less/More files are locat-
ed in these folders. The file names of the less/more files are [preset name]
LMxxx.orbl600f, where “xxx" is three numbers, like “080” (which cor-
responds to a LESS/MORE value of 8.0).

All of these files have the “read-only” attribute to make them inconven-
ient to erase, even at the operating system level. You cannot erase or
overwrite them from the OPTIMOD-PCn Control application. If you erase
or modify a factory or less/more file from an external file manager like
Windows Explorer (a very unwise thing to do), you will have to reinstall
the OPTIMOD-PCn software to regenerate the file unless you have a
backup copy of the file elsewhere.

Each factory preset has an associated folder containing all of the
less/more files for that preset. The less/more folders are located immedi-
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ately below the presets folder; each less/more folder bears the name of
its associated preset.

You can create custom “factory” presets that have full LEss-MoRE functionality. See
Creating Custom “Factory” Presets on page 3-90.

Customizing Processing Presets

You can change the settings of a Factory Processing Preset, but if you want to pre-
serve your changes, you must then store those settings as a User Preset, which you
are free to name as you wish. You can also create User presets by editing existing
user presets and saving the results under a new name.

The suffix of User Presets is orRB1600USER. The Factory preset remains unchanged.

You cannot create User Presets from scratch. Start by recalling a Factory preset. You
can then immediately store this in a new User Preset (with “Save As” from the FILE
menu), give it whatever name you wish, make changes to the settings as desired,
and then save it again. Alternatively, you can recall a Factory preset, make the
changes first, and then store this as a User Preset. Either way, the Factory preset re-
mains for you to return to if you wish.

You can also modify an existing User Preset.

When you modify an existing preset, whether Factory or User, the
OPTIMOD-PCn server software will automatically generate a temporary
User Preset whose name consists of “Modified” appended to the front of
the existing preset name. If you do not save your modifications, this tem-
porary preset will remain on the server’s hard drive until you further
modify any preset. Then the temporary preset will be overwritten.

You can store as many User Presets as the 1600PC application’s host computer hard
drive and operating system can accommodate. User Presets are shown on the “Open
Preset” list by the name that you gave them when you saved them.

You can name them as you wish, limited only by the file naming limits in your oper-
ating system.

Do not use a suffix; .orb1600user will be added automatically.

User Presets are not stored the c:\Program Files (x86)\Orban\Optimod-PCn
1600\presets\ folder. By default, they are instead stored in on the computer run-
ning the OPTIMOD-PCn Service in

C:\Users\Public\Documents\Orban\Optimod-PCn 1600\Processor[x]\presets,

where “Processor[x]” is the name of the audio Processor (for example, "Proces-
sor1”). Additionally, when it connects to the OPTIMOD-PCn Service, 1600PC makes
copies of the Factory Presets and store them here too (although without their asso-
ciated LEss-MoORE folders).
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If you are running 1600PC on a different computer from that running the OPTIMOD-
PCn Service, 1600PC automatically copies to the remote computer the User Presets
associated with the audio Processor to which you are connected. It also copies the
Factory Presets. Again, the default folder is

C:\Users\Public\Documents\Orban\Optimod-PCn 1600\Processor[x]\presets.

A User Preset that you create while working with a given Processor is available only
to that Processor. If you wish to copy User Presets from Processor x to Processor vy,
you must use Windows to copy the corresponding *.ORB1600USER file from

C:\Users\Public\Documents\Orban\Optimod-PCn 1600\Processor[x]\presets tO
C:\Users\Public\Documents\Orban\Optimod-PCn 1600\Processor[y]\presets.

Do this on the computer running the OPTIMOD-PCn Service.

If you want to back up a user preset, use the standard Windows file copy mechanism
to copy it from any folder where it is currently located into a backup folder you have

made. It is wise to back up User Presets regularly.

If you want to delete a user preset, use Windows to delete the preset’'s associated
* .ORB1600USER file.

Setup presets

Setup presets contain setup information, such as input levels, output levels, global
TARGET LOUDNESS, and operate/defeat switches for various signal-processing blocks.
Like Processing presets, you may customize Setup presets and save them from FILE >
SAVE SETTINGS AS in the control application.

Overview of an OPTIMOD-PCn Installation

OPTIMOD-PCn 1600 is a Windows Service running on Microsoft Windows 7 or higher
and an Intel x86 CPU. All encoding and audio processing is performed natively on
the x86 CPU.

The 1600's OPTIMOD-PCn audio processing is controlled via the 1600PC control ap-
plication, which can run locally or remotely.

The 1600PC control software is supported only on Windows 7 and higher
computers.
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The OPTIMOD-PCn 1600 Service can spawn up to 16 independent audio processors,
depending on the number of Processors you have purchased. Each Processor can be
controlled independently by the 1600PC control application.

The number of Processors you have purchased determines the maximum
number of instances permitted on your system. However, turning on
CPU-intensive parts of the OPTIMOD-PCn 1600 processing, like the MX
limiter or Optimix upmixer, may limit the number of available instances
to fewer than the maximum because all of the CPU power has been used
up. If the CPU is overloaded, it will cause audio glitches and stuttering.
See Table 1-1 on page 1-5 and associated text.

Operationally, Processors are almost independent of each other. 1600PC connects to
only one Processor at a time, allowing you to recall, edit and save presets, set in-
put/output mix levels, and do other housekeeping tasks for that Processor. Multiple
instances of 1600PC can be connected simultaneously to different Processors, regard-
less of whether they were spawned by a single OPTIMOD-PCn Service or by multiple
Services on multiple computers.

An important exception to this principle of independence is that changing the setup
parameters of a given Processor, like its input and output sound devices, requires
the Service to be stopped and restarted. This will briefly interrupt audio for all Pro-
cessors and will happen automatically from the TooLs > SERVICE SETTINGS menu if
you open it and then click OK. If you accidentally open the Service Settings menu
and do not want to interrupt audio, click CANCEL.

Processors are named “Processor1,” Processor 2,"” etc., and are identified as such in
the Service Settings window in 1600PC. For convenience, you may assign each one a
name (“alias”). Instructions for doing so are provided in Section 2 of this manual.
This allows the 1600PC control application to be connected to the desired Processor
and allows you to specify the audio input and output routing of each instance.

Conceptually, there are two options for operating OPTIMOD-PCn: Jocal and net-
work. Regardless of whether operation is “local” or “network,” a server that accepts
TCP/IP communications runs in the background on the 1600.

e Network operation allows you to control one or more OPTIMOD-PCn Services
over a network, regardless of whether the Service is located in the controlling
computer. This is the recommended configuration. It allows the computer run-
ning the Service to provide a maximum number of audio Processors and facili-
tates locating this computer in a machine room without being connected to a
keyboard, mouse, or monitor.

e Local operation runs the 1600PC control application on the same computer as
the Service. Local operation is not preferred because it dedicates some of the
1600's CPU power to running the remote software instead of audio processing
or encoding, and because the computer running the Service may not be
equipped with high-resolution graphics.
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The 1600PC control application always uses TCP/IP to communicate through the
1600's server software to instances of the audio processing. All Processors running in
one 1600 Service are controlled via the same IP address and port numbers.

Start up the 1600PC control application as you would any Windows application. As
of this writing, it is necessary to run 1600PC with Administrator privileges so that it
can address the parts of the Registry that contain the Service parameters.

The Control application will initialize without connecting to an instance, so you
must connect the application to the instance you wish to control.

Networking the 1600: Overview

The 1600PC control application can control one or more 1600s installed anywhere on
a TCP/IP network, including the Internet. A complex system (such as one that a major
broadcast group, or large server farm/ISP might operate) could have dozens of cli-
ents and servers networked together. Each host computer has a TCP/IP address and
port assigned to it and runs one instance of the OPTIMOD-PCn Service. We will call
such a host computer a “server.” The Service is the “switchboard” that allows the
1600PC to control multiple Processors running on one computer.

The control application can automatically find all Processors within a given host
computer anywhere on the network if the control application knows the IP address
of the host computer and the Port number assigned to the Service in TooLs >
SERVICE SETTINGS.

To connect to a Processor, you must first add the host computer/server to your con-
trol application via CONNECT > ADD PROFILE (step 15 on page 2-12). Here, you provide
the host computer’s IP address and port number. Once a profile is added, you can
connect to it by choosing the desired Processor in the CONNECT drop-down list.

Each local copy of the Optimod-PCn Control application allows you to name a 1600
server (e.g., “Server 1"”) so you do not have to remember its IP address each time you
connect the Control application to it.

The server names are stored locally on each computer; each local copy of
the Optimod-PCn Control application can create a different profile name
for a given server. A server's real “name” is always its IP address.

You can see a drop-down list of all instances that have been added previously, re-
gardless of whether you are logged onto the host computer housing those instanc-
es. Once you have logged onto the host computer, you can connect to any Processor
on this list if it is “available” (that is, if it running in the host). If you have not previ-
ously connected to a given instance and specified “remember password,” you must
supply your User Password before you can connect.

Once you have specified “Remember Password,” the password dialog box
will not appear again and the “Remember Password” status can only be
canceled by an administrator. “Remember Password” can compromise se-
curity, so you should use this feature with discretion.
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Only one client can be logged into a given Processor at one time; the instance will
return "in use” if another client attempts to log into the same instance. However,
more than one client can be logged onto a given host computer at once if each cli-
ent is logged onto a different Processor within that host.

Section 2 of this manual provides detailed, systematic instructions for setting up a
network.

Security

OPTIMOD-PCn is designed for networking. Because most PCs are now networked,
the instances must be protected from unauthorized access when networking is acti-
vated. Two levels of security achieve this:

e Each Processor has a User password that allows an authorized user to “connect”
to the instance via the OPTIMOD-PCn Control Application. When this occurs, the
user can work with the audio processing functions in the instance, can change
and edit presets, and can do other tasks similar to those that one would do on a
stand-alone audio processor. Additionally, each Processor has a Terminal Pass-
word (operating at the User security level) that allows you to connect to an in-
stance via the OPTIMOD-PCn TCP/IP terminal server to allow external control of
the Instances from either a Telnet/SSH client or a custom third party application.
See OPTIMOD 1600PCn Control APl on page 5-1.

e Each OPTIMOD-PCn Service has an Administrator password that allows an ad-
ministrator to set up the Service and the various Processors.

Only an administrator can assign and change user passwords. If the user
has checked “remember password” on the dialog box requesting pass-
word entry, only the administrator can “uncheck” the “remember pass-
word” function for that instance.

Unless networking is activated, Processors located in a given machine are
visible only to the Optimod-PCn Control application running locally on
that machine. They are invisible to other machines on the network. Not
running in “network” mode therefore provides considerable security.

e By creating a “Network Accept List,” you can specify which computers are per-
mitted to connect to a given OPTIMOD-PCn instance. This provides a layer of se-
curity that complements password protection. See step (7.C) on page 2-7.

Each audio Processor is enumerated as “Processor[x],” where x is a digit, with the
first instance starting at 1. The number is the fundamental means by which the Op-
timod-PCn software identifies the instance.

The Optimod-PCn software allows you to give a Processor an easily remembered
name (e.g., “KORB Streaming”) so the software does not have to address the Proces-
sor by its generic name. This name is an alias that is local to the computer from
which you named the Processor; the same Processor could be known by a different
name on each computer in the network.
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If you give your Processor an alias name, this name will appear (instead of
PROCESSOR 1, etc.) next to the Service name in the Connect drop-down box and at
the top left hand corner in the 1600PC application when you are connected to that
instance.

Only the generic name (“Processor[x]”) is unique. The name is always
available on "Service Settings” screen, which is accessible from the Tools
drop-down menu box. The 1600PC Remote application uses the generic
name to identify the folder on the host computer’s hard drive that con-
tains the setup and user presets (if any) for that instance.

Only an administrator can rename an instance (profile), and that name
will remain only on the machine from which it was assigned that name.

For 1600PC to access Processors on other machines, 1600PC must always know these
remote Processors’ passwords to access them. The administrator initially assigns
these passwords at the machine in which the remote Processors are installed. If you
plan network operation, it is very important to assign both a User and an Adminis-
trator password to each Processor in that machine to prevent the Processors from
being hacked.

The dual password system is useful in protecting a networked installation
from being damaged by disgruntled employees or hackers who might get
access to a User password and server IP address. A malicious user might
set incorrect presets and audio levels, activate test tones, mute the audio,
or delete user presets. (This is another reason, other than potential hard
drive failure, why it is wise to back up user presets.)

However, a malicious user cannot take exclusive control of a Processor by
changing its name or password. Only an administrator can do that.
Meanwhile, the administrator can change User passwords and rename
Processors from a central location. It is wise to do this each time a person
with a User password leaves the employ of the entity doing the stream-
ing or broadcasting—it’s like “changing the locks.”

No networked Processor is viewable inside 1600PC Remote software until you "add”
its Profile (which encompasses all audio Processors spawned from a given computer’s
Service) to the list of viewable instances by going into Connect>Add and then sup-
plying the IP address and the instance’s User password (if a password was assigned
to that instance). This allows one host computer to accommodate multiple Proces-
sors, each processing competitor's streams, while allowing a given competitor to
view only its own Processor(s) from the Control application.

Input/Output Configuration

To move audio into and out of OPTIMOD-PCn, use normal sound input/output
hardware having Windows drivers. The drivers must support WASAPI at the output
side. OPTIMOD-PCn uses Windows MME on the input side so that Windows can per-
form sample rate conversion if necessary.
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The input/output sample rate of OPTIMOD-PCn is 44.1 kHz, 48 kHz, 96 kHz, and 192
kHz, 16-bit or 24-bit. Using Windows Control Panel > Sound, you must configure the
sound devices you are using for the sample rate and bit depth of your choice.

We recommend 48 kHz, 24-bit. The processing always runs internally at
48 kHz. 44.1 kHz, 96 kHz and 192 kHz support were added for the con-
venience of users who are embedding the Optimod into facilities built
around one of these sample rates. Because the high-quality synchronous
sample rate converters in your Optimod put additional load on your CPU,
do not use 44.1 kHz, 96 kHz or 192 kHz unless you have a good reason to
do so.

Locking Clocks: If the input and output sound devices are not on the same hardware
(for example, if they are on two separate soundcards), to achieve long-term stability
the sample rates of the input device and output device must be proactively locked
together. Simply setting the sample rates of the input and output device to the
same numerical value is insufficient. Failure to proactively lock sample rates will
cause the musical pitch of the output to be slightly different from the input and can
cause glitching and/or a delay build-up between input and output because samples
are not being read out from the output at the same rate that they are being ap-
plied. Synchronization is customarily achieved with a wordclock connection to both
devices. If you are using an audio-over-IP connection, be sure that the wordclock
generator is locked to the AolP network sample rate, which is customarily deter-
mined by “Grandmaster” clock hardware on the network.

See the diagram on page 1-41 for typical correct (labeled [¥) and incorrect (labeled
Q) setups with an internal audio source. See page 1-43 for correct and incorrect set-
ups with an external audio source. These diagrams can be magnified as needed.

Subject to the limitations below, you may use Virtual Audio Cable to move audio
from one application to another (for example, from a playout system to the input of
OPTIMOD-PCn), VAC is available for purchase at a reasonable price'. VAC includes a
driver that allows you to create multiple “virtual audio cables” in software, so you
can interconnect audio applications without looping them through a hardware
sound card. Each cable you create appears in Windows’' list of available sound I/0
devices.

To avoid glitches or delay build-up, the input and output sample rate of a given ap-
plication must be precisely locked together, but the VAC clock frequency cannot be
locked to a hardware sound device. Moreover, older versions of VAC did not support
locking multiple VAC “cables” to the same (internal) clock. Hence VAC can only be
used safely with a given application if that application uses VAC for both input and
output and you are using the current version of VAC.

An example of a safe chain within a given computer is:
Playout System > VAC > OPTIMOD-PCn > VAC > Streaming Encoder > Network.

" http://software.muzychenko.net/eng/vac.htm
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You must carefully configure VAC to match how you have set up the input and out-
put sample rate and bit depth (step 10 on page 2-8). The input of a stereo or mono
instance of OPTIMOD-PCn is always two-channel. If you have purchased the upmix-
ing version of a stereo Processor, then that Processor can be configured for stereo or
5.1 surround output; 5.1 is needed if you wish to use the Optimix upmixer. If a given
Processor is configured for stereo output, the Optimix controls will not appear in
1600PC.

Using OPTIMOD-PCn for Netcasting

It is usually best to run the OPTIMOD-PCn audio processor on the same computer
that runs your streaming encoder. This simplifies interconnection between the audio
processor(s) and encoder(s). In Windows installations, we recommend using Virtual
Audio Cable to pass the processed output of OPTIMOD-PCn to the streaming encod-
er.

OPTIMOD-PCn’s inputs accept uncompressed PCM-format digital audio from a Win-
dows Sound Recording Device, as shown in the Windows Sound Control Panel. For
surround processing, the device must be capable of multichannel operation.

The inputs will not accept “bitstream” inputs encoded with formats like Dolby Digi-

tal® or DTS®. Inputs must be “PCM” (Pulse-Code Modulation) format with sample
rates of 44.1 kHz, 48 kHz, 96 kHz, or 192 kHz and 16 or 24 bit word length.

Using OPTIMOD-PCn in Digital Radio Service

The best location for OPTIMOD-PCn is as close as possible to the transmitter so that
OPTIMOD-PCn’s digital output can be connected to the transmitter through a signal
path that introduces no change in OPTIMOD-PCn'’s output PCM bitstream.

Sometimes it is impossible to locate OPTIMOD-PCn at the transmitter. Instead, it
must be located on the studio side of the link connecting the audio facility to the
transmitter. If the transmitter is not accessible, all audio processing must be done at
the studio, and you must tolerate any damage that occurs later.

If an uncompressed digital link is available, this is an ideal situation because such a
link will pass OPTIMOD-PCn’s output with little or no degradation. However, such a
link is not always available.

If only a 32 kHz sample rate link is available, the sample rate conversion
necessary to downsample the audio will cause overshoots when
OPTIMOD-PCn is operated at 20 kHz bandwidth because the sample rate
converter removes spectral energy. In this case, you can minimize over-
shoot by operating OPTIMOD-PCn at 15 kHz bandwidth. (Set it from the
GLOBAL tab in the 1/0O window:.)

Unless the path is a digital path using no lossy compression, this situation will yield
lower performance than if OPTIMOD-PCn is connected directly to the transmitter
because artifacts that cannot be controlled by OPTIMOD-PCn will be introduced by
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the link to the transmitter. These artifacts can decrease average modulation by 2-
4dB and can also add noise and audible nonlinear distortion. In the case of lossy dig-
ital compression, this deterioration will be directly related to the bitrate. For an ana-
log path, the deterioration will depend on the amount of linear and nonlinear dis-
tortion in the path.

One strategy is to apply to OPTIMOD-PCn’s output signal the same lossy compression
that the digital radio transmitter would apply. If a digital link is available with suffi-
cient bitrate to pass this compressed signal, it can then be passed directly to the digi-
tal radio transmitter without further processing if synchronization issues can be re-
solved. Consult with the manufacturer of your digital radio transmitter to see if this
can be done.

Where only an analog or lossy digital link is available, feed the audio output of
OPTIMOD-PCn directly into the link. If available, the transmitter’s protection limiter
should be adjusted so that audio is normally just below the threshold of limiting:
The transmitter protection limiter should respond only to signals caused by faults or
by spurious peaks introduced by imperfections in the link.

Where maximum quality is desired, it is wise to request that all equipment in the
signal path after the studio be carefully measured, aligned, and qualified to meet
the appropriate standards for bandwidth, distortion group delay and gain stability.
Such equipment should be measured at reasonable intervals.

It is important to understand that the codecs used in digital radio service introduce
overshoot as a side-effect of bitrate reduction. It is wise to evaluate the codec in use
for this issue. In general, allowing 2 dB of headroom (by setting OPTIMOD-PCn out-
put level control at -2 dB) will suffice even for HE-AAC because overshoots above 2
dB have low energy and are unlikely to be audible.

OPTIMOD-PCn at the Transmitter: Gain Control before the STL

The audio received at OPTIMOD-PCn’s input should have the highest possible quali-
ty. To achieve the full audible benefit of OPTIMOD-PCn processing, use a studio-
transmitter link (STL) that is as flat as the bandwidth of OPTIMOD-PCn as used in
your facility (usually 20 kHz). Ideally, you should use a 20-bit (or better) uncom-
pressed digital link with at least 44.1 kHz sample frequency.

Because the audio processor controls peaks, it is not important that the audio link
feeding OPTIMOD-PCn’s input terminals be phase-linear. However, the link should
have low noise, the flattest possible frequency response from 20-20,000Hz, and low
nonlinear distortion.

If the audio link between the studio and the transmitter is noisy (or, if digital, is lim-
ited to 16 bits or less), performing the AGC function at the studio site can minimize
the audibility of this noise. AGC applied before the audio link improves the signal-
to-noise ratio because the average level on the link will be greater. Further, many
STLs require level control to prevent the STL from being overloaded. You can use
another 1600 for this purpose.
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Setting Output/Modulation Levels

In a perfect world, one could set the peak level at OPTIMOD-PCn’s output to 0 dBFS.
However, there are at several potential problems that may make it desirable to set
the modulation level slightly lower.

IMPORTANT: In OPTIMOD-PCn, adjusting the output level control does not change
loudness; it only sets the amount of headroom between 0 dBFS and the maximum
peak output level produced by the audio processing. This allows you to easily adjust
the output level control to compensate for downstream overshoots. See Setting
Loudness on page 1-20 and step (4.C) on page 2-18.

e First is the fact that the peak limiter operates at a finite sample rate: 192 kHz
(non-MX) or 256 kHz (MX). This ensures that overshoot after phase-linear sample
rate conversion or D/A conversion will not exceed 0.5 dB and will typically be less
than 0.1 dB.

e Second is additional processing, such as equalization. Equalization that applies
boosts at certain frequencies is very likely to add peak level and thus cause clip-
ping. However, equalization that attenuates certain frequencies can also cause
overshoots because of added phase shifts. So be wary of any equalization and al-
low headroom to accommodate it.

e Third is headroom in lossy data compression systems. A well-designed perceptual
encoder will accept samples up to 0 dBFS and will have internal headroom suffi-
cient to avoid clipping. However, there is no guarantee that receiver manufac-
turers or decoder providers will implement perceptual decoders with sufficient
headroom to avoid clipping overshoots, and in fact, some very popular player
devices and software suffer from clipping in the analog domain due to over-
shoot. Such overshoots are the inevitable side effect of increasing the quantiza-
tion noise in the channel, and can be as large as 3-4dB. Most perceptual encoder
algorithms are designed to have unity gain from input to output. So if peak lev-
els at the input frequently come up to 0dBFS, peak levels at the output will fre-
quently exceed 0dBFS (and will be clipped) unless the decoder algorithm is ad-
justed to be less than unity gain.

Canny engineers will therefore familiarize themselves with the performance of
real-world receivers and player software and will reduce the peak modulation of
the transmissions if it turns out that most receivers are clipping due to perceptu-
al encoding overshoots. Our experience to date indicates that allowing 3dB
headroom should prevent audible overshoot-induced clipping in low bite-rate
systems (e.g., 32 kbps streams), while 2dB is adequate for 128kbps and above.
While some clipping may still occur, it will have a very low duty cycle and will
almost certainly be inaudible.

In sound-for-picture applications, the goal is often to have the loudness of your
broadcast or stream be the same as the loudness of other broadcasts or streams so
that consumers do not have to readjust their volume controls when changing from
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one program stream to another. EBU R128 extends this concept to other media and
transmission types with the goal of delivering consistent loudness to consumers re-
gardless of the program type or source.

Dolby digital broadcasts and streams contain “dialnorm” metadata to help achieve a
specified target loudness. OPTIMOD-PCn 1600 has been designed to always support
dialnorm (called “target loudness” in OPTIMOD-PCn), making it easy to ensure cor-
rect loudness. While some of the concepts may seem unfamiliar at first, learning
about them can pay off by increasing audience comfort and satisfaction. See About
Target Loudness and ITU-R BS.1770 starting on page 1-16.

Managing Delay from Input to Output

To optimize audio quality and to allow adding features like automatic phase skew
correction and surround upmixing, we chose to design the 1600 audio processing
software without regard to input/output delay. Accordingly, the delay can be as
much as 1 second. Because of limitations of the Windows audio system, this delay is
not 100% repeatable; it is not possible to achieve sample-accurate delay matching of
the 1600's audio processor to an external delay.

However, the differential delay between the surround and downmix outputs of a
surround instance is fixed to sample accuracy. Moreover, the delay of a given in-
stance in “pass-through” mode is always matched to its delay in “operate” mode, so
it is possible to crossfade between the modes smoothly.

OPTIMOD-PCn allows the functions listed below to be smoothly activated or defeat-
ed during audio programming, which is done via controls in the processing presets.
Because these functions each add significant input/output delay and CPU usage,
Setup presets include switches that can defeat these functions entirely and remove
their delay from the audio path.

e Phase Skew Correction
e Stereo Synthesis
e Optimix upmixing

Conversely, the MX limiter functions (MX LIMITER INOUT and MX OVERSHOOT
SOFT/HARD) change the I/O delay when they are turned on and off. This is because
the MX limiter is very CPU-intensive, so it is undesirable to run the MX processing
when it is unneeded just to permit smooth switching between MX and non-MX lim-
iting.

Because the I/0 delay changes, it is impossible to switch between presets having dif-
ferent settings of the MX LIMITER IN/OUT and/or MX OVERSHOOT SOFT/HARD controls
without introducing audio glitches. This is usually not a problem because MX opera-
tion always equals or outperforms non-MX operation. (It will outperform whenever
a significant amount of peak limiter gain reduction occurs, as indicated on the
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LIMITER G/R meters.) The only reasons to defeat MX operation are to decrease CPU
loading and/or delay.

Monitoring on Loudspeakers and Headphones

In live operations, highly processed audio often causes a problem with the DJ or pre-
senter’s headphones. Thanks to no-compromise audio processing, the delay through
OPTIMOD-PCn can be as much as 1 second, so its output cannot be used for monitor-
ing in live broadcasting, as it will affect audio cueing and DJ mixing in addition to
being unacceptably distracting through headphones.

Such problems can be avoided if the DJ/presenter’s headphones are driven directly
from the program line or, better, by an inexpensive analog compressor connected to
the program line. If the DJ/presenter relies principally on headphones to determine
whether a digital radio station is on the air, simple loss-of-data and loss-of-audio
alarms should be added to the system. Such alarms could be configured to cut off
audio to the DJ/presenter’s phones when an audio or carrier failure occurs.

If monitoring a live broadcast though audio processing is essential, one can instead
use Orban’s OPTIMOD-PC 1101 card, which uses onboard DSP to achieve low delay.
However, this card is cannot provide audio quality as high as that delivered by the
1600.

Controlling Levels in a Playout System Feeding
OPTIMOD-PCn

To optimize the consistency of a broadcast or netcast, preprocessing each program
element via OPTIMOD-PCn before it is stored on a playout system is not as effective
as processing the playout system’s output in real time using OPTIMOD-PCn. The lat-
ter technique maximizes the smoothness of transition between program elements
and makes voice from announcers or presenters merge smoothly into the program
flow, even if the announcer is talking over music.

You can help OPTIMOD-PCn operate best by setting the level of each program ele-
ment when you load it into the playout system. Many audio editing programs per-
mit a sound file to be “peak-normalized,” which amplifies or attenuates the level of
the file to force the highest instantaneous peak to reach 0 dBFS. This is a very poor
way to set the levels of different audio files on a playout system. Absolute peak lev-
els have nothing to do with loudness, so peak-normalized files are likely to have
widely varying loudness levels depending on the typical peak-to-average ratio of the
audio in the file. Because of over-use of peak limiting in today’s CD mastering
(which has the unfortunate side-effect of sucking the life and punch out of music),
the average level of a CD produced in the ‘80s can be as much as 15 dB lower than
the average level of a CD produced today. When a playout system segues two such
disparate peak-normalized files, this can cause audible loudness inconsistencies in
your broadcast/netcast while OPTIMOD-PCn’s AGC section corrects the loudness.
OPTIMOD-PCn's AGC section uses window-gating technology to minimize the audi-
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bility of such gain riding. Even so, 15 dB of level correction can take several seconds
and is determined by OPTIMOD-PCn’s AGC release time setting.

It is far better to normalize levels in a playout system by making the average levels
of all elements identical, which means that they would all peak at the same level
when observed with a VU meter. The average output level of the playout system
should be set to about —18dBFS to keep OPTIMOD-PCn AGC nominally in the center
of its range. This allows OPTIMOD-PCn’s AGC to work as unobtrusively as possible.
Moreover, if your system includes locally originated speech material, using a micro-
phone processor (like the dbx 286A, Symetrix 528E, or AirTools 6200/2x) will help
smooth the transition between live and recorded program segments.

You can also achieve good results by normalizing files so that they all have the same
BS.1770 loudness, integrated over the entire file.

Managing Audio Clocking: Block Diagrams

See Locking Clocks on page 1-35.

The diagram on page 1-41 shows typical correct (labeled V1) and incorrect (labeled
Q) setups with an internal audio source. The diagram on page 1-43 shows correct
and incorrect setups with an external audio source. These diagrams can be magni-
fied as needed.
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Using Lossy Data Reduction in the Audio Chain be-
fore OPTIMOD-PCn

Many broadcasters and netcasters are now using lossy data reduction algorithms like
MPEG-1 Layer 2 or Layer 3 to increase the storage time of digital playback media. In
addition, source material is often supplied through a lossy data reduction algorithm,
whether from satellite or over landlines. Sometimes, several encode/decode cycles
will be cascaded before the material is finally presented to OPTIMOD-PCn's input.

All such algorithms operate by increasing the quantization noise in discrete frequen-
cy bands. If not psychoacoustically masked by the program material, this noise may
be perceived as distortion, “gurgling,” phasiness, or other interference. Psychoa-
coustic calculations are used to ensure that the added noise is masked by the desired
program material and not heard. Cascading several stages of such processing can
raise the added quantization noise above the threshold of masking, such that it is
heard. In addition, there is at least one other mechanism that can cause the noise to
become audible at the radio. OPTIMOD-PCn’s multiband limiter performs “automat-
ic equalization” that can significantly change the frequency balance of the program.
This can cause noise that would otherwise have been masked to become unmasked
because the psychoacoustic masking conditions under which the masking thresholds
were originally computed were changed.

Accordingly, if you use lossy data reduction in the studio, you should use the highest
data rate possible. This maximizes the headroom between the added noise and the
threshold where it will be heard. In addition, you should minimize the number of
encode and decode cycles, because each cycle moves the added noise closer to the
threshold where the added noise is heard.

Warranty, User Feedback

User Feedback

We are very interested in your comments about this product. We will carefully re-
view your suggestions for improvements to either the product or the manual. Please
email us at info@indexcom.com.

LIMITED WARRANTY

Rorb Inc. warrants Optimod-PCn software and its associated security key (if used)
against defects in material or workmanship for a period of one year from the date
of original purchase for use, and agrees to repair or, at our option, replace any de-
fective item without charge for either parts or labor.

Software upgrades and technical support expire one year from your date of pur-
chase unless you have purchased a maintenance contract either when you pur-
chased the OPTIMOD-PCn software or any time before your original support period
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expires. After this date, support time extensions are no longer available for pur-
chase, and you must purchase a new version of the software if you wish to upgrade.

If you purchased Optimod-PCn pre-installed by Modulation Index LLC in a computer,
please refer to the separate Modulation Index warranty covering the computer
hardware.

IMPORTANT: This warranty does not cover damage resulting from accident, misuse
or abuse, lack of reasonable care, loss of parts, or attempts to use this product in
computers not having the supported CPU and operating systems (see Hardware and
Software Requirements starting on page 1-3). No responsibility is assumed for any
special, incidental, or consequential damages. However, the limitation of any right
or remedy shall not be effective where such is prohibited or restricted by law.

No other warranty, written or oral, is authorized.

This warranty gives you specific legal rights and you may have other rights that vary
from state to state. Some states do not allow the exclusion of limitations of inci-
dental or consequential damages or limitations on how long an implied warranty
lasts, so the above exclusions and limitations may not apply to you.
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Section 2

Installation

Hardware Installation

These Hardware Installation instructions apply to computers pre-configured with 1600
PC software.

Allow about 2 hours for installation.

Installation consists of: (1) unpacking and inspecting the 1600, (2) mounting the
1600 in a rack, (3) connecting inputs, outputs, Ethernet, and power.

DO NOT connect power to the unit yet!

1. Unpack and inspect.

A) If you note obvious physical damage, contact the carrier immediately to make
a damage claim. Packed with the 1600 are:

Quantity Item
1 Operating Manual and software on CD

2 Line Cords (domestic, European)
4 Rack-mounting screws, 10-32 x ¥%z—with washers, #10
1 PC Remote Software CD

B) Save all packing materials! If you should ever have to ship the 1600 (e.g., for
servicing), it is best to ship it in the original carton with its packing materials
because both the carton and packing material have been carefully designed
to protect the unit.

2. Mount the host computer in a rack.

There should be a good ground connection between the rack and the host com-
puter chassis — check this with an ohmmeter to verify that the resistance is less
than 0.5Q.

When running the maximum number of OPTIMOD-PCn Processors, the comput-
er's CPU can dissipate more than 100 watts, and you must account for this in your
installation. Mounting the unit over large heat-producing devices (such as a vac-
uum-tube power amplifier) may shorten component life and is not recommend-
ed. Ambient temperature should not exceed 45°C (113°F) when equipment is
powered.
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Equipment life will be extended if the unit is mounted away from sources of vi-
bration, such as large blowers and is operated as cool as possible.

Install the appropriate power cord(s).

Depending on how they are ordered, some host computers are equipped with
dual-redundant power supplies with automatic failover. Each power supply has a
dedicated connection to the AC line. For maximum reliability, connect the two
supplies to two AC circuits.

AC power passes through an IEC-standard mains connector and an RF filter de-
signed to meet the standards of all international safety authorities.

The power cord is terminated in a “U-ground” plug (USA standard), or CEE7 / 7
plug (Continental Europe), as appropriate to your 1600’s Model Number. The
green/yellow wire is connected directly to the 1600 chassis.

If you need to change the plug to meet your country’s standard and you are
qualified to do so, see Figure 2-1. Otherwise, purchase new mains cords with the
correct line plug attached.

The host computer requires a significant amount of time to boot up, so a brief
AC line glitch that causes the computer to restart will cause a significant inter-
ruption in audio service and will shut down Windows abnormally. Therefore, we
strong recommend driving the computer from an uninterruptable power supply.
To achieve maximum reliability, connect each power supply to a separate UPS. In
addition, a UPS should protect the computer from line surges and minimize the
likelihood of damage caused by them.
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4. Connect inputs and outputs.

Do this according to the manufacturer’s instructions for the Windows input and
output devices you will be using. See step 10 on page 2-8.

5. Connect to a network.

The host computer has two Ethernet ports, one dedicated to control and one to
audio-over-IP transport, such as Ravenna and Dante. The corresponding audio-
over-IP driver software must be installed in the computer. To achieve highest ca-
pacity and lowest latency, the audio network should be dedicated only to audio
and should not be shared with other data traffic.

We recommend that you control the 1600 via your non-audio LAN from a remote
computer running our 1600PC software. This allows the 1600 hardware to run a
maximum number of audio Processors and facilitates locating the 1600 in a ma-
chine room.

Because the 1600 runs the Windows operating system, you must assign it a static
IP address, subnet mask, and gateway using standard Windows procedures. (We
assume that you already know how to do this.) Using a static IP allows you to
connect reliably to the 1600 from remote computers running our 1600PC remote
control software.

If the CPU is not fully loaded, you may also control the 1600 from an instance of
1600PC software running on the 1600 hardware. In this case, the 1600PC soft-
ware communicates with the 1600's audio processing via a “localhost” connec-
tion, which is set up in the 1600 as IP address 127.0.0.1.

Procedures and instructions for connecting to a PC are subject to development
and change. We advise you to download the latest version of this manual in pdf
format from
https://www.indexcom.com/support/Archive/Orban/1600/Documentation.’

You can use Adobe’s .pdf reader application to open and read this file. If you do
not have the .pdf reader, it is available for free download from www.adobe . com.

Software Installation and Setup

1. Defeat Windows Fast Startup (Windows 8 and higher).

To achieve most reliable startup, OPTIMOD-PCn Service is set for DELAYED START
in Windows and starts after a 60-second delay. Windows 8 introduced Fast
Startup, which overrides the delayed start during a power-on Windows boot. To
ensure that OPTIMOD-PCn starts reliably on power-up, you must defeat Windows
FAST STARTUP:

A) Navigate to CONTROL PANEL > ALL CONTROL PANEL ITEMS > POWER OPTIONS.

L For login credentials, contact: support@indexcom.com
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B) Click CHOOSE WHAT THE POWER BUTTONS DO on the left side of the screen.
Q) Click CHANGE SETTINGS THAT ARE CURRENTLY UNAVAILABLE.

D) Under SHUTDOWN SETTINGS, uncheck TURN ON FAST STARTUP (RECOMMENDED).
2. Install 1600PC software on the computer that will control the 1600.

1600PC software will be installed when you install the Service. However, in most
cases, it is preferable to control the 1600 from another computer because this
will maximize the amount of CPU power dedicated to processing audio.

To control the 1600 from another computer, you must install 1600PC software on
that computer. Because the 1600PC application is graphics-intensive but is oth-
erwise requires only a small amount of CPU power, almost any modern computer
will work if it has competent graphics support.

1600PC software is not copy-protected; you may install it on as many
computers as you wish. Remember that the 1600PC application does not
do audio processing; it only controls OPTIMOD-PCn Service(s) running on
local or remote computers. The Service does the audio processing and is
copy-protected via a hardware key or via a CodeMeter software license.

A) From https://www.indexcom.com/support/Archive/Orban, download the in-
staller program, Orban-Optimod-PCn_1600-1601-1602_x.x.x.x.exe, where
"x.x.x.x" represents the software version. (For example, for version 1.0 soft-
ware, this would be 1.0.0.0.) Downloading ensures that you get the latest
software version. For login credentials, contact: support@indexcom.com.

B) Run Orban-Optimod-PCn_1600-1601-1602_x.x.x.x.exe on its host computer by
right-clicking its icon and selecting RUN As ADMINISTRATOR. The installer will
start up. Follow the instructions it provides on each screen. In the SELECT
COMPONENTS screen, choose OPTIMOD APPLICATION FOR REMOTE ACCESS.

This program installs the necessary files and adds an Orban/Optimod 1600
folder to your computer’s Start Menu. This folder contains shortcuts to the PC
Remote application and to the documentation. If you accepted the option
during installation, there is also a shortcut to the PC Remote application on
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Up to I"I"‘L"jD j' Max inst IZD j' Ms per int |7 j' Stream ﬁ1'|t|imit|c'5'bIE range j' Clock corr ratio IIDD'DDDDDDD 3: I Volume contral

Reset counters |
Stream buffer watermark control——————————————————— ¥ Enable channelmixina [ Enable spk pin

Restartl
I Enabled  Low |90 7| ms High |20 ¥ ms Maxwait |3Dlj :l' ms | [~ UsePortCls  Stream buffer (ms) | 50
Restart Audio Enginel Set | Resetcountersl

Set
Prio I Auto j

Cable | M5 | SR range | BPS range | NC range | Stream fmt Iimitl Vol ctl | Chan mix | PortCls | Wmk ctl | Current format | Rc stms | Pb stms | Signﬂ Oflows | UFlows |
1 7 43000,,43000 16..16 2.6 Cable range Off On Off Off
2 7 44100..48000 16..16 2.2 Cable range Off Oon Off Off ExtPCM/(48000/16/2(3)

Figure 2-2: Virtual Audio Cable Setup
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If needed, install Virtual Audio Cable on the server computer.

If you need to connect audio from one application to another (such as the out-
put of a playout system to the input of OPTIMOD-PCn), we recommend using Vir-
tual Audio Cable. It is available for purchase from its vendor:

http://software.muzychenko.net/eng/vac.htm

VAC consists of an audio driver that creates Windows Recording and Playback
sound devices, and a control application. You must set up one “cable” for every
interconnection you require between applications. While it is beyond the scope

— Application Control Settings
Allow Tietwark to

Port: I 12100 W access Local

PrOCEsSOrs. .}

r |se Metwork
Accept List

Metwaork Accept List |

—Metwork Terminal Control Settings
Port: I 12101

Metwaork Accept List |

lUse localhost only
W
I for Terminal Access

IJse Mekwark
r Accept Lisk

— Serial Terminal Control Settings

r Allow Serial Port

Settings | Ao

—Service Security

Password: I

Confirm Password: I

—ViewfSet Audio IO Routing

Edit | IPrccesscr 1

—SMMP Settings

—SMMP Agent

{¥ Disable SMMP " Enable SMMP

Port | 151

Mote: Agent Port change and Disable feature
reguires an Optimod Service restart.

—Primary Manager

Address | 192 . 168 . 254 . 254

Port I ]

—Secondary Manager

Address | 192 . 168 . 254 . 254

Port | 0

—Community Strings

Read String: I

Confirm String: I

Write String: |

Confirm String: I

Mumber of Processors: |2

—Service

Stop Skark

—Upgrade and Suppart Rights Time Limit

| Expires On: Jun/17/2016

| Version is: Valid | Days Remaining: 366

Cancel |

Figure 2-3: Service Settings
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of this manual to provide detailed setup instructions, Figure 2-2 on page 2-4
shows a typical setup, where Cable 2 connects the output of a playout system to
the input of OPTIMOD-PCn. Carefully note the usage limitations in Locking
Clocks on page 1-35.

4. Authorize the server computer.

e [f your 1600PCn is protected by a hardware key: Plug the 1600PC copy protec-
tion key (supplied with your software) into an available USB port of the com-
puter you will be using to do audio processing. Any computer running the
OPTIMOD-PCn Service must be authorized.

The key does not require a Windows driver.

If the computer is already running without the key, inserting the key will
not automatically start the Service. Do this from the 1600PC TooLs >
SERVICE SETUP window.

e [f your 1600PCn is protected by CodeMeter software authorization: The soft-
ware installer (step 5 below) will install the document Instructions to create li-
cense request file for Optimod PCn.pdf and offer to open it. Follow these in-
structions to obtain your authorization.

5. Install 1600PC software on the computer that will run the Service and perform au-
dio processing.

Follow the instructions in step 1 above, except choose OPTIMOD APPLICATION AND
SERVICE in the SELECT COMPONENTS screen. Be sure that you run the installer as
Administrator.

During installation, the installer will automatically create an Inbound Rule in the
Widows Firewall to permit connection to the OptimodService3.exe applica-
tion. The firewall must permit inbound connections if you wish to control
OPTIMOD-PCn remotely.

6. Set up the Service.

NOTE: You can only set up the Service via a 1600PC running on the same PC as
the Service, and you must have Administrator rights to do so. You cannot use a
remote instance of 1600PC for this setup. If you need to set up the Service re-
motely, use Windows Remote Desktop to control a 1600PC running on the Ser-
vice computer.

A) Start up the 1600PC application on the computer running the Service.
B) Open the SERVICE SETTINGS window from TOOLS > SERVICE SETTINGS.

Q) In the NUMBER OF PROCESSORS drop-down, select the number of independent
audio processors you wish to run. This is limited to the number of processors
you purchased, which is encoded in your security key or CodeMeter authoriza-
tion, depending on which version of 1600PCn you have.

About the Upgrade and Support Rights Time Limit Field: The version of
OPTIMOD-PCn software you have purchased never expires, but free up-
grades and technical support are available for a limited time. The cutoff
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date and the number of Processors you have purchased r,e.lccept List ﬁ1
are encoded in your license key or CodeMeter authoriza-
tion. The date shown is the last day that free technical
support is available for your license, and you can only run
versions of the software released before this date. You
may purchase an extension any time before this date by
contacting info@indexcom.com. After this date, exten-
sions are no longer available for purchase, and you must
purchase a new version of the software if you wish to Add | | |
upgrade.

7. Set up application control settings.

Cancel |

These settings can allow 1600PC applications anywhere
on your network to connect to the Service.

A) Choose the Port that you will use to control the Service from 1600PC.
The default is 12100.

B) If you wish to allow 1600PC running on other computers to connect to the
Service, check ALLow NETWORK TO ACCESS LOCAL PROCESSORS.

By default, this box is not checked. When it is not checked, no Processor
in your computer can be accessed through the OPTIMOD-PCn Control
Application running on the network.

Before you check this box, be sure that you have assigned a password to
each OPTIMOD-PCn Processor in your computer (step 12.D) on page 2-11).

Q) If you wish to only allow certain IP addresses to connect to the Service:
a) Check the Use NETWORK ACCEPT list box.
b) Click the NETWORK ACCEPT LIST button.
¢) Click the ADD button.

d) Enter host name, domain name, IP address, or subnet address in CIDR

format.
Examples:
host.domain.com Single Computer
domain.com Entire Domain
123.45.67.8 Single Computer
123.45.67.8/24 Entire IP (subnet) Range
123.45.67.8/255.255.255.0 Entire IP (subnet) Range

e) If you wish to add another computer, repeat steps (a) through (c).

f) When you are finished adding computers, click OK.
8. Set up Network Terminal Control Settings

The OPTIMOD-PCn Service application hosts a TCP/IP terminal server to allow ex-
ternal control of the OPTIMOD-PCn Processors from either a Telnet/SSH client or
a custom third party application. Many controls are accessible and all commands
are simple text strings. Upon receiving valid commands, OPTIMOD-PCn will con
firm by returning a simple text string status message. By implementing external
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10.

control this way, multiple OPTIMOD-PCn
Processors can be controlled using stand-
ards-based network protocols (that are not
Microsoft Windows-specific) anywhere that
network connectivity is available.

A) The IP address of the terminal server is
the same as the address of the computer
hosting the Service. The default Port is
12101, but you can change this as de-
sired.

B) If you wish to allow only Localhost
(127.0.0.1) access to the terminal server,
check USE LOCALHOST ONLY FOR TERMINAL
ACCESS.

Set up security for the Service

In any but the simplest and most secure in-
stallations, we strongly recommend using
password protection to limit access to the
SERVICE SETTINGS. Enter it in the SERVICE
SETTINGS > SERVICE SECURITY / PASSWORD
box.

Set up audio I/O for each Processor.

Each Processor must have a Windows Re-
cording sound device assigned to its input
and a Windows Playback sound device as-
signed to its output. You may use the same
device for the input to more than Proces-
sor, but each output must be assigned to a
different device. Before you configure
OPTIMOD-PCn you must first configure
Windows to be consistent with the
OPTIMOD-PCn setup you are planning to
use. The sample rates of the input and out-
put devices must be locked together; see
Locking Clocks on page 1-35.

A) Set up the Windows Sound Devices you
will be using.

a) Go to Windows CONTROL PANEL>
SOUND> RECORDING> PROPERTIES>

Playback |Record|ng |Sounds |Communlmuons|

Select a playback device below to modify its settings:
Speakers
High Definition Audio Device
I Ready
Headphones
High Definition Audio Device
Ready
‘Wave Out 1 2047090834
# Orban Optimod 1101
@) Dcfault Device
‘Wave Out 2 2047090834
a Orban Optimod 1101
Ready
st oeaat |7

Choose your configuration

Select the speaker setup below that is most like
the configuration on your computer,

Audio channels:

!ﬂ

Click any speaker above to test it

General | Levels | Enhancements | Advanced

Default Format

Select the sample rate and bit depth to be used when running
in shared mode.

[16 bit, 48000 Hz (VD Quality) <[ et |

Exclusive Mode

Allnw applications to take exclusive control of this device
Give exclusive mode applications priority

Restore Defaults

[ oK ][ Cancel ” Apply ]

Figure 2-4: Windows Audio 1/O Setup

ADVANCED. For mono or stereo operation, configure each Recording device
for configure each Recording device for your choice of 44.1 kHz, 48 kHz, 96
kHz, or 192 IHz sample rate, 16-bit or 24-bit, 2 Channel.
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b) Go to Windows CONTROL PANEL> SOUND> PLAYBACK. Depending on whether
or not you want to be able to send an stereo>5.1 upmix to a given
Playback (output) device, highlight the device, set it for configure each
Recording device for the same sample rate and bit depth that you used for
the Recording Device (in PROPERTIES > ADVANCED), and 2 Channel or 5.1
Channel (in CONFIGURE).

Many I/O devices support only Stereo / 2 Channel. 5.1 will usually require
using the “Speakers” playback device.

The drivers of the Playback devices you choose must support Windows
WASAPI. Most do, as Microsoft introduced and standardized this model
starting with Windows Vista.

For both Recording and Playback devices, check ALLOW APPLICATIONS TO
TAKE EXCLUSIVE CONTROL OF THIS DEVICE and GIVE EXCLUSIVE MODE APPLICATIONS
PRIORITY.

¢) If the ENHANCEMENTS tab is present for a given playback device, click it and
check DISABLE ALL ENHANCEMENTS.

B) Set up OPTIMOD-PCn’s inputs and outputs.

a) In SERVICE SETTINGS > VIEW/SET AUDIO I/O ROUTING, choose the Processor you
wish to set up.

b) Specify the input device from the drop-down menu. This must be a device
that you configured in step A)a) on page 2-8.

¢) Choose the processing mode and output channel mode:

[2.0>2.0 STEREOQ ]

[2.0>5.1 uPMmIX],

[1.0 MONOQ]

[5.1 SURROUND (6-IN, 6-0UT)]

[5.1 SURROUND + 1 DOWNMIX (6-IN, 8-0UT)]

These choose mono processing (using 2-channel 1/O), stereo processing with
2-channel 1/0 (no upmixing), stereo processing with 2-channel input and
5.1-channel output (to support an upmixed output), 5.1 surround
processing, and 5.1 processing with additional 2.0 downmix processor with
its own dedicated loudness controller. 5.1 inputs are only available if you
have purchased one or more surround instances of OPTIMOD-PCn.

The specified Windows Recording and Playback devices must be set up to
match the processing mode [step (A) on page 2-8] or OPTIMOD-PCn will
issue an error message when you click OK.

Because many Windows sound devices do not support a true mono
mode, OPTIMOD-PCn’s Mono mode uses stereo (2.0) input and output
devices. The main benefit of Mono processing is that it cuts CPU usage by
approximately 50% compared to Stereo processing.

d) Click OK.

C) Repeat step (B) for each Processor you are setting up.
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D) Click OK to dismiss the SERVICE SETTINGS dialog box. This will restart the Ser-
vice and briefly mute the audio.

11.Local installations: Connecting to an

OPTIMOD-PCn Processor.
Add Profile

If 1600PCn software is running on the same Edit Profile
computer that runs the Service, connect to
Processors via CONNECT > LOCAL.

12. Set up passwords and names for Processors in T—
your computer. (optional)

Before you perform this and subsequent
steps, please read Overview of an OPTIMOD-PCn Installation starting on page 1-
30. OPTIMOD-PCn is versatile, so it is important to understand the information in
that section.

Each Processor in OPTIMOD-PCn 1600 software appears to the 1600PC remote
application as a separate, individually addressable audio processor. The number
of instances you have purchased determines the maximum number of instances
permitted on your system. However, turning on CPU-intensive parts of the
OPTIMOD-PCn 1600 processing, like the MX limiter or Optimix upmixer, may limit
the number of available instances to fewer than the maximum because all of the
CPU power has been used up.

If the CPU is overloaded, you will hear glitches and stuttering in the au-
dio and, in Windows Task Manager on the 1600, you will probably see
one or more cores of the CPU sitting at close to 100% utilization. Each
Processor must run almost entirely in one core, although several Proces-
sors can share one core if that core has enough resources to run them
smoothly. Note that two Hyperthreaded cores share the CPU resources of
a given physical core, so the effective clock speed of a Hyperthreaded
core is slightly more than half that of a physical core. See Table 1-1 on
page 1-5 and the associated discussion.

Logically, instances are almost independent of each other. 1600PC remote soft-
ware connects to one instance at a time. Each instance can run its own processing
presets regardless of what presets other instances are running.

A) On the computer running the Service, start the OPTIMOD-PCn control applica-
tion, 1600PC.exe, by clicking its icon (“agent”) in your computer’s system tray,
or from START > PROGRAMS > ORBAN > OPTIMOD PCN 1600.

Of course, you may create Windows shortcuts to 1600PC using the normal
Windows mechanisms.

Newly installed Processors have no passwords. You do not need to assign
a password to a Processor unless you want that Processor to be accessible
to a network connected to your computer.

Once you have assigned passwords, these passwords can be changed ei-
ther locally or on the network by anyone with the Administrator pass-
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word for that instance, but no one else. Do not lose the Administrator

password you assign in the steps below.

B) Connect to the Local Processor to which you are assigning a name and pass-

C) From the Tools menu bar, choose “Administration.”

word.

Initially, OPTIMOD-PCn software identifies a
Processor as Processor[x], where the numbering
starts at 1 and increases in steps of 1 for each
Processor. You can give the Processor an easily
remembered name (“alias”) by filling in the
PROCESSOR NAME field. OPTIMOD-PCn software
can then identify the Processor by this name
from anywhere on your network.

If you had previously set up 1600PC on a remote
computer to include the Profile for this service
computer [step (15.A) on page 2-13], the Profile
on the remote computer will not update auto-
matically to show a Processor’s revised Processor
Name. To make the revised name appear, De-
lete the Profile on the remote computer and
Add it again.

D) Assign a User Password to the Processor by fill-

E)

F)

ing in the USER PAssworRD and CONFIRM
PassworD fields identically. This password al-
lows you to connect to a Processor via 1600PC.

Assign a Terminal Password to the Processor by
filling in the TERMINAL PASSWORD and CONFIRM
PassworD fields identically. This password al-
lows you to connect to a Processor via
OPTIMOD-PCn TCP/IP terminal server to allow
external control of the OPTIMOD-PCn Processors

from either a Telnet/SSH client or a custom third party application. See

OPTIMOD 1600PCn Control APl on page 5-1.

Assign an Administrator Password to the Processor by filling

Administration

Prafile M arme: ||_.;..:a|

Processar Information

Proceszsar Humber: Proceszsor 1

Proceszsor Mame:

Proceszsor Securty

|Jzer Pazaword; |

Confirm Pazsward: |

[ Remember User Fazsword

Adminigtrator Password: |

Confirm Pazsward: |

[ Remember Administrator Password

Terminal Pazsword:

Confirm Pazsward:

Save |

Cancel

in the

ADMINISTRATOR PASSWORD and CONFIRM PASSWORD fields identically.

To preserve security, do not make the User and Administrator passwords

identical.

Be sure to write down and remember the Administrator Password be-
cause you must have it to change the Processor’s User Password or the
Processor Name in the future. You may check REMEMBER ADMINISTRATOR
PAsswoORD, but be aware that this will allow anyone with access to the
Service computer to change the User and Administrator passwords for
this Processor. Used maliciously, this privilege could lock you out of the
Processor, requiring an inconvenient uninstallation, reinstallation and re-

configuration of the Service.
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G) Click SAVE to confirm your entries.

H) Repeat steps (B) through (G) for each new Processor installed in your local
computer.

When you re-enter the CONNECT menu, you will now see the Processors listed by
the names you have assigned to them, not by their Processor Numbers.

13. Edit the local OPTIMOD-PCn server’s network accessibility, port numbers, and Ser-
vice Security Password. (optional)

A) If the OPTIMOD-PCn application is currently connected to a Processor, discon-
nect it by choosing DISCONNECT from the CONNECT menu.

B) Navigate to TOOLS > SERVICE SETUP.

C) Enter the Service Security Password that you originally set in step 9 on page 2-
8.

The Service Setup Window appears.

D) Edit parameters in this window as desired. Then click OK. (See step 7 on page
2-7.)

14. Edit a given Processor's name and/or passwords. (optional)

A) Connect to the local Processor to which you are assigning a name and pass-
word.

B) From the Tools menu bar, choose “Administration.”

The Enter Administrator Password window appears. Enter the Processor’s
Administrator password and hit Enter.

If you did not enter an Administrator Password in step (12.E), you will not
see the “Enter Administrator Password” dialog box and the Processor and
Security Administration window will appear immediately.

C) The Processor and Security Administration window opens. Edit the fields as
required. (See step 11 on page 2-10.)

D) Click “Save" to confirm your changes.

15. Make Processors visible on remote computers (i.e. those not hosting the Service).
(optional)

To aid security, all OPTIMOD-PCn Processors are initially hidden from 1600PC ap-
plications running on computers other than the computer hosting the Service for
those Processors. On each remote-control computer, you must explicitly “add”
each Service computer so that its Processors appear on the Connection list of the
1600PC application running on the remote-control computer.

To make a Processor controllable from a remote-control 1600PC, you must know
three things: (1) the IP address of the Service computer implementing the Proces-
sor, (2) the port that was assigned to the Service (default is 12100), and (3) the
User or Administrator password of each Processor.
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To add Processors, you must be able to con- [ ai4 profie
nect to the Orban server software on the

Service computer running those Processors: Profls Name: | T5500
e The Service computer must be online IPaddess: | 192 . 188 . 1 . 739 pgn [12100
and connected to the network. Frocessors ot Femote Site
Proceszor Number Processzor Mame
e The Orban server software on the Ser- T—— |KEEL

vice computer must be running, which Frocessar 2 Processor 2
means that the security key must be
plugged into a USB socket or Code-
Meter authorization software must be
running on the Service computer.

e The Windows firewall on the Service
computer must allow OptimodSer-
vice3.exe access to the network. (See
Using Windows Firewall with
OPTIMOD-PCn on page 2-37.)

e The “Allow Network to Access Local Instances” box in the Service comput-
er's SERVICE SETUP [step (7.B) on page 2-7] must be selected.

Computers not actually doing audio processing should not have the OPTIMOD-
PCn Service installed on them; 1600PC does not require (or use) the Service to
connect to remote Service computers. However, in a network connected to more
than one Service computer it is possible to make other Service computers visible
to 1600PC running on one of them. To do this, Add the Profiles of the additional
Service computers one at a time using the instructions in step (A) below. In this
case, 1600PC can still only control the Service Settings for the computer on which
it is installed; the Service Settings of other Service computers on the network can
only be accessed via their local 1600PC applications.

A) Add a Service computer to the list of available computers containing
OPTIMOD-PCn instances:

a) Select CONNECT>ADD PROFILE.
The AbD PROFILE window appears.
b) Enter the Profile Name, IP Address, and Port of the Service computer.

The Profile Name can be any name you wish to use—for example, “Re-
mote.” The profile name is known only to your local computer. The net-
work identifies a given Service computer by its IP address and port, not its
profile name. The profile name is merely a convenient alias that you use
to help identify a Service computer hosting OPTIMOD-PCn Processors
without your having to memorize the computer’s IP address.

¢) Click Add.

If 1600PC can connect to the Service computer, the Processor Names of all
Processors running on that Service computer will automatically appear in
the PRoCESSORS AT REMOTE SITE list. 1600PC will add them to the Connect
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16.

17.

menu and the Connection
List window. You can open
the Connection List window
by selecting it from the View
menu.

B) Add remote computer Profiles
and the instances in each Pro-
filed computer as desired, by
repeating step (A) for each re-
mote computer.

. _ -
|8 Optimod-PCn 1600- T5500:Processor 2 - [2.0 Less-More]

il File Edit View Tools

T5500: Processor 2

Connect to a remote Processor. (optional)

Add Profile

TR D MX Med

Disconnect

Gain

10— 0 —-E=
Processorl

tereo Enhancer

Local
T5500

7 Processor 2

You can now connect to any Processor that you added in step 11 on page 2-10 if
this Processor’s Service is running and connected to the network.

A) Click the CONNECT menu. A drop-down menu appears containing a list of all
remote computers. Drag your mouse down to the desired computer to reveal
a submenu containing all Processors within it that have been added. Select
the desired Processor to connect to it.

B) The "Enter User Password” dialog box appears. Enter the password and click
ENTER. If you wish to bypass this dialog box automatically in the future, check
the REMEMBER USER PASSWORD box in the ADMINISTRATION screen on your local
computer [step (12.C) on page 2-11]. (Only Administrators of your local Ma-
chine can restore this dialog box once you have specified that it is to be by-

passed.)

After you click ENTER, the
Control application will dis-
play the state of the Processor
to which you just connected,
and you can recall presets, ad-
just input/output levels, edit
and save presets, etc.

. Enter User Password

Processor Mumber:

|F'n:u:essor 1

Frocessor Mame:

|KBEL

el |

Jser Password: ||

Delete a remote computer’s profile. (optional)

If you no longer wish to have a particular re-

mote computer appear in the list

computers, you can delete it from the list. Addi-
tionally, Deleting a profile and then Adding it
again will refresh the Processor Names if you
changed these on the Service Computer.

. Connection List =
of available :
El'a All Connections
l:l Local
Delete Profile

A) Disconnect from any Processors using the
CONNECT > DISCONNECT menu item.

B) Open the CONNECTION LIST window using

VIEW > CONNECTION LIST.

O) Right-click the remote computer you wish

PROFILE.

Rename Profile

Cancel

to remove and select DELETE
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The remote computer’s profile (and the profiles of all of its correspond-
ing Processors) are removed from your local computer. This action does
not affect any other computer on the network.

You can restore the remote computer’s profile by following the instruc-
tions in step (15.A) on page 2-12.

Setup: The OPTIMOD-PCn Control Application

Once you have connected the Optimod-PCn Control application to an OPTIMOD-PCn
Processor, the software allows you to control the Processor as if it were a dedicated
hardware processor. The Control application displays gain reduction meters, as well
as controls that allow you to edit the sound of the factory presets to your liking. Sec-
tion 3 of this manual explains these sound editing controls in detail.

1. Select the Processor you are setting up.

A) From the Connect menu on the Control application, select the Processor you
are setting up by connecting to it.

If you wish, you can edit the factory default Input/Output (“10") setup.
You also have the option to OPEN SETUP or SAVE SETUP AS in the Control
application’s FILE menu. Therefore:

e You can save your current setup to a file and then apply it to another Pro-
cessor.

e You can load a previously saved setup into the Processor that is currently
selected

2. Activate or defeat processing blocks as needed.

Extemal AGC Phase Comector

0 Mo i e @ Defeat '@ Active

i@ Defeat

Loudness Meter Linits

Meter Delay

OPTIMOD-PCn allows you to deactivate processing blocks that you do not
need. This can reduce input/output delay and/or reduce CPU usage.
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A) From the TooLs menu, open the I/O Mixer and click the UTiLITY tab.
B) Set each switch as appropriate.

e OPTIMIX: Defeating Optimix removes about 212 ms of delay and reduces
CPU usage substantially because the Optimix upmixer does not operate, nor
does the center-channel MX limiter when the MX limiter is activated in a
given processing preset. If this switch is ACTIVE, these elements operate
even if Optimix is bypassed in the active processing preset. This prevents
glitches when activating or defeating Optimix within the processing preset.

Optimix is defeated automatically if the processor’s output is configured
as STEREO in step 10.B)c) on page 2-9. The Optimix tab will not appear.

e STEREO SYNTHESIZER: The stereo synthesizer is not a compute-intensive pro-
cess, but it introduces about 187 ms of look-ahead delay to allow its auto-
matic mode sensing to work (by sensing silence in the right channel). De-
feating the stereo synthesizer removes this delay.

e PHASE CORRECTOR: The phase corrector is a moderately CPU-intensive pro-
cess that introduces about 170 ms of delay. Unlike Optimix, it does not op-
erate in the background when it is defeated in the active processing preset.
Therefore, the main benefit to defeating it in the System is to remove its
delay.

e BS.1770 LOUDNESS CONTROLLER: This can defeat the BS.1770 safety limiter.
The BS.1770 meter runs regardless of the setting of this control.

e CBS LOUDNESS CONTROLLER: This defeats the CBS loudness controller and
loudness meter. The CBS loudness controller/meter relies on a large fil-
terbank, so it uses a significant amount of CPU, and defeating it can some-
times help achieve smooth operation on slower CPUs.

e LOUDNESS METER UNITS: This determines the label of the BS.1770 loudness
meter and only affects the graphics. LkFS is typically used in the United
States and LUFS in Europe.

C) Set the EXTERNAL AGC mode as appropriate for your installation.
[Yes] or [No]

This control turns OPTIMOD-PCn’s internal AGC (Automatic Gain Control)
on or off.

In radio applications, it is common to have an external AGC at the studio
side of a studio-to-transmitter link to protect the link from overload.
Most of the processing structures in OPTIMOD-PCn control level with a
preliminary AGC internal to OPTIMOD-PCn. If you are using an external
AGC device (such as an Orban 6300 multipurpose audio processor or an-
other OPTIMOD-PCn) in front of OPTIMOD-PCn, set OPTIMOD-PCn’s in-
ternal AGC to DisaBLED. This is to ensure that the internal and external
AGGCs do not “fight” each other and that they do not simultaneously in-
crease gain (resulting in increased noise).
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Temporarily set AGC to ENABLED so that the Analog and Digital Input ref-
erence level alignment steps (below) will work correctly. After you have
finished with these steps, set the AGC parameter appropriately for your
installation.

3. Configure global audio processing parameters.

imput | Main Output  Giobal | Test | Uiy |

Max Low Pass Fiter

Target Loudness

A) From the TooLs menu, open the I/O Mixer and click the GLOBAL tab
B) Set the MAX LowPASS FILTER cutoff frequency.

[10.0 kHz] to [20.0 kHZz]

There are two sets of controls, one for SURROUND PROCESSING and one for
DOWNMIX PROCESSING. SURROUND refers to the main audio processor,
which includes the Optimix upmixer if configured for 5.1 output.
DownNMix refers to the downmix processor, which always emits a stereo
downmix of the audio regardless of whether Optimix is active or by-
passed.

The DownMmix processor is not supported in v0.9 software. Only the
SURROUND PROCESSING controls work.

You can set OPTIMOD-PCn’s audio bandwidth in two places:

(1) in the I/O Mixer’'s GLOBAL tab, and (2) in the main window's EQ tab. (If
the EQ tab is not visible, click the “ad” button on the toolbar.) OPTIMOD-
PCn’s bandwidth is always the Jowest of these settings. The frequency in
GLOBAL is a technical parameter that determines the highest bandwidth
available. The installing engineer should set it to be appropriate for the
sample rate of the digital system that OPTIMOD-PCn is driving. For exam-
ple, if OPTIMOD-PCn is driving a system with a 32 kHz sample rate, set
the MaX LowpaAss FILTER cutoff frequency to 15.0 kHz. That way, a setting
of 20 kHz in the EQ tab will not cause excessive bandwidth and aliasing
because OPTIMOD-PCn will automatically override it with the MaXx
LowPAss FILTER cutoff frequency setting.

NOTE THAT THE LP FILTER ON THE EQ TAB IS PART OF THE ACTIVE PRESET, LIKE ANY
OTHER EQUALIZATION CONTROL IN THE PRESET. IF YOU RECALL A DIFFERENT PRESET,
THE LOWPASS FILTER CUTOFF FREQUENCY CONTROL IN THE NEW PRESET WILL NOW
DETERMINE THE SYSTEM BANDWIDTH (UNLESS, OF COURSE, THE Lowpass Filter
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CUTOFF FREQUENCY SETTING IN THE NEW PRESET IS HIGHER THAN THE Max Low-
pass Filter CUTOFF FREQUENCY PARAMETER IN THE Global PAGE).

4, Set Digital Output properties.
A) Navigate to I1/0 > STEREO OUTPUT.
B) Adjust DITHER to on or off, as desired.
[in] or [out]

OPTIMOD-PCn can add “first-order high-pass” dither before any trunca-
tion of the output word. The amount of dither automatically tracks the
setting of the WORD LENGTH control.

OPTIMOD-PCn’s dither is first-order noise shaped dither that adds less
noise in the midrange than white PDF dither. However, unlike extreme
noise shaping, it adds a maximum of 3dB of excess total noise power
when compared to white PDF dither. It is therefore a good compromise
between white PDF dither and extreme noise shaping.

In many cases, you will not
need to add dither because
the source material has al-
ready been correctly dithered
and more than enough input : ] Flat
dither is passed through to
OPTIMOD-PC’s output. How-

nput  Main Output | Global | Test | Utiity |

Proc Pre-emphasis

ever, particularly if you use Output Pre-emphasis
the Noise Reduction feature,
the processing can sometimes Flat hd

attenuate input dither so
that it is insufficient to dither
the output correctly. In this
case, you should add dither
within OPTIMOD-PCn. It is
safest to always add dither
when operating with 16-bit

output. Dither

C) Set output and Target Loud-
ness parameters to achieve
the desired target loudness and output headroom.

a) Set the 100% OuTPUT LEVEL control to the amount of the peak headroom
you need to match the downstream transmission channel.

In some applications, it is important to leave peak headroom below
0 dBFS to accommodate overshoots in the downstream transmission sys-
tem. For example, when using a lossy codec like HE-AAC, it is wise to al-
low at least 1.5 dB of peak headroom to compensate for codec-induced
overshoots.

The 100% OutpuT LEVEL control sets OPTIMOD-PCn’s maximum peak out-
put level with respect to 0 dBFS, which allows you to compensate for
transmission channels that introduce peak overshoots. It is effectively a
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peak limiter threshold control and does not change loudness. Hence, the
average output level does not change but the maximum peak output
level is constrained to the control's setting?. If you have set TARGET
LOUDNESS correctly on OPTIMOD-PCn, you can change the output level
control freely without causing your loudness to be incorrect with respect
to other transmissions.

OPTIMOD-PCn’s peak limiter is “true-peak”-aware (per ITU BS.1770), so
the peak headroom that you specify will be preserved even after sample
rate conversion or D/A conversion.

b) To adjust loudness, adjust the active TARGET LOUDNESS value. This control is
in the active processing preset in the LESS-MORE tab. If the processing
preset’s TARGET LOUDNESS = GLOBAL, then OPTIMOD-PCn instead uses the
global SURROUND TARGET LOUDNESS value in /O SETUP > GLOBAL.

Speech Mode

Figure 2-5: Target Loudness in Processing Preset

For more detail, refer to About Target Loudness and ITU-R BS.1770 start-
ing on page 1-16 and Setting Loudness starting on page 1-20. Customiz-
ing Processing Presets to Achieve Specified Target Loudness starting on
page 2-23 provides information on customizing processing presets to
achieve a specified BS.1770 loudness.

Your Optimod’s Target Loudness and output level controls are only cali-
brated correctly if the transmission channel after the Optimod has unity
gain. Because gain > 1 can cause clipping and gain < 1 will cause loss of
headroom in the transmission channel, non-unity gain after the Optimod
is bad engineering practice.

2.0 Bandmix 2.0 Limiters Optimix Upmi

Target Loudness

Unlike most other Optimods, the LEss-MoRE control in a processing pre-
set affects texture while changing loudness as little as possible. Set loud-

Figure 2-6: Target Loudness in I/O SETUP

2 If this causes large amounts of gain reduction to occur in the look-ahead limiter,
the average level will decrease somewhat. However, this will only happen with
pathologically high settings of Target Loudness and will never happen at the set-
tings of TARGET LOUDNESS typically used in broadcasts (-24 per ATSC A/85 or -23 per

EBU R128).
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ness by adjusting the active Target Loudness value. “TV" presets use the
global TARGET LouDNESs value; other presets usually have local TARGET
LOUDNESS values.

For a detailed explanation, refer to Setting Loudness starting on page 1-
20. Customizing Processing Presets to Achieve Specified Target Loudness
on page 2-23 provides further detail.

D) Set preemphasis curve on which the peak limiting operates.
[Flat], [50 ps], [75 ps]

Normally, OPTIMOD-PCn will feed transmission channels that do not use
preemphasis and you should set this control FLAT. 50uS and 75pS
preemphasis are only useful if the OPTIMOD-PCn is protecting a transmis-
sion link that uses preemphasis (like certain satellite uplinks) or if you are
using a TVxxx preset to drive an analog aural transmitter (i.e., one that
produces a preemphasized FM aural carrier in analog television transmis-
sion). Use FLAT preemphasis for DAB, DRM, HD Radio, digital television,
netcasts, and any other channel that uses a lossy codec. When in doubt,
use FLAT preemphasis.

For these applications, you can apply preemphasis to OPTIMOD-PCn's
five-band compressor’s sidechain (to make the five-band compressor
"preemphasis-aware,” allowing it to be used as a high-frequency limiter)
and before OPTIMOD-PCn’s peak limiter so the limiter will control the
peaks of the preemphasized audio.

When the OuTPUT DE-EMPHASIS control is set to FLAT, a deemphasis filter
after the look-ahead limiter restores “flat” audio at OPTIMOD-PCn'’s out-
put; otherwise, the output is preemphasized. When the output is deem-
phasized, the transmitter driven by OPTIMOD-PCn must restore the
preemphasis before the signal is transmitted.

When in doubt, choose PRE-E and bypass the transmitter’s preemphasis.
This prevents potential mismatches between the Optimod’'s output
deemphasis filter and the transmitter’s input preemphasis filter, which
can introduce peak overshoots.

OPTIMOD-PCn’s processing is tuned to be most effective with “flat me-
dia” and cannot provide “competitive” loudness for preemphasized radio
channels. Because OPTIMOD-PCn 1600 is not sold or licensed as a proces-
sor for FM radio transmission, HARD MX OveERsHoOT MoDE is locked out
when preemphasis is not FLAT. We recommend using one of Orban’s Op-
timod-FM processors for this application.

OPTIMOD-PCn can process audio for transmission on a preemphasized
analog television aural carrier because this application requires lighter
processing than FM radio. OPTIMOD-PCn’s TVAxxxx factory presets have
been created for this application.

We strongly encourage you to use the MX limiter if you have configured
OPTIMOD-PCn to use preemphasis. This will produce far fewer gain-
pumping artifacts than will non-MX operation.

If lack of CPU power forces you to use the non-MX limiter, only use it for
light-to-moderate protection limiting with a low duty cycle. Otherwise,
you may hear pumping on material with a lot of high frequency energy
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like sibilance and cymbals. The cure is lowering the MB FINAL LiMIT DRIVE
control until the problem is no longer audible.

If you find that lowering the MB FINAL LiMIT DRIVE causes too much loud-

ness loss, use the Band 5 compressor as a high frequency limiter to com-

promise between loudness and limiting artifacts. Set B5 DELTA RELEASE to

+6 and B5 STEREO COEJPLING to Ofr. Adjust B5 THRESHO.LD control unt_il | Optimod-PCn 1600 - [T5500 35ysteme
you see gain reduction on the Band 5 GR meter with problematic —mmmm
material. Continue to lower the B5 THRESHOLD control until you no Input | Stereo Ouput | Test | Uity | Giobal |
longer hear gain pumping. Instead, you will probably hear some
high frequency loss. This loss is less subjectively objectionable than
gain pumping.

You can use the AGC+LIMITER and TVA factory presets as exam-
ples of how to do this. See AGC+LIMIT on page 3-34.

5. Adjust the Input Reference Level control.

This step adjusts the drive to OPTIMOD-PCn’s audio processing so
that it operates in its preferred range.

A) In the I/O Mixer, click the INPUT tab.
B) Open the GREGG HD MED factory processing preset.

a) On the Optimod-PCn Control application, choose FILE/OPEN
PRESET.

The Open Preset dialog box appears.
b) Click GREGG HD MED in the preset list.

The GReGG HD MEeD preset becomes active. The dialog box remains open
until you explicitly close it by clicking DoNE.

C) Calibrate using program: Feed normal program material to OPTIMOD-PCn.
a) Play program material from your studio, peaking at the level to which you

normally peak program material (typically 0 VU if your console uses VU
meters).

b) In the I/0 Mixer window, click the GLOBAL tab.
¢) Verify that EXTERNAL AGC is set to No.

Refer to step (2.C) on page 2-16.
d) Click the INPUT tab.

e) Set the INPUT REFERENCE LEVEL control to make the AGC GAIN REDUCTION meter
(on the main meter screen in the Optimod-PCn Control application)
indicate an average of 10 dB gain reduction when normal levels are applied
to the OPTIMOD-PCn’s input.

If necessary, scroll the Mixer window horizontally so that the AGC GAIN
REDUCTION meter is visible.

If the AGC GAIN REDUCTION meter averages less than 10dB gain reduction
(higher on the meter), or if the GATE indicator stays on when program
material is present, turn the INPUT REFERENCE LEVEL fader down (so the
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reference level is lower). f the AGC GAIN REDUCTION meter averages more
gain reduction (lower on the meter), turn the INPUT REFERENCE LEVEL fad-
er up.

The VU and PPM calibrations are arranged so that the PPM scale is 7 dB
higher than the VU. This approximates the difference in indication be-
tween a VU meter and PPM with dynamic program material. See VU and
PPM metering on page 1-23.

The INPUT REFERENCE LEVEL control is calibrated to comply with industry
standard levels. A typical reference level is =18 dBFS (VU) for EBU coun-
tries. SMPTE standard reference level is —20 dBFS (VU). If you are using
one of those reference level, it is usually OK to simply set the INPUT
REFERENCE LEVEL control (VU) to this reference level.

f) When finished, reset AGC to DISABLED, if required.
6. To copy an IO setup from a source Processor to a destination Processor (optional):

a) If you have not already saved the 10 setup you wish to apply to the
destination Processor, use the 1600PC to connect to the source Processor.
Then go to FILE/SAVE SETUP and save the 10 setup of the source Processor.

When saving, use any legal operating system filename other than de-
fault.orbs, Which is a reserved name. Setup files have the form *.orbs.

A given Processor’s setup is stored in the Registry on the computer where
that Processor resides.

The current active setup file is always the last file that was recalled by the
FILE/OPEN SETUP operation. If you have never recalled a setup file this way,
the current active setup is stored in a file named system.orbs.

The current active setup file is a transient file. That is, the Optimod-PCn
Control application updates it whenever you change the setup manually.
The Optimod-PCn Control application also automatically updates the file
when the application starts and reads the setup information from the
Registry. You cannot assume that a *.orbs setup file (other than de-
fault.orbs)is static or that it will retain its original information.

The factory default system setup is stored as default.orbs. This is a read-
only file. It is the only system setup file that is static and unchanging. For
further security, it is automatically regenerated each time the Orban Con-
trol Program or Service starts up.

b) Connect the 1600PC to the destination Processor.
¢) Go to FILE/OPEN SETUP.
d) Navigate to the folder containing the setup file you wish to retrieve.

This will usually be the file you saved in step (a).

The OPTIMOD-PCn file system labels the Processor folders as “Proces-
sor[x],” which is the generic name for a given Processor as shown in the
TooLs > ADMINISTRATION dialog box for that Processor. In that folder will
be a preset folder containing the setup you wish to restore.

e) Highlight the setup file and select OPEN.
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The Optimod-PCn Control application will automatically make a copy of
just-opened setup file in the destination Processor’s Presets folder. It will
automatically update this file if you make manual changes to the desti-
nation Processor’s 10 setup. The original setup file is not changed.

B) If you wish to edit an existing (or factory) setup, proceed to step 2 below.

C) When you are finished setting up each Processor, close the I/O MIXErR window
by clicking DONE.

Customizing Processing Presets to Achieve Specified Target Loudness

Radio-Style Presets: Most non-TV presets have local TARGET LOUDNESS values (i.e.
TARGET LOUDNESS in the LESS-MORE tab is not set to GLOBAL. We chose these values
to represent competitive loudness/distortion trade-offs in traditional, non-R128 ap-
plications—their loudness is much higher than —-23 LUFS and represents the typical
loudness encountered in non-R128 netcasts. (See Figure 2-5 and Figure 2-6 on page
2-19.)

The fact that the presets have local TARGET LOUDNESS is a compromise between the
needs of users who process for specified target loudness and those who process
more traditionally. You can adjust the loudness of any such preset by changing its
TARGET LOUDNESS value to the desired target loudness or to GLOBAL: GLOBAL is con-
venient for those processing for government-specified target loudness. After you
have adjusted TARGET LOUDNESS, LESS-MORE continues to be available and adjusts
texture (usually, the amount of gain reduction in the multiband compressor) while
changing loudness as little as possible.

Because of their limited graphic resolution, the CBS and BS.1770 loudness meters are
calibrated relative to the active TARGET LOUDNESS value: “0"” always corresponds to
the active TARGET LOUDNESS value. Hence, adjusting TARGET LOUDNESS will not
change the loudness meter indications. This makes it easy to customize presets. After
you have finished your coloration and texture adjustments, fine-tune the LIMITER
DRIVE CONTROL to make the loudness meters indicate “0” on average.

To achieve most dynamic-sounding audio, the CBS and BS.1770 loudness controllers
are turned off in the radio-style presets. Therefore, they will produce loudness meter
indications that are somewhat less consistent than those produced by the “TV" pre-
sets. Nevertheless, they will always provide excellent subjective source-to-source con-
sistency.

TV Presets: The “TV” factory presets do not need customization to achieve correct
loudness because out of the box, they provide loudness equal to the global TARGET
LOUDNESS value (as set in I/O SETuP > UTILITIES). In almost every application, a factory
preset (possibly as customized with LESS-MORE, which preserves correct loudness)
will suffice for a given application. However, for the sake of completeness, we pro-
vide instructions below describing how to customize them while retaining the cor-
rect loudness.

If you are processing for specified target loudness in television or other video appli-
cations and wish to customize a factory preset, be aware of two major philosophies,
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one presented in ATSC Recommendation A/85 and the other in EBU Recommenda-
tion R128.

ATSC A/85: If you wish to ensure that dialog levels are consistent from one program
segment to the next, use the 1600's CBS loudness meter as a reference for adjusting
a user preset’'s loudness. In this case, we prefer relying on the CBS Loudness Control-
ler to do final loudness control and turning the BS.1770 Safety Limiter off, although
you may leave it on if your organization demand strict adherence to BS.1770 meter
readings. Consistent loudness of the “anchor element” (usually dialog) is the goal
suggested in ATSC Recommendation A/85, which is the basis for CALM Act compli-
ance, and we prefer this goal to strictly relying on the BS.1770 loudness meter.

EBU R128: If you wish to ensure that integrated loudness as measured on a BS.1770-2
meter is consistent from one piece of program material to the next, use OPTIMOD-
PCn’s BS.1770 loudness meter as a reference. In this case, you may wish to active
OPTIMOD-PCn’s BS.1770 Safety Limiter, which will constrain BS.1770 integrated
loudness with a sliding 10-second integration window from exceeding the setting of
the BS.1770 THRESHOLD control. However, note that R128 encourages mixing to
achieve a wide dynamic range, where some material may considerably exceed the
target loudness when measured on a “short-term” (three-second integration time;
ungated) BS.1770 meter. Moreover, R128 requires online loudness control to be de-
feated if upstream material is known to be pre-processed such that the integrated
loudness of each program segment (per BS.1770) is identical to the active Target
Loudness value with a 0.5 LUFS window. To do this, use activate the PASS-THROUGH
switch in your active preset (in the LESS-MORE tab) and save the result as a user pre-
set.

See Appendix A: Using the ITU BS.1770 and CBS Loudness Meters to Measure Loud-
ness Controller Performance starting on page 3-93 for a comparison of the ATSC
A/85 and EBU R128 philosophies of loudness control.

The CBS and BS.1770 loudness meters’ calibrations track the 1600's active TARGET
LOUDNESS value, which is either (1) the TARGET LOUDNESS value (in the System tab) or
(2) the TARGET LOUDNESS value in the active processing preset if this value is not set
to GLOBAL.

The controls to which the following procedure refers are described later in Section 3.

A) Make sure that the 1600’s active TARGET LOUDNESS value is the same as the di-
alnorm or Target Loudness metadata you are transmitting to consumers’ re-
ceivers.

For U.S. program providers, this ensures that the 1600-processed trans-
mission will meet the requirements of the CALM Act.

EBU Tech 3344 has suggestions about setting target loudness when tar-
geting receivers and player devices that cannot receive dialnorm or Tar-
get Loudness metadata from the signals they are reproducing.
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B) Recall the TV 5B GENERAL PURPOSE preset and set the INPUT REFERENCE LEVEL
control in SETUP > INPUT to produce 10 dB of AGC gain reduction with typical
input material. Then recall the preset you intend to edit.

Q) If the AGC's idle gain (i.e. the gain reduction produced by the AGC when its si-
lence gate is on) is inappropriate, adjust it with the AGC IDLE GAIN control. It is
usually adjusted so that the idle gain is equal to the gain reduction that occurs
with normal program material. Its normal setting is 0. See AGC Idle Gain on
page 3-53.

If you are using a factory processing preset and you have adjusted the in-
put reference level correctly, there is no need to adjust the AGC DRrIvE or
AGC IDLE GAIN controls.

D) Adjust the MULTIBAND DRIVE to produce the desired amount of multiband gain
reduction. We recommend about 5 dB for dialog at normal levels.

E) If you wish to use the CBS Loudness Controller: Set the LOUDNESS THRESHOLD
control to 0 dB, which matches the CBS Loudness Controller’s threshold to the
OPTIMOD-PCn’s active TARGET LOUDNESS value. Then set the MB LIMIT DRIVE
control so that the CBS segment of the LOUDNESS GR meter indicates 3 dB of
gain reduction with dialog at normal levels. (The CBS Loudness Controller’s
gain reduction appears in blue on the LOUDNESS GR meter.)

You should see the LoubNEess LEVEL meter peaking around 0 dB when the
LoubnEss GR meter shows that gain reduction is occurring

F) If you wish to use the BS.1770 Safety Limiter: Set the BS.1770 THRESHOLD con-
trol to your preferred level. 0 LU provides the tightest control as indicated on
a BS.1770 meter, but this is likely to cause program material with an usually
low peak to RMS ratio to sound too quiet. Most natural sound is produced
when the BS.1770 THRESHOLD control is set to +2 LU or higher.

G) If you do not wish to use the Loudness Controller: Set the LOUDNESS
THRESHOLD and BS.1770 LIMIT THRESHOLD controls to OFF. Then adjust the MB
LIMITER DRIVE control to produce an average of 0 LU on the BS.1770 loudness
meter with program material at normal levels.

Presets with the loudness controller off will produce wider source-to-
source loudness variation (as indicated on the BS.1770 and CBS loudness
meters) than presets with the loudness controller on. However, they will
sound more dynamic and natural while still achieving good subjective
loudness consistency.

If you chose an appropriate TARGET LOUDNESs value for your transmission,
the 1600’s limiting meters should rarely indicate any gain reduction. This
means that the target loudness is well matched to the headroom in the
transmission system.

H) Save your work as a User Preset.
[) Set PASS-THROUGH GAIN (optional).

EBU Recommendation R128 requires online loudness controllers to be de-
featable so that they do not change the dynamics of upstream material
that is known to meet the R128 requirement: the loudness of each pro-
gram segment must be within a +0.5 LU window centered on the active
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Target Loudness value. This measurement must be done over the entire
program segment using a BS.1770-2 (or higher) “integrated” measure-
ment.

You may operate any processing preset in Pass-through mode; use the
PASS-THROUGH SWITCH to enable or defeat pass-though mode and set the
PASS-THROUGH GAIN control (in the LESS-MORE tab) as needed.

When set to 0 dB, OPTIMOD-PCn provides unity gain from input to out-
put regardless of the settings of any controls except the PASS-THROUGH
GAIN control. The INPUT REFERENCE LEVEL and 100% OUTPUT LEVEL controls
do not affect the gain. The normal setting is 0 dB, because this retains the
target loudness of the source material.

If you need a pass-through preset you can recall conveniently, set the
PASS-THROUGH SWITCH in any factory preset to IN and save the result as a
User Preset.

MX presets have a different input/output delay than non-MX presets. A
Pass-through user preset should have the same MX LIMITING control set-
ting as the active preset you use when not in Pass-through mode. We
recommend starting with your active preset and then editing it to pro-
duce your Pass-through user preset.

To protect the output channel from clipping, the peak limiter remains in-
line during Pass-through operation and the 100% OuTtPuT LEVEL control
operates normally to specify the maximum peak level at the output with
respect to 0 dBFS. If you set the PAss-THROUGH GAIN control higher than 0
dB or if the 100% OuTPuT LEVEL control is set lower than 0 dBFS, it is pos-
sible that you will observe limiter gain reduction. If you need to use sub-
stantial amounts of gain reduction, you will get best results by starting
with an MX preset.

Problems and Possible Causes

Always verify that the problem is not the source material being fed to OPTIMOD-
PCn, or in other parts of the system.

OPTIMOD-PCn does not start up immediately after Windows boots.

e A delay of 60 seconds is normal and by design. The OptimodService3 start-up
mode in Windows is AuTO (DELAYED). This helps prevent Windows from compet-
ing with OPTIMOD-PCn for CPU cycles during start-up.

Audio stutters or echoes after Windows is powered up.
e If you are running Windows 8 or higher, you have not defeated Windows Fast
Startup and the Service is starting prematurely. See step 1 on page 2-3.
| downloaded a new version of the OPTIMOD-PCn software and it will not run.

e The version of OPTIMOD-PCn software you have purchased never expires, but
there is a time limit for free upgrades and technical support. This time limit is
burned into your copy protection key or CodeMeter authorization.
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To see the time limit, open the SERVICE SETTINGS window from TOOLS > SERVICE
SETTINGS and look at the UPGRADE AND SUPPORT RIGHTS TIME LimIT field. The date
shown is the last day that free technical support is available for your license, and
you can only run versions of this software released before this date. You may
purchase an extension any time before this date by contacting
custserv@orban.com. After this date, extensions are no longer available for pur-
chase, and you must purchase a new version of the software if you wish to up-
grade.

To support expired licenses, Orban keeps older versions of the software available
for download. Choose the newest one that is older than your expiration date.

When you launch the OPTIMOD-PCn control application, meters and controls do not appear.

e You must connect the control application to a Processor using the CONNECT
menu. This is true even if the control application and audio processing are run-
ning on the same computer.

You cannot connect to a given Processor from 1600PC.

e The Service is not running or is configured incorrectly. Be sure that the output
sound device you are using is configured in WINDOWS CONTROL PANEL > SOUND to
match OPTIMOD-PCn’s output format (stereo or 5.1), sample rate (44.1, 48, 96, or
192 kHz), and bit depth (16-bit or 24-bit). 1600PC will usually issue an error mes-
sage if there is a mismatch. The Service will not allow audio processing to occur
if the input and output devices are configured incorrectly. See step 10 on page
2-8.

e If the Processor is password-protected, you must know it to connect to that Pro-
cessor. This will be obvious because you will be asked for the password when
you try to connect.

e The Service is stopped. The Service will only run if a valid copy protection key is
inserted into a USB slot or if the server computer is running CodeMeter authori-
zation software.

e The Service has a build date that is after the expiration date of your software
license. See OPTIMOD-PCn does not start up immediately after Windows boots
above.

e The computer’'s CPU is insufficiently powerful to support OPTIMOD-PCn opera-
tion. This will usually cause audio stuttering, but in extreme cases will cause the
Service not to start.

e Necessary runtime files were not installed. To ensure correct installation, you
must run the installer application as Administrator.
You cannot connect to the OPTIMOD-PCn Service.

e If the Service has been assigned an Administrator Password (step 9 on page 2-8),
you must supply it to gain access to the Service Settings.
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e The copy protection key (if used in your version of 1600PCn) is not present. Note
that the Service will not start up automatically if you insert the key after you
have booted the host computer. If the key was missing, first insert the key and
then start the Service from TooLs > SERVICE SETTINGS in 1600PC.

e If your version of 1600PCn is protected by CodeMeter software authorization,
this must be correctly installed and registered. See the document Instructions to
create license request file for Optimod PCn.pdf, which the 1600PCn installer in-
stalls as part of the installation process.

The OPTIMOD-PCn Service crashes when you try to add Processors.

e The computer on which you are running the Service must have a CPU that sup-
ports the Intel SSE4.1 vector instruction set. All Intel i-series processors support
SSE4.1. See CPU on page 1-4.

e You are attempting to run more processors than your computer’s CPU can ac-
commodate. However, this will usually just cause audio stuttering but will not
cause the Service to crash. See Table 1-1: CPU hardware requirements for one In-
tel i-series processor hardware core on page 1-5.

You hear audio glitches, pops or clicks.
e Your computer’s CPU is insufficiently powerful. See CPU on page 1-4.

e The sample rates of the audio input and output devices are not precisely locked.
See Locking Clocks on page 1-35.

There is a long-term delay build-up between input and output.
e The sample rates of the audio input and output devices are not precisely locked.
See Locking Clocks on page 1-35.
You cannot connect to a given OPTIMOD-PCn Processor from a remote computer running
1600PC on your network.

e You must check the ALLow NETWORK TO ACCESS LOCAL PROCESSORS box in the
TooLs > SERVICE SETTINGS dialog box for the Service on the Service computer
that implements that Processor. See Figure 2-3: Service Settings on page 2-5.

Other possible causes are:

e The version of 1600PC on the remote computer is the not same as the version on
the computer running the Service. If it is not, it will issue an error message.
Please install the same version on the remote machine. 1600PC is not copy-
protected, so you may freely install it on as many computers as you wish.

e Your computer’s firewall is blocking the connection. See page 2-37.
e Password is wrong.

e The target Processor is open on another 1600PC application running on your
network.
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e The system that houses the target Processor is not on.

e The Orban Windows service routine, optimodService3.exe, is Not running in the
computer doing the audio processing.

e The Service has malfunctioned. It is usually possible to restart the Service from
the TooLs > SERVICE SETTINGS dialog box in 1600PC running on the Service com-
puter. (You may have to restart it twice.) If all else fails, try restarting opti-
mod3Service from CONTROL PANEL > ADMINISTRATIVE TOOLS > SERVICES.

The Optimix tab does not appear in the User Controls.

e Optimix controls will only appear if the Processor is set for 5.1 output. Setting a
given Processor for stereo output automatically locks out Optimix. The stereo
synthesizer controls remain, in a tab labeled STEREO SYNTHESIZER.

Hard MX Overshoot mode cannot be activated.

e The HARD MX Overshoot mode is only available when the preemphasis is set to
FLAT IN /O > STEREO OUTPUT.

e HARD MX is a very CPU-intensive process and will cause audio stuttering if the
host computer is insufficiently powerful. To reduce CPU load, try defeating Op-
timix and the CBS Loudness Controller in I/O > UTILITIES. (Note that if the output
sound device is stereo, Optimix will be defeated automatically regardless of the
indication in I/O > UTILITIES.)

If you have forgotten your Administrator or User Password.

e If you have forgotten an individual Processor’'s password, you can change it if
you know the Administrator Password. See step (12.D) on page 2-11.

e There is no "backdoor” to retrieve a given Service's Administrator password. If
you have forgotten the Administrator password, you must uninstall OPTIMOD-
PCn using the Orban uninstaller, available from the Windows Programs menu.
When you uninstall, you will be asked if you want to retain your settings for use
in a new install. Select No. This will wipe out all of your audio routing settings
and passwords, allowing you to create a fresh installation with default settings

Before you uninstall, you may use Windows Explorer to make a backup copy of
the existing system.orbs for each Processor. The default location is:
C:\Users\Public\Documents\Orban\Optimod-PCn 1600\

Processor [x]\presets\

Use a different name than system.orbs (like Processorl.orbs) for the copy. Af-
ter you reinstall, you can use these files to restore your I/O settings except for 1/0
routing. Do this by copying them back into the Processor[x] folders after you
have connected 1600PC to each of the processors. Then make them active via the
FILE > OPEN SETTINGS menu item in 1600PC. You must do this once for each Pro-
cessor. (See step 6 on page 2-22 for more detail.)
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Meters in the 1600PC Control Application freeze momentarily but audio continues to be pro-
cessed normally.

e This is by design. The software thread controlling the meters is given lower than
“normal” priority in Windows to prevent the meters from interrupting im-
portant threads that maintain audio continuity. Quickly changing control set-
tings will sometimes temporarily cause the meters to freeze because the control
setting messages have a higher priority than the meters.

Poor peak level control

e Thanks to its “true-peak” limiter, which anticipates and controls peak levels fol-
lowing an ideal reconstruction filter in the analog domain, OPTIMOD-PCn audio
processing usually controls its output peak levels to an accuracy of 0.2 dB at any
output sample rate—in principle, sample rate conversion is similar to reconstruc-
tion. However, codecs like HE-AAC have intrinsic peak overshoots and you must
allow headroom for these to prevent audible clipping in player devices. 1.5 dB is
typically sufficient, as the remaining clipping will have a low duty cycle and is
unlikely to be audible. OPTIMOD-PCn’s OuTPUT LEVEL control directly controls
headroom without affecting loudness. For example, to allow 1.5 dB of head-
room for codec overshoots, set this control to —1.5 dB.

e An analog connection can cause analog-domain overshoot if the connection is
not phase linear and has a low-frequency cutoff of greater than 0.15Hz (at
-3dB).

Audible distortion

e Make sure that the problem can be observed on more than one sound system
and at several locations.

e Verify that the source material at OPTIMOD-PCn's audio inputs is clean. Heavy
processing can exaggerate even slightly distorted material, pushing it over the
edge into unacceptability.

e The subjective adjustments available to the user have enough range to cause
audible distortion at their extreme settings. Advancing the MB FINAL LiMIT DRIVE
control too far will inevitably cause distortion. (Distortion is very probable if gain
reduction in the final limiter frequently exceeds 8 dB.) Setting the LESS-MORE
control beyond “9" will cause audible distortion of some program material.

e OPTIMOD-PCn’'s MX peak limiter has several controls that affect the tradeoff
between bass punch and IM distortion between the bass and midrange. Try turn-
ing up BASS PRE-LIMITING and BASS LIMITING (move them more towards to right of
the screen). Setting BAsSS PRE-LIMIT MODE to HARD and setting the MX LIMITER
THRESHOLD control slightly below “0” can also help.

Audible noise in processed audio

e Excessive compression will always exaggerate noise in the source material.
OPTIMOD-PCn reduces this problem with its compressor gate, which freezes the
gain of the AGC and compressor systems whenever the input noise drops below
a level set by the Gate Threshold control, preventing noise below this level from
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being further increased.

There are two independent silence gates in each processing channel of the 1600.
The first affects the AGC and the second affects the Multiband Compressor. Each
has its own threshold control. (See MB Gate on page 3-65.)

In sound for picture, the setting of the Gate Threshold control is quite critical if you
want the processing to be undetectable to the audience. If this control is set too
low, then the 1600 will pump up quiet sounds like ambiance and underscoring
to unnaturally high levels. Refer to Section 3 of this manual for a further discus-
sion.

e If you are using OPTIMOD-PCn's with a soundcard having an analog input, the
overall noise performance of the system is usually limited by the overload-to-
noise ratio of the soundcard’s analog-to-digital converter.

e In digital radio applications, if an analog studio-to-transmitter link (STL) is used
to pass unprocessed audio to OPTIMOD-PCn, the STL's noise level can severely
limit the overall noise performance of the system because compression in
OPTIMOD-PCn can exaggerate the STL noise. For example, the overload-to-noise
ratio of a typical analog microwave STL may only be 70-75dB. In this case, it is
wise to use an Orban Studio Level Controller (like an Orban 6300 or another
OPTIMOD-PCn) to perform the AGC function prior to the STL transmitter and to
control the STL's peak modulation. This will optimize the signal-to-noise ratio of
the entire transmission system. An uncompressed digital STL will perform much
better than any analog STL. Section 1 of this manual has a more detailed discus-
sion.

Shrill, harsh sound; excessive sibilance

e Excessively high settings of the HF GAIN control can cause this problem. It can
also be caused by excessively high settings of the B5 THREsHOLD (Band 5 Com-
pression Threshold) control. In the latter case, you are first likely to notice the
problem as harsh sibilance on voice.

Gain pumping when high frequency energy is present

e This will occur with many OPTIMOD-PCn non-MX factory presets when
OPTIMOD-PCn'’s preemphasis is set to 50 ps or 75us. [See step 4.C) on page 2-18.]
The gain pumping happens because the preemphasis creates a large high fre-
quency boost before the look-ahead limiter, so the look-ahead limiter must pro-
duce large amounts of gain reduction to control peak levels.

To correct this problem, activate the MX limiter (in the DISTORTION tab), and, if
necessary, turn down the FINAL LIMITER DRIVE control. Note that activating the
MX limiter will cause CPU usage to increase.

Compared to the look-ahead limiter that performs peak limiting when
the MX limiter is defeated, the MX limiter is much less susceptible to gain

pumping.
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System will not pass line-up tones at full output level/100% modulation

e This is normal in OPERATE mode. Sine waves have a very low peak-to-average
ratio by comparison to program material. The processing thus automatically re-
duces their peak level to bring their average level close to that of program ma-
terial, promoting a more consistent and well-balanced sound quality.

To pass line-up tones transparently, use Bypass Mode (in 1/O > TEST) with the
BYPASS GAIN set to 0 dB.

PAss-THROUGH mode will pass tones very close to 100%, but OPTIMOD-PCn'’s
peak limiter remains in the signal path.

Speech/music detector toggles continuously between Speech and Music with a low-frequency
test tone
e This can occur when the main highpass filter and speech highpass filters are set
differently. If the test frequency is midway between the two filter frequencies,
switching between them will cause the tone level to change abruptly, fooling
the speech/music detector into thinking that this is a speech waveform. This issue
never arises with program material. See Highpass Filter on page 3-61.

Dialog is muffled in TV applications

e Set the B3>B4 CoUPLING and B4>B5 COUPLING controls to a higher value. This will
allow the processing to apply more dynamic high frequency boost. In the sur-
round processing, adjust these controls in the center channel compressor.

e Set the Center (surround) or Speech Mode (stereo) B4 COMPRESSOR THRESHOLD
control to a higher value (i.e., closer to 0 dB). This will produce less gain reduc-
tion in the presence region.

e Try using the 1600’s HF Enhancer (in the EQUALIZER tab) and set the HF ENHANCE
control to taste. For most TV programming, moderate settings (like 3 dB) are ap-
propriate because they minimize the possibility of increasing noise.

General dissatisfaction with subjective sound quality

e Make sure that all Windows audio processing is defeated for the Playback Win-
dows sound device you are using. See step 10.A)c) on page 2-9.

e OPTIMOD-PCn is a complex processor that can be adjusted for many different
tastes. For most users, the factory presets, as augmented by the gamut offered
by the LEss-MORE control for each preset, are sufficient to find a satisfactory
“sound.” However, some users will not be satisfied until they have accessed oth-
er Modify Processing controls and have adjusted the subjective setup controls in
detail to their satisfaction. Such users must fully understand the material in Sec-
tion 3 of this manual to achieve the best results from this exercise.
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Problems Specific to Dolby Digital Transmissions

Loudness incorrect compared to other Dolby Digital Transmissions

e Be sure that the active TARGET LOUDNESS setting in the 1600 is the same as the
dialnorm setting you are transmitting to consumers. Use a device like the Dolby
LM100 Loudness Meter to read out the dialnorm you are transmitting to your
audience (or simply check the dialnorm setting of your Dolby Digital encoder).
See Customizing Processing Presets to Achieve Specified Target Loudness on
page 2-23.

e Be sure that the 1600's input reference level control is set to produce normal
amounts of gain reduction. See step 5 on page 2-21.

e |f the loudness controller is on, be sure that the LOUDNESS THRESHOLD control is
set to 0 dB.

This matches the loudness controller’s threshold to the 1600's active
TARGET LOUDNESS value.

e If you are using the loudness controller: Once Target Loudness is correct, be sure
that your active preset is causing the 1600’s Loudness Gain reduction meter to
indicate approximately 3 dB of gain reduction on normal dialog. Adjust its MB
LimiT DRIVE control if it does not.

There are two LOUDNESS LEVEL meters. “dB” indicates according to the CBS
(Jones & Torick) algorithm. The Lk (or LU) meter indicates BS.1770 short-term
loudness as a floating yellow segment and BS1770-3 Integrated Loudness as a
bar. The Integrated measurement uses a 10-second rolling window.

When the loudness controller is operating normally, the 1600's LOUDNESS LEVEL
(dB) meter should be peaking around 0 dB on dialog. If it is not and you are us-
ing a custom preset, you might get better loudness control by slightly tweaking
the LOUDNESS THRESHOLD control to make the LOUDNESS LEVEL (dB) meter peak
around 0, bearing in mind that the correct setting is 0 dB for typical sound-for-
picture processing. A maximum variation of £1 dB will typically suffice.

If the 1600's active TARGET LOUDNESS setting is not the same as the dial-
norm setting you are transmitting to your audience, the 1600’s Loudness
Level meters will be calibrated incorrectly, so even if the meters are indi-
cating 0 dB, loudness at the consumer’s receiver will not be correct.

Note that because the 1600’s Loudness Level (dB) meter shares the loud-
ness controller’s filterbank, the meter does not show the effect of the
LoubnEess ATTAck control, which shapes the loudness controller’s gain re-
duction signal outside the loudness controller’s feedback loop. It also
does not show loudness reduction caused by OPTIMOD-PCn’s peak limit-
ers Therefore, if you are using values of LOUDNESs ATTACK below about
50% and/or large amounts of peak limiting, the loudness of transient
events may be significantly higher than the Loudness Level (dB) meter in-
dicates.
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The BS.1770 meters [LoubNESs LEVEL (Lk or LU)] are located after all pro-
cessing, so they accurately indicate the BS.1770 short-term and Integrated
loudness of OPTIMOD-PCn’s output.

e If you have defeated the loudness controllers: If you have made a custom preset
with the loudness controllers defeated, use the FINAL LiMIT DRIVE control to cali-
brate the preset’s loudness such that the BS.1770 loudness meter indicates 0 LU
during normal operation with typical program material. Loudness will not be as
consistent as it is when the loudness controller is active.

A BS.1770 loudness meter indicates higher loudness than expected with some program material

e Set the BS.1770 SAFETY LIMIT THRESHOLD control closer to 0 LU. This control is in
the active processing preset. Using the BS.1770 safety limiter will prevent the
meter from reading above the preset threshold but may cause subtle loudness
pumping because of limitations in the BS.1770 algorithm. See BS.1770 Safety
Limiter on page 3-26 for a more detailed discussion.

Your Optimod has a built-in BS.1770-2 (or higher) long-term (gated) meter with
a 10-secondintegration time. This should agree with an external BS.1770-2 meter
that is set up with a 10-second gated integration time, a “Relative” scale (i.e. Lk
or LU), and a reference level equal to your Optimod’s active TARGET LOUDNESS
value.

¢ We do not recommend using the loudness controllers with music-oriented for-
mats, as they will unnecessarily constrain dynamics. In particular, the BS.1770
Safety Limiter is likely to cause music produced with high amounts of dynamics
compression to be unnaturally quiet with respect to speech. If the loudness con-
trollers are turned off (as they are in most radio-style presets), the setting of the
TARGET LOUDNESS control will correspond only approximately to the measured
loudness. To fine-tune the loudness for your program material, tweak the MB
FINAL LiMIT DRIVE control. Use OPTIMOD-PCn'’s loudness meters to guide you.

CBS Loudness Controller reduces transient punch of programming

e Reduce the amount of fast gain reduction in the loudness controller by setting
the LOUDNESS ATTACK control closer to 0%. This will allow more short loudness
peaks to pass through without attenuation by the loudness controller. We be-
lieve that the range from 50% to 70% offers the most useful tradeoffs between
reducing punch and allowing irritating short-term loudness bursts to pass
through uncontrolled.

Transient loudness events (like esses in speech) sound obtrusively loud
e Set the SPEECH B5 THRESHOLD control more negative.

e Set the TRANSIENT ENHANCE control closer to 0 ms.

Commercials too loud in sound for picture applications
e Make sure that the Loudness Controller is activated on the preset that you are

using—the LOUDNESS THRESHOLD control must not be set OFF (see page 3-72) and
is normally set to 0 dB.
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e If the Loudness Controller is active but based on its gain reduction meter, you do
not believe it is working hard enough, set its threshold lower using the
LOUDNESS THRESHOLD control or increase its gain reduction by turning up the MB
FINAL LiMIT DRIVE CONTROL, which is located before the loudness controller.

Note that the Loudness Controller controls subjective loudness to an ab-
solute threshold and does not understand the context of the program.
Therefore, if a commercial follows a piece of very quiet program materi-
al, the commercial may still seem loud even though the Loudness Con-
troller is working properly.

See Loudness Control on page 3-24.

Technical Support

If you require technical support, contact Modulation Index customer service (but
please try to find the answer in this manual first). Free technical support is available
during your support period. In 1600PC, you can see when your support period ex-
pires in the Upgrade and Support Rights Time Limit field in the TooLs > SERVICE
SETUP window. (See About the Upgrade and Support Rights Time Limit Field on
page 2-6.)

See https://www.indexcom.com/about/ for contact information. Be prepared to de-
scribe the problem accurately. Know the serial number of your 1600 and the soft-
ware, and service versions are you running. The Windows operating system version
and hardware platform will also be required.

The software version number is available in 1600PC via Help > About Op-
timod-PCn 1600... If you used the automatic installer, the software ver-
sion number in the 1600PC installed in the computer running the Service
will be the same as the version number of the Service.

Before you return a product to the factory for service, please refer to this manual.
Make sure you have correctly followed installation steps, operation procedures, and
any appropriate troubleshooting suggestions. If you are still unable to solve a prob-
lem, contact our Customer Service department. Often, a problem is relatively simple
and can be fixed quickly after telephone or email consultation.

If you must return a product for factory service, please notify Customer Service by
telephone or email before you ship the product; this helps us to be prepared to ser-
vice your unit upon arrival. In addition, when you return a product to the factory for
service, we strongly recommend you include a letter describing the problem.

Please refer to the terms of your Limited One-Year Standard Warranty, which ex-
tends to the first end user. After expiration of the warranty, a reasonable charge
will be made for parts, labor, and packing if you choose to use the factory service
facility. Returned units will be returned C.O.D. if the unit is not under warranty.
Orban will pay return shipping if the unit is still under warranty. In all cases, the cus-
tomer pays transportation charges to the factory (which are usually quite nominal).
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Adding a Custom Logo

A user defined bitmap can be displayed at the right of the meter dialog in the PC
Control application. There is no default bitmap assignment available. You may cre-
ate one bitmap that works with all Processors hosted by a given Service, or you can
use individual bitmaps for each Processor.

The Control Application will not automatically scale the bitmap size. It must be cre-
ated with these parameters:

Size: 180 pixels wide x 90 pixels high
Format: Windows 24-bit
Filename: logo.bmp

To use this feature, create or copy a 180 x 90 pixel standard Windows format .bmp
file and name it 1ogo.bmp. If you wish this to appear on all Processors, place this file
in the presets directory. This will usually be the default application install directory:

Windows 32-bit
c:\Program Files\Orban\OPTIMOD-PCn 1600\Processor[x]\presets\

Windows 64-bit
c:\Program Files (x86)\0Orban\OPTIMOD-PCn 1600\Processor[x]\presets\

If you wish to have a different logo for each Processor, do not put logo.bmp in Pro-
gram files. (If you do, it can overwrite the logo.bmp files for the individual Proces-
sors.) Instead, put logo.bmp here (where Processor x is the name of the Processor):

C:\Users\Public\Documents\Orban\Optimod-PCn 1600\Processor x\presets
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Using Windows Firewall with OPTIMOD-PCn

Depending upon your network security requirements, it may be necessary to config-
ure a software firewall application like Windows Firewall, included with Windows.

1. Enable Windows Fire-
wall:

A) Navigate to
CONTROL PANEL >
WINDOWS FIREWALL

B) Click Turn wWindows
Firewall On or
Off.

C) Enable the On
(recommended)
button.

D) Select the Ad-
vanced tab.

Customize settings for each type of network

You can modify the firewall settings for each type of network location that you use.

What are network locations?

Home or work (private) network location settings
I&] % Turn on Windows Firewall

[ Block all incoming connections, induding those in the list of allowed programs

¥ Notify me when Windows Firewall blocks a new program

I@'] € Turn off Windows Firewall (not recommended)

Public network location settings
I&] % Turn on Windows Firewall

[ Block all incoming connections, induding those in the list of allowed programs

¥ Notify me when Windows Firewall blocks a new program

I@] ' Turn off Windows Firewall {not recommended)

2. Choose the network device that will be used for OPTIMOD-PCn access and will be
protected with Windows Firewall.

A) Click Settings...

& Windows Firewall

General | Exceptions | Advanced

Metwark Connection Settings

“Windows Firewall i enabled for the connections selected below. To add
exceptions for an individual connection, select it. and then click Settings:

[MiLacal Arsa Connedtion

Selfings.

Secuity Logging

ICMP

information.

Default Settings

click Restore Defaults.

"ou can reale alog file for troubleshonlting purposes Setings
With Interet Conliol Message Frotoool M), the Setings
sompulters on a netwark can share error and status =T

T restore all Windows Firewallseltings to a default state, [ geoeo oo
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B) Click Add...

C) Enter the Description of the service, the name
or IP address, the External Port number, and
the Internal Port number.

D) Select TCP.

The IP address will be that of the
computer. To avoid any conflict, we
recommend choosing a Port higher
than 1024 that is not otherwise as-
signed according to IANA:

http://www.iana.org/assignments/port-
numbers

Advanced Settings

]

Services | ICMP

Select the services running on your nebwark that Internet users can
access

Services

[ FTP Server

O Internet Mail Access Protocal Version 3 [IMAP3)
[ Internet Mail Access Protocal Version 4 (IMAP4]
O Internet Mail Server [SMTF)

O Past-Office Pratacal Wersion 3 [FOP3]

[ Remcte Desktop

O Secure Web Server [HTTPS]

[ Telnet Server

[ ‘web Server HTTF]

Add.. | | Edt. |

Service Settings

LDesciiption of service:
Orban Optimad 1100

Mame or IP address [for example 192 168.0.12) of the
computer hosting this service on wour network:

192168.0.12

External Port number for this service:

11100 @ICP  CUDP
Internal Paort number far this service:
1110

e Port 12100 is the default for the OPTIMOD-PCn Control Application.

e Port 12101 is the default for the OPTIMOD-PCn Terminal Application.

All processors are controlled by the same Service and share the sma port

number.
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E) Select OK. hdvanced Settings

Services | |CMP

A dialog box appears, indicating that the Orban Opti-

mod 1600 Service is accessible through Windows Fire- Heinia GG
wa I | . Services
[ FTP Server

O Intemet Mail &ccess Pratocal Yersion 3 [IMAP3]
O Intemet Mail decess Pratocal Version 4 [IMAP4)
O Intemet kail Server [SMTF]

(Orban Optimad 1100

[ Post-Office Pratocal Yersion 3 [POFP3)

[ Remote Desktop

O Secue'web Server HTTFS)

[ Telnet Server

[ web Semer (HTTF]

add. [ Edt. | [ Deete |
F) If any changes are required (like IP address or port): Service Settings
a) CIle Edlt Description of service:
b) Ma ke the Cha nges- Mame or IP address [for example 192.168.0.12) of the
computer hozsting thiz service on your network:
C) CIle OK. 192.168.012

Esternal Port number for this service:
11100 @Ik CQUDP
Internal Port number for this service:

11100

Ok ][ Cancel ]

NAT (Network Address Translation) Firewalls

If the computer containing OPTIMOD-PCn is on a network behind a NAT firewall,
you must configure the firewall to allow outside access to the OPTIMOD-PCn com-
puter from another computer outside the firewall. This is usually done via router
port forwarding: The OPTIMOD-PCn port(s) are forwarded to the OPTIMOD-PCn
computer by configuring the NAT firewall accordingly. The OPTIMOD-PCn computer
is then addressed with the network IP address (WAN) instead of the actual IP address
of the OPTIMOD-PCn computer.

For a single IP addressable network, each port can only be used once unless your
router supports port forwarding. Therefore, if you have more than one computer
with OPTIMOD-PCn requiring outside access, each computer must have a unique
OPTIMOD-PCn port. If your router supports port forwarding, you can assign unique
incoming ports, map them to the different IP addresses and then use the same ports
on each computer.

The OPTIMOD-PCn Control application uses TCP only.
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Refer to your router/firewall documentation for the exact configuration procedure,
paying close attention to the network security risks inherent in configuration
changes.

SNMP Support

[SNMP s not supported in v0.9x software.]

The SNMP (Simple Network Manage- ~SHMP Settings
ment Protocol) features allow you to SNMP Agent

monitor your Optimod’s status and to ' Disable SNMP " Enable SNMP
send Alarm notifications to your net-
work via the Ethernet connection of Port [ 161

your Optimod'’s host computer. It is be-
yond the scope of this manual to pro-
vide a general explanation of how
SNMP works. The text below provides
sufficient information to use your Op-
timod in your specific SNMP setup if Address | 192 . 168 . 254 . 254
you are already familiar with the gen-
eral principles of setting up SNMP.

Mote: Agent Port change and Disable feature
requires an Optimod Service restart.

Primary Manager

Part | 0

Secondary Manager
SNMP Software Installation
SNMP support is installed automatically
on your computer when you install Port [0
OPTIMOD-PCn software.

Address | 192 . 168 . 254 . 254

Community Strings

SNMP Network Setup

Read String: |
To set up SNMP, you must run
OPTIMOD-PCn control software on the Confirm String: |
same computer that houses the
OPTIMOD-PCn card(s) being monitored Write String: |

by SNMP. SNMP runs as part of the
same Windows Service that manages
communication between OPTIMOD-

PCn, your computer, and your network. Cancel B |2—

From the ToOLS menu, select SERVICE
SETTINGS to access the SNMP configuration controls.

Confirm String: |

¢ SNMP (Enable/Disable): enables or disables the SNMP feature.
¢ Primary Manager Address: sets the address of the Primary SNMP Manager.

e Primary Manager Port: sets the port of the Primary SNMP Manager.

When SNMP is enabled, you can disable the primary or secondary man-
ager by setting its port to 0.

e Secondary Manger Address: sets the address of a Secondary SNMP Manager.
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e Secondary Manger Port: sets the address of a Secondary SNMP Port.

SNMP mib File Location

The default 1600 install location is:

\Program Files\Orban\OPTIMOD-PCn 1600\orbanl600.mib
or
C\Program Files (x86)\0rban\OPTIMOD-PCn 1600\orbanl6e00.mib

SNMP Default Settings

¢ SNMP Agent: Disabled

e Primary Manager(Alarm) Address: 192.168.254.254

e Primary Manager (Alarm) Port: 0

e Secondary Manger (Alarm) Address: 192.168.254.254
e Secondary Manger (Alarm) Port: 0

SNMP Features

Get/Query:

e Processor name

e Software version

e Primary and Secondary Manager IP

e Primary and Secondary Manager Port

e InputSilence

Traps/Alert:

e InputSilence

SNMP Community String:

The “SNMP Community string” is like a user id or password that allows access to a
router's or other device's statistics. Set it in SERVICE SETTINGS>SNMP SETTINGS to im-
plement SNMP security. PRTG sends the community string along with all SNMP re-
quests. If the community string is correct, the device responds with the requested
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information. If the community string is incorrect, the device simply discards the re-
quest and does not respond.

e Read String allows users to set a password for SNMP to retrieve information
from the Optimod. Default is PusLIc.

e Write String allows users to set a password for SNMP to write (set) information
from the Optimod. Default is PRIVATE.
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Figure 3-1: The OPTIMOD-PCn Control Application

The OPTIMOD-PCn Control Application

e AGC meter shows the gain reductions of the “Master” (above-200 Hz) and
"Bass” (below-200 Hz) bands in the slow AGC processing that precedes the
multiband compressor. Full-scale is 24dB gain reduction.

e Gate indicators show gate activity. They light when the input audio falls below
the threshold set by the gate threshold controls. (There are two gating circuits—
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one for the AGC and one for the multiband compressor/limiter—each with its
own gate threshold control.) When gating occurs, the AGC and compressor’s re-
covery times slow drastically to prevent noise rush-up during low-level passages.

e Stereo Enhancer meter shows the amount of extra gain, in dB, being applied to
the stereo difference signal (L-R) to increase the apparent width of the stereo
soundstage.

e HF Enhancer meter shows the amount of dynamic 4 kHz first-order high frequen-
cy shelving equalization, in dB, being applied to the signal.

e Multiband gain reduction meters show the gain reduction in the multiband com-
pressor. Full-scale is 25 dB gain reduction. In a stereo instance, each meter is split
vertically to show the gain reduction in the left and right channels. In a surround
instance, each meter is split vertically to show the gain reduction in the main (all
channels but center) and center channels. See Multiband Compressor/Limiter
starting on page 3-19 for an explanation of how the main and center compres-
sors are coupled in surround instances.

¢ Input Meters show the peak input level applied to the audio processing, in units
of dBFS. Higher levels call for higher settings of the INPUT REFERENCE LEVEL con-
trol. If the meter indicates “0,” this indicates that the input peak level has
reached 0 dBFS. This is common if the program material applied to OPTIMOD-
PCn was aggressively mastered and there is unity gain between the playout sys-
tem and the input of OPTIMOD-PCn.

e Output Meters show the peak level of the processed samples at OPTIMOD-PCn's
output, in dBFS. They will clearly show the effect of the 100% OuTPUT LEVEL
CONTROL. (For example, setting this control to —-2.0 dBFS will cause the meters to
peak at -2.

If the output of a stereo Processor is configured for 5.1-channel, five output me-
ters will appear to show the effect of the Optimix stereo>surround upmixer.
Note that there is no LFE channel shown because Optimix places energy below
80 Hz in the Lf and Rf channels instead of in an LFE channel. This makes it maxi-
mally compatible with home theater receivers’ bass management functionality—
if Lf and Rf speakers are “small,” the receiver will route bass to the LFE channel
if present.

e Limiter meters show the amount of peak limiting (dB) in the various audio chan-
nels, which we chose not to couple because the fast release time of this circuit
would otherwise cause elements in one channel to modulate the opposite chan-
nel objectionably. Full-scale is 12 dB gain reduction.

If the output of a stereo Processor is configured for 5.1-channel, five limiter me-
ters will appear.
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Bass Limiter meters show the amount of peak limiting applied to the bass energy
in the various audio channels. Full-scale is 12 dB gain reduction.

If the output of a stereo Processor is configured for 5.1-channel, five limiter me-
ters will appear.

Loudness meters shows the subjective loudness of the output, measured using
the 1981 Jones & Torick CBS Technology Center algorithm and by the ITU.
BS.1770 algorithm. (See page 1-26 for a discussion of the CBS meter and page 1-
17 for BS.1770.)

There is only one meter for each algorithm regardless of the number of
channels and loudspeakers in the listening room because a given listener
has only one perception of loudness.

The meter is calibrated with reference to the Target Loudness / dialnorm
value that you specify in the 1600’s active Setup for that processing chain.
(See step 4.C) on page 2-18.) If you adjust the processing so that the
Loudness Level meter peaks at 0 dB on dialog and you set up your Dolby
Digital encoder so that that you are transmitting this same dialnorm
metadata value to consumer receivers, your transmission will have the
correct loudness compared to other correctly set up transmission chan-
nels.

If the CBS loudness controller is defeated in I1/O MiIXeEr > UTILITY, the CBS
Loudness Meter (dB) will show no activity.

Loudness Gain Reduction shows the amount of gain reduction that the Loudness
Controller and BS.1770 safety limiter are producing. The CBS controller gain re-
duction appears in blue, while the BS.1770 safety limiter gain reduction appears
in cyan. The two indications are stacked, so the edge of the meter shows the to-
tal gain reduction produced by both algorithms. Full-scale is 12 dB gain reduc-
tion. These meters will only show gain reduction if the LOUDNESS THRESHOLD and
BS.1770 SAFETY LIMIT THRESHOLD are not off (MULTIBAND tab in the active pro-
cessing preset), and both loudness controllers are activated in I/O MIXErR > UTILITY.

Downmix meters (in surround processors) indicate the amount of loudness con-
trol, peak limiting, and high frequency limiting produced by the downmix pro-
cessing. The high frequency limiter is only active when the downmix operates
preemphasized, as set in SETUP > OUTPUT. The downmix loudness controller is on-
ly active in surround instances of the processing.

Control Pane shows editing controls that allow you to customize the factory pre-
sets. There are two levels of control: Basic Control and Advanced Control. The
control pane is organized in tabs. Clicking a given tab will bring up the controls
pertaining to the tab’s title.

Sliders can be grouped according to the following rules. When sliders are
grouped, adjusting one slider will cause all other sliders in that group to move
by the same number of increments.
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e At least one slider in a given window is always active and will be the base
for any grouping.

e SHIFT CLICK will toggle a slider’s status (ADD or REMOVE) with the current
group of one or more sliders.

e CONTROL CLICK will add a slider to the current group.

e CLICK DRAG will un-group all current sliders and make a new group consist-
ing of the sliders within the hatched selection box.

e CONTROL CLICK DRAG will add the sliders within the hatched-selection box
to the current group

e CLICKing on a part of the window outside of any slider will ungroup the
sliders.

e CLICKing a slider outside the group will ungroup all current sliders and se-
lect the clicked one.

e |/O Window allows you to set input and output levels and system setup parame-
ters.

e File Menu allows you to open factory and user presets and to save user presets
that you have created by editing factory presets or older user presets. When you
save a preset, it is saved on the computer housing the OPTIMOD-PCn card on
which you created the preset and to the computer running the Control Applica-
tion. To share presets between cards, use a file manager or Windows Explorer to
copy preset files from one folder to another.

You can also save and restore the state of the OPTIMOD-PCn I/O controls by us-
ing the SAVE SETUP and OPEN SETUP menu items.

e Edit Menu can open up the OPTIMOD-PCn I/O Mixer screens. It can reveal Ad-
vanced Control, which is organized in tabs and allows you to edit processing pre-
sets to get the sound you want.

e View Menu allows you to display or hide the Toolbar, which contains icon-based
shortcuts for common tasks. It also allows you to hide or display the status bar
and the Connection List, and lets you activate help for individual controls using
Windows Tooltips.

e Tools Menu allows you to access the OPTIMOD-PCn I/0 window, the PROCESSOR
ADMINISTRATION screen, and the SERVICE SETTINGS Screen.

e Connect Menu allows you to connect to an OPTIMOD-PCn Processor to perform
the various tasks implemented by the Control application and the OPTIMOD-PCn
Mixer application. It also allows you to add, edit and remove profiles and to dis-
connect from a card.
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e Help Menu provides access to the Help and About functions, including the Oper-
ating Manual.

¢ Info Bar shows:
o the OPTIMOD-PCn Processor to which you are currently connected
e the preset that the Processor is running
e the state of the automatic Music/Speech detector
e the state of the Optimix upmixer (ACTIVE, INACTIVE, or DEFEATED)
e the CPU core in which the Processor is running
e the active TARGET LOUDNESS value.
¢ Toolbar contains icons that implement common functions, like recalling and sav-

ing presets, opening the 1/0 mixer screen, opening the advanced modify screens,
saving presets, and Help.

Introduction to Processing

Some Audio Processing Concepts

Reducing the peak-to-average ratio of the audio increases loudness. If peaks are re-
duced, the average level can be increased within the permitted modulation limits.
The effectiveness with which this can be accomplished without introducing objec-
tionable side effects (such as pumping or intermodulation distortion) is the single
best measure of audio processing effectiveness.

Compression reduces the difference in level between the quiet and loud sounds to
make more efficient use of permitted peak level limits, resulting in a subjective in-
crease in the loudness of quiet sounds. It cannot make loud sounds seem louder.
Compression reduces dynamic range relatively slowly in a manner similar to riding
the gain. Limiting and clipping, on the other hand, reduce the short-term peak-to-
average ratio of the audio.

Limiting increases audio density. Increasing density can make loud sounds seem
louder, but can also result in an unattractive busier, flatter, or denser sound. It is im-
portant to be aware of the many negative subjective side effects of excessive density
when setting controls that affect the density of the processed sound.

Clipping sharp peaks does not produce any audible side effects when done moder-
ately. Excessive clipping will be perceived as audible distortion.
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Look-ahead limiting is limiting that prevents overshoots by examining a few milli-
seconds of the unprocessed sound before it is limited. This way the limiter can antic-
ipate peaks that are coming up.

In Dolby Digital transmission channels, appropriate setting of the TARGET
LoupNEss metadata parameter will allow enough headroom to keep peak
levels below the threshold of the 1600’s peak limiters. The best sounding
limiting is no limiting at all.

Loudness control prevents the subjective loudness from exceeding a preset thresh-
old.

Distortion in Processing

In a competently designed processor, distortion occurs only when the processor is
controlling peaks to prevent the audio from exceeding the peak modulation limits
of the transmission channel. The less peak control that occurs, the less likely that the
listener will hear distortion. However, to reduce the amount of peak control, you
must decrease the drive level to the peak limiter, which causes the average level
(and thus, the loudness) to decrease proportionally.

Loudness and Distortion

In processing, there is a direct trade-off between loudness and distortion. You can
improve one only at the expense of the other. Thanks to our psychoacoustically op-
timized designs, this is less true of Orban processors than of any others. Neverthe-
less, all intelligent processor designers must acknowledge and work within the laws
of physics as they apply to this trade-off.

In AM and FM processing, we have long said that there is a direct trade-
off between loudness, brightness, and distortion, However, because DAB
and netcasting systems don’t use preemphasis, there is no problem get-
ting the audio to sound bright and the trade-off is only between loud-
ness and distortion.

Perhaps the most difficult part of adjusting a processor is determining the best
trade-off for a given situation. We feel that it is usually wiser to give up ultimate
loudness to achieve low distortion. A listener can compensate for loudness by simply
adjusting the volume control. However, a listener cannot make an excessively com-
pressed or peak-limited signal sound clean again.

If processing for high quality is done carefully, the sound will also be excellent on
small playback systems. Although such a signal might fall slightly short of ultimate
loudness, it will tend to compensate with an openness, depth, and punch (even on
small speakers) that cannot be obtained when the signal is excessively squashed.

If women form a significant portion of the station’s audience, bear in mind that
women are more sensitive to distortion and listening fatigue than men. In any for-
mat requiring long-term listening to achieve market share, great care should be tak-
en not to alienate women by excessive stridency, harshness, or distortion.
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Speech/Music Detector

The Speech/Music Detector allows OPTIMOD-PCn to change its processing parame-
ters depending on whether the input program material is speech or other material
(usually music).

The algorithm is straightforward: Speech is detected if (1) the input is mono, and (2)
there are syllabic pauses at least once every 1.5 seconds. Speech with a stereo music
background will usually be detected as “music,” or the detector may switch back
and forth randomly if the stereo content is very close to the stereo / mono detector’s
threshold. Mono music with a “speech-like” envelope may be incorrectly detected as
“speech.” Music incorrectly detected as “speech” can exhibit a slight loss of loudness
and punch, but misdetection will never cause objectionable distortion on music.

Speech that is not located in the center of the stereo sound field will always be de-
tected as “music” because the detector always identifies stereo material as “music.”

Processing for Audio Codecs

Professional netcasters committed to providing their audiences with the best audio
possible at a given bitrate should consider the use of a high-performance codec like
Modulation Index’s StreamS, which uses standards-based MPEG-4 AAC/HE-AAC/He-
AACv2/xHE-AAC. xHE-AAC is the most efficient codec available at the time of this
writing. It can provide good entertainment-quality audio at bit rates as low as
24kbps stereo or 16kbps mono, allowing coverage of audiences listening on dial-up
connections or via wireless devices. The lower bitrates also penetrate crowded net-
works with fewer audio interruptions.

OPTIMOD-PCn’s ability to maintain source-to-source spectral consistency is also an
important advantage. Once you have set up the processing to minimize codec arti-
facts caused by a given piece of program material, OPTIMOD-PCn’s will automatical-
ly minimize codec artifacts with any program material.

All codecs add peak overshoot to the audio. This because they remove energy that is
psychoacoustically masked by the input audio. It is not unusual for low bit rate co-
decs to overshoot by 2 dB. To minimize the possibility of clipping at the decoder, it is
wise to allow 2 dB of peak headroom at the encoder. In other words, set OPTIMOD-
PCn’s output level control to -2 dBFS when driving an audio encoder. While there
may be a few low-energy overshoots above this, clipping them will not cause audi-
ble artifacts.

Depending on the type of program material you are processing, at lowest bitrates
(32 kbps and lower with HE-AAC) it is may be advisable to use presets with
OPTIMOD-PCn’s MX limiter defeated because the extreme peak density produced by
the MX limiter may unduly stress the codec. However, defeating the MX limiter will
also reduce punch and transient definition, so you must decide by careful listening
to the output of the decoded signal after the codec’s encode/decode cycle.
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Some decoders contain a peak limiter that prevents clipping if enabled. However,
the subjective quality of any such peak limiter is unpredictable to the netcaster, so it
is better to avoid activating them at all.

OPTIMOD-PCn in Radio-Oriented Applications: From Bach to Rock

OPTIMOD-PCn can be adjusted so that the output sounds:

e as close as possible to the input at all times (using the Two-Band Protection Lim-
iter preset)

e open but more uniform in frequency balance (and often more dramatic) than
the input (using the Two-Band structure or running the Five-band structure with
slow release time)

¢ dense, quite squashed, and very loud (using the Five-band structure with faster
release times)

The dense, loud setup will make the audio seem to jump out of car and table radios,
but may be fatiguing and invite tune-outs on higher quality home receivers. The
loudness/distortion trade-off explained above applies to any of these setups.

In professional broadcasting environments, you will achieve best results if Engineer-
ing, Programming, and Management go out of their way to communicate and co-
operate with each other. It is important that Engineering understand the sound that
Programming desires, and that Management fully understands the trade-offs in-
volved in optimizing one parameter (such as loudness) at the expense of others
(such as distortion or excessive density).

Never lose sight of the fact that, while the listener can easily control loudness, he or
she cannot make a distorted signal clean again. If such excessive processing is per-
mitted to audibly degrade the sound of the original program material, the signal is
irrevocably contaminated and the original quality can never be recovered.

Sound for Picture Applications: Controlling Dynamic Range

The most crucial commandment in sound for picture is this: dialog must always be
intelligible. Sound for picture is usually heard under less-than-ideal conditions and
its dynamic range must be controlled accordingly. Apartment-dwellers must set their
volume controls to avoid disturbing neighbors or even other members of the family.
At the quiet side, intelligibility of dialog is often impacted by environmental noise
such as children playing or a dishwasher going in the kitchen. When one considers
that the hearing acuity of a significant portion of the audience is somewhat im-
paired compared to that of a healthy 20-year-old, one concludes that the dynamic
range of dialog must not exceed 15dB if it is to be intelligible to 99% of viewers un-
der common domestic viewing conditions. Feature-film dynamic range is inappropri-
ate for home viewing (except in dedicated home theaters) and the dynamic range of
a significant portion of the audio from video source material must be compressed to
best serve the audience. The challenge (which OPTIMOD-PCn effectively meets) is to
compress dynamic range unobtrusively.
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OPTIMOD-PCn can be adjusted so that the output sounds as close as possible to the
input at all times (using the PEAK LIMITER preset), or so that it sounds open but more
uniform in frequency balance than the input (using considerable interband coupling
and a slow release time in the five-band compressor), or so that it sounds dense,
quite squashed, and very loud (using faster release times and less band coupling).

In television audio, inconsistent loudness between channels or program elements is
annoying, so the dense, loud setup is never appropriate. The 1600 offers two-band
and five-band presets (whose names begin with “TV") that exploit the AGC’s and
multiband compressor’'s compression ratio controls to subtly control dynamic range
in sound for picture applications. These presets effectively and unobtrusively main-
tain dialog intelligibility while retaining a sense of dynamic range, allowing low-
level elements to be heard easily. Meanwhile, the CBS Loudness Controller prevents
subjective loudness from exceeding a preset ceiling.

The preset tuning controls on the 1600 give you the flexibility to adapt the pro-
cessing to individual program segments. In most cases, your goal should be to
choose the type of processing that best optimizes dynamic range while controlling
the loudness of the loudest sounds so that they are not irritating and are consistent
with the loudness of other stations or sources. When the 1600 is otherwise set up
correctly (so that it is cognizant of the dialnorm metadata you are transmitting to
viewers), its TVxxxx presets achieve this goal most precisely by exploiting the loud-
ness controller. The “radio-style” presets are crafted to match the target loudness as
well as can be achieved without use of the loudness controller.

If you want more consistent loudness from a “radio-style” preset, set its
LoUDNESs CONTROLLER THRESH control to =10 dB, turn up its MB LIMITER DRIVE
control until the loudness controller gain reduction meter indicates about
3 dB of gain reduction with typical program material, and save the result
as a user preset. However, this will often reduce punch with musical pro-
gramming.

Protection Limiting

OPTIMOD-PCn has an advanced peak limiter that is more than competitive with the
best mastering peak limiters, particularly in MX mode. The PEAK LIMITER MX preset
allows you to use OPTIMOD-PCn as a mastering-style limiter that is capable of a sur-
prisingly favorable trade-off between loudness and undesired artifacts. It is typically
possible to make —6 or =7 LUFS masters that sound clean, punchy, and open.

Studio AGC

You can use OPTIMOD-PCn as a studio AGC and STL protection peak limiter. In a typ-
ical application, OPTIMOD-PCn substitutes for the AGC in an Optimod at the trans-
mitter and provides protection limiting for the STL, which can be flat or preempha-
sized at 50 or 75 ps. The AGC is turned off in the transmitter-side Optimod.

OPTIMOD-PCn’s AGC uses an improved version of the dual-band, window-gated,
matrix technology as the AGCs in Orban’s 2300, 5300, 8300, 8382, 8400, 8500, 9300,
and 9400 Optimods. Therefore, it can effectively substitute for the AGCs in these
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devices and can help maintain an all-digital signal path throughout the facility. Be-
cause OPTIMOD-PCn’s AGC is even more advanced than the AGCs in Orban’s 2200,
8200, and 9200 Optimods, OPTIMOD-PCn can upgrade the performance of these
older products when substituted their AGCs.

Moreover, because OPTIMOD-PCn supports presets that be recalled by remote con-
trol, it can be automatically synchronized to the presets on-air at a transmitter-side
Optimod when presets are dayparted.

To achieve this match:

A) Recall one of the STUDIO AGC presets. There are three such presets, for flat,
50 ps, and 75 s preemphasized STLs. See AGC+LIMIT on page 3-34.

You must also configure the peak limiter to match the preemphasis that
your STL uses. See step 4.C) on page 2-18.

B) Edit AGC parameters of the OPTIMOD-PCn preset so they are the same as the
AGC parameters on-air at the transmitter-side Optimod. Then save your work
as an OPTIMOD-PCn User Preset.

If you use more than one preset in the transmitter-side Optimod, make
one OPTIMOD-PCn User preset for each transmitter-side Optimod preset.

C) Adjust the transmitter-side Optimod'’s input reference level so that the Opti-
mod performs the correct amount of multiband gain reduction (i.e., the same
amount of GR that it would have performed if its internal AGC were active).

About OPTIMOD-PCn’s Signal Processing Features

Audio Processing Signal Flow

The signal flows through OPTIMOD-PCn in order through the following blocks:

e DCRemoval

¢ Input Conditioning, includes defeatable highpass filtering, lowpass filtering and
phase rotation.

e Stereo Synthesizer, auto-detecting and defeatable, uses Orban’s classic comple-
mentary comb filter technique (stereo processing only)

e Mono Bass processing blends the left and right channels below 80 or 100 Hz (de-
featable; stereo processing only).

e Subharmonic Synthesizer creates energy one octave below program energy in
the range of 50-90 or 60-120 Hz when such energy is not present at the input
and when music is detected.
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e Left/Right Phase Skew Correction corrects phase shifts between the left and right
stereo channels that could otherwise cause comb filtering in the mono sum (ste-
reo processing only).

e Stereo Enhancement uses upward expansion of the stereo difference signal as
triggered by transients in the stereo sum signal.

e Optimix™ dual-mode automatic stereo>surround upmixer (surround processing
location)

e Two-Band Gated AGC, with target-zone window gating and silence gating
e Equalization, including high-frequency enhancement

e Downward Expander in five bands

e Multiband Compression in five bands

e Automatic Loudness Control using Orban’s third-generation CBS Loudness Con-
troller™ algorithm plus BS.1770 Safety Limiter

e Optimix™ dual-mode automatic stereo>surround upmixer (stereo processing
location)

e Peak Limiting of several varieties

Tutorial: More about Dynamics Processing (starting on page 3-28) provides a basic
tutorial on the concepts of dynamics processing, including AGC, compression, and
peak limiting.

Sample Rate Conversion

The base sample rate of OPTIMOD-PCn’s internal processing 48 kHz even when the
input and output are configured for 44.1, 96 or 192 kHz; in these cases, synchronous
sample rate conversion occurs at the input and output. This 48 kHz rate accommo-
dates a 20 kHz audio bandwidth with a comfortably wide 4 kHz transition band for
the anti-aliasing filter. Except for one study that used grossly overspecified anti-alias
filters (whose impulse responses were at least four times as long as necessary to
achieve flat response to 20 kHz), we are aware of no bias-controlled double-blind
studies that have ever suggested that sample rates higher than 48 kHz are audibly
superior to 48 kHz (or even that there is any audible difference at all when an opti-
mally-designed anti-alias filter is used).

Moreover, the noise and distortion produced by a given digital filter at 48 kHz is
about 6 dB lower than the noise and distortion produced by a filter having the same
frequency response but operating at 96 kHz. OPTIMOD-PCn uses many digital filters,
both in its equalizer section and for the crossovers in the multiband compressor.
Hence, we believe that 48 kHz is the ideal rate for OPTIMOD-PCn’s audio processing.
Higher sample rates would not only increase CPU usage but would decrease the sig-
nal-to-noise ratio of the processing.
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Input Conditioning

e A highpass filter with a cutoff frequency of 0.15 Hz removes DC offset from
source material without causing significant tilt of low-frequency squarewaves.

e A highpass filter, tunable between 20 Hz and 200 Hz and with selectable 6, 12,
18, or 24 dB/octave slopes, is useful for production applications where it is neces-
sary to remove low frequency rumble from a recording, and in news/talk broad-
casting formats.

e A gentle-slope (6, 12, 18, or 24 dB/octave) lowpass filter, tunable between 4 kHz
and 15 kHz and with selectable 6, 12, 18, or 24 dB/octave slopes, is useful for
production and mastering.

e A defeatable phase rotator makes speech more symmetrical, reducing its peak-
to-average ratio by as much as 6 dB without adding nonlinear distortion. Hence,
phase rotation can be very useful for loudness processing of speech.

e A very steep lowpass filter can be tuned between 10 kHz and 20 kHz. Set it to
complement the bandwidth of the transmission channel that OPTIMOD-PCn is
driving. “20 kHz" is a placeholder that is actually “no filter.”

e Stereo Synthesizer

e The stereo synthesizer emulates the classic analog Orban 275A automatic stereo
synthesizer.

e This process creates an artificial stereo difference signal (L-R) by passing the
mono input through a multistage allpass filter. After matrixing with the original
mono input (which is the L+R signal) to produce the synthesized left and right
channels, the result is a “complementary comb filter” whose notches are spaced
in frequency in an approximately logarithmic manner. Because only the L-R sig-
nal is created artificially, it cancels out of a mono mixdown, making the synthe-
sizer's output completely mono-compatible. This processing is only available in
stereo mode.

e The synthesizer can be invoked manually or by automatic detection of silence on
the right input channel.

¢ Mono Bass Processing

e This applies a steep-slope 80 Hz or 100 Hz highpass filter to the stereo difference
signal (L-R). A compensating delay is applied to the L+R signal, making the
bandwidth of the transition between mono and well-separated stereo as narrow
as possible. This processing is only available in stereo mode.

¢ We strongly recommend activating mono bass processing when the stereo syn-
thesizer is active.
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Subharmonic Synthesizer

The subharmonic synthesizer generates subharmonics of fundamental frequencies in
the 50-90 or 60-120 Hz range, user-selectable via the SUBHARMONIC CUTOFF FREQ con-
trol. The subharmonics are one octave below the frequencies from which they are
generated (i.e., 25 to 45 Hz or 30 to 60 Hz) and track the levels of their generating
frequencies.

If input program material below 45 or 60 Hz is present, the subharmonic synthesizer
automatically reduces the level of the synthesized subharmonics to prevent excess
build-up of energy below 45 or 60 Hz.

To prevent introducing unnatural coloration in male speech, the subharmonic syn-
thesizer is defeated when the automatic speech/music detector detects speech. This
is particularly critical when the SUBHARMONIC CUTOFF FREQ control is set to 120 Hz
because the synthesizer can cause “thumping” sounds behind deep male speech. It is
therefore important to keep raw speech in the center of the stereo image, because
this is one of the criteria that the speech/music detector uses to discriminate be-
tween speech and music.

Stereo Enhancement

OPTIMOD-PCn provides a stereo enhancement algorithm based on Orban’s analog
222 Stereo Enhancer, which increases the energy in the stereo difference signal (L-R)
whenever a transient is detected in the stereo sum signal (L+R). By operating only on
transients, the 222 increases width, brightness, and punch without unnaturally in-
creasing reverb (which is usually predominantly in the L-R channel).

Use stereo enhancement with care if you are driving a low bitrate codec. At low bi-
trates, these codecs use various parametric techniques for encoding the spatial at-
tributes of the sound field. Stereo enhancement can unnecessarily stress this encod-
ing process.

Because stereo enhancement complements the Optimix 2.0->surround upmixer by
making the upmix more dramatic and enveloping, enhancement is available in both
stereo and surround modes. In surround mode, the enhancement is coupled to the
state of the Optimix upmixer and operates only when Optimix is upmixing.

Gating circuitry detects “mono” material with slight channel or phase imbalances
and suppresses enhancement so this built-in imbalance is not exaggerated. It also
allows you to set a “width limit” to prevent over-enhancement of material with sig-
nificant stereo content, and will always limit the ratio of L-R/ L+R to unity or less.

Left/Right Phase Skew Correction

The phase skew corrector maximizes the quality of a mono mixdown that might oc-
cur in a receiver or player device. At higher frequencies (where audible comb filter-
ing of the mono sum is most likely to occur), the corrector removes phase differ-
ences between the left and right channels, converting the HF signal into "intensity
stereo” while preserving phase differences at lower frequencies where these differ-
ences are important for psychoacoustic “envelopment.” The PHASE CORRECTOR
CROSSOVER control in the LESS-MORE tab of the active Processing Preset sets the
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crossover frequency above which phase correction occurs, and IN/OUT activates or
defeats the phase corrector via a delay-matched crossfade.

This process can not only correct problems due to phase skew between the left and
right channels of an analog recording due to head gap misalignment, it can also cor-
rect comb filtering caused by spaced microphones feeding the left and right chan-
nels, which can occur on drum kits and other sources that have been multi-miced.

When OPTIMOD-PCn is used as a pre-processor for an FM audio processor like an
Orban Optimod-FM, the phase corrector minimizes the amount of energy in the ste-
reo subchannel, which consequently minimizes multipath distortion without com-
promising stereo separation. It can allow more stereo enhancement to occur for a
given amount of multipath distortion. The process also minimizes the amount of
peak overshoot during SSB/VSB operation of the stereo encoder (if available), thus
minimizing the amount of composite limiting needed to constrain peak modulation
to 100%.

Because the phase skew corrector can subtly alter the stereo spatial effect, we rec-
ommend using it only as necessary (for example, with formats that play older re-
cordings from the analog era). It can be smoothly activated and defeated via a de-
lay-matched crossfade, so it is practical to do live switching between a preset with
the process active and one where it is inactive.

Because it adds considerable delay and uses a significant amount of CPU power, the
phase skew corrector can be bypassed completely in /0O > UTILITY. If you are not us-
ing it and do not need to activate it smoothly “on-air,” bypass it.

This processing is only available in stereo mode and is locked out when the Optimix
upmixer is set to AUTO or UPMIX modes. The Optimix phase skew corrector is a some-
what different process that corrects only the center channel of the upmix while leav-
ing the left and right channels unmodified, which maximizes the subjective envel-
opment of the upmix.

Optimix® Automatic Stereo>Surround Upmixer

The built-in Optimix Stereo>Surround Upmixer is located before the AGC in a sur-
round processing chain. To allow the preceding processing to save CPU cycles by op-
erating in stereo mode, Optimix is located just before the peak limiters in a stereo
processing chain.

Optimix can be operated in two modes: FRONTAL and WRAP, determining whether
the virtual soundstage is wrapped around the listener (putting the listener “inside
the band”) or is placed primarily in the front (putting the listener “inside the audito-
rium”).

In surround mode, Optimix's placement in the signal chain means the AGC and
multiband compressor process the upmix the same way as they do true surround
material. This allows the multiband compressor to correct the frequency and loud-
ness balances of dialog automatically, even if the dialog was sourced from a two-
channel stereo mix.



3_ 16 OPERATION ORBAN MODEL 1600

In surround mode, Optimix can automatically sense whether the input material is
two-channel stereo or surround. It does this by detecting energy in the center, left
surround, and right surround input channels. In automatic switching mode, if Opti-
mix detects energy in any of these channels, it will immediately bypass the upmixer.
If there is no energy in any of these channels, Optimix will create a realistic-
sounding surround mix from stereo input.

In stereo mode, Optimix is located after the loudness controllers in the signal path.
No automatic switching is provided because its input is always stereo.

Peak limiters follow Optimix and operate in five-channel mode. To save CPU, in MX
mode only the Lf, Rf, and C peak limiters use the MX algorithm. Because the peak
level of the upmixed L and R surround channels is typically much lower, these chan-
nels require little or no peak limiting and can use the non-MX look-ahead limiting
algorithm without adding artifacts.

Optimix includes a sophisticated delay/phase correction algorithm that prevents
phase cancellations between the left and right channels from affecting the crispness
and high frequency response of the upmixed center channel. It does not affect other
channels in the upmix. This is particularly important with older program material
that may have been archived on analog tape, which is frequently subject to phase
skew between the left and right channels.

See Optimix™ Upmixer Controls on page 3-45.

Two-Band Gated AGC

The AGC is a two-band device, using Orban’s patented “master/bass” band coupling.
It uses a linear-phase crossover.

In surround mode, the total power in the input channels (RMS) determines the gain
reduction, so all channels receive equal amounts of gain reduction.

In stereo mode, there are two gain-control sidechains, one for each stereo channel.
To preserve RMS operation, the MAXDELTAGR control operates a constant-power,
symmetrical panpot. When the MAXDELTAGR control is set to O, it applies equal
amounts of left and right energy to both sidechains, which causes the left and right
sidechains to track each other, maintaining 100% stereo coupling. As the
MAXDELTAGR control is set to higher values, it progressively applies less right-channel
energy to the left-channel sidechain and vice-versa. Setting the control to a higher
value will partially correct stereo program material with left/right channel imbalanc-
es. Higher settings should be used with caution, as they can cause instability in the
stereo image.
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The AGC contains a compression ratio
control that allows you to vary to ratio
between 2:1 and essentially «:1. Lower
ratios can make gain riding subtler on
critical formats like classical and jazz. See
Figure 3-4. 6

The AGC incorporates target-zone gat-
ing. If the input program material’s level
falls within a user-settable window (typi-
cally 3dB), the release time slows to a
user-determined level. It can be slow
enough (0.5 dB/second) to effectively +6
freeze the operation of the AGC. This
prevents the AGC from applying addi-
tional, audible gain riding to material
that is already well controlled. It also lets +12 95
you run the AGC with fast release times — 6dB
without adding excessive density to ma- T T 1 T T
terial that is already dense. Figure 3-5 12 6 0 *6 12
shows the behavior of the window for INPUT LEVEL [dB]
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The AGC has a dedicated silence-gating detector whose threshold can be set inde-
pendently of the silence gating applied to the multiband compressor. In stereo
mode, the gating detector is operated from the output of the left-channel panpot
implemented by the MAXDELTAGR control, so if this control is set for fully uncoupled
operation (not recommended) and there is energy only in the right channel, then
the gate will activate.

Equalization

OPTIMOD-PCn has a bass shelving equalizer, four bands of fully parametric bell-
shaped EQ, and a dynamic high-frequency enhancer.

You can set the slope of the bass shelving EQ to 6, 12, or 18 dB/octave, adjust the
shelving frequency and set the amount of equalization.

OPTIMOD-PCn’s bass, midrange, and high frequency parametric equalizers have
curves that were modeled on the curves of Orban’s classic analog parametrics (like
the 622B), using a sophisticated, proprietary optimization program. The curves are
matched to better than 0.15dB. This means that their sound is very close to the
sound of an Orban analog parametric. They use very high quality filter algorithms to

e

18-12-6
dB/octave

LF Shelf EQ HF Shelf EQ

Figure 3-6: LF and Dynamic HF Shelving Equalizer Frequency Response

LN, AN, AN
DZERNZEaN17¢

‘ Low Freq Parametric EQ ‘ Mid Freq Parametric EQ ‘ High Freq Parametric EQ ‘

Figure 3-7: Parametric Equalizer Frequency Response for Narrow and Wide Bandwidths
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ensure low noise and distortion.

The HF Enhancer is a program-controlled HF shelving equalizer that intelligently and
continuously analyzes the ratio between broadband and HF energy in the input
program material. It can equalize excessively dull material without over-enhancing
bright material. It interacts synergistically with the five-band compressor to produce
sound that is bright and present without being excessively shrill.

The BRILLIANCE control adds additional gain before the Band 5 multiband compres-
sor, so it acts like a steep-slope shelving equalizer.

See Figure 3-6 and Figure 3-7 on page 3-18 for illustrative frequency responses of
the shelving and parametric equalizers.

Multiband Compressor/Limiter

The multiband compressor/limiter operates in five frequency bands. Each band com-
pressor has a KNEE and RATIO control. A soft knee and gentle ratio are particularly
useful in production and mastering applications, allowing subtle compression that
retains as much of the dynamics of the input program material as the operator de-
sires. (The SOFT KNEE AND SOFT KNEE MX presets are intended for mastering; they ex-
ploit the soft knee features.) These features are also exploited in the TV 5B DRAMA
preset.

Several band-coupling controls allow the gain reduction of a given band’s compres-
sor to be affected by the gain reduction in its neighboring band’s compressor. These
coupling controls allow anything from quasi-wideband compression to fully inde-
pendent multiband compression.

The surround multiband compressor (available only in Surround versions of
OPTIMOD-PCn) is always stereo-coupled and has two main sidechains.

e The first surround sidechain responds to the power (RMS) sum of all channels.
However, to prevent sibilance in the center channel from ducking high frequen-
cies in the remaining channels, the center channel does not affect the gain re-
duction in bands 4 and 5.

10 100 1,000 10,000 700,000
Band 1 ‘ Band 2 ‘ Band 3 ‘ Band 4 ‘ Band 5

Figure 3-8: Multiband Compressor Crossover Filters (lllustrative)
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As in the AGC, the SURROUND OPTIMIZATION control for the active preset deter-
mines how the rear channels are weighted in the RMS sum.

This sidechain applies the slow “compression” component of the gain reduction
identically in all channels except for the center. However, each channel also has
an individual “limiting” function that is not stereo coupled. This prevents fast
transients in one channel from audibly modulating the gains of the other chan-
nels. Because this “limiting” function operates quickly, it does not affect stereo
imaging.

Do not confuse this “limiting” function with the 1600’s look-ahead limit-
er, which is located after the Loudness Controller in a given processing
chain and which has much faster attack and release times.

e The second surround sidechain responds to the center channel alone. It provides
both a “compression” and “limiting” function.

The dual-sidechain architecture’s main application is to improve dialog intelligi-
bility by preventing strong energy in the non-center channels from drowning out
dialog in the center channel even when the original mix was miscalculated. To
achieve this, the center channel’s gain sometimes needs to be increased with re-
spect to the other channels and the dialog needs to be re-equalized automatical-
ly by multiband compression. Moreover, this dual-sidechain architecture permits
the multiband compressor to de-ess center channel dialog as necessary without
affecting the other channels.

Completely independent compression of the dialog channel can cause unnatural-
sounding level imbalances between the dialog and the remaining program ele-
ments. To address this, there are two coupling controls for each frequency band
in the multiband compressor. These coupling controls work by constraining the
difference (in dB) between the center channel’s gain reduction and the main
channel’s gain reduction. To do this, they clamp the center channel’s gain reduc-
tion with respect to the main channel but do not affect the gain reduction in the
main channel. In other words, the center channel’s gain reduction is either the
output of the center channel’s compression sidechain or a fixed offset from the
main channel’s gain reduction. There are separate controls to set the maximum
positive and negative offsets. The constraints are applied to the entire center
gain reduction signal (compression plus limiting).

To preserve intelligibility, it is important to prevent the center channel’s gain re-
duction from becoming too large with respect to the other channels. The Bx
MAIN>CENTER MAX +DELTA GR control sets the maximum positive gain reduction
difference in each band. When the five-band structure is used, it is common to
set this control to 0 dB in Bands 1-3. To facilitate de-essing (and because Bands 4
and 5 in the center channel do not contribute to the gain reduction in the main
sidechain), we recommend setting the B4 and B5 MAIN>CENTER MAX +DELTA GR
controls to allow some extra gain reduction to occur in center channel Bands 4
and 5. It is OK to set this control to OFF in Band 5, which allows unconstrained
de-essing above 6 kHz. The TVxxxx factory presets provide examples.

Meanwhile, a Bx MAIN>CENTER MAX —DELTA GR sets the maximum negative gain
reduction difference in each band, which constrains the amount of dynamic dia-
log boost. It also constrains the degree to which the center channel compressor
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can pull up noise. If there are program elements other than dialog panned into
the center channel, the control constrains the amount by which the front stereo
image can be narrowed. 3 dB is a typical setting.

Each band in the stereo multiband compressor (provided in stereo versions of
OPTIMOD-PCn) has two sidechains—one for the left and one for the right channel.
You can separately set the left/right coupling of each band anywhere from 100%
stereo coupled to fully independent.

Although the multiband compressor’s architecture has two sidechains,
OPTIMOD-PCn does not allow two different programs to be routed
through a stereo Processor. If you need one or more channels of mono
processing, use an instance of mono processing for each. This allows each
Processor to have separate setup and processing controls applied to it.

e In STEREO mode, there is one LOUDNESS LEVEL meter, AGC GATE indicator, and
MB GATE indicator. However, you can still uncouple each band in both the AGC
and multiband compressors to a variable extent—anywhere from perfect stereo
coupling to completely uncoupled operation. The coupling control determines
the maximum amount of gain difference permitted between the left and right
channels in a given band and therefore the amount of stereo image shift per-
mitted in each frequency band.

Parallel Compression

The parallel compression mode drives downstream processing with the sum of the
input and output of the multiband compressor. As compressor gain reduction in-
creases, the compressor contributes less and less to the overall output. Parallel mode
is mainly useful for classical music, preserving the dynamic impact of loud material
while making quiet material more audible. Typical applications are preparing mate-
rial for in-flight entertainment or other noisy environments.

There are two specific controls for parallel mode (in the MULTIBAND tab):
COMPRESSOR MODE [Inline, Parallel]] and COMPRESSION THRESH OFFSET [0 to —60 dB, 1
dB steps]. Additionally, in parallel mode the MULTIBAND DRIVE control is repurposed
so that it sets the amount of compressor output that is added to the compressor’s
input. Its setting indicates the amount of amplification of quiet material that occurs
when the compressor produces no gain reduction. It does not affect the amount of
compressor gain reduction.

The COMPRESSION THRESH OFFSET control is only active in Parallel mode. It moves all
compressor thresholds in the five-band compressor down by the same amount. It is
needed because the MULTIBAND DRIVE control does not affect the amount of com-
pressor gain reduction and because the individual bands’ COMPRESSION THRESHOLD
controls do not have enough range to achieve the desired amount of gain reduction
with all program material.

Parallel compression is usually used to bring up quiet material while minimally af-
fecting loud material. Hence, the compressor threshold must be much lower than
normal so that the compressor develops maximum gain reduction with high-level
material. Adjust the COMPRESSION THRESH OFFSET control so that the compressor
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gain reduction meters are active but on-scale during quiet material that you wish to

make louder. Typical settings are —30 to —40 dB.

It is normal for the five-band compressor gain reduction meters to indicate full-scale
during loud material. (The maximum gain reduction is clamped internally to 40 dB.)

The COMPRESSION THRESH OFFSET control also scales the MB GATE THRESHOLD and the
DOwWN EXPANDER thresholds downward so that these features can be effective with
source material that has low intrinsic noise, like most digital recordings. These fea-
tures can help resist increasing audible noise (such as air conditioning rumble) dur-

ing the quietest parts of the program.

Note that parallel compression can be effective and unobtrusive even with faster

settings of the MULTIBAND RELEASE control.
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Figure 3-9: Parallel Compression Input vs
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To prevent phase cancellation between the compressor’'s output and input, the
summation occurs immediately after the compressor's VCAs, and the five-band
crossover is still in the signal path. ALLPASS crossover mode produces phase rotation,
so LINEAR crossover mode is most appropriate for the kind of program material typi-
cally processed with parallel compression.

LFE Processing

In a surround Processor, the LFE channel has its own dedicated compressor with
ATTACK TIME and THRESHOLD controls. Its other settings (such as RATIO and
BREAKPOINT) track the settings of the B1 compressor. To constrain build-up of LFE
energy, the B1>LFE COUPLING control clamps the maximum gain of the LFE channel
with respect to the band 1 compressor in five-band mode and the Bass band in two-
band mode. For example, when this control is set to 3 dB (the default) and the B1
compressor exhibits 12 dB of gain reduction, the LFE channel can never have less
than 9 dB of gain reduction even if the LFE compressor would have produced less
than 9 dB of gain reduction if uncoupled.

Peak Limiter
OPTIMOD-PCn’s look-ahead true-peak limiter pre-
vents overshoots by examining a few milliseconds +12 -

of the unprocessed sound before it is limited. This
way the limiter can anticipate peaks that are com-
ing up. The limiter's sidechain is oversampled to
384 kHz to prevent significant overshoot from oc-
curring after sample rate conversion or D/A conver-
sion. In stereo and mono instances additional pre-
processing, borrowed from MX SOFT mode (see be-
low), reduces potential artifacts caused by wide-
band limiting. Surround instances do not use the
additional pre-processing because the target loud-
ness of surround instances is usually -23 or -24
LUFS, which requires little or no peak limiting.

OUTPUT LEVEL [dB]
X e
N
|

N}
i
|

-36 -

The limiter's drive level mainly determines the gain
reduction. Two cascaded gain controls set this drive 2 aa R : s
level. One is MB LIMIT DRIVE; the second is a “hid- INPUT LEVEL [dB]

den” control whose gain is set by the active TARGET

LOUDNESS value. Additionally, the 100% OuTPUT

LEVEL control is a limiter threshold control that in- Figure 3-10: Peak Limiter Output vs. Input
creases the amount of limiting as the control is

turned down (see Figure 1-4 on page 1-21).

For more about the concept of target loudness, see About Target Loudness and ITU-
R BS.1770 starting on page 1-16.

You can activate MX peak limiter technology, which introduces fewer audible arti-
facts than pure look-ahead limiting when a large amount of limiter gain reduction is
required and can add some “exciter”-like harmonic enhancement, depending on the
setting of the HF DISTORTION CONTROL control. MX limiting is a CPU-intensive process
that can add up to 240 ms of delay and is mainly beneficial if the target loudness is
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above -12 LUFS. (When the target loudness is below —12 LUFS, the peak limiter usu-
ally operates lightly.)

The MX limiter has two overshoot compensator modes: HARD and SOFT. HARD is very
CPU-intensive and is mainly useful when you need to create very high loudness, such
as that found in some “hypercompressed” CDs. Additionally, SOFT CAN be cleaner
sounding at the expense of producing some audible gain pumping. The choice of
HARD or SOFT modes must be made by ear.

HARD mode is only available when the preemphasis is FLAT.

In surround mode, or if you are in stereo mode and upmixing via Optimix, MX limit-
ing is applied to the left, center, and right channels only. The surround channels,
which normally have lower peak levels, are limited using the non-MX limiter. This
provides the advantages of MX limiting without excessively increasing CPU usage.

In stereo mode and with Optimix defeated in I/O Setup, only the left and right MX
limiters are active, saving CPU cycles.

Loudness Control

OPTIMOD-PCn’s third-generation CBS Loudness Controller and BS.1770 Safety Limit-
er cooperatively and automatically control subjective loudness.

Useful in sound-for-picture applications, particularly when government regulations
like the CALM Act require control of subjective loudness, the third-generation CBS
Loudness Controller follows the multiband compressor in the signal flow diagram.
This placement reduces the drive level into the peak limiter when the loudness con-
troller produces gain reduction. This minimizes peak-limiter-induced artifacts.

The loudness controller takes into account control settings that affect the peak lim-
iter so that the loudness controller approximately monitors the loudness at the lim-
iter's output, not the loudness at the multiband compressor’s output. It does so by
scaling its sidechain drive by two gain factors: (1) the MB LiMIT DRIVE control and (2)
the 1600’s active TARGET LOUDNESS value, which is determined either globally or by
the active preset depending on the active preset’'s TARGET LOUDNESS setting. (See
Figure 1-4 on page 1-21 and Peak Limiter on page 3-23.) The TARGET LOUDNESS value
is the same as value of “dialnorm.” OPTIMOD-PCn contains a BS.1770 “integrated”
meter with an integration time of 10 seconds. To comply with these standards,
TARGET LOUDNESS is customarily set to =24 in the United States and -23 in the EU.

The Loudness Controller constrains the loudness of most commercials well enough
to eliminate viewer annoyance. It works by constantly monitoring the subjective
loudness of the 1600's output. The subjective loudness is a single value that repre-
sents the listener’s impression of the loudness in the listening room. It takes into ac-
count the contribution of all stereo and surround channels.

When subjective loudness would otherwise exceed the threshold set by the
LOUDNESS THRESHOLD control, the CBS Loudness Controller reduces the gain of mate-
rial above 200 Hz, preventing loudness from exceeding the threshold. To prevent
the loudness controller from causing too much dynamic bass boost, you can use the
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LOUDNESS CONTROLLER BASS COUPLE control to limit the maximum difference be-
tween the gain of the band below 200 Hz and the band above 200Hz. For example,
when this control is set to 3 dB and the loudness controller’s gain reduction is 10 dB,
the gain reduction below 200 Hz will be 7 dB. However, if the loudness controller’s
gain reduction is 2 dB, the gain reduction below 200 Hz will be 0 dB because the dif-
ference is now less than 3 dB.

The loudness controller is triggered mainly by program material that has a lot of en-
ergy between 1 and 7 kHz, which is the ear’s most sensitive range. The five-band
compressor can automatically re-equalize such program material so that it does not
induce unnatural-sounding gain reduction in the loudness controller, and will de-ess
extremely sibilant program material before the loudness controller receives it.

The loudness controller’s attack and release times are tuned to match the loudness
integration times of the ear and are program-adaptive. Only the attack time is user-
adjustable.

If you feel that the Loudness Controller is not controlling the loudness of commer-
cials or other subjectively loud program material sufficiently well, you may wish to
set the threshold lower, forcing the Loudness Controller to do more work. You may
also wish to activate the BS.1770 Safety Limiter.

In the LOUDNESS GAIN REDUCTION meter, the gain reduction of the BS.1770 safety lim-
iter (in dB units) is stacked with gain reduction of the CBS loudness controller. The
CBS controller gain reduction appears in blue, while the BS.1770 safety limiter gain
reduction appears in cyan. The CBS Loudness Controller produces both fast and slow
loudness control; the fast control rides on top of the slow control. You can easily see
this dual-speed operation on the LOUDNESS GR meter. The LOUDNESS ATTACK control
determines how much fast control the Loudness Controller produces. As the control
is turned down toward 0%, it allows longer and longer loudness peaks to pass
through.

Because of the system topology, the LouDNESS LEVEL (CBS) meter assumes
that the LOUDNESs ATTACK control is always set to 100% and does not indi-
cate the effect of lower settings. As long as the control is set to 50% or
higher, this limitation should not have any significant effect on the loud-
ness level meter’s accuracy, and regardless of setting does not affect the
BS.1770 loudness meter’s accuracy. However, it is wise to double-check
the effect of the LOUDNESS ATTACK control on subjective loudness by listen-
ing tests and/or use of an external loudness level meter like the free
Orban Loudness Meter for Windows, which uses the same algorithm as
the built-in LOUDNESS LEVEL meter (www.orban.com/meter).

Moreover, because of their placement in the signal path the CBS loudness
controller and meter are unaware of the amount of gain reduction that
occurs in the peak limiter. In normal sound-for-picture applications (with
target loudness around -23 LUFS), the limiter operates very lightly (if at
all) and does not affect the loudness, so loudness control and metering
are very accurate. If the target loudness is high (for example, -8 LUFS,
which is a typical Target Loudness value in the radio-style presets), the
peak limiter may be active enough to reduce loudness by 1 or 2 LU, and
this will cause the LoupNEss LEVEL meter to over-indicate the loudness by
this much. (Again, you can use the free Orban Loudness Meter to check
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the actual loudness at OPTIMOD-PCn's output, and this issue does not af-
fect the built-in BS.1770 meter.) Note that all target loudness values rec-
ommended in EBU R-128 are low enough to cause the loudness meter
and controller to be very accurate.

The Loudness Controller may reduce the dramatic effect of certain sounds in enter-
tainment programming, like gunshots, explosions, or screeching tires. Operators may
therefore want to turn the Loudness Controller on during commercial breaks and
off during normal programming. All sound-for-picture presets have the Loudness
Controller on. The easiest way to handle this situation is to start with your preferred
preset, turn the Loudness Controller off, and then save the result as a User Preset.
Using one of the 1600's remote control mechanisms, recall the “with loudness con-
troller” and “without loudness controller” presets as desired.

Turning down the LOUDNESS ATTACK control provides another way to maintain the
dramatic impact of loudness transients in dramatic programming; it can let gunshots
and the like through while still constraining long-term loudness to a fixed threshold.
While this is an easy solution that does not require your automation system to tell
the 1600 when to recall presets, it is not ideal because there are some short-term
loudness events, like sibilance, applause, and whistles, that can be annoying to audi-
ences. You can use the Speech-Mode B4 and B5 compressor threshold controls to
accomplish the same goal.

Another loudness control strategy is this: Instead of using two presets with and
without loudness control (as described above), you can create presets with different
settings of the LOUDNESS ATTACK control (and possibly different settings of the
LOUDNESS THRESHOLD control as well). Try a slow attack (50% or below) for dramatic
programming and a faster attack (70%) for commercial breaks. This will maintain
some automatic loudness control for dramatic programming while controlling the
loudness of commercial breaks more rigorously.

Note that the Loudness Controller operates with reference to an absolute subjective
loudness threshold that does not adapt to program context. This means that if there
is a transition between very quiet program material (like footfalls through rustling
leaves) and a commercial, the commercial may still seem offensively loud even
though the Loudness Controller is controlling its loudness correctly with reference to
other sounds that reach full-scale loudness. Philosophically, this is inevitable; the
Loudness Controller cannot reduce the level of the commercial to the level of rus-
tling leaves without destroying the effectiveness of the commercial and angering
the sponsor!

BS.1770 Safety Limiter

Following the CBS Loudness Controller is a BS.1770 Safety Limiter that will prevent a
BS.1770-2 (or higher) loudness meter with 10-second integration time from indicat-
ing higher than the setting of the BS.1770 THRESHOLD control, which is found in the
MULTIBAND page. The BS.1770 THRESHOLD control is part of the on-air processing pre-
set, so if you change the setting of this control from its default value (which we rec-
ommend doing), you should save your work as a User Preset.

Because some organizations will disqualify an automatic loudness controller if it
causes a BS.1770 meter to read higher than a specified threshold, all of the “TV" fac-



OPTIMOD-PCn OPERATION 3-27

tory presets have this controller active with the BS.1770 THRESHOLD control set to 0
LU. If your organization does not have a strict policy about processing for the
BS.1770 meter, we recommend that you edit your preferred preset by setting this
control anywhere from +2 to OFF and then saving the result as a User Preset.

The BS.1770 safety limiter receives the output of the CBS Loudness Con-
troller and drives the final peak limiters. The total amount of loudness
control-induced gain reduction is the sum of the gain reduction produced
by the CBS Loudness Controller and the gain reduction produced by the
BS.1770 safety limiter. The gain reduction produced by the BS.1770 safety
limiter changes slowly, seldom exceeds 2 dB, and is indicated by the cyan
section of the LOUDNESS GR meter. The gain reduction produced by the
CBS Loudness Controller may change slowly or quickly (depending on the
nature of the program material), appears in blue, and rides on top of the
BS.1770 gain reduction. The peak reading of the meter thus shows the
total gain reduction that both controllers produce.

We included this safety limiter for customers whose policies require the
BS.1770 loudness meter reading to be constrained below specified
threshold regardless of how loud human listeners perceive the program
to be. Our experience suggests that the BS.1770-2 meter will often over-
read material with unusually low peak-to-average ratios, like highly pro-
duced commercials and promos. Strict reliance on the BS.1770 meter can
therefore make such material sound unnaturally quiet compared to sur-
rounding material, so we prefer the sound when the CBS Loudness Con-
troller is used exclusively for loudness control.

For a more detailed discussion of these issues, refer to Appendix A: Using
the ITU BS.1770 and CBS Loudness Meters to Measure Loudness Control-
ler Performance, starting on page 3-93.

Downmix Processing

OPTIMOD-PCn includes a dedicated downmix processor that applies correct loudness
control and peak limiting to the stereo downmix and makes the downmix available
as a separate output. Two outputs are available and each can have a separate target
loudness applied to it.

In surround mode, the downmix chains include loudness control that both outputs
share. Each output has a dedicated high frequency limiter and a look-ahead (non-
MX) peak limiter.

The difference in Optimix’s placement between stereo and surround modes allows
the downmix processing to be simplified in stereo mode. Because Optimix’s output
mixes down to the original stereo, the loudness control originally applied to the
main stereo signal, pre-Optimix, also works for the downmix, so the downmix pro-
cessor only needs to do high frequency limiting and peak limiting.

The high frequency limiters only operate when the downmix operates preempha-
sized, as set in I/O > DOwWNMIX OUTPUT. When the downmix processor is operated
preemphasized, it can correctly control the modulation of an analog television or
FM transmitter. Although it cannot achieve “competitive loudness” in FM broadcast,
the downmix processor can provide excellent performance in analog television ap-
plications, and in digital television applications where the target loudness is below —
20 LUFS.
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Tutorial: More about Dynamics Processing
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Figure 3-12: Compressor Attack and Release
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OPTIMOD-PCn’s AGC, multiband compressor, and peak limiter are all forms of dy-
namics processing. Their main differences are the speed of the attack and release
times and their compression ratios. In OPTIMOD-PCn’s AGC and multiband compres-
sor, these parameters are all user-adjustable. To prevent peak overshoots, the peak
limiter must have an instantaneous attack time and the infinite compression ratio.

Figure 3-12, Figure 3-13 and Figure 3-14 show the audio level as a function of time
and are conceptual and simplified. In fact, the attack and release time characteristics
of OPTIMOD-PCn’s AGC and multiband compressors automatically adapt themselves
to the program material they are processing.

Figure 3-11 shows the slow attack and release characteristics typical of AGC. This di-
agram shows an infinite compression ratio; lower ratios are available in OPTIMOD-
PCn’s AGC. The AGC performs slow gain riding; it does not increase program density.

Figure 3-12 shows the attack and release times found in OPTIMOD-PCn’s multiband
compressors, which are substantially faster than the AGC. The multiband compressor
is designed to be able to increase program density if the user wants, but also has
slow attack and release times available if the user wants to retain the density of the
original program material.

Figure 3-13 shows a typical peak limiter attack and release characteristic. The attack
is instantaneous to prevent overshoots. Figure 3-13 is not drawn to the same time
scale as Figure 3-11 and Figure 3-12; the release time of OPTIMOD-PCn's peak limiter
is hundreds of times faster than that of the AGC or multiband compressor.

Figure 3-14 shows one of the many things that can go wrong in a badly designed
compressor. The attack causes more gain reduction than necessary to reduce the
output level to the threshold of compression, and the gain must then recover to
bring the output level to the compression threshold. This attack overshoot and sub-
sequent release causes audible “gulping” or “gain pumping,” which gives the im-
pression that the program level is constantly changing in an audibly obtrusive way.
The gain pumping exacerbated by a release time that is too slow, so that the audio
level starts out too quiet at the beginning of the release period and then slowly and
obviously recovers to its final value. While this kind of sound is sometimes used for
artistic purposes in production and mastering, in a processor like OPTIMOD-PCn
(which is designed to handle all types of program material gracefully without intro-
ducing objectionable side-effects), it imposes an unstable sonic signature on all pro-
gram material and is considered one of the marks of incompetently-designed pro-
cessing.

Customizing OPTIMOD-PCn’s Sound

See Figure 3-2: OPTIMOD-PCn Digital Signal Processing Simplified Block Diagram on
page 3-13.

The subjective setup controls on OPTIMOD-PCn give you the flexibility to customize
your station’s sound. Nevertheless, as with any audio processing system, proper ad-
justment of these controls consists of balancing the trade-offs between loudness,
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density, and audible distortion. The following pages provide the information you
need to adjust OPTIMOD-PCn controls to suit your format, taste, and competitive
situation.

When you start with one of our Factory presets, there are two levels of subjective
adjustment available to you to let you customize the Factory preset to your re-
quirements: Basic Control and Advanced Control.

Basic Control

The single LESS-MORE control changes many different subjective setup control set-
tings simultaneously according to a table that we have created in OPTIMOD-PCn’s
factory presets, which are files with the Windows read-only attribute. In this table
are sets of subjective setup control settings that provide, in our opinion, the most
favorable trade-off between loudness, density, and audible distortion for a given
amount of processing. We believe that most OPTIMOD-PCn users will never need to
go beyond the LESS-MORE level of control, because the combinations of subjective
setup control settings produced by this control have been optimized by our audio
processing experts on the basis of years of experience designing audio processing,
and upon hundred of hours of listening tests.

Unlike previous Optimods, the LESS-MORE control has been designed keep loudness
constant when adjusted. Instead, turning it up typically changes texture by increas-
ing the multiband compressor drive (and this the amount of multiband compressor
gain reduction), while decreasing the peak limiter drive appropriately.

To change a preset’s loudness, change the value of TARGET LOUDNESS, which you can
do by editing the local value of TARGET LOUDNESS in the processing preset (LESS-
MORE tab) or setting that value to GLOBAL and then changing the global TARGET
LOUDNESS value (in I1/0 MIXER > GLOBAL). Changing the value of TARGET LOUDNESS will
change the drive level into the peak limiter (and hence, will change its gain reduc-
tion). This does not change the indication of the loudness meter because it indicates
loudness relative to the active TARGET LOUDNESS value.

In the “video” presets, the LESS-MORE control also sets the average amount of dy-
namic range control provided by the processing. As you go from less to more, the
loudness of loud sounds will stay about the same but the loudness of quieter sounds
will increase. Because of OPTIMOD-PCn'’s sophisticated gating circuits, very quiet ma-
terial like background sounds, quiet underscoring, hiss, and hum will not be pumped

up.

You need not (in fact, cannot) create a sound entirely from scratch. All User Presets
are created by modifying Factory Presets or by further modifying Factory Presets
that have been modified previously. It is wise to set the LESS-MORE control to
achieve a sound as close as possible to your desired sound before you make further
modifications at the Advanced Modify level. This is because the LESS-MORE control
gets you close to an optimum trade-off between loudness and artifacts, so any
changes you make are likely to be smaller and to require resetting fewer controls.
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In OPTIMOD-PCn, LESS-MORE affects only the dynamics processing (compression and
peak limiting)—OPTIMOD-PCn’s equalization and stereo enhancement are decou-
pled from LESS-MORE. You can therefore change EQ or stereo enhancement and not
lose the ability to use LESS-MORE. When you create a user preset, OPTIMOD-PCn will
automatically save your EQ and stereo enhancement settings along with your LESS-
MORE setting. When you recall the user preset, you will still be able to edit your
LESS-MORE setting if you wish.

If you want to create a signature sound for your broadcast or netcast that is far out
of the ordinary, if your taste differs from the people who programmed the LESS-
MORE tables, or if you are using OPTIMOD-PCn in mastering or production applica-
tions, you will find the advanced processing controls useful. You can customize or
modify any subjective setup control setting to create a sound exactly to your taste.
You can then save the settings in a User Preset and recall it later. This sort of custom-
ization is usually unnecessary for sound-for-picture but can be very useful for radio,
production, and mastering applications.

Compressor attack time, release time, and threshold controls are available. These
controls can be dangerous in inexperienced hands, leading you to create presets
that sound great on some program material but overdrive the peak limiter on other
material, causing objectionable pumping or distortion. We therefore recommend
that you create custom presets at the Advanced Modify level only if you are experi-
enced with audio processing sound design and if you are willing to take the time to
double-check your work on many different types of program material.

In production and mastering applications, you will usually be working with one
piece of program material at a time. Here, you can use all of Advanced Modify’'s
power to get the sound you want without being concerned about how your settings
will sound with other material.

The PC Remote software organizes its controls in tabbed screens. The EQUALIZATION,
STEREO ENHANCER, and LESS-MORE labs access the Basic Modify controls. The remain-
ing tabs show the Advanced Modify controls, logically organized by functionality.

Important Note: Once you have edited a preset’'s dynamics parameters in
Advanced Modify, LEsS-MORE control is no longer available in Basic Mod-
ify. As noted above, we strongly recommend using the LESS-MORE control
to achieve a sound as close as possible to your desired sound before you
make further modifications at the Advanced Modify level.

Gain Reduction Metering

Because it uses floating point processing, OPTIMOD-PCn has essentially unlimited
amounts of available gain reduction, unlike Orban’s DSP-based processors. However,
the meter should never exceed 25 dB gain reduction if OPTIMOD-PCn has been set
up for a sane amount of gain reduction under ordinary program conditions. If any
AGC or compressor gain reduction meter reads full-scale, this is usually a sign that
you are using too much gain reduction, which can cause unpleasant compression
artifacts.
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The peak limiter gain reduction meters have 12 dB of range. If you are using the MX
limiter and the input program material is not excessively peak-limited, it is common
for these meters to go to full-scale briefly without audibly objectionable conse-
guences. However, you must assess this by ear for the program material you are pro-
cessing.

Fundamental Requirements:
High-Quality Source Material and Accurate Monitoring

A major potential cause of distortion is excess peak limiting. Another cause is poor-
quality source material, including the effects of your playback machines, electronics,
and studio-to-transmitter link (if any). If the source material is distorted even slight-
ly, that distortion can be exaggerated by OPTIMOD-PCn—particularly if a large
amount of gain reduction is used. Very clean audio can be processed harder without
producing objectionable distortion.

A high-quality monitor system is essential. To modify your sound effectively, you
must be able to hear the results of your adjustments. In too many facilities, the best
monitor is significantly inferior to the sound systems found in many listeners’
homes!

Factory Programming Presets

Factory Programming Presets are our “factory recommended settings” for various
program formats or types. The Factory Programming Presets are starting points to
help you get on the air quickly without having to understand anything about adjust-
ing OPTIMOD-PCn’s sound.

You can easily edit any of these presets with the LESS-MORE control to optimize the
trade-off between loudness and distortion according to the needs of your format,
although this is often unnecessary. It is OK to use unmodified factory presets on the
air. These represent the best efforts of some very experienced transmission pro-
cessing sound designers. We are sometimes asked about unpublished “programming
secrets” for Optimods. In fact, there are no “secrets” that we withhold from users.
This manual reveals our “secrets” and the presets embody all of our craft as pro-
cessing experts. The presets are editable because other sound designers may have
different preferences from ours, not because the presets are somehow mediocre or
improvable by those with special, arcane knowledge that we withhold from most of
our customers.

Start with one of these presets. Spend some time listening critically to your sound.
Listen to a wide range of program material typical of your format and listen on sev-
eral types of audio systems (not just on your studio monitors). Then, if you wish, cus-
tomize your sound using the information in the Protection Limiter, Two-Band and
Five-Band sections that follow.
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Each factory preset has full LESs-MORE capability. The table shows the presets, in-
cluding the source presets from which they were taken and the nominal LESS-MORE
setting of each preset. Some of the Five-Band presets appear several times under
different names because we felt that these presets were appropriate for more than
one format; these can be identified by a shared source preset name.

Important! If you are dissatisfied with the sound available from the facto-
ry presets, please understand that each named preset is actually 19 pre-
sets that can be accessed via the LESS-MORE control. Try using this control
to trade off the amount of dynamic range reduction against processing
artifacts and side effects. Once you have used LESS-MORE, save your edit-
ed preset as a User Preset.

Do not be afraid to choose a preset other than the one named for your program-
ming if you believe this other preset has a more appropriate sound. Also, if you
want to fine-tune the frequency balance of the programming, feel free to use Basic
Modify and make small changes to the Bass, Mid EQ, and HF EQ controls. OPTIMOD-
PCn lets you make changes in EQ (and stereo enhancement) without losing the abil-
ity to use Less-More settings.

Of course, Less-More is still available for the unedited preset if you want
to go back to it. Other than by purposeful abuse within Windows (the
preset files have the read-only attribute and this should not be changed),
there is no way you can erase or otherwise damage the Factory Presets.
So, feel free to experiment.

Protection, AGC and Mastering Presets

PROTECTION, AGC AND MASTERING PRESETS

Preset Names Source Preset Less-More Loudness
AGC+ LIMIT FLAT AGC+ LIMIT FLAT 5.0 -15 LUFS
AGC+ LIMIT PRE-E AGC+ LIMIT 50us 5.0 -15 LUFS
ROCK MASTERING MXH [ ROCK MASTERING MXH 5.0 -6 LUFS
ROCK MASTERING MX ROCK MASTERING MX 5.0 -6 LUFS
PEAK LIMIT MX PEAK LIMIT MX 1.0 -16 LUFS
SOFT KNEE SOFT KNEE 5.0 -12 LUFS
SOFT KNEE MX SOFT KNEE MX 5.0 -12 LUFS

Table 3-1: Protection, AGC and Mastering Presets

AGC+LIMIT [FLAT, PRE-E]: These presets allow OPTIMOD-PCn to serve as a studio
AGC, substituting for the AGC in an Optimod at a radio or television transmitter and
providing protection limiting for the STL that links the output of OPTIMOD-PCn to
the input of the Optimod at the transmitter. See Studio AGC on page 3-9.

If PROC PRE-EMPHASIS (in I1/0O > STEREO OUTPUT) is FLAT, use the AGC+LIMIT FLAT preset;
otherwise, use AGC+LIMIT PRE-E. See step (4.C) on page 2-18. These presets are iden-
tical, except that AGC+LIMmIT PRE uses the MX limiter and AGC+LIMIT FLAT does not.
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(The MX limiter is much less vulnerable to audible gain pumping caused by large
amounts of preemphasized high frequency energy.)

It is common to adjust the AGC attack times, release times, etc. to your preference
and then save the result as a user preset.

PEAK LIMITER MX: The PEAK LIMITER MX preset turns off all processing other than the
peak limiter to implement a fast true-peak protection limiter with very high perfor-
mance.

In the LIMITER tab, you may choose either SOFT or HARD MX overshoot limiter modes.
HARD can be useful if you need to produce maximum loudness. The highest usable
loudness available in HARD mode is approximately —4 LUFS, but we recommend using
-6 LUFS or lower to achieve best quality. Attempting to go above -6 LUFS quickly
sacrifices bass punch.

The subjective differences between SOFT and HARD are subtle. SOFT sounds cleaner
on most material, but can produce some audible gain pumping when driven very
hard. HARD is closer to a “clipper sound,” so it is not quite as clean sounding but
does not produce gain pumping. It may exhibit less IM distortion on material with
very heavy bass, particularly with dominant frequencies below 50 Hz.

The loudness meters continue to work, and continue to be calibrated such that 0 is
equal to the setting of the TARGET LOUDNESS control. However, they are located be-
fore the peak limiters, so if you are driving the peak limiters hard so that their limit-
ing action alone changes loudness, you should monitor the output of OPTIMOD-PCn
with an external loudness meter like the free Orban loudness meter, which can be
bridged across the OPTIMOD-PCn output. (Get the meter at www.orban.com/meter.)

Warning: If you use HARD mode with the OPTIMIX DEFEAT SWITCH (in I/O > UTILITIES) set
to ACTIVE, you may overload your computer’'s CPU and cause audio stuttering. The
stuttering will normally stop if you change the control setting that caused it. Worst-
case, clearing this may require stopping and restarting the Service, which you can do
by disconnecting 1600PC from any Processor and then entering the TooLs > SERVICE
SETTINGS dialog box and clicking RESTART. Only the fastest computers can run HARD
mode combined with Optimix, but many computers can use HARD MODE with Optimix
defeated. You can also get more CPU headroom by setting the CBS LOUDNESS
CONTROLLER switch (in I/O > UTILITIES) to OuT.

SOFT KNEE: These presets (in MX and non-MX versions) are “zeroed-out” starting
points for mastering applications, particularly where soft knee compression is de-
sired. These presets must be manually tweaked to complement the program materi-
al being processed. See Production and Mastering starting on page 3-86.

These presets are phase-linear. They set all equalization flat and turn off the AGC.
The multiband compressor (two-band or five-band) is set to supply a very soft-knee
compression characteristic with approximately 5-10 dB of gain reduction. The ratio
for a given compressor starts out at 1:1 and ends up at «:1 when the input level is 20
dB above threshold.
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Mastering engineers will certainly want to adjust the compression thresholds and
band coupling to complement the program material. The ratio and knee controls
are adjustable separately for each band’s compressor. For example, one might want
to use a low ratio and soft knee in bands 1-4 while using a higher ratio and/or hard-
er knee in band 5 (for de-essing).

The 1600's powerful equalization section is, of course, also available. Additionally,
these presets set the look-ahead limiter drive control conservatively, which ensures
highest quality. However, the 1600’s look-ahead limiter can be driven quite hard
without objectionable side effects, so the 1600 can create competitively loud mas-
ters. For “loudness war” masters, start with the MX version.

ROCK MASTERING [MX, MXH]: These presets demonstrate how OPTIMOD-PCn can be
used as a mastering processor to make clean, bright, detailed, punchy, and very loud
masters. They are based on the SoFT KNEE MX preset, but with substantial customiza-
tion. They work best when fed mixes that have not previously had dynamics pro-
cessing (such as wideband compression) applied to the entire mix.

These presets are a useful starting point, but we expect that any mastering engineer
would tweak them for each piece of program material being mastered. For an in-
depth discussion, see Production and Mastering starting on page 3-86.

Rock Mastering MXH uses HARD MX LIMIT OVERSHOOT MODE. Note the Warning on
page 2-35; this preset can overload the CPU of many computers.

Radio-Style Presets

Preset Names Source Preset Less-More Loudness
Adult Contemp MX MED GREGG HD MX Med XLF 9.0 -7 LUFS
Adult Contemp MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
Alternative MX GREGG HD MX Med XLF 9.0 -7 LUFS
Ambient MX LIGHT GREGG HD MX Light 7.0 -11 LUFS
Ambient MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
Chill MX LIGHT GREGG HD MX Light 7.0 -11 LUFS
Chill MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
CHR MX HEAVY GREGG HD MX Xcess XLF 9.0 -6 LUFS
CHR MX MED GREGG HD MX Med XLF 9.0 -7 LUFS
CLASSICAL-5 BAND MX CLASSICAL-5 BAND MX 7.0 -14 LUFS
CLASSICAL-5 BAND CLASSICAL-5 BAND 7.0 -14 LUFS
CLASSICAL-5 BAND Parallel CLASSICAL-5 BAND Parallel 5.0 -14 LUFS
CLASSICAL-5B+AGC MX CLASSICAL-5B+AGC MX 5.0 -14 LUFS
CLASSICAL-5B+AGC CLASSICAL-5B+AGC 5.0 -14 LUFS
CLASSICAL-5B+AGC Parallel CLASSICAL-5B+AGC Parallel 5.0 -14 LUFS
Classic Hits MX GREGG HD MX Heavy XLF 10.0 -7 LUFS
Classic Rock MX GREGG HD MX Med XLF 9.0 -7 LUFS
Country MX GREGG HD MX Med XLF 9.0 -7 LUFS
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RADIO-STYLE PRESETS

Preset Names Source Preset Less-More | Loudness
Dance MX GREGG HD MX XXLF 9.0 -8 LUFS
Easy Listen MX LIGHT GREGG HD MX Light 7.0 -11 LUFS
Easy Listen MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
GOLD MX GOLD MX 9.5 -8 LUFS
GOLD GOLD 5.0 -10 LUFS
Gold MX HEAVY GREGG HD MX Heavy XLF 10.0 -7 LUFS
GREGG HD MX Med Dry GREGG HD MX Med Dry 9.0 -9 LUFS
GREGG HD MX Med Dry XLF GREGG HD MX Med Dry XLF 9.0 -9 LUFS
GREGG HD MX Heavy GREGG HD MX Heavy 7.0 -7 LUFS
GREGG HD MX Heavy XLF GREGG HD MXH Heavy XLF 10.0 -5 LUFS
GREGG HD MXH Heavy XLF GREGG HD MX Heavy XLF 10.0 -7 LUFS
GREGG HD MX Light GREGG HD MX Light 7.0 -11 LUFS
GREGG HD MX Light XLF GREGG HD MX Light XLF 7.0 -11 LUFS
GREGG HD MX Med GREGG HD MX Med 9.0 -7 LUFS
GREGG HD MX Med XLF GREGG HD MX Med XLF 9.0 -7 LUFS
GREGG HD MX Open GREGG HD MX Open 9.0 -10 LUFS
GREGG HD MX Open XLF GREGG HD MX Open XLF 9.0 -10 LUFS
GREGG HD MX Xcess GREGG HD MX Xcess 9.0 -6 LUFS
GREGG HD MX Xcess XLF GREGG HD MX Xcess XLF 9.0 -6 LUFS
GREGG HD MXH Xcess XXLF GREGG HD MXH Xcess XXLF 10.0 -7 LUFS
GREGG HD MX XXLF GREGG HD MX XXLF 9.0 -8 LUFS
GREGG HD MX XXXLF GREGG HD MX XXXLF 10.0 -8 LUFS
GREGG HD Med Dry XLF GREGG HD Med Dry XLF 9.0 -11 LUFS
GREGG HD Med Dry GREGG HD Med Dry 9.0 -11 LUFS
GREGG HD Heavy GREGG HD Heavy 7.0 -9 LUFS
GREGG HD Heavy XLF GREGG HD Heavy XLF 10.0 -9 LUFS
GREGG HD Light GREGG HD Light 7.0 -11 LUFS
GREGG HD Light XLF GREGG HD Light XLF 7.0 -11 LUFS
GREGG HD Med GREGG HD Med 9.5 -9 LUFS
GREGG HD Med XLF GREGG HD Med XLF 9.0 -9 LUFS
GREGG HD Open GREGG HD Open 9.0 -10 LUFS
GREGG HD Open XLF GREGG HD Open XLF 9.0 -10 LUFS
GREGG HD Xcess GREGG HD Xcess 9.0 -8 LUFS
GREGG HD Xcess XLF GREGG HD Xces XLF s 9.0 -8 LUFS
GREGG HD XXLF GREGG HD XXLF 9.0 -10 LUFS
Hip-Hop MX GREGG HD MX XXLF 9.0 -8 LUFS
Indie MX GREGG HD MX Med XLF 9.0 -7 LUFS
Jazz MX POP MX OPEN FLAT 9.0 -10 LUFS
Lounge MX LIGHT GREGG HD MX Light 9.0 -10 LUFS
Lounge MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
Modern Rock MX GREGG HD MX Med XLF 9.0 -7 LUFS
NEWS-TALK MX NEWS-TALK MX 7.0 -10 LUFS
NEWS-TALK NEWS-TALK 7.0 -10 LUFS
Oldies MX GREGG HD MX Heavy XLF 10.0 -7 LUFS
POP MX XLF POP MX XLF 9.0 -8 LUFS
POP MX FLAT EQ POP MX FLAT EQ 9.0 -8 LUFS
POP MX LIGHT FLAT POP MX LIGHT FLAT 7.0 -11 LUFS
POP MX OPEN FLAT POP MX OPEN FLAT 9.0 -10 LUFS
POP XLF POP XLF 9.0 -10 LUFS
POP FLAT EQ POP FLAT EQ 9.0 -10 LUFS
POP LIGHT FLAT POP LIGHT FLAT 7.0 -11 LUFS
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RADIO-STYLE PRESETS

Preset Names Source Preset Less-More | Loudness
POP OPEN FLAT POP OPEN FLAT 9.0 -10 LUFS
R and B MX GREGG HD MX XXLF 9.0 -8 LUFS
Rap MX GREGG HD MX XXLF 9.0 -8 LUFS
Reggae MX GREGG HD MX XXLF 9.0 -8 LUFS
Rock MX GREGG HD MX Med XLF 9.0 -7 LUFS
Smooth Jazz MX LIGHT GREGG HD MX Light 7.0 -11 LUFS
Smooth Jazz MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
Soul MX GREGG HD MX Heavy XLF 10.0 -7 LUFS
Soul MX XXLF GREGG HD MX XXLF 9.0 -8 LUFS
SPORTS MX SPORTS MX 7.0 -10 LUFS
SPORTS SPORTS 7.0 - 10 LUFS
Standards MX LIGHT POP MX LIGHT FLAT 7.0 -11 LUFS
Standards MX OPEN GREGG HD MX Open XLF 9.0 -10 LUFS
Urban GREGG HD MX XXLF 9.0 -8 LUFS

Table 3-2: Radio-Style Presets

e If a preset’s name contains “XLF,” the subharmonic synthesizer is active.

e If a preset’'s name contains “MX,” the MX peak limiter is active in SOFT over-
shoot limiting mode. If a preset’'s name contains “MXH,"” the MX peak limiter is
active in HARD overshoot limiting mode.

e Most presets with names that are specific to a programming format (like “Mod-
ern Rock”) duplicate other presets, called the “Source Presets” in Table 3-2. The
format-specific duplicates were created solely for your convenience and are only
suggestions. You may prefer the sound of a preset whose name is not the same
as your format; this is perfectly OK.

All of the presets with format-specific names use the MX limiter. To create a
non-MX format-specific preset, use the non-MX version of the format-specific
preset’s “Source Preset.”

CLASSICAL: As their names imply, the CLASSICAL 5-BAND and CLASSICAL 5-BAND+AGC
presets (in MX and non-MX versions) are optimized for classical music, gracefully
handling recordings with very wide dynamic range and sudden shifts in dynamics.
They use heavy inter-band coupling to prevent large amounts of automatic re-
equalization, which could otherwise cause unnatural stridency and brightness in
strings and horns and which could pump up very low frequency rumble in live re-
cording venues.

The Five-Band preset defeats the AGC, using only the five-band compressor for gain
reduction. It also defeats phase rotation and uses the phase-linear five-band crosso-
ver to ensure the most transparent Five-Band sound available.

CLASSICAL-5B+AGC uses the AGC set for 2:1 compression ratio. Because of the
AGC, it affects more of the total dynamic range of the recording than does the
CLASSICAL-5 BAND preset. However, the AGC provides extremely smooth and un-
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obtrusive compression because of the gentle ratio and window gating. This preset
uses the Five-Band compressor very lightly with a fast release time as a peak limiter.
The AGC does almost all of the compression.

CLASSICAL-5B defeats the AGC and exploits OPTIMOD-PCn'’s soft-knee five-band
compression with an initial compression ratio of 1:1. Quiet material is gently com-
pressed with a very low compression ratio. The compression ratio increases as the
source material gets louder (see Figure 3-16 on page 3-71). Very quiet material is
typically amplified by 10 dB. This level-dependent compression ratio provides very
smooth, subtle compression.

CLASSICAL-5B+AGC PARALLEL and CLASSICAL-5 BAND PARALLEL use the com-
pressor's parallel mode to bring up low-level passages while preserving more and
more of the music’s dynamics as it gets louder (see Parallel Compression on page 3-
21). These presets can be very subtle and musical while still allowing the quiet parts
of the music to be heard clearly in noisy environments.

For these presets, LESS-MORE sets the amount of amplification of quiet parts of the
program. While neither Parallel preset uses the MX limiter (because the low target
loudness typically used in classical operations usually causes little or no peak limit-
ing), you can activate the MX limiter without losing LESS-MORE functionality.

Because these presets pass the dynamics of loud parts of the music through essen-
tially unmodified, you must use care not to overdrive the peak limiter. These presets
are safest to use with low target loudness (-16 LUFS and below), where overdriving
the peak limiters is less likely. Because of this level sensitivity, we expect that most
users will want to customize the Parallel presets by adjusting the COMPRESSION
THRESH OFFSET control and possibly the TARGET LOUDNESS and/or MB FINAL
LIMIT DRIVE controls.

CLASSICAL-5B+AGC PARALLEL has the AGC turned on to prevent the peak limiters
from being grossly overdriven if the input is unusually loud. However, because of
the AGC's slow attack time and 2:1 compression ratio, loud transients can set
through

CLASSICAL-5 BAND PARALLEL has the AGC turned off, so operators must do ap-
propriate gain riding to prevent annoying loudness inconsistencies between differ-
ent recordings. In facilities where the program is played out via an automation sys-
tem, it may be sufficient to statically normalize the gain of individual elements so
that the BS.1770 Integrated Loudness of the entire element meets a target value,
typically —16 to —20 LUFS. With classical music formats, the target loudness of speech
material should be 3 to 6 LU below the target loudness of music.

Because the CLASSICAL presets preserve a significant amount of the dynamic range
present in the source material (including speech), it is wise to use a separate micro-
phone processor to ensure appropriate voice/music balance.

GOLD [MX]: GoLD and GoLb MX are loud and "hi-fi”-sounding while still respecting
the limitations and basic flavor of the recordings from the era of the 1950s through
1970s. It is the only OPTIMOD-PCn preset that uses a considerable amount of fixed
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equalization to achieve a bright, punchy, “present” sound without over-
exaggerating high frequencies. The highs in recordings of this era are often noisy,
distorted, or have other technical problems that make them unpleasant sounding
when the processor over-equalizes them in an attempt to emulate the high frequen-
cy balance of recently recorded material.

Because they provide an example of using fixed parametric equalization, these pre-
sets can be useful as a guide for further customization. (Most of the OPTIMOD-PCn
radio-style presets do not use fixed equalization other than shelving bass boost.)

The GREGG family of presets was designed by Greg Ogonowski. Most use a 200 Hz
band1/band2 crossover frequency to achieve a bass sound similar to the classic five-
band Gregg Labs FM processors. Dynamically, most of these presets produce a con-
siderable increase in bass energy below 100 Hz and a decrease of bass energy cen-
tered at 160 Hz. This bass sound works particularly well with speakers having good
bass response.

The GREGG HD MX xxx presets fully exploit OPTIMOD-PCn’s MX peak limiter tech-
nology to be loud without the usual peak limiter artifacts. There are also several
non-MX presets, which can be used when the target loudness is lower and it is im-
portant to maximize the number of instances of OPTIMOD-PCn that can run on a
given computer; these presets cut CPU usage approximately in half compared to the
MX presets.

Most of the GREGG presets are designed to achieve extremely punchy bass, even
with program material that lacks bass. GREGG presets use the subharmonic synthe-
sizer in conjunction with bass equalization to achieve this. The processing is tuned
dynamically (using the bass limiter and Band 1 of the multiband compressor) to pre-
vent bass from becoming excessive if the program material already has sufficient
bass.

As is always true with presets, the only way to judge them and decide if they are
appropriate for your goals is to audition them with program material typical of your
format.

GREGG HD and GREGG OPEN HD are good general-purpose presets for popular
music programming if you wish to save CPU cycles by not using the MX limiter. The
OPEN version uses a slower multiband release time and increases density less.

Sonically, GREGG HD and GREGG OPEN HD are not competitive with the GREGG
HD MX xxx presets unless the target loudness is =16 LUFS or lower (above that, the
MX presets will sound brighter, more detailed, and punchier). However, GREGG HD
and GREGG OPEN HD will not produce overtly objectionable artifacts (such as audi-
ble gain pumping) unless the target loudness is =8 LUFS or higher.

GREGG HD MX HEeAvy, MEDIUM, and LIGHT are good general-purpose presets for pop-
ular music programming if you want an excellent trade-off between loudness and
artifacts. As you go from LIGHT to HEAvY, OPTIMOD-PCn will produce more and more
density and source-to-source consistency. GREGG HD MX MEDIUM is the factory de-
fault preset in a new OPTIMOD-PCn installation.
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GREGG HD MX OPEN uses a SLow multiband release to achieve a combination of
open, relaxed sound and good source-to-source consistency.

GREGG HD MX XCESs is an “up-against-wall” preset that is nevertheless useful if
you want a very consistent, high-energy presentation—despite the implication of
"excess,” this is not a “joke preset.” (There no useless, “joke presets” in OPTIMOD-
PCn!)

GREGG HD MX XXLF goes for extreme bass punch and impact for formats like Urban
and Dance, and was originally created for European customers seeking an “over the
top” bass texture.

GREGG HD MXH Heavy XLF uses HARD MX clipping to achieve extremely high loud-
ness. With turned-down down the LIMITER ATTACK controls, It is purposely designed
to exhibit some compressor pumping, giving it a more “processed” sound than the
other GREGG presets.

GREGG HD MX XXXLF is similar to GREGG HD MX XXLF. This preset generates a lot
of synthetic bass energy and is targeted towards “Gold” and “Oldies” formats
where the original program material lacks bass impact.

GREGG HD MXH Xcess XXLF was derived from GREGG HD MX Xcess, but uses HARD
MX limiting and, like GREGG HD MX XXXLF, generates generous amounts of syn-
thetic bass and is optimized for “Gold” and “Oldies” formats.

NEWS-TALK: This preset (in both MX and non-MX versions) is quite different from
the others. It is based on the fast multiband release time setting so it can quickly
perform automatic equalization of substandard program material, including tele-
phone. It is useful for creating a uniform, intelligible sound from widely varying
source material, particularly source material that is “hot from the field” with uncon-
trolled quality.

The MX limiter has little value for speech programming, as the non-MX look-ahead
limiter is very clean on speech. NEWS-TALK MX exists mostly for the convenience of
users having mixed formats, streaming music for part of the day and news or talk at
other times. It allows you to use an MX preset for the music programming and
switch between the music and news-talk presets without audible glitches caused by
a sudden change in input/output delay when activating the MX limiter.

The MX limiter adds about 240 ms of delay when active.

POP MX: The POP MX family of presets offer a different bass texture compared to
the GREGG presets. In general, they do not push low bass as hard, and may there-
fore be preferred to the GREGG presets if most of the audience is listening on player
devices with small loudspeakers having no significant response below 100 Hz or so.

POP+SUBHARM MX is appropriate for programming that mixes recordings from dif-
ferent eras. It uses the subharmonic synthesizer to add low bass to material that
lacks it. As such, it is the POP preset most appropriate for player devices with good
low-frequency response.
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POP MX FLAT EQ, POP MX LIGHT FLAT, and POP MX OPEN FLAT use no bass boost
or subharmonic synthesis, although they still exploit the ability of the multiband
compressor to automatically re-equalize material that lacks bass. They use a combi-
nation of the multiband compressor and HF Enhancer to re-equalize dull-sounding
material automatically. The LIGHT version uses SLow multiband release time to min-
imize density build-up caused by the multiband compressor. OPEN is very similar to
LIGHT, except that OPEN uses the multiband compressor’s LINEAR-PHASE crossover
mode, whereas LIGHT uses ALLPASS

These presets may be preferred if the musical style of the program material calls for
modest amounts of bass. Examples include traditional country and smooth jazz.

SPORTS: Similar to NEWS-TALK except the AGC Release (AGC Release Time) is slower
and the Gate Thresh (Gate Threshold) is higher. This recognizes that most sports
programming has very low signal-to-noise ratio due to crowd noise and other on-
field sounds, so the preset does not pump this up as the NEWS-TALK preset would

tend to do.

Sound for Picture Presets

Note on A/V Sync for version 0.9 software: As of this writing, OPTIMOD-PCn v0.9's
input/output delay varies from about 450 to 1000 ms, depending on which features
are activated. Each time the OPTIMOD-PCn Service is stopped and restarted, the de-
lay may vary by as much as 25 ms due to use of the Windows MME sound model for
the input device, and this will make it difficult to achieve consistent A/V sync. In fu-
ture software releases, we expect to reduce the delay somewhat and to make it
more repeatable by making the Windows WASAPI model available at the input.

The sound-for-picture presets have GLOBAL TARGET LOUDNESS. They use non-MX lim-
iter mode because little or no peak limiting is required for typical target loudness
used in video applications, so it is pointless to waste CPU cycles on MX limiting.

Most of these presets have the CBS Loudness Controller turned on. It is set so that

OUND-FOR-P RE PR
Preset Names Source Preset Less-More Loudness
TV 5B DRAMA COUPLED TV 5B DRAMA COUPLED 5.0 GLOBAL
TV 5B DRAMA TV 5B DRAMA 5.0 GLOBAL
TV 5B GEN PUR W NR TV 5B GEN PUR W NR 5.0 GLOBAL
TV 5B GEN PURP NOLC TV 5B GEN PURP NOLC 5.0 GLOBAL
TV 5B GEN PURPOSE TV 5B GEN PURPOSE 5.0 GLOBAL
TV 5B NEWS TV 5B NEWS 5.0 GLOBAL
TV 5B OPTICAL FILM TV 5B OPTICAL FILM 5.0 GLOBAL
TV 5B SPORTS TV 5B SPORTS 5.0 GLOBAL
TV AGC+LC TV AGC+LC 5.0 GLOBAL
TV AGC+LC+DS TV AGC+LC+DS 5.0 GLOBAL

Table 3-3: Sound-For-Picture Presets
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loudness is constrained to a level consistent with the active TARGET LOUDNESS value
(see Loudness Control on page 3-24). The TARGET LOUDNESS value is the same as the
“target loudness” as measured by an ITU-R BS.1770-2 (or higher) Integrated loud-
ness meter (with a 10-second rolling windows of integration) in units of LkFS (ATSC
Rec. A/85) and LUFS (EBU Rec. R128). To comply with these standards, TARGET
LOUDNESS is customarily set to =24 in the United States and -23 in the EU.

To constrain the reading of a BS.1770 loudness meter (included with OPTIMOD-PCn)
to a fixed threshold, almost all “TV" presets have the BS.1770 THRESHOLD control set
to 0 LK. However, if your organization does not have a strict policy about processing
for the BS.1770 meter, we recommend that you edit your preferred preset by setting
this control anywhere from +2 to OFF and then saving the result as a User Preset. For
a more detailed discussion, see BS.1770 Safety Limiter on page 3-26.

If you wish to use a given preset with the CBS loudness controller turned off, set the
LOUDNESS THRESHOLD control (in the MULTIBAND tab) to OFF and save the result as a
User Preset.

TV 5B-GEN PUR W/NR (TV Five-Band General Purpose with Noise Reduction): provides
effective dynamic range control and “automatic re-equalization” of most dramatic
material. It uses the Loudness Controller to control loudness tightly. It applies single-
ended noise reduction to the material, which will reduce unwanted noise like hiss,
hum, or stage rumble. However, it will also reduce ambience. If the program materi-
al is carefully produced (as are most contemporary feature-film soundtracks), you
may wish to use TV 5B-GEN PURPOSE (which does not apply noise reduction), or, if
the material is so well produced that it would not benefit from “automatic re-
equalization,” use TV 2B-GEN PURPOSE.

TV 5B-GEN PURPOSE (TV Five-Band General Purpose without Noise Reduction): is
identical to TV 5B-GEN PUR W/NR except that the single-ended dynamic noise reduc-
tion system is off.

TV 5B GEN PURP -LC (TV Five-Band General Purpose without Loudness Controller):
This preset is the same as TV 5B-GEN PURPOSE except the Loudness Controller is
turned off and the MB DRIVE control is backed off by 3 dB to achieve approximately
the same loudness as TV 5B-GEN PURPOSE. Because the Loudness Controller is inac-
tive, this preset has more dynamic punch than TV 5B-GEN PURPOSE. The five-band
processing makes the audio spectrum more consistent than does TV 2B-GEN PUR
-LC, so TV 5B-GEN PURP -LC controls loudness better than TV 2B-GEN PURP -LC
even though the Loudness Controller is inactive.

TV 5B-DRAMA (TV Five-Band Drama): uses the 1600’'s soft knee compression and
AGC RATIO control to regulate loudness while still preserving some of the dynamic
range of the original mix. In addition, the five-band compressor automatically re-
equalizes material that may otherwise sound spectrally unbalanced. The center
channel compressor effectively de-esses dialog without punching holes in the re-
maining channels. Coupling between the center channel and remaining channels
allows the center channel’s level to be boosted automatically by as much as 3 dB
with respect to the other channels if this is needed to help intelligibility.
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We prefer this preset to TV 2B-DRAMA because of its effective, unobtrusive de-essing
and because it is more resistant to spectral gain intermodulation, which is program
material in one frequency range’s audibly pumping material in a different range.

Because it preserves some dynamic range, it is important that the input level to the
1600 not be too far awry. Usually, network feeds will meet this requirement but lo-
cal playout of older material that has not been checked for loudness by a long-term
Loudness Level meter like ITU-R BS.1770 may not work well. Use one of the general-
purpose presets for this kind of material.

This preset fully exploits the Loudness Controller, which usually shows slight gain
reduction with dialog at normal levels.

TV 5B-DRAMA COUPLD (TV Five-Band Drama Coupled): is similar to TV 5B DRAMA but
uses more interband band coupling in the five-band compressor and a slower multi-
band compressor release time so it performs less automatic re-equalization of the
program material. This is an alternative to the two-band compression available on
older Optimods.

TV 5B-NEWS (TV Five-Band News): rides gain more quickly than the general-purpose
presets. Its AGC release time is faster, so it will bring up low-level material more
quickly. It is designed for live news programs where input levels may be quite un-
predictable. It also automatically re-equalizes substandard audio (which is quite
common in live news broadcasts). The dynamic single-ended noise reduction is
turned on.

TV 5B-SPORTS (TV Five-Band Sports): is similar to TV 5B-NEwsS, except the AGC release
time is slower to resist pumping up crowd noise.

TV 5B OPTICAL FILM (TV Five-Band Optical Film): is designed to make the best of the
low-quality audio provided with optical film sound tracks (particularly 16mm). The
gate threshold is quite high to avoid pumping up hiss, thumps, and other optical
artifacts. The threshold of the single-ended dynamic noise reduction system is also
high so that this system can reduce artifacts as far as possible. Release times are
slow, because we assumed that material encoded on optical film has already been
carefully level-controlled to accommodate the very limited dynamic range of the
medium, so little gain riding is therefore required from the 1600.

Editing Presets

OPTIMOD-PCn is very flexible, enabling you to fine-tune your sound to your re-
quirements. Each preset can be edited with the LESS-MORE control. In all presets,
LESS-MORE attempts to keep the target loudness constant and equal to the active
TARGET LOUDNESS value, which is either local to the preset, or if the preset’'s TARGET
LOUDNESS control is set to GLOBAL, the TARGET LOUDNESS specified in I/O SETUP >
GLOBAL.

If you want to create your own User Presets, the following detailed discussion of the
processing structures is important to understand. If you only use Factory Presets or if
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you only modify them with LESS-MORE, you may still find the material interesting
but you do not need to understand it to get excellent sound from OPTIMOD-PCn.
We have carefully designed OPTIMOD-PCn'’s factory presets and most users will not
need to go beyond these.

The LESS-MORE control affects the video-oriented presets differently than it does the
music presets. When a video-oriented preset is on the air, the LESS-MORE control ad-
justs the average amount of gain reduction by adjusting the AGC DRIVE control. This
also adjusts the idle gain—the amount of gain reduction in the AGC section when
the structure is gated. (It gates whenever the input level to the structure is below
the user-adjustable threshold of gating.)

When a music preset is on the air, the LESS-MORE control sets the amount of overall
processing while attempting to keep the target loudness constant. Typically, it does
this by adjusting the MULTIBAND DRIVE and MB FINAL LIMIT DRIVE controls in a comple-
mentary way: If the MULTIBAND DRIVE IS turned up, the MB FINAL LIMIT DRIVE is turned
down. Hence, with music presets OPTIMOD-PCn’s loudness meters show how LESs-
MoORE affects loudness.

Because the music presets do not use OPTIMOD-PCn’s CBS Loudness Con-
troller or BS.1770 Safety Limiter, the loudness meters will show more var-
iation than they do for the video presets. However, we believe that sub-
jectively, they provide excellent consistency of both loudness and texture
between program elements.

The controls give you the flexibility to customize your sound. However, as with any
audio processing system, proper adjustment of these controls requires proper bal-
ancing of the trade-offs explained above. The following provides the information
you need to adjust controls to suit your applications and taste.

Optimix™ Upmixer Controls

Optimix Adjustments

Name Rang_]e

Mode Bypass; Auto-Detect; Upmix ON
Center Width 0to 1in 0.1 steps

Front/Rear Balance 0to1in 0.1 steps

Stage Shape Frontal, Wraparound

Center Delay Correction ON, OFF

Table 3-4: Optimix Upmixer Adjustments

These controls are only available if the Processor's output has been configured for
5.1 channels. See step 10.B)c) on page 2-9.

Optimix automatically upmixes stereo program material above 80 Hz to 5.0 surround
that is fully compatible with 5.1 systems. Because of the wide variability in subwoof-
er setups, Optimix instead routes energy below 80 Hz from the original stereo mix to
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the Lf and Rf outputs of the upmixer. If properly set up, a home theater receiver will
route this information to a subwoofer if one is in place and the Lf and RF loud-
speakers are “small.”

Delay Correction (ON, OFF) automatically corrects time skew or phase shift between
the left and right input channels. It prevents comb filtering in the derived center
channel. This maximizes mono compatibility and maintains the best possible crisp-
ness and intelligibility in the center channel, which usually contains dialog. Because
the left/right phase corrector is automatically bypassed when the Optimod MODE is
AUTO or UPMIX, you must use the Optimix delay corrector if you wish to phase-correct
an upmix.

Optimix has two controls that affect the shape of the upmixed surround soundstage.

Center Width (0 to 1 in 0.1 steps) determines whether extracted center-channel in-
formation will be routed solely to the center output or if some amount of the center
energy is blended into the Left Front and Right Front outputs. While setting this
control to “0"” maximizes the “discreteness” of the upmix, some operators prefer to
mix a certain amount of center energy into Lf and Rf to ensure that dialog is not lost
completely if the center channel is not correctly set up at the consumer’s receiver.

Front/Rear Balance (0 to 1 in 0.1 steps) is the ratio between the Lf/Rf and Ls/Rs levels
above 80 Hz, in absolute (not dB) units. The control “pans” the derived left/right
channels (where the center information has been removed) between the Lf/Ls and
Rf/Rs output pairs respectively. Technically, it is used to determine the amount of
envelopment in the upmix. Setting this control to 1.0, which mixes the derived L/R
channels equally front and rear, works well for television-oriented audio. Setting the
control to 0 turns off the surround channels.

Stage Shape (WRAP, FRONTAL) determines whether the virtual soundstage is wrapped
around the listener (putting the listener “inside the band”) or is placed primarily in
the front (putting the listener “inside the auditorium”). In FRONTAL mode, the sur-
round speakers contain mainly reflections and other manifestations of the acoustics
of the (real or artificial) space in which the stereo recording was placed by its crea-
tor. (Optimix never adds artificial reverb.)

About Downmix Compatibility: Optimix reads downmix parameters (Cen-
ter and Surround downmix coefficients) from the Optimod and automat-
ically chooses gains for the five upmixed channels. If DELAY CORRECTION is
OFF, the downmix in WrRAP mode is identical to Optimix's stereo input, as-
suming a Dolby Lo/Ro downmix. Optimix takes into account the settings
of its FRONT/REAR BALANCE and CENTER WIDTH controls. When DEeLAY
CORRECTION is ON, the downmix includes the effect of the center channel
delay corrector and can make the stereo downmix crisper and more intel-
ligible than the Optimix’s stereo inputs. If the receiver is stereo-only, the
bass balance in the downmix will be identical to that of the stereo mate-
rial applied to Optimix’s input.

In FRONTAL mode, the downmix can have slightly more reverb or ambi-
ence than the original stereo, although there is no artificial reverb added
and the result is usually satisfactory.
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Stereo Enhancer Controls

Name Range
Amount 0.0...10.0
In/ Out Out/In
Ratio Lim 70 ... 100%
Depth 0...10

Table 3-5: Stereo Enhancer Controls

It is the user's responsibility to make sure that the Optimod's downmix
level controls agree with the Center Downmix Level and Surround
Downmix Level in the AC3 metadata that is being transmitted to con-
sumers. (Dolby specifies the center default value as -3 dB and the sur-
round default value as —1.5 dB.)

Delay Correction and Dolby Surround: Although delay correction is very
effective for most program material, it is incompatible with two-channel
input material that was previously Dolby Surround-encoded such that the
encoder, before encoding, created the phase-shifted surround channels
necessary to create an Lt/Rt output, which can be decoded by the con-
sumer using Dolby Pro Logicto L, C, R, and S.

When Delay Correction is on, Dolby Surround material intended for the
surrounds will be reproduced in both the surrounds and center. When
Delay Correction is off, material encoded for the surrounds will only ap-
pear in the surrounds.

Stereo Enhancer Controls

The stereo enhancer emulates the Orban 222 analog stereo enhancer, which in-
creases the energy in the stereo difference signal (L-R) whenever a transient is de-
tected in the stereo sum signal (L+R). It complements Optimix, increasing the sense

of envelopment and space while maintaining excellent downmix compatibility.

The stereo enhancer’s gating operates under two conditions.

The two stereo channels are close to identical in magnitude and phase.

In this case, the enhancer assumes that the program material is actually
mono and thus suppresses enhancement to avoid creating undesired
channel imbalance.

The ratio of L-R / L+R of the enhanced signal tries to exceed the threshold set by
the L-R / L+R Ratio Limit control.

In this case, the enhancer prevents further enhancement in order to pre-
vent excess L-R energy, which can sound unnatural and which can in-
crease multipath distortion in FM broadcasting.

Even when OPTIMOD-PCn is used for surround processing, the stereo enhancer is still
available. In this case, it is defeated automatically unless Optimix is actively upmix-
ing. This preserves the dimensionality of true surround input material, but helps Op-
timix provide a more enveloping surround effect.
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The STEREO ENHANCER meter indicates the amount of gain (in dB) that applied to the
L-R signal.

It is unwise to use stereo enhancement with low bitrate codecs. At low
bitrates, these codecs use various parametric techniques for encoding the
spatial attributes of the sound field. Stereo enhancement can unneces-
sarily stress this encoding process.

The stereo enhancer has the following controls:
Amount sets the maximum spatial enhancement.

Enhancer In / Out bypasses the stereo enhancer. OuT is equivalent to setting the
AMOUNT to 0.

L-R / L+R Ratio Limit sets the maximum amount of enhancement to prevent multi-
path distortion. However, if the original program material exceeds this limit with no
enhancement, the enhancer will not reduce it.

Stereo Synthesizer Controls

Stereo Synthesizer Controls

Name Range
Mono>Stereo Algorithm Bypass, Auto, Upmix
In / Out Wide, Narrow
Mono>Stereo Separation 0...10

Table 3-6: Stereo Synthesizer Controls

The stereo synthesizer emulates the classic analog Orban 275A automatic stereo
synthesizer'.

This process creates an artificial stereo difference signal (L—-R) by passing the mono
input through a multistage allpass filter. After matrixing with the original mono in-
put (which is the L+R signal) to produce the synthesized left and right channels, the
result is a “complementary comb filter” whose notches are spaced in frequency in an
approximately logarithmic manner. Because only the L-R signal is created artificially,
it cancels out of a mono mixdown, making the synthesizer's output completely
mono-compatible?.

' The 275A manual, which provides substantial detail, can be downloaded from
ftp://ftp.orban.com/275A/.

2 Robert Orban: “A Rational Technique for Synthesizing Pseudo-Stereo from Mono-
phonic Sources,” J. Audio Engineering Society, Volume 18 Issue 2 pp. 157-164; April
1970
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The synthesizer can be activated manually via PC Remote or the API (see Section 5 of
the manual). Automatic activation is also available. In AUTOMATIC mode, synthesis
from audio on the left input channel will occur if silence is detected on the right in-
put channel. A 187 ms look-ahead delay in the audio path compensates for the de-
lay built into the detector to prevent false triggering on extremely brief right chan-
nel pauses. Silence gating prevents triggering unless there is activity on the left
channel.

The stereo synthesizer has the following controls, located in the UrPMiX page of the
GUI:

Mono>Stereo Upmix (Bypass, Auto, UpMix) allows you to manually bypass the syn-
thesizer or force it to always upmix from material on the left channel. Auto forces
upmixing when silence is detected on the right input channel, as described above.

Mono>Stereo Algorithm (WIDE, NARROW) sets the number of notches in the comple-
mentary comb filters. WIDE produces fewer notches than NARROW. WIDE produces the
most dramatic effect on music, while NARROW prevent speech from becoming un-
naturally wide-sounding, and is preferable in sound-for-picture applications.

Mono>Stereo Separation sets the gain applied to the allpass filter chain. 0 suppresses
synthesis, while 10 causes the magnitudes of the L+R and L-R signals to be identical.

Assuming equal gains in the L+R and L-R channels, the mathematics of
the process require the phase difference of the L and R channels to be 90
degrees at the frequencies where their magnitudes are equal. This can
produce”phasiness” that some people dislike. If the output of the synthe-
sizer is applied to OPTIMOD-PCn's phase correction algorithm, this will
remove the “phasiness” at higher frequencies at the expense of putting
bumps of up to 3 dB in the frequency response of the mono sum (assum-
ing that MoNO>STEREO SEPARATION = 10). Because of this compatibility is-
sue, we recommend instead simply turning down the MONO>STEREO
SEPARATION control until the result sounds comfortable and convincing. 7
(where the L-R signal is 70% of the L+R signal) is a good compromise
value.

AGC Controls

The AGC smoothly rides gain before the multiband compressor. Unlike AGCs in some
other Optimods, only a linear-phase crossover is available and the left and right
channels are coupled using RMS summation. The AGC MAXDELTAGR control deter-
mines the amount of coupling in stereo processors. While we have removed some
features relating to left/right band coupling and sum-and-difference operation, we
believe that the new AGC design used in the 1600 is substantially smoother and
more transparent than the AGCs used in earlier Optimods.

The AGC may be operated in left/right mode or sum-and-difference mode.

AGC ("AGC Off/On") control activates or defeats the AGC.
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It is usually used to defeat the AGC when you want to create a preset with minimal
processing (such as a CLASSICAL preset). The AGC is also ordinarily defeated if you
are using a studio level controller to protect a transmission link before OPTIMOD-
PCn. However, in this case it is better to defeat the AGC globally in System Setup
[see step (2.C) on page 2-16].

AGC Drive control adjusts signal level going into the slow dual-band AGC, therefore
determining the amount of gain reduction in the AGC. This control also adjusts the
“idle gain”"—the amount of gain reduction in the AGC section when the structure is
gated. (It gates whenever the input level to the structure is below the threshold of
gating.)

The total amount of gain reduction in the Five-Band structure is the sum of the gain
reduction in the AGC and the gain reduction in the five-band compressor. The total
system gain reduction determines how much the loudness of quiet passages will be
increased (and, therefore, how consistent overall loudness will be). It is determined
by the setting of the AGC DRIVE control, by the level at which the console VU meter
or PPM is peaked, and by the setting of the MULTIBAND DRIVE (compressor) control.

AGC Release ("AGC Master Release”) control provides an adjustable range from 0.5
dB/second (slow) to 20 dB/second (fast). The increase in density caused by setting the
AGC RELEASE control to fast settings sounds different from the increase in density
caused by setting the Five-band’s MULTIBAND RELEASE control to FAST. You can trade
the two off to produce different effects.

Unless it is purposely speeded-up (with the AGC RELEASE control), the automatic
gain control (AGC) that occurs in the AGC prior to the multiband compressor makes
audio levels more consistent without significantly altering texture. Then the multi-

Name Range

AGC Off / On Off / On

AGC Drive -10...25dB
AGC Master Release 0.5,10,15,2...20dB/S
AGC Bass Release 1...10 dB/sec
AGC Gate Threshold Off, -44 ... -15 dB
AGC Bass Coupling 0 ... 24 dB, Off
AGC Window Size -25...0dB

AGC Window Release 0.5...20dB

AGC Ratio w:1,4:1,3:1, 2:1
AGC Bass Threshold -12.0...2.5dB
AGC Idle Gain -10...+10dB
AGC Master Attack 0.2...6

AGC Bass Attack 1...10

AGC Crossover

Allpass, LinearNoDelay,

AGC Matrix

L/R, sum/difference

AGC MaxDelta GR

0.0...24.0dB, off

Master Delta Thresh

-6.0... +6.0dB

Bass Delta Thresh

-6.0 ... +6.0 dB

Table 3-7: AGC Controls
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band compression audibly changes the density of the sound and dynamically re-
equalizes it as necessary: booming bass is tightened; weak, thin bass is brought up;
highs are always present and consistent in level.

The various combinations of AGC and compression offer great flexibility:

e Light AGC + light compression yields a wide sense of dynamics, with a small
amount of automatic re-equalization.

e Moderate AGC + light compression produces an open, natural quality with au-
tomatic re-equalization and increased consistency of frequency balance.

¢ Moderate AGC + moderate compression gives a denser sound, particularly as the
release time of the multiband compressor is sped up.

e Moderate AGC + heavy compression (particularly with a FAST multiband release
time) results in a “wall of sound” effect, which may cause listener fatigue.

Adjust the AGC (with the AGC DRIVE control) to produce the desired amount of AGC
action, and then fine-tune the compression and clipping with the Five-Band struc-
ture’s controls.

AGC Gate (“AGC Gate Threshold”) control determines the lowest input level that
will be recognized as program by OPTIMOD-PCn; lower levels are considered to be
noise or background sounds and cause the AGC or multiband compressor to gate,
effectively freezing gain to prevent noise breathing.

In sound for picture, the setting of the gate threshold controls are quite critical if
you want the processing to be undetectable to the audience. If this control is set too
low, then OPTIMOD-PCn will pump up quiet sounds such as ambience and under-
scoring to unnaturally high levels.

There are two independent silence-gating circuits in OPTIMOD-PCn. The first affects
the AGC and the second affects the multiband compressor (2-band or 5-band). Each
has its own threshold control.

In the five-band structure, the multiband silence gate causes the gain reduction in
bands 2 and 3 of the five-band compressor to move quickly to the average gain re-
duction occurring in those bands when the gate first turns on. This prevents obvious
midrange coloration under gated conditions, because bands 2 and 3 have the same
gain.

The multiband gate also independently freezes the gain of the two highest frequen-
cy bands (forcing the gain of the highest frequency band to be identical to its lower
neighbor), and independently sets the gain of the lowest frequency band according
to the setting of the DJ BASS boost control (in the Equalization screen). Thus, with-
out introducing obvious coloration, the gating smoothly preserves the average
overall frequency response “tilt” of the multiband compressor, broadly maintaining
the "automatic equalization” curve it generates for a given piece of program mate-
rial.
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If the MB GATE THR (Gate Threshold) control is turned OFfF, the DJ BAss con-
trol is disabled.

AGC Bass Coupling control clamps the amount of dynamic bass boost (in units of dB)
that the AGC can provide.

The AGC processes audio in a master band for all audio above approximately 200 Hz
and a bass band for audio below approximately 200 Hz. The AGC Master and Bass
compressor sidechains operate without internal coupling. The gain reduction in the
BAss audio path is either the output of the Bass compressor sidechain or the output
of the Master band sidechain. The AGC BAss COUPLING control sets the switching
threshold. For example, if the AGC BAsSS COUPLING control is set to 4 dB and the mas-
ter gain reduction is 10 dB, the bass gain reduction cannot decrease below 6 dB even
if the gain reduction signal from the Bass compressor sidechain is lower. However,
the audio path bass gain reduction can be larger than the master gain reduction
without limit. In the previous example, the bass gain reduction could be 25 dB

The normal setting of the AGC BASS COUPLING control is 0 dB, which allows the AGC
bass band to correct excessive bass as necessary but does not permit it to provide a
dynamic bass boost.

Window Size determines the size of the floating “slow zone” window in the master
band of the AGC. (The Bass band is not windowed.)

The window works by slowing down changes in the AGC gain reduction that are
smaller than the WINDOW SizE. The window has 2:1 asymmetry around the current
AGC gain reduction. For example, if the WINDOW SIZE is set to 4 dB, the window ex-
tends 4 dB in the release direction and 2 dB in the attack direction.

If the AGC needs to respond to a large change in its input level by making a gain
change that is larger than the window, then the AGC's attack and release controls
determine the AGC's response time. However, if the change in input level is smaller
than the window size, the WINDOW RELEASE control determines the attack and re-
lease times. This is usually much slower than the normal AGC time constants. This
prevents the AGC from building up density in material whose level is already well
controlled.

The previous explanation was somewhat simplified. In fact, the window has “soft
edges.” Instead of switching abruptly between time constants, the attack and re-
lease times morph smoothly between the setting of the WINDOW RELEASE control and
the setting of the AGC master release and attack controls.

The normal setting for the Winpow SizE is 3 dB.

Window Release (see WINDOW SIZE above.)

AGC Ratio determines the compression ratio of the AGC. The compression ratio is
the ratio between the change in input level and the resulting change in output lev-
el, both measured in units of dB.
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OPTIMOD-PCn compressor can be operated at a compression ratio as low as 2:1. This
can add a sense of dynamic range and is mostly useful for subtle fine arts formats
like classical and jazz.

AGC Bass Threshold determines the compression threshold of the bass band in the
AGC. It can be used to set the target spectral balance of the AGC.

As the AGC B CpPL control is moved towards “100%,"” the AGC BASS THRESHOLD con-
trol affects the sound less and less.

The interaction between the AGC BAsS THRESHOLD control and the AGC B CpL con-
trol is a bit complex, so we recommend leaving the AGC BASS THRESHOLD control at
its factory setting unless you have a good reason for readjusting it.

AGC Idle Gain. The "“idle gain” is the target gain of the AGC when the silence gate is
active. Whenever the silence gate turns on, the gain of the AGC slowly moves to-
wards the idle gain.

The idle gain is primarily determined by the AGC DRIVE setting—a setting of 10 dB
will ordinarily produce an idle gain of —10 dB (i.e., 10 dB of gain reduction). Howev-
er, sometimes you may not want the idle gain to be the same as the AGC DRIVE set-
ting. The AGC IDLE GAIN control allows you to add or subtract gain from the idle gain
setting determined by the AGC DRIVE setting.

You might want to do this if you make a custom preset that otherwise causes the
gain to increase or decrease unnaturally when the AGC is gated. For example, to
make the idle gain track the setting of the AGC DRIVE control, set the AGC IDLE GAIN
control to zero. To make the idle gain 2 dB lower than the setting of the AGC DRIVE
control, set the AGC IDLE GAIN control to -2.

AGC Bass Attack sets the attack time of the AGC bass compressor (below 200Hz).

AGC Master Attack sets the attack time of the AGC master compressor (above
200Hz).

AGC Bass Release sets the release time of the AGC bass compressor.

AGC Maximum Delta GR (stereo processing only) approximates the maximum gain
difference permitted between the two stereo channels of the AGC. Set it to “0" for
perfect stereo coupling. In sum/difference mode it constrains the gain difference
between the sum and difference channels.

In surround processing, the RMS sum of all audio channels controls the
gain reduction of the AGC, which is identical in all channels.

AGC Matrix (stereo processing only) allows you to operate the AGC in left/right
mode or in sum / difference mode. Usually you will operate in left/right mode. How-
ever, sum / difference mode can give a type of stereo enhancement that is different
from the enhancement modes offered in the built-in stereo enhancer. This will only
work if you allow the two channels of the AGC to have different gains. To do this,
set the AGC MaxiMmum DELTA GR control greater than zero.
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It is unwise to set this control beyond 3 dB. In FM pre-processing applica-
tions, multipath distortion could increase because the amount of L-R en-
ergy builds up excessively. We prefer using the built-in stereo enhancer
because its built-in gating circuits prevent over-enhancement.

Master Delta Threshold (stereo processing only) allows you to set the difference be-
tween the compression thresholds of the sum and difference channels. (This control
is only useful when you set the AGC MATRIX to SUM/ DIF.) By setting the threshold of
the difference channel lower than the sum channel, you can have the AGC automat-
ically produce more gain reduction in the difference channel. This will reduce the
separation of material with an excessively wide stereo image (like old Beatles rec-
ords). To make this work, you must set the MAX DELTA GR control away from zero.
For example, to limit an excessively wide image while preventing more than 3 dB
difference in gain between the sum and difference channels, set the Max DELTA GR
control to 3.0 and the MASTER DELTA THRESHOLD control to some positive number,
depending on how much automatic width control you want the Optimod to per-
form.

Bass Delta Threshold (stereo processing only) works the same as MASTER DELTA
THRESHOLD, but applies to the bass band. You will usually set it the same as MASTER
DELTA THRESHOLD.

Equalizer Controls

The table summarizes the equalization controls. The equalizer is located between
the AGC and five-band compressor sections.

See Figure 3-6 and Figure 3-7 on page 3-18 for typical equalizer frequency response
curves.

Any equalization that you set will be automatically stored in any User Preset that
you create and save. For example, you can use a User Preset to combine an unmodi-
fied Factory Programming Preset with your custom equalization. Of course, you can
also modify the Factory Preset (with Basic or Advanced Modify) before you create
your User Preset.

In general, you should be conservative when equalizing modern, well-recorded pro-
gram material. This is particularly true with general-purpose video programming.

Except for BASS GAIN, most of the factory presets use less than 3 dB of equalization.
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Bass Shelf Hinge Frequency Bass Shelf Controls, the 5-band
structure’s low bass equalization
S controls, are designed to add

q \ punch and slam to rock and urban
Bass Gain [ || A S music. They provide a parametric
\ A shelving equalizer with control
over gain, hinge frequency, and

2
18dB/oct I}:// slope (in dB/octave).
Bass Slope 12dB/oct

6dB/oct

Bass Shelf Hinge Frequency sets the frequency where shelving starts to
take effect.

Bass Gain sets the amount of bass boost (dB) at the top of the shelf.

Bass Slope sets the slope (dB/octave) of the transition between the top
and bottom of the shelf.

Because the Five-Band structure often increases the brightness of pro-
gram material, some bass boost is usually desirable to keep the sound
spectrally well balanced. Adjustment of bass equalization must be deter-
mined by individual taste and by the requirements of your format. Be
sure to listen on a wide variety of consumer systems—it is possible to cre-
ate severe distortion on poor quality speakers by over-equalizing the
bass. Be careful!

The moderate-slope (12 dB/octave) shelving boost achieves a bass boost
that is more audible on smaller radios, but which can sound boomier on
high-quality systems. The steep-slope (18 dB/octave) shelving boost cre-
ates a solid, punchy bass from the better consumer systems with decent
bass response. The 6 dB/octave shelving boost is like a conventional tone
control and creates the most mid-bass boost, yielding a “warmer” sound.
Because it affects the mid-bass frequency range, where the ear is more
sensitive than it is to very low bass, the 6 dB/octave slope can create more
apparent bass level at the cost of bass “punch.”

There are no easy choices here; you must choose the characteristic you
want by identifying your target audience and the receivers they are most
likely to be using. Regardless of which curve you use, we recommend a
+2 to +5 dB boost for most formats. Larger amounts of boost will in-
crease the gain reduction in the lowest band of the multiband compres-
sor, which may have the effect of reducing some frequencies. So be
aware the large fixed bass boosts may have a different effect than you
expect because of the way that they interact with the multiband com-
pressor. (The GREGG presets use this effect purposely to create a dynamic
cut in the mid-bass.)

Low Frequency Parametric Equalizer is a specially designed equalizer whose boost
and cut curves closely emulate those of a classic Orban analog parametric equalizer
with conventional bell-shaped curves (within +0.15 dB worst-case). This provides
warm, smooth, “analog-sounding” equalization.

LF Freq determines the center frequency of the equalization, in Hertz.
Range is 20-500Hz.



3 - 5 6 OPERATION

ORBAN MODEL 1600

LF Gain determines the amount of peak boost or cut (in dB) over a +10 dB

range.

LF Width determines the bandwidth of the equalization, in octaves. The
range is 0.8-4.0 octaves. If you are unfamiliar with using a parametric
equalizer, 1.5 octaves is a good starting point. These curves are relatively
broad because they are designed to provide overall tonal coloration, ra-
ther than to notch out small areas of the spectrum.

The LF parametric can be used in the mid-bass region (100-300Hz) to add
“warmth” and “mellowness” to the sound when boosting. When cutting,
it can remove a “woody"” or "boxy"” sound.

The equalizer, like the classic Orban model 622B, has constant “Q”
curves. This means that the cut curves are narrower than the boost

Equalizer Controls

Group Name Range
Bass Shelf Bass Frequency 80, 85, 90, 95, 100, 105, 110, 115, 120, 125,
130, 135, 140, 145, 150, 160, 170, 180, 190,
200, 210, 220, 230, 240, 250, 270, 290, 310,
330, 350, 380, 410, 440, 470, 500Hz
Bass Gain 0...12dB
Bass Slope 6,12,18 dB/Oct
Low Low Frequency 20 ... 500 Hz
Low Gain -10.0 ... +10.0 dB
Low Width 0.8 ... 4 octaves
Mid Mid Frequency 250 ... 6000 Hz
Mid Gain -10.0 ... +10.0 dB
Mid Width 0.8 ... 4 octaves
High High Frequency 1.0 ... 15.0 kHz
High Gain -10.0 ... +10.0 dB
High Width 0.8 ... 4 octaves
All All Frequency 20 Hz ... 20.0 kHz
All Gain -10.0 ... +10.0 dB
All Width 0.8 ... 4 octaves
HF Enhancer High Frequency 0..15dB
Enhancer
Sensitivity Trim —-10... +10dB
Threshold Trim 0...+20dB

Subharmonic

Subharmonic Injection

Off, -99.0 ... 0 dB

Highpass Filter,
Speech HP Filter

Highpass Filter Freq

Injection
Subharmonic Cutoff 90Hz, 120Hz
Freq

DJ Bass (5B) DJ Bass Boost Off, 1... +10 dB

Off, 20, 30, 40, 50, 60, 70, 80, 90, 100, 110,
120, 130, 140, 150, 170, 200 Hz

Highpass Filter Slope

6, 12, 18, 24 dB / octave

LP Filter (EQ)

Lowpass Filter Freq

4,5,6,7,8,9,10, 11, 12, 13, 14, 15 kHz

Lowpass Filter Slope

6, 12, 18, 24 dB / octave

LP Filter (steep)

Lowpass Filter

10, 11,12, 13, 14, 15, 20 kHz

Phase Rotate

Phase Rotate

In / Out

Table 3-8: Equalizer Controls
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curves. The width (in octaves) is calibrated with reference to 10 dB boost.
As you decrease the amount of EQ gain (or start to cut), the width in oc-
taves will decrease. However, the “Q" will stay constant.

“Q" is a mathematical parameter that relates to how fast ringing damps
out. (Technically, we are referring to the “Q” of the poles of the equaliz-
er transfer function, which does not change as you adjust the amount of
boost or cut.)

The curves in OPTIMOD-PCn’s equalizer were created by a so-called “min-
imax” (“minimize the maximum error” or "equal-ripple”) IIR digital ap-
proximation to the curves provided by the Orban 622B analog parametric
equalizer. Therefore, unlike less sophisticated digital equalizers that use
the "bilinear transformation” to generate EQ curves, the shapes of
OPTIMOD-PCn’s curves are not distorted at high frequencies.

Midrange Parametric Equalizer is a parametric equalizer whose boost and cut curves

closely emulate those of an analog parametric equalizer with conventional bell-
shaped curves.

Mid Freq determines the center frequency of the equalization, in Hertz.
Range is 250-6000Hz.

Mid Gain determines the amount of peak boost or cut (in dB) over a £10

dB range.

Mid Width determines the bandwidth of the equalization, in octaves. The
range is 0.8-4.0 octaves. If you are unfamiliar with using a parametric

equalizer, one octave is a good starting point.

With Five-Band presets, the audible effect of the midrange equalizer is
closely associated with the amount of gain reduction in the midrange
bands. With small amounts of gain reduction, it boosts power in the
presence region. This can increase the loudness of such material substan-
tially. As you increase the gain reduction in the midrange bands (by turn-
ing the MULTIBAND DRIVE control up), the MID GAIN control will have
progressively less audible effect. The compressor for the midrange bands
will tend to reduce the effect of the MID frequency boost (in an attempt
to keep the gain constant) to prevent excessive stridency in program ma-
terial that already has a great deal of presence power. Therefore, with
large amounts of gain reduction, the density of the presence region en-
ergy will be increased more than will the level of energy in that region.
Because the 3.7 kHz band compressor is partially coupled to the gain re-
duction in the 6.2 kHz band in most presets (as set by the B4>5
COUPLING control), tuning MID FREQ to 2-4 kHz and turning up the MID
GAIN control will decrease energy in the 6.2 kHz band—you will be in-
creasing the gain reduction in both the 3.7 kHz and 6.2 kHz bands. You
may wish to compensate for this effect by turning up the BRILLIANCE
control.

With Two-Band presets, the midrange equalizer will behave much more
as you might expect because the two-band structure cannot automatical-
ly re-equalize midrange energy. Instead, increasing midrange energy will
moderately increase the Master band’s gain reduction.

Use the mid frequency equalizer with caution. Excessive presence boost
tends to be audibly strident and fatiguing. Moreover, the sound quality,
although loud, can be very irritating. We suggest a maximum of 3 dB
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boost, although 10 dB is achievable. In some of our factory music presets,
we use a 3 dB boost at 2.6 kHz to bring vocals more up-front.

High Frequency Parametric Equalizer is an equalizer whose boost and cut curves
closely emulate those of an analog parametric equalizer with conventional bell-
shaped curves.

High Freq determines the center frequency of the equalization, in Hertz.
The range is 1-15 kHz

High Gain determines the amount of peak boost or cut over a +10 dB
range.

High Width determines the bandwidth of the equalization, in octaves.
The range is 0.8-4.0 octaves. If you are unfamiliar with using a parametric
equalizer, one octave is a good starting point.

Excessive high frequency boost can exaggerate hiss and distortion in pro-
gram material that is less than perfectly clean. We suggest no more than
4 dB boost as a practical maximum, unless source material is primarily
from high-quality digital sources. In several of our presets, we use this
equalizer to boost the upper presence band (4.4 kHz) slightly, leaving
broadband HF boost to the BRILLIANCE and/or HF ENHANCE controls.

All Frequency Parametric Equalizer is similar to the other parametric sections but can
be swept over the entire audio band, from 20 Hz to 20 kHz.

Brilliance controls the drive to Band 5. The Band 5 compressor/limiter dynamically
controls this boost, protecting the final limiter from excessive HF drive. We recom-
mend a maximum of 4 dB of Brilliance boost and most people will prefer substan-
tially less.

DJ Bass (“DJ Bass Boost”) control determines the amount of bass boost produced on
some male voices. In its default OFF position, it causes the gain reduction of the
lowest frequency band to move quickly to the same gain reduction as its nearest
neighbor when gated. This fights any tendency of the lowest frequency band to de-
velop significantly more gain than its neighbor when processing voice because voice
will activate the gate frequently. Each time it does so, it will reset the gain of the
lowest frequency band so that the gains of the two bottom bands are equal and the
response in this frequency range is flat. The result is natural-sounding bass on male
voice. This is particularly desirable for most video programming.

If you like a larger-than-life, “chesty” sound on male voice, set this control away
from OFF. When so set, gating causes the gain reduction of the lowest frequency
band to move to the same gain reduction (minus a gain offset equal to the numeri-
cal setting of the control) as its nearest neighbor when gated. You can therefore set
the maximum gain difference between the two low frequency bands, producing
considerable dynamic bass boost on voice. This setting might be appropriate for
news and sports.

The difference will never exceed the difference that would have other-
wise occurred if the lowest frequency band were gated independently. If
you are familiar with older Orban processors like OPTIMOD-FM 8200, this
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is the maximum amount of boost that would have occurred if you had set
their DJ BAss BoosT controls to ON.

The amount of bass boost will be highly dependent on the fundamental
frequency of a given voice. If the fundamental frequency is far above
100Hz, there will be little voice energy in the bottom band and little or
no audio bass boost can occur even if the gain of the bottom band is
higher than the gain of its neighbor. As the fundamental frequency
moves lower, more of this energy leaks into the bottom band, and you
hear more bass boost. If the fundamental frequency is very low (a rarity),
there will be enough energy in the bottom band to force significant gain
reduction, and you will hear less bass boost than if the fundamental fre-
quency were a bit higher.

This control is only available in the Five-Band structure.

If the GATE THRESH (Gate Threshold) control is turned OFfF, the DJ BAss
boost setting is disabled.

The High Frequency Enhancer is a program-adaptive, 6 dB/octave shelving equalizer
with a 4 kHz turnover frequency. It constantly monitors the ratio between high fre-
quency and broadband energy and adjusts the amount of equalization in an at-
tempt to make this ratio constant as the program material changes. It can therefore
create a bright, present sound without over-equalizing material that is already
bright.

High Frequency Enhancer is a mix control for the high frequency enhancer
that sets the amount of enhanced high frequencies being mixed into the
input and clamps the maximum enhancement to the control’s setting.

Sensitivity Trim (v0.9.9 and higher) trims the ratio of high-frequency to
wideband energy produced by HF Enhancer at a given setting of the HIGH
FREQUENCY ENHANCER control. Higher settings increase the amount of en-
hancement. Default is 0 dB, which retains the behavior of the previous
high frequency enhancer. This had only one control: HIGH FREQUENCY
ENHANCER.

Threshold Trim (v0.9.9 and higher) trims the high frequency enhancer in-
put level above which full HF enhancement occurs. Higher settings pro-
duce lower amounts of enhancement at low levels. Default is 0 dB, which
produces the same behavior as previous versions of the HF enhancer.
Note that the HF Enhancer is driven by the AGC, so its input level tracks
the AGC's output level.

Subharmonic Injection, Subharmonic Cutoff Freq The subharmonic synthesizer gen-
erates subharmonics of fundamental frequencies in the 50-90 or 60-120 Hz range, as
selected by the SUBHARMONIC CUTOFF FREQ control. The subharmonics are one octave
below the frequencies from which they are generated (i.e., 25 to 45 Hz or 30-60 Hz)
and track the levels of their generating frequencies. Subharmonic injection can be
varied from 0 to 100% of the level of the generating frequency. 50% is a good start-
ing point for popular music formats.

If input program material below 50 or 60 Hz is present, the subharmonic synthesizer
automatically reduces the level of the synthesized subharmonics to prevent excess
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build-up of energy below 50 or 60 Hz (i.e. the amount of subharmonic injection will
be lower than the setting of the SUBHARMONIC INJECTION control).
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Figure 3-15: Equal Loudness Curves

To prevent introducing unnatural coloration in male speech, the subharmonic syn-
thesizer is defeated when the Optimod’s automatic speech/music detector detects
speech. When you use the 120 Hz cutoff frequency (which can cause “thumps” be-
hind low-pitched male speech), it is wise to ensure that raw speech is panned to the
exact center, which is one important criterion that the speech/music detector uses to
detect speech.

It is important to understand that material below 50 Hz takes up lots of peak level
to produce significant loudness. Moreover, the close spacing of psychoacoustic
“equal loudness” curves® below 50 Hz means small changes in amplitude lead to
large change in subharmonic loudness. The unpredictability of receiver bass re-
sponse means that the perceived loudness of subharmonics is highly receiver-
dependent. Because of the amount of peak level they use up, subharmonics will al-
ways make a broadcast sound quieter for a given amount of processing arti-

3 The equal-loudness curves are popularly known as “Fletcher/Munson” curves, alt-
hough these have been superseded by ISO 226:2003. The image was taken from
en.wikipedia.org.
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facts/distortion—they use up peak level that otherwise could be dedicated to audio
to which the ear is more sensitive. (This is an inevitable effect of the equal-loudness
curves.) For all these reasons, it is wise not to overdo subharmonic synthesis.

Note that when you apply an L+R sinewave at a frequency between 50 to
90 Hz to the 1600’'s input, the 1600’s speech/music detector will detect
this as “speech,” so no subharmonics will be produced. To test the sub-
harmonic synthesizer with tone, there must be at least 2 dB of level dif-
ference between the left and right inputs. In other words, be sure that
the 1600's speech/music detector is indicating “music” in the 1600 PC GUI.

Highpass Filter, Speech Highpass Filter determines if a sweepable 6, 12, 18 or 24
dB/octave highpass filter will be placed in-circuit before other processing. The 6, 12
and 18 dB/octave filters have a Butterworth response and the indicated frequency is
where the filter is 3 dB down. The 24 dB/octave filter has a Chebychev response with
0.01 dB of passband ripple. The indicated highpass frequency of this filter is the
passband edge of the filter. (For example, if the filter is set to 20 Hz, the high filter’s
response will be flat £0.01 dB to 20 Hz.

The highpass filter is useful for reducing low frequency noise, particularly when
OPTIMOD-PCn is being used for production or mastering.

Two control sets (each containing FREQUENCY and SLOPE) are available, one for mu-
sic mode and one for speech mode. These can be switched via OPTIMOD-PCn's au-
tomatic speech/music detector.

It is wise to make sure that the main and speech-mode highpass filter set-
tings are the same unless you specifically want to apply additional
highpass filtering to speech. Like all automatic speech/music detectors,
the one in your Optimod can occasionally make mistakes, so it is also wise
in mixed-format programming to set the filter no higher than 70 Hz. This
way, if the Optimod mistakenly identifies music as speech (or decides that
voice-over-music is speech), it will not cause an obvious dropout of bass
frequencies.

Note that an L=R test tone whose level changes depending on whether
speech or music is detected can repeatedly toggle the speech/music de-
tector between “speech” and “music” modes. This is because the sudden
jump in tone level is “speech-like” and triggers the speech/music detec-
tor's syllabic detector. An example is a 100 Hz tone when the main
highpass filter frequency is 50 Hz and the speech highpass filter frequen-
cy is 200 Hz. This issue never occurs with program material.

Lowpass Filter (steep) control sets the bandwidth (and therefore the amount of high
frequency signal OPTIMOD-PCn passes) from 10 kHz to 20 kHz. The lowpass filter can
replace any anti-aliasing filters in downstream equipment. Set the filter to 20 kHz
(full bandwidth) for downstream equipment with sample rates of 44.1 or 48 kHz. Set
the filter to 15 kHz for 32 kHz sample rate. For other sample rates, set the filter so
that it is as close as possible to 45% of the sample rate without exceeding 45%.

This setting is unique to the preset in which it resides. Regardless of its
setting, OPTIMOD-PCn will not permit the system bandwidth to exceed
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the bandwidth set by the Max Lowpass FILTER parameter located in the
Configuration page of the I/O Mixer.

Lowpass Filter (gentle) is intended for program equalization, not anti-aliasing like
the steep lowpass filter. It is intended mainly for mastering where the steep lowpass
filter might cause audibly objectionable ringing. It is sweepable from 4 to 15 kHz
with slopes of 6, 12, 18 or 24 dB/octave. The filter's shape is Butterworth, and the
setting indicates the frequency where the filter is 3 dB down.

Phase Rotator determines if the phase rotator will be in-circuit. The purpose of the
phase rotator is to make voice waveforms more symmetrical. Because it can slightly
reduce the clarity and definition of program material, we recommend leaving it OuT
unless program material is mainly speech, where it may result in cleaner sound be-
cause it can substantially reduce the amount of gain reduction that OPTIMOD-PCn's
look-ahead limiter produces on speech waveforms.

Multiband Compressor Controls

Following the AGC is an equalization section, a five-band compressor, a dynamic
single-ended noise reduction system, an output mixer (for the five bands), and a
peak limiter.

When the input is noisy, you can sometimes reduce the noise by activating the sin-
gle-ended noise reduction system. Functionally, the single-ended noise reduction

Multiband Controls

Advanced Name Range

Multiband Drive 0..25

Multiband Gate Threshold Off, -44 ... -15 dB
Downward Expander Off, -18.0 ... 12.0 dB
Speech Downward Expander Off, -18.0 ... 12.0 dB
B5 Downward Expander Off, -18.0 ... 12.0dB
Downward Expander Stereo Coupling On, Off

Crossover Linear, Allpass

B1/B2 Crossover 100 Hz, 150 Hz, 200 Hz
B1/B2 Crossover Slope Shallow, Steep

B1 MaxDeltGr 0 ... 24 dB, Off

B2 MaxDeltGr 0 ... 24 dB, Off

B3 MaxDeltGr 0...24 dB, Off

B4 MaxDeltGr 0...24 dB, Off

B5 MaxDeltGr 0 ... 24 dB, Off
Loudness Threshold Off, +10.0 ... -14.0 dB
Loudness Attack 0...100%

Loudness Bass Couple 0...12 dB, Off
BS.1770 Threshold 0...6 dB, Off

Mono Bass On, Off

Mono Bass Crossover 80, 100 Hz
Compressor Mode Inline, Parallel
Compression Thresh Offset 0...—60 dB, 1 dB steps

Table 3-9: Multiband Controls
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system combines a broadband downward expander with a program-dependent low-
pass filter. This noise reduction can be valuable in reducing audible hiss, rumble, or
ambient studio noise. We use it for the news and sports factory presets.

The Five-Band structure does not have a separate Loudness Controller because its
Five-Band compressor automatically re-equalizes the spectral balance of various
pieces of program material in a way that tends to make their loudness more con-
sistent.

The Five-Band Structure’s Full and Advanced Setup Controls

The tables below summarize the Five-band and Band Mix controls in the dynamics
section. The AGC, Equalizer, Stereo Enhancer, and Clipper controls are common to
both the Two-Band and Five-Band structures and are discussed in their own sections
in Section 3.

Multiband Drive control adjusts the signal level going into the five-band compressor,
and therefore determines the average amount of gain reduction in the five-band
compressor. Range is 25dB. It works differently in INLINE and PARALLEL compressor
modes. In INLINE mode, the control sets the drive into the multiband compression
and thus the amount of gain reduction that it produces.

In parallel mode, the MULTIBAND DRIVE control is repurposed so that it sets the
amount of compressor output that is added to the compressor’s input. Its setting
indicates the amount of amplification of quiet material that occurs when the com-
pressor produces no gain reduction. It does not affect the amount of compressor
gain reduction; set this with the COMPRESSION THRESH OFFSET control, which only
works in parallel mode. See Parallel Compression on page 3-21.

In PARALLEL mode, it is @ mix control located after the multiband compressor and
sets how much of the compressor’s output is added to its input signal before being
passed to the next processing stage.

Adjust the MULTIBAND DRIVE control to your taste and programming requirements.
Used lightly with a slow or medium release time, the Five-Band compressor produces
an open, re-equalized sound that is appropriate for most video programming. The
Five-Band compressor can increase audio density when operated at a fast or medi-
um-fast release because it acts more and more like a fast limiter (not a compressor)
as the release time is shortened. With fast and medium-fast release times, density
also increases when you increase the drive level into the Five-Band compressor be-
cause these faster release times produce more limiting action. Increasing density can
make loud sounds seem louder, but can also result in an unattractive busier, flatter,
or denser sound. It is very important to be aware of the many negative subjective
side effects of excessive density when setting controls that affect the density of the
processed sound.

Because OPTIMOD-PCn’s AGC algorithm uses sophisticated window gating, it is pref-
erable to make the AGC do most of the gain riding (instead of the five-band com-
pressor), because the AGC can ride gain quickly without adding excessive density to
program material that is already well controlled. The five-band compressor is typical-
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ly used with 5 to 10 dB of average gain reduction so it can perform automatic re-
equalization of material that the AGC has already controlled without adding exces-
sive density to the audio or re-equalizing to an unnatural extent.

The MULTIBAND DRIVE interacts with the MULTIBAND RELEASE. With slower release time
settings, increasing the MULTIBAND DRIVE control scarcely affects density. Instead, the
primary danger is that the excessive drive will cause noise to be increased excessively
when the program material becomes quiet. You can minimize this effect by activat-
ing the single-ended noise reduction and/or by carefully setting the MULTIBAND GATE
THRESHOLD control to freeze the gain when the input gets quiet.

When the release time of the Five-Band compressor is set towards FAST, the setting
of the MuLTIBAND DRIVE control becomes much more critical to sound quality be-
cause density increases as the control is turned up. Listen carefully as you adjust it.
With these fast release times, there is a point beyond which increasing the Five-Band
compressor drive will no longer yield more loudness, and will simply degrade the
punch and definition of the sound. Instead, let the AGC do most of the work.

Because excessive loudness is an irritant in sound for picture, there is almost never
any reason to push processing to the point where it degrades the audio. We recom-
mend no more than 10dB gain reduction as shown on the meters for Band 3. More
than 10dB, particularly with the fast release time, will often create a wall of sound
effect that many find fatiguing.

To avoid excessive density with fast Five-Band release time, we recommend using no
more than 5dB gain reduction in band 3, compensating for any lost loudness by
speeding up the AGC RELEASE instead.

Multiband Release; Speech Multiband Release control can be switched to any of sev-
en settings. To understand how to adjust this control for video programming, please

Multiband Attack/Release/Threshold
Advanced Name Range

Multiband Release Slow, Slow2, Med, Med2, MFast, MFast2, Fast
Speech Multiband Release Slow, Slow?2, Med, Med2, MFast, MFast2, Fast

ORBAN MODEL 1600

Loudness Threshold

Off, 0.0 ... -24.0dB

Loudness Attack 0...100%
Loudness Bass Couple 0...12 dB, Off

Bx Compression Threshold -16.00 ... 0.0, Off
Bx Speech Compression Threshold -16.00 ... 0.0, Off

Bx Attack

4.0 ... 50.0 ms, Off

Speech Bx Attack

4.0 ... 50.0 ms, Off

Bx Limiter Attack 0...100%
Bx Delta Release —-6..6
Bx Knee 1...50 dB
Bx Compression Ratio 1:1... 001
Bx Breakpoint 1...50 dB
Transient Enhance 0...10 ms

Table 3-10: Multiband Attack / Release Controls
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see the discussion above under MB DRIVE.

The SPEECH MB RELEASE control overrides the MB RELEASE control when OPTIMOD-
PCn automatically detects speech (page 3-7). You may wish to set the SPEECH MB
RELEASE control faster for speech (to maximize smoothness and uniformity) and
slower on music (to prevent excessive build-up of density).

Figure 3-12 on page 3-28 shows the effect of compressor attack and release on the
amplitude of the audio waveform.

Compression Threshold; Speech Compression Threshold controls set the compression
threshold for music and speech in each band (following OPTIMOD-PCn’s automatic
speech/music discriminator), in units of dB. We recommend making small changes
around the factory settings to preserve the internal headroom built into the pro-
cessing chain. These controls will affect the spectral balance of the processing above
threshold, but are also risky because they can significantly affect the amount of dis-
tortion produced by the back-end clipping system.

You can use these controls to set independent frequency balances for music and
speech (page 3-7).

MB Gate (“Multiband Gate Threshold”) control determines the lowest input level
that will be recognized as program by OPTIMOD-PCn; lower levels are considered to
be noise or background sounds and cause the AGC or multiband compressor to gate,
effectively freezing gain to prevent noise breathing.

There are two independent gating circuits in OPTIMOD-PCn. The first affects the
AGC and the second affects the five-band compressor. Each has its own threshold
control.

The multiband silence gate causes the gain reduction in bands 2 and 3 of the five-
band compressor to move quickly to the average gain reduction occurring in those
bands when the gate first turns on. This prevents obvious midrange coloration un-
der gated conditions, because bands 2 and 3 have the same gain.

The gate also independently freezes the gain of the two highest frequency bands
(forcing the gain of the highest frequency band to be identical to its lower neigh-
bor), and independently sets the gain of the lowest frequency band according to the
setting of the DJ BASS boost control (in the Equalization screen). Thus, without in-
troducing obvious coloration, the gating smoothly preserves the average overall
frequency response “tilt” of the five-band compressor, broadly maintaining the “au-
tomatic equalization” curve it generates for a given piece of program material.

If the MB GATE control is turned OFff, the DJ Bass control (in the Equaliza-
tion screen) is disabled.

Crossover sets the structure of the five-band crossover to ALLPASS or LINEAR.
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In LINEAR mode, the delay through the five-band compressor is essentially constant
at all frequencies. Accordingly, each crossover band is down 6 dB at the crossover
frequency.

In ALLPASS mode, the magnitude response through the crossover is flat when all
bands have the same amount of gain reduction, but the five-band compressor ap-
plies an overall phase rotation to the sound—different frequencies are delayed by
different amounts of time. Each crossover band is down 3 dB at the crossover fre-
guency.

In general, LINEAR sounds more “precise” than ALLPASS and preserves transient detail
better. However, ALLPASS can sound “fuller” or “bigger” than LINEAR. The audible
difference between the two is often subtle and neither is “correct”; choosing a
crossover type is a matter of preference. Most loudspeakers, including many highly
regarded models, use allpass crossovers, and given this fact, it is important not to
assume that LINEAR is always correct just because it introduces no phase distortion.

Figure 3-8 on page 3-19 is a conceptual depiction of the frequency response of the
crossover filters.

B1/B2 Crossover (Band 1 to Band 2 Crossover Frequency) sets the crossover frequency
between bands 1 and 2 to either 100 Hz or 200 Hz. It significantly affects the bass
texture, and the best way to understand the differences between the two crossover
frequencies is to listen.

B1/B2 Crossover Slope (SHALLOW, STEEP) determines the selectivity of the filter used
to separate the frequencies applied to the band 1 and band 2 crossover sidechains,
which compute the gain applied to the audio in each frequency band. The control
does not affect the shape of the crossover in the audio path, only in the sidechain,
where it determines how much the band 1 and band 2 gain reductions are affected
by frequencies outside the main passband of a given band. For example, when this
control is set to STEEP and the B1/B2 CROSSOVER control is set to 200 Hz, a strong
signal at 100 Hz (which is outside the main frequency range covered by band 2) will
produce less gain reduction in band 2 than it would if the control was set to
SHALLOW.

Subjectively, a setting of STEEP produces a more consistent bass texture between
various program elements than does a setting of SHALLOW. STEEP is the preferred
choice if you want consistent, punchy bass texture. On the other hand, SHALLOW pre-
serves more of the original bass coloration of the source because it produces less
gain reduction difference between band 1 and band 2 than does STEEP.

Mono Bass causes the two input channels to be blended to mono below a frequency
set by the MONO BAsSS CROSSOVER control. This function is implemented via a linear-
phase highpass filter applied to the stereo difference channel (L-R). A compensating
delay in the stereo sum channel makes the transition between subjectively perfect
separation and mono as narrowband as possible.

If there is significant bass energy in the L-R channel, this process will reduce the
overall bass heard by the listener. Because the process precedes the multiband com-
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pressor, this will tend to restore this loss of bass by producing less gain reduction in
band 1. This will be most effective if the B1/B2 CROSSOVER SLOPE control is set to
STEEP and you use 100 Hz B1/B2 CROSSOVER.

Sometimes, it is useful to use the bass shelving equalizer in the EQ section to pro-
duce a bit of bass boost to compensate statically for bass loss caused by the mono
bass process.

Mono Bass Crossover (see MONO BASS above)

MB Downward Expander (“Multiband Downward Expander Threshold”) determines
the level below which the single-ended noise reduction system’s downward expand-
er begins to decrease system gain and below which the high frequencies begin to
become low-pass filtered to reduce perceived noise. There are three controls: the MB
DowN EXPANDER and SPEECH MB DOWN EXPANDER controls set the expansion thresh-
old in Bands 1-4 for Music and Speech modes, while the B5 DOWN EXPANDER DELTA
THRESHOLD control offsets the expansion threshold in Band 5 with respect to the ac-
tive MB DoOwN EXPANDER threshold for both Speech and Music modes. Activate the
single-ended dynamic noise reduction by setting these controls to a setting other
than OFF.

The single-ended noise reduction system combines a broadband downward expand-
er with a program-dependent low-pass filter. These functions are implemented by
causing extra gain reduction in the multiband compressor. You can see the effect of
this extra gain reduction on the gain reduction meters. The maximum expander gain
reduction achievable is constrained to 6 dB in bands 2-5 and 18 dB in band 1, as this
range often contains hum and/or rumble that can benefit from extra noise reduc-
tion.

Ordinarily, the gating on the AGC and multiband limiter will prevent objectionable
build-up of noise and you will want to use the single-ended noise reduction only on
unusually noisy program material. Modern commercial recordings will almost never
need it. We expect that its main use will be in talk-oriented programming, including
sports.

Please note that it is impossible to design such a system to handle all program mate-
rial without audible side effects. You will get best results if you set the MB DOwWN
EXPANDER control of the noise reduction system to complement the program materi-
al you are processing. The MB DOWN EXPANDER should be set higher when the input
is noisy and lower when the input is relatively quiet. The best way to adjust the MB
DOWN EXPANDER control is to start with the control set very high. Reduce the control
setting while watching the gain reduction meters. Eventually, you will see the gain
increase in sync with the program. Go further until you begin to hear noise modula-
tion—a puffing or breathing sound (the input noise) in sync with the input program
material. Set the MB DOWN EXPANDER control higher until you can no longer hear the
noise modulation. This is the best setting.

Obviously, the correct setting will be different for a sporting event than for classical
music. It may be wise to define several presets with different settings of the MB
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DOWN EXPANDER control and to recall the preset that complements the program ma-
terial of the moment.

Note also that it is virtually impossible to achieve undetectable dynamic noise reduc-
tion of program material that is extremely noisy to begin with, because the program
never masks the noise. It is probably wiser to defeat the dynamic noise reduction
with this sort of material (traffic reports from helicopters and the like) to avoid ob-
jectionable side effects. You must let your ears guide you.

Band 5 is particularly critical for noise reduction because much of the Downward
Expander’s utility lies in hiss reduction. Hiss has most of its energy in band 5, while
program material typically has less energy in this band, so the B5 DOWN EXPANDER
control’s setting is critical to removing hiss while minimizing removal of desired pro-
gram energy.

Band 5 is uncoupled from the lower bands so the band 5 downward expander can
produce less gain reduction than other bands. This can help prevent loss of desired
high frequency material in the program.

B3>B4 CPL (“Band 3>4 Coupling”) control determines the extent to which the gains
of band 4 (centered at 3.7 kHz) and 5 (above 6.2 kHz) are determined by and follow
the gain of band 3 (centered at 1 kHz). Set towards 100% (fully coupled) this control
reduces the amount of dynamic upper midrange boost, preventing unnatural upper
midrange boost. The gain of band 5 is further affected by the B4>B5 CPL control.

Excessive HF energy is one cause of audibly objectionable artifacts in low bitrate co-
decs. The B3>B4 CpL AND B4>B5 CpPL controls can be very useful in reducing such arti-
facts: Setting them for large amounts of coupling will minimize OPTIMOD-PCn’s abil-

Advanced Name Range
B2>B1 Coupling 0...100 %
B2>B3 Coupling 0...100 %
B3>B2 Coupling 0...100 %
B3>B4 Coupling 0..100 %
B4>B5 Coupling 0...100 %
B1 Output Mix -6.0...+6.0
B2 Output Mix -6.0... +6.0
B3 Output Mix -6.0... +6.0
B4 Output Mix -6.0... +6.0
B5 Output Mix -6.0...+6.0
B1 On/Off On, Off

B2 On/Off On, Off

B3 On/Off On, Off

B4 On/Off On, Off

B5 On/Off On, Off

Table 3-11: MB Band Mix Controls
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ity to increase high frequency energy dynamically.

B4>B5 CPL (“Band 4>5 Coupling”) controls the extent to which the gain of band 5
(6.2 kHz and above) is determined by and follows the gain of band 4.

The sum of the high frequency limiter control signal and the output of the B4>B5
CPL control determines the gain reduction in band 5. The B4>B5 CPL control re-
ceives the independent left and right band 4 gain control signal. Range is 0 to 100%
coupling.

B3>B2 Coupling and B2>B3 Coupling controls determine the extent to which the
gains of bands 2 and 3 track each other.

When combined with the other coupling controls, these controls can adjust the five-
band processing to be anything from fully independent operation to quasi-
wideband processing.

B2>B1 Coupling control determines the extent to which the gain of band 1 (below
100Hz or 200Hz, depending on crossover setting) is determined by and follows the
gain of band 2 (centered at 400Hz). Set towards 100% (fully coupled), it reduces the
amount of dynamic bass boost, preventing unnatural bass boost. Set towards 0%
(independent), it permits frequencies below 100Hz (the “slam” region) to have max-
imum impact in modern rock, urban, dance, rap, and other music where bass punch
is crucial. Accordingly, it can be useful in music video oriented formats.

Bx Output Mix Because these controls mix after the band compressors, they do not
affect the compressors’ gain reductions and can be used as a graphic equalizer to
fine-tune the spectral balance of the program material over a +6 dB range.

Their range has been purposely limited because the only gain control element after
these controls is the look-ahead limiter, which can produce pumping or distortion if
overdriven. The thresholds of the individual compressors have been tuned to pre-
vent audible distortion with almost any program material. Large changes in the fre-
quency balance of the compressor outputs will change this tuning, leaving
OPTIMOD-PCn more vulnerable to unexpected audible distortion with certain pro-
gram material.

You can also get a similar effect by adjusting the compression threshold of the indi-
vidual bands. This is comparably risky with reference to look-ahead limiter overload,
but unlike the MB BAND Mix controls, the threshold adjustments do not affect the
frequency response when a given band is below threshold and is thus producing no
gain reduction.

B1-B5 On/Off switches allow you to mute any combination of bands in the five-band
compressor and permit you to “solo” any individual band. This can be useful when
you are designing new user presets.

B1-B5 Attack (Time); Speech B1-B5 Attack controls set the speed with which the gain
reduction in each band responds to level changes at the input to a given band’s
compressor for music and speech respectively, following OPTIMOD-PCn's automatic
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speech/music detector. These controls are risky and difficult to adjust appropriately.
They affect the sound of the processor in many subtle ways. The main trade-off is
“punch” (achieved with slower attack times) versus distortion and/or pumping pro-
duced in the look-ahead limiter (because slower attack times increase overshoots
that the look-ahead limit must eliminate). The results are strongly program-
dependent and must be verified with listening tests to a wide variety of program
material.

Because there are separate controls for music and speech (page 3-7), you can set at-
tack times faster for speech (to minimize look-ahead limiter artifacts) and slower for
music (to maximize punch and transient definition).

The ATTACK time controls are calibrated in arbitrary units that very approximately
correspond to milliseconds. Higher numbers correspond to slower attacks.

Limiter Attack controls allow you to set the limiter attack anywhere from 0 to 100%
of normal in the Five-Band compressors, each of whose gain reduction has a fast-
release (limiter) and slow-release (compressor) component. Because the limiter and
compressor characteristics interact, you will usually get best audible results when
you set these controls in the range of 70% to 100%. Below 70%, you will usually
hear gain pumping because the compressor function is trying to create some of the
gain reduction that the faster limiting function would have otherwise achieved. If
you hear pumping in a band and you still wish to adjust the limiter attack to a low
setting, you can sometimes ameliorate or eliminate the pumping by slowing down
the compressor attack time in that band.

These controls have nothing to do with the final peak limiter.

Delta Release controls are differential controls. They allow you to vary the release
time in any band of the Five-Band compressor/limiter by setting an offset between
the MULTIBAND RELEASE setting and the actual release time you achieve in a given
band. For example, if you set the MULTIBAND RELEASE control to medium-fast and the
BAND 3 DELTA GR control to -2, then the band 3 release time will be the same as if
you had set the MULTIBAND RELEASE control to medium and set the BAND 3 DELTA GR
control to 0. Thus, your settings automatically track any changes you make in the
MULTIBAND RELEASE control. In our example, the release time in band 3 will always be
two “click stops” slower than the setting of the MULTIBAND RELEASE control.

If your setting of a given DELTA RELEASE control would otherwise create a release
slower than “slow” or faster than “fast” (the two end-stops of the MULTIBAND
RELEASE control), the band in question will instead set its release time at the appro-
priate end-stop.

Band 1-5 Max Delta GR controls set the maximum permitted gain difference be-
tween the left and right channels for each band in the multiband limiter. The five-
band processing chain uses a full dual-mono architecture, so the channels can be
operated anywhere from fully coupled to independent. We recommend operating
band 1-4 fully coupled (BAND 1-4 MAX DELTA GR = 0) for best stereo image stability.
However, audio-processing experts may want to experiment with lesser amounts of
coupling to achieve a wider, “fatter” stereo image at the cost of some image insta-
bility.
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B5 MAX DELTA GR is set OFF most factory presets. This permits band 5 to be used as a
fast-operating high frequency limiter that works independently on the left and right
channels. This prevents gain reduction in one channel from causing audible spectral
modulation on the other channel. However, the additional stereo difference chan-
nel energy created by independent operation can adversely affect certain low bi-
trate codecs (like WMA). It is wise to do careful listening tests through the codec to
determine if it sounds better with B5 MAX DELTA GR =0 dB.

B1-B5 Compression Ratio sets the compression ratio of a given band at its thresholds
of compression. Beyond threshold, the ratio increases with increased gain reduction
until it becomes «:1 at the amount of gain reduction (in dB) set by the B[X]
COMPRESSOR KNEE control. When you adjust these controls, the thresholds of the
multiband compressors change automatically so that the total amount of gain re-
duction stays approximately the same. (This automatic adjustment is internal to the

1z
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20 24 28 32 35 4i

Figure 3-16: Output level in dB (y) for a given input level in dB (x) at various settings of the
KNEE and RATIO control
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1600's DSP; the MB THRESH controls’ displayed settings do not show it.)

To achieve a classic soft knee characteristic, set the COMPRESSION RATIO control to 1:1
and set the COMPRESSION KNEE control to the gain reduction in dB at which you wish
the compression ratio to level off to «:1. The maximum setting produces the softest
knee. Setting the KNEE to 0 dB produces a classic hard knee curve with «:1 compres-
sion ratio regardless of the setting of the corresponding COMPRESSION RATIO control.

See Figure 3-16 on page 3-71 for the curves of output level vs. input level for various
settings of the KNEE and RATIO controls. See Figure 3-9 on page 3-22 for the in-
put/output curve in parallel compression mode.

Compression Knee (see COMPRESSION RATIO above).

Compression Breakpoint The release rate (measured in dB/second) in the 1600’s com-
pressors is constant when the gain reduction is higher than the control’s setting, and
exponential when the gain reduction is lower than the control’s setting.

When the release is exponential, the release rate is proportional to the amount of
gain reduction..

Compression-induced audio density remains constant when the gain reduction is
above the BREAKPOINT setting. When the gain reduction is below the BREAKPOINT
setting, density decreases proportionally to the amount of gain reduction.

For example, if the BREAKPOINT is set to 10 DB, the release rate (in dB/second) will be
constant when the gain reduction is above 10 dB. Between 10 dB and 0 dB gain re-
duction, the release rate will slow down more and more.

The calibration of the BREAKPOINT controls is only accurate when KNeEe = 0 dB and/or
RATIO = infinity:1 — i.e., when the compression ratio is essentially infinite. When the
ratio is less than infinite, the effective breakpoint of the compressor will be lower
than COMPRESSOR BREAKPOINT setting.

The main use of the COMPRESSOR BREAKPOINT control is to prevent the compressor
from objectionably increasing audio density when using low compression ratios and
a significant amount of gain reduction—for example, 10 dB. The BREAKPOINT control
is best adjusted by ear. If you find that density increases too much as gain reduction
increases, lower the COMPRESSOR BREAKPOINT control’s setting. If you want more
density at high amounts of gain reduction, increase the COMPRESSOR BREAKPOINT
control’s setting. 10 dB is a good starting point for setting this control.

Loudness Threshold sets the maximum subjective loudness allowed by the CBS Loud-
ness Controller with reference to the input of the 1600's MB look-ahead limiter. (See
Loudness Control on page 3-24.)

Loudness Controller Attack: See Loudness Control on page 3- 24.

Loudness Controller Bass Couple: See Loudness Control on page 3- 24.
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BS.1770 Threshold: See BS.1770 Safety Limiter on page 3-26.

Compressor Mode: See Parallel Compression on page 3-21.

Compression Thresh Offset: is active only in parallel compression mode. See Parallel
Compression on page 3-21.

Peak Limiter

Regardless of whether MX mode is ON or OFF, a bass pre-limiter stage controls low
frequency peaks ahead of the main peak limiter, while a “true-peak”-aware look-
ahead limiter (equivalent to the look-ahead limiter in Orban products like
OPTIMOD-PC 1101) implements final peak control. This limiter typically constrains
the true peak overshoot (i.e., the maximum peak value that would appear after an
ideal digital-to-analog converter) to 0.2 dB or less. (See Figure 3-10: Peak Limiter
Output vs. Input on page 3-23.)

OPTIMOD-PCn’s OuTtPuT meter shows peak levels based on audio sample
values. To assess the accuracy of OPTIMOD-PCn'’s true peak limiting, you
can use the free Orban Loudness Meter, available for download from
www.orban.com/meter. This displays the “Reconstructed Peak” level,
which is the same as “True Peak” level.

Bass Clip Threshold sets the threshold of the bass pre-limiter with respect to the
threshold of the final peak limiter. The BASS LIMITER gain reduction meters show the
amount of bass clipping or limiting in each audio channel.

The SPEECH BASs CLIP THRESHOLD control overrides the BASS CLIP THRESHOLD control
when OPTIMOD-PCn automatically detects speech (page 3-7).

Bass Pre-Limit Mode sets the operation of the bass pre-limiter to HARD, MEDIUM, or
SOFT. In surround instances this control does not work when the MX limiter is OFF;
in this case the bass clip mode is always MEDIUM.

e HARD produces the most midbass harmonic enhancement.

This can be useful if you want maximum bass punch, because this setting
allows bass transients (like kick drums) to make square waves. The peak
level of the fundamental component of a square wave is 2.1 dB higher
than the peak level of the flat top in the square wave. Therefore, this al-
lows you to get low bass that is actually higher than 100% modulation
(or 0 dBFS)—the phase of the harmonics produced by the clipping works
to reduce the peak level of the overall program.

The squarewaves produced by this clipper are lowpass-filtered to reduce
the audibility of the higher clipper-generated harmonics. Nevertheless,
the downside is that material with sustained bass (including speech) can
sound somewhat less clean than it will with the MEDIUM or SOFT settings.

The HaRD clip algorithm used in 1600 is improved compared to that used
in older Optimods. It uses a different algorithm that is less likely to cause


http://www.orban.com/meter

3—74 OPERATION ORBAN MODEL 1600

audible distortion, so HARD bass clipping in the 1600 is more useful than
it was in older Optimods.

e MEDIUM uses more sophisticated signal processing than HARD to reduce distortion
substantially.

e SOFT uses the most sophisticated look-ahead signal processing to reduce distor-
tion further.

The tradeoff of using MEDIUM or SOFT bass clipping is less bass punch compared to
HARD.

MB Final Limit Drive control adjusts the level of the audio driving the peak limiter,
thereby adjusting the peak-to-average ratio of the processed audio. The MB FINAL
LimiT DRIVE control primarily determines the loudness/distortion trade-off.

Turning up the MB FINAL LIMIT DRIVE control drives the look-ahead limiter harder,
reducing the peak-to-average ratio, and increasing the loudness of the output.
When the amount of limiting is increased, the audible intermodulation distortion
caused by limiting increases, even though special algorithms minimize the increase
compared to less sophisticated designs. Lower settings reduce loudness, of course,
but result in a cleaner sound.

The MX peak limiter uses a variety of tactics to adapt its operation intelligently to
the program material applied to it. Compared to the look-ahead peak limiter in
non-MX mode, the MX peak limiter produces a different set of artifacts when over-
driven. Depending on how you set the other controls, these artifacts may include
loss of bass punch, harsh clipper-like distortion, “soft” IM distortion, and/or excessive
density that can cause fatigue. If you intend to make adjustments to the FINAL LIMIT
DRIVE control, it is wise to familiarize yourself with these artifacts by purposely over-
driving the peak limiter via the MB FINAL LIMIT DRIVE control and listening to what
happens with different types of program material.

When using preemphasis, it is usually necessary to turn down the MB FINAL LiMIT

Peak Limiter Controls

Name Range

Bass Clip Shape 0.0...10.0

Bass Clip Threshold -6.0 ... +6.00, Off
Bass Limiting 0...-6
BassPre-Limit Mode (all modes except surround MX-OFF) Soft, Medium, Hard
Bass Pre-Limiting (all modes except surround MX-OFF) 0...1

Distortion Control (MX mode only) 0...1

HF Distortion Control (MX Mode only)

Final Limit Drive -10.0 ... +12.0
MX Limiter On, Off

MX Limiter Threshold (all modes except surround MX-OFF) -6.0 ... +6.00, Off
MX Qvershoot Limit Mode (MX mode only) Hard, Soft
Speech Bass Clip Threshold -6.0 ... +6.00, Off
Transient Enhance 0...10 ms

Table 3-12: Peak Limiter Controls
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DRIVE control to prevent the peak limiter from causing objectionable artifacts.

You may find it illuminating to recall several Factory Presets, adjust LEss-
MORE to several points in its range, and then open the Full Control screen
to examine the trade-offs between the release time and FiNAL LiMIT drive
made by the factory programmers. However, note that all Factory Presets
were created to complement FLAT preemphasis. As explained above, you
must turn down the FINAL LimiT DRIVE control when using preemphasis.

Transient Enhance is mainly useful in mastering. This control allows you to insert an
audio delay in the sidechain of the five-band compressor. By delaying the gain con-
trol signal, this allows attack transients to pass through the multiband compressor
uncompressed, which can increase punch. There is a tradeoff between this control
and the activity of the look-ahead limiter, which will have to eliminate attack transi-
ents exceeding the look-ahead limiter’s threshold. For any material, there will be an
optimum setting for the TRANSIENT ENHANCE control that provides the most punch
without triggering peak limiter artifacts.

MX Technology and Non-MX Stereo/Mono Peak Limiter Controls

MX Limiter When MX LIMITER is ON, additional peak control occurs between the bass
pre-limiter and the look-ahead limiter, and the look-ahead true-peak limiter is used
very lightly for final overshoot control only. When the peak limiter section is being
driven heavily, the MX peak limiter, which uses a psychoacoustic model, provides
decreased audible distortion, more transient punch, a degree of “exciter”-like har-
monic enhancement that you can adjust with the HF DISTORTION CONTROL control,
and a crisper, more open high frequency texture.

When MX LIMITER is OFF in stereo and mono instances, the MX pre-processing is still
active to reduce the drive into the final look-ahead limiter and control potential IM
distortion. Surround instances omit the pre-processing in non-MX mode. Non-MX
mode is more likely to cause audible gain pumping when driven heavily.

The MX limiter has two downsides: its sophisticated processing increases the amount
of CPU power required compared to non-MX mode, and it adds up to several hun-
dred milliseconds of input-to-output delay. The delay is required so that the MX lim-
iter has time to make intelligent decisions about how to process. In stereo and mono
instances, non-MX mode has the same delay as non-MX SOFT mode; in surround
mode, the delay is lower in non-MX mode.

Defeating the MX limiter can allow more instances of processing to be run on the
CPU.

When the target loudness is below —12 LUFS (as is typical for material “mastered for
iTunes®”), the MX limiter is unlikely to provide significant audible advantages be-
cause the overall peak limiter section is not being driven hard, so the non-MX look-
ahead limiter (which is itself quite capable) is unlikely to produce audible artifacts
when used alone. If you want to minimize CPU usage, it is wise to perform listening
tests to see if the MX limiter provides audible advantages with your program mate-
rial.
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In mastering applications, on the other hand, neither CPU usage nor delay are usual-
ly relevant, so you may wish to save time by always activating the MX limiter be-
cause it will very seldom degrade the sound compared to not using it.

When the target loudness is below —22 LUFS (as is typical is sound-for-picture appli-
cations), the MX limiter never provides audible advantages because at this target
loudness, the peak limiter rarely produces any gain reduction at all.

The only exception to these recommendations is when preemphasis is enabled.
When you use OPTIMOD-PCn in a preemphasized mode (step 4.C) on page 2-18), this
inserts a frequency-dependent high frequency boost before peak limiter. This boost
can be as large as 20 dB at 20 kHz. The peak limiter handles this boost far more
smoothly when the MX limiter is active, so we strongly advise always using the MX
limiter when you use preemphasis.

The three controls described below are active except in surround instances when the
MX limiter is OFF. They allow you to trade off loudness, distortion, and bass energy.
Increasing bass increases the likelihood that audible IM distortion between bass and
other program elements will occur. Depending on the program material you are
processing, you may prefer to have a cleaner sound (with less bass) or a sound with
more distortion but punchier bass. We offer controls, explained below, that allow
you to make this tradeoff.

MX Limiter Threshold sets the threshold of the peak limiter with respect to the
threshold of the final look-ahead limiter, used for overshoot control. This control is
normally set to 0 dB. When the peak limiter is driven very hard (as determined by
the setting of the MB FINAL LiMIT DRIVE control), setting the MB LIMITER THRESHOLD
slightly below 0 dB can reduce gain pumping artifacts that would otherwise be
caused by the final look-ahead limiter.

Bass Pre-Limiting / Speech Bass Pre-Limiting The bass pre-limiter can intelligently re-
duce the bass applied to the main peak limiter to reduce or prevent audible IM dis-
tortion. It does so when the pre-limiter’s analysis of the program material indicates
that this action is needed to prevent or minimize audible IM distortion between the
bass (125 Hz and below) and other program elements in the main peak limiter. The
BAss PRE-LIMITING control allows you to specify the maximum amount of bass reduc-
tion that can occur. Lower settings increase bass punch but do not protect against
IM distortion as effectively as higher settings do.

There are two controls, one for Speech mode and one for Music mode, allowing you
to have separate settings depending on whether OPTIMOD-PCn automatically de-
tects speech or music input.

Bass Limiting Like the bass pre-limiter, the main peak limiter can automatically re-
duce bass when it detects potentially audible IM distortion. The BASS LIMITING control
allows you to limit the amount of potential bass reduction at the expense of a pos-
sible increase in IM distortion. The scale shows the maximum amount of dynamic
bass cut that can be produced, in dB.

The three controls below are available only in MX mode.
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Distortion Control This control determines the amount of audible distortion that the
main peak limiter is permitted to create. Higher settings can increase loudness and
punch at the expense of audible clipping distortion. Lower settings are cleaner but
may reduce punch and loudness. We prefer it at 0, which is its cleanest setting. All
MX factory presets use this setting.

The best way to familiarize yourself with the effects of this control is by listening
extensively to different types of program material while experimenting with differ-
ent settings of the control. Because the MX peak limiter uses advanced algorithms
that differ from those used by past Orban processors, the loud-
ness/distortion/brightness/punch tradeoffs are also different and it is worthwhile to
take the time to get a feel for the MX limiter’s capabilities.

HF Distortion Control determines the amount of program-adaptive harmonic en-
hancement that the MX limiter is permitted to create around 6 kHz. “1.0" gives the
same amount of harmonic enhancement as previous versions of the software.

Turning down the control produces a cleaner sound that is less bright, but may have
more “peak limiter” sound as the limiter's internal overshoot compensator works
harder.

MX Overshoot Limit Mode (HARD, SOFT) determines the algorithm used to eliminate
overshoots produced by the main part of the MX processing. HARD uses a complex,
computationally intensive process that shares certain characteristics with clipping,
while SOFT uses a look-ahead limiter. In general, low bitrate codecs will handle SoFT
mode better than HARD mode.

HARD produces punchier transients and is often preferred when the absolute maxi-
mum loudness is desired. It adds about 200 ms of delay compared to SOFT, and this
is easy to hear when one is switching back and forth between HARD and SOFT
modes. (Switching between modes produces audible discontinuities and should not
be done “on-air.”)

For applications where the MX limiter is not driven to its limits, SOFT may be pre-
ferred because it has less distortion and loads the CPU significantly less. As always,
you should choose based on program material and processing goals. Subjectively, it
might be said that HARD is more “rock ‘n’ roll,” while SOFT is more “polite.”

HARD mode is very CPU-intensive and can overload some computers. See the Warn-
ing on page 3-35.

Note: Because the 1600 PCn software is not licensed as a processor for FM radio,
HARD mode is locked out when the pre-emphasis is set to 50 ps or 75 ps.

Phase Corrector Controls

These controls are located in the LESS-MORE tab. See Left/Right Phase Skew Correc-
tion on page 3-14. Because the phase corrector is automatically bypassed when the
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Optimod MODE is AUTO or UPMIX, you must use the Optimix delay corrector if you
wish to phase-correct an upmix.

Phase Corrector Controls

Name Range
Phase Corrector In, Out
Phase Corrector Crossover 62.5...796 Hz

Table 3-13: Phase Corrector Controls

Downmix Controls

[Downmix #2 is not available in v 0.9.10 software.]
Except as noted, these controls are located in the DOwNMIX tab.
Loudness Threshold sets the maximum subjective loudness allowed by the CBS Loud-

ness Controller with reference to the input of the 1600’s MB look-ahead limiter. (See
Loudness Control on page 3-24.)

Loudness Controller Attack: See Loudness Control on page 3- 24.

Loudness Controller Bass Couple: See Loudness Control on page 3- 24.

Downmix Controls

Name Rang_;e

HF Limiter —6.0...+6.0 dB
Drive Trim —6.0...+6.0 dB
Loudness Threshold —14.0...+10 dB, Off
Loudness Attack 0...100%
Loudness Bass Couple 0...12 dB, Off
BS1770 Safety Limiter 0...+6 dB, Off
Loudness Attack 0...100%

I/O CONTROLS:

Downmix Center —6.0...+3.0 dB
Downmix Surround —6.0...+3.0 dB
Downmix Back —6.0...+3.0 dB
Downmix 1 Target Loudness -31...-.5 LUFS
Downmix 2 Target Loudness -31....5LUFS
Downmix Output Level —6.0...0.0 dBFS
Downmix Proc Pre-emphasis Flat, 50us, 75 us
Downmix Output Pre-Emphasis Flat, Pre-emph

Table 3-14: Downmix Controls
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BS.1770 Threshold: See BS.1770 Safety Limiter on page 3-26.

Downmix Center / Surround / Back (in I/O > Downmix) set the contribution of the
center, surround, and back (7.1 only) channels to the downmix.

Drive Trim trims the drive level into the downmix HF limiter and loudness controllers
over a range of +6 dB. To permit the downmix loudness to track the surround loud-
ness, the sum of the DRIVE TRIM and Surround MB LIMITER DRIVE controls sets the
drive into the downmix HF limiter and loudness controllers.

Use the DRIVE TRIM control to make fine-tune the downmix loudness, which can be
read from the downmix’s loudness meters.

This control is needed because the surround loudness meters and control-
lers operate on the power sum (RMS sum) of the surround channels,
whereas the downmix is a voltage sum, where the mix of the channels is
set by the I/O > DowNmix > DowNMIX CENTER / DOWNMIX SURROUND / DOWNMIX
BAck controls. This can cause the loudness of the downmix not to track
the loudness of the surround.

The best way to make sure that the loudness of the downmix never ex-
ceeds the DowNMIX TARGET LOUDNESS is to activate the downmix loudness
controllers and then adjust the DRIVE TRiM control so that a slight amount
of loudness controller gain reduction always occurs for program material
at normal levels. Normally, no more than 2 dB of DRIVE TRIM adjustment
is needed to achieve this.

Downmix 1/2 Target Loudness: (in I/O > Downmix) These are gain controls between
the output of the downmix loudness controller and the inputs of the output 1 and
output 2 HF limiter / peak limiter chains. The controls scale the output of the loud-
ness controller so that when the BS1770 Safety Limiter = 0 LU, the BS1770 loudness
will be constrained to the Target Loudness value.

Downmix Output Level sets the maximum peak level produced by the processing. It
does not adjust loudness. Do that with the Downmix #1 or #2 TARGET LOUDNESS con-
trol.

Downmix Proc Pre-emphasis determines if the input to the HF limiter and peak limit-
er is flat or if it has 50 ps or 75 ps pre-emphasis applied to it. Pre-emphasis is useful
when driving analog channels like an analog TV transmitter.

Downmix HF Limiter Is a split band limiter that operates above 6 kHz to reduce pre-
emphasis-induced overload when the downmix is being operated PRE-EMPHASIZED.

Test Modes

The Test Modes screen allows you to switch between OPERATE, BYPASS, and TONE.
When you switch to BYPASS or TONE, OPTIMOD-PCn saves the preset you had on-air
and will restore it when you switch back to OPERATE. Even if you had been editing a
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preset and did not yet save these changes as a User preset, you will not lose the edits
you made.

Available Tone waveforms are SINE, SQUARE, and PINK NOISE.
The pink noise spectrum is accurate to +0.05 dB, 20-20,000 Hz.
"Squarewaves” are available up to 1 kHz.

Your Optimod is a band-limited system (like any digital system). Because
of the Gibbs phenomenon, no band-limited system can produce true
squarewaves without overshoot. Instead, your Optimod generates useful
squarewave-like waveforms without overshoot by applying a waveform
whose sample values periodically switch between +1 and -1 to a non-
overshooting pulse-shaping lowpass filter. This eliminates overshoot at
the cost of increasing the risetime of the “squarewave” edges.

The main purpose of these waveforms is to test the transmission system
following the Optimod to determine if the path introduces overshoot,
tilt, or ringing into the “squarewave.” This is particularly important if you
are using an analog signal path after the Optimod because the -3 dB fre-
quency of the path must be 0.15 Hz or lower to prevent 50 Hz
squarewaves from overshooting more than 1% and increasing peak lev-
els.

To prevent aliasing and ensure that only odd-order harmonics are gener-

Setup: Test
Parameter Labels Units Default Range (CCW to CW) Step
Mode --- Operate Operate, Bypass, Tone
Tone Waveform - - Sine, Square, Pink Noise
Bypass Gain dB 0.0 -18...+25 1
Tone Frequency Hz 400 16, 20, 25, 31.5, 40, 50, LOG
(Sine) 63, 80, 100, 125, 160,

200, 250, 315, 400, 500,

630, 800, 1000, 1250, 1600,

2000, 2500, 3150, 4000, 5000,

6300, 8000, 9500, 16000, 12500,

13586.76, 15000, 20000
Tone Frequency Hz 400 16, 20, 25, 31.5, 40, 50, LOG
(Square) 63, 80, 100, 125, 160,

200, 250, 315, 400, 500,

630, 800, 1000
Tone Level % 100 0..121 1
Lf Tone Bypass Off, On, Bypass
Rf Tone Bypass Off, On, Bypass
Ls Tone --- Bypass Off, On, Bypass
Rs Tone --- Bypass Off, On, Bypass
C Tone Bypass Off, On, Bypass
LFE Tone Bypass Off, On, Bypass
Lb Tone --- Bypass Off, On, Bypass
Rb Tone --- Bypass Off, On, Bypass

Table 3-15: Test Modes
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ated, the source waveform is generated at 192 kHz sample rate and has
an identical, integer number of samples in its “+1” and “-1" segments.
Hence, output frequencies that are not submultiples of 96 kHz (like 315
Hz) will differ from their labeled values by a few percent. This causes no
problems when testing transmission systems.

Table 3-15: Test Modes on page 3-80 shows the facilities available, which should be
largely self-explanatory.

In TONE mode, any channel can be set to OFF (the tone is off). ON (the tone is on) or
ByPAss (equivalent to placing that channel in BYPASS mode). When bench testing
OPTIMOD-PCn, you can cause one hardware output to emit a tone while leaving the
remaining channels in BypAass. This eliminates the need for an external test oscilla-
tor.

Using Optimod-PCn for Offline File Processing

Wawve File Processar

—File Processor uses settings from Processaor 1

[~ select Input Folder [~ select Output Folder

Select Files IJsing same as Input Folder

Beqin Processing

—File Processor Status

Cancel |

Optimod-PCn provides basic offline file processing functionality via the
EDIT>PROCESS FILE menu item. Only 16-bit and 24-bit linear PCM stereo.wav files at
44.1 kHz, 48 kHz, 96 kHz, and 192 kHz sample rates are supported. To avoid com-
promising quality, MP3 is not supported.
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If the input file contains metadata such as INFO List, ID3v2, Cart Chunk (AES46-2002),
and/or Broadcast WAVE Format (BWF) “bext” metadata, Optimod-PCn will copy this
metadata to the output file.

File processing does not interrupt streaming on active Processors. To determine the
number of Processors available for file processing, your Optimod subtracts the num-
ber of actively streaming processors (as shown in the NUMBER OF PROCESSORS field in
TOOLS>SERVICE SETTINGS) from the total number of stereo plus surround processors
available from your USB key or CodeMeter authorization (as shown in the
PROCESSOR CONFIGURATIONS AVAILABLE field in TOOLS>SERVICE SETTINGS) and dedicates
the unused processors to file processing (up to a maximum of 16 processors). If you
are using all of your available processors for streaming, your Optimod will create
one “extra” processor and dedicate it to file processing.

Processing speed depends on the host computer’s CPU and the number of Processors
available for file processing. If the CPU is capable of glitch-free processing in your
Optimod'’s live streaming mode, file processing will be somewhat faster than real-
time. When processing all the files in a folder, your Optimod will open each file in
an available processor and will process the files in parallel. For example, if you are
processing a folder with four or more files and the Number of Processors is four, this
will approximately quadruple the processing speed compared to having just one
Processor.

You can choose to process a single file or all files in a specified folder. Output files
have the same name as the input files except that out is appended to the file
name. You may specify separate Input and Output folders; if you do not specify an
Output folder, the output files will be written to the Input folder.

The output file is the same size as the source file. Therefore, we recommend having

at least 50 ms of silence at the be-
ginning and end of the source file
to accommodate both slight uncer-

General Sharing Securty Previous Versions Customize o i X
tainties in processing delay com-

Object name:  D:\Temp'Tones pensation and processes like the

Group or user names: subharmonic synthesizer  and
multiband compressor that use fil-
2 Robert (DelT7500"\Robert) ters whose transient response can
{o Admiistrator (Del T7500\Administrator) slightly extend the active length of

the output file compared to the

To change pemissions, click Edit. Edit_ mpUt file.

Pemmissions for SYSTEM Allow Deny Because the file processor runs as a
Modiy - Windows Service, the folder con-
Read & exscute W, taining the source and output files
List folder contents v must have Administrator and Sys-
Read v tem security access in Windows. The
Witte v Input folder must have Read per-
Special pemissions v mission and the Output folder must

For special permissions or advanced settings, Advenced have Write permission. To verify

click Advanced. and (if necessary) implement this,

Cancel Aoy
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right-click the folder and choose PROPERTIES> SECURITY. The “Group or user names”
box must include “Administrators” and “SYSTEM."” If not, click EDIT and then in the
“Permissions for ‘Folder name'” box that appears, click ADD. After you have added
" Administrators,” click it and check the READ and WRITE permissions in the “Permis-
sions for Administrators” box. Do the same thing for SYSTEM.

File processing uses Processor 1’s current processing and system settings.

Your Optimod does not have a built-in player to preview file processing, so you must
use an external player like Windows Media Player. Because file processing uses Pro-
cessor #1's settings, we suggest using Processor 1's streaming functionality to pre-
view and adjust the file processing. The rest of your available processors can be used
for a combination of streaming and file encoding

A) To preview, use the CONNECT menu to connect to Processor #1.

B) Open the file in the external player and play it out while listening to the Op-
timod’s output. (For example, you could connect the player to the Optimod’s
Processor 1 input via Virtual Audio Cable.) While listening, choose and/or cus-
tomize a preset to taste.

Note that if you are preparing files for a playout system to feed a stream
having no online audio processing, you must know the target loudness of
the stream and must set the Optimod’s TARGET LOUDNESS (in the 2.0 LEss-
MoRE tab) to match. Doing this will calibrate the Optimod’s loudness me-
ters so that “0” corresponds to the target loudness. If you are customiz-
ing a preset, you may use these meters to guide your adjustments so that
the loudness of the processed files will be correct. See About Target
Loudness and ITU-R BS.1770 starting on page 1-16.

Also note that file processing cannot be aware of boundaries and transi-
tions between program elements contained in multiple files. For exam-
ple, if you mix two loudness-normalized files, the loudness of the mix can
be 3 (or more) dB higher than target loudness. For this reason, we believe
that for streaming applications, online, live Optimod-PCn processing is
likely to provide the best possible listening experience.

C) Once you have tuned the processing to your liking, choose the FILE>PROCESS
FILE menu item. This will temporarily disconnect the GUI from Processor 1.

D) Using the SELECT INPUT FOLDER and SELECT OUTPUT FOLDER checkboxes and
SELECT FILES or SELECT FOLDER button, choose the file or folder you wish to
process and the destination folder.

If you check SELECT INPUT FOLDER, your Optimod will process all the source
files in the folder that you choose after you click SELECT FOLDER. If you do
not check SELECT INPUT FOLDER, your Optimod will process just the file you
choose after you click SELECT INPUT FILE.

E) Click BEGIN PROCESSING. Any streaming that is occurring on other Processors
will continue, and the File Process Status Window will display the processing’s
progress.

Until the processing is complete and you have clicked the DoNE button (or un-
til you click the CANCEL button), you will not be able to reconnect the GUI to a
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Processor. If you were connected to Processor 1 prior to invoking the
FILE>PROCESS FILE menu item, clicking the DONE or CANCEL buttons will re-
connect the GUI to the Processor automatically.

If the CANNOT OPEN FILE error message appears, correct the security per-
missions for the input and output folders per the instructions on page 3-
82.

Figure 3-17 shows the typical file processing speed for a 6t"-generation i7 CPU as a
function of CPU clock speed and the limiting algorithm in use: no MX, MX SoFT, and
MX HARD. The measurements for this graph were made on a Dell Precision 3620 with
a solid-state drive, 16 GB of RAM, and an Intel i7 7700K 4.2 GHz (4.37 GHz meas-
ured) CPU running Windows 10 Pro. The “Processing Time"” as a function of CPU
clock speed was based on the 4.37 GHz measurements with the assumption that
processing speed is linearly proportional to clock frequency.

Using the Graph: To estimate the time required to process a given file, on the graph
find the “processing time"” based on your CPU speed and limiter algorithm; then di-
vide the real-time speed of your file by the speed-up factor. For example, if your file
is 5 minutes long, your CPU is clocked at 4.0 GHz, and the MX limiter is off in the
active preset, the curve shows a speed-up of about 6x, so the file will take approxi-
mately 5/6 minutes (50 seconds) to process.

Note that there is an initialization time of 5-10 seconds before the file processing
starts, so counting initialization, shorter files will produce less speed-up than longer
files.

Using the API for File Processing
Your Optimod’s API provides commands to process files. This allows you to automate

Orban Optimod-PCn File Processing Time
1-300sec/5 min File

fl A
S

// MX Limit HARD
1 4.

== MX Limit OFF

CPU Speed
[GHz]
N w

[x Realtime]
Processing Time

Figure 3-17: Normalized File Processing Time as a Function of CPU Speed
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file processing by writing custom software to generate the required commands. See
OPTIMOD 1600PCn Control API starting on page 5-1.

These commands are case-sensitive.
Start by specifying the input file or folder.

For processing a single file:
fpinput c:\music source\sourcefile.wav

c\music_source\sourcefile.wav is the full path of the source file.

returns

FP_INPUT:source source file found [or] source file not found
For processing a folder:

fpinput c:\music_source\

c\music_source\ is the source folder.

returns

FP_INPUT:source source folder found [or] source folder not found

After you have specified the input file or folder via the fpinput command, specify
the output folder. As soon as you do this successfully, file processing will start:

fpoutput c:\music_destination\
returns

FP OUTPUT:destination folder found. File processing started. [or] destination
folder not found

After a single file is processed (or an error occurs), the API returns

FP STATUS:file processed successfully [or] Could not open destination folder
for writing. Check folder security permissions.

After a folder is processed (or an error occurs), the API returns:

FP STATUS:folder processed successfully [or] Could not open destination folder
for writing. Check folder security permissions.
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Production and Mastering Applications

Using its offline wav file processing capabilities (see Using Optimod-PCn for Offline
File Processing on page 3-81), OPTIMOD-PCn can be a useful tool for mastering and
production applications in the professional audio industry, such as preparation of
equalized, level-controlled, peak limited CD masters. We have frequently used
OPTIMOD-PCn in this context, achieving excellent results.

Because of their broadcast origins, most of the 1600’'s presets provide more pro-
cessing than would ordinarily be required for mastering. In addition, we would ex-
pect that the mastering engineer would want to tweak a preset carefully to com-
plement the program material being mastered. The 1600 provides important tools
to allow a mastering engineer to fine-tune the processing to complement the pro-
gram material:

e Four bands of parametric equalization with low-noise filter structures and curves
modeled after classic second-order analog bell-shaped EQ.

e Sweepable lowpass and highpass filters with selectable 6, 12, 18 or 24 dB/octave
slopes.

e A powerful, low-noise parametric bass shelving equalizer with sweepable fre-
quency and a choice of 6, 12, or 18 dB/octave slopes.

e Five-band compressor/limiter with selectable allpass or phase-linear crossovers
and powerful controls, including attack time, release time, threshold, knee, and
ratio for each band. These compressor/limiters also offer user-adjustable inter-
band coupling, allowing the user to operate them anywhere from quasi-
wideband to fully independent. The compressor can be operated in either inline
or parallel modes. In parallel mode, it can bring up the level of quiet material
very unobtrusively while preserving the dynamics of louder material.

e An extremely powerful peak limiter with advanced, proprietary distortion reduc-
tion algorithms.

You cannot create a user preset “from scratch”; you must create it by modifying an
existing preset, factory or user. Each preset has an “easy adjustment” facility called
LESS-MORE, which is a one-knob provision for turning the amount of processing up
or down.

Systematically, the following is a good method for creating mastering presets. It as-
sumes that you have already set the processor mixer controls to achieve normal drive
levels.

Note that by drawing a marquee around several controls by clicking and dragging
with your computer’s mouse, you can temporarily couple them so you can adjust
several bands’ controls (for example, the LIMITER ATTACK controls) simultaneously.
The coupling will remain active until you click outside the area that the marquee
encloses.
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A) Set the 100% OuTPUT LEVEL control in the I/O Mixer to match your application.
If your master is intended for a distribution channel using lossy compression,
-1.5 dBFS is reasonable. For a lossless or PCM channel, -0.2 dB should be ade-
quate.

If your mastered audio is intended for transmission via a lossy codec like
AAC, MP3 or WMA, be aware that the codec’s decoder may overshoot
and cause audible clipping distortion. See Setting Output/Modulation
Levels on page 1-38. If the 1600’s output is applied directly to a lossy co-
dec, decrease the setting of the 1600’s output level control to allow the
necessary headroom. If the 1600’s output is applied to a linear PCM stor-
age medium (like a CD), it is better to use the entire dynamic range of
the linear medium by setting the 1600’s output level close to 0 dBFS.
Then compensate for codec overshoots by reducing gain when you trans-
code from the linear PCM recording to the codec.

B) Recall a mastering-oriented preset. See the discussion of the PEAK LIMIT MX,
SOFT KNEE, SOFT KNEE MX, ROCK MASTERING MX, and ROCK MASTERING MXH pre-
sets in Protection, AGC and Mastering Presets starting on page 3-34. These
presets are good starting points, but we would expect a mastering engineer
to adjust them to taste.

If you want to use parallel compression mode, start with CLASSICAL
PARALLEL MX and turn off the AGC. (You can do this in the preset’'s AGC
tab or by setting EXTERNAL AGC 70 YES in I/O > UTILITY.) See Parallel Com-
pression on page 3-21.

Note that you can use the PASS-THROUGH SWITCH (in the LESS-MORE tab)
to compare your work with the original audio.

Q) In the LESS-MORE tab, set the TARGET LOUDNESS according to the requirements
of your deliverable. This control scales OPTIMOD-PCn's LOUDNESS LEVEL meters
so that “0” on these meters corresponds to the active TARGET LOUDNESS.

The BS.1770 meter (the rightmost LoUDNESS LEVEL meter) shows BS.1770-2
(or higher) Integrated loudness as a varying-length bar and Short-Term
loudness (3-second integration time) as a single white segment. The Inte-
grated loudness is gated according to BS.1770-2 and is computed using a
10-second rolling window of integration.

If the medium uses the Dolby Digital codec, set OPTIMOD-PCn’s TARGET
LoupNESS REFERENCE value to match the dialnorm value to be authored
into the medium’s Dolby Digital metadata. (Refer to step 4.C) on page 2-
18.)

D) The mastering-oriented presets have the AGC turned OFF. If you need a very
large amount of compression for an application like processing material in-
tended for in-flight entertainment systems, you can either edit the preset to
turn the AGC on or start with a non-mastering preset.

You can turn the AGC off globally for all presets, which is convenient if
you don’t expect to use it in the future. See step (2.C) on page 2-16.

E) Unless you will be using a large amount of compression for special applica-
tions, set the MB GATE THRESHOLD to OFF.

In the mastering-oriented presets, this is already done.
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F) Adjust the MULTIBAND DRIVE control to achieve the desired amount of multi-
band gain reduction. Except for PEAK LIMITER MX, the mastering-oriented pre-
sets will adjust this control as LESS-MORE is adjusted.

G) Adjust the MULTIBAND RELEASE control to achieve the desired compression den-
sity.

You can use the DELTA RELEASE controls to fine-tune the release time of
each band independently.

The release characteristic is always “automatic” (i.e., with program-
dependent time constants) and the MuLTIBAND RELEASE control simply
scales this process. This, combined with multiband operation, makes the
compression remarkably resistant to the usual compressor pumping and
squashing.

H) Adjust the ATTACK TIME controls on the individual compressors to trade off
overshoot control against transient punch.

I) Adjust the RATIO and KNEE controls in each band to taste.

The RATIO control sets the compression ratio at the threshold of compres-
sion. To achieve a classic soft knee characteristic, set the RaTio to 1:1 and
adjust the softness of the knee with the KNee control.

The KNEE control sets the gain reduction in dB at which the compression
ratio reaches «:1. (See Figure 3-16 on page 3-71 and associated text for a
description of the RATIO, KNEE, and BREAKPOINT controls.)

J) After you adjust the RATIO and KNEE controls, adjust the THRESHOLD controls in
the individual bands to achieve the desired amount of gain reduction.

The KNEe control automatically and invisibly changes a given band'’s in-
ternal compression threshold to keep the compressor’s output level con-
stant whenever the drive level is high enough to move the gain reduction
into the o:1 range. This means that the internal threshold decreases with
softer knee settings (higher settings of the KNee control). However, the
indicated threshold the 1600’s user interface does not change. This be-
havior ensures that the THRESHOLD control alone determines the maximum
output level of the compressor, regardless the KNEe control’s setting.

K) Adjust the LIMITER ATTACK TIME controls to taste.

These controls allow you to set the limiter attack anywhere from 0% to
100% of normal in the Five-Band compressors, each of whose gain reduc-
tion has a fast-release (limiter) and slow-release (compressor) component.
Because the limiter and compressor characteristics interact, you will usu-
ally get best audible results when you set these controls in the range of
50% to 100%. Below 50%, you will usually hear pumping because the
compressor function is trying to create some of the gain reduction that
the faster limiting function would have otherwise achieved. If you hear
pumping in a band and you still wish to adjust the limiter attack to a low
setting, you can sometimes ameliorate or eliminate the pumping by slow-
ing down the compressor attack time in that band.

Of course, sometimes artistic pumping is desired for certain styles of mu-
sic and/or recording. The LIMITER ATTACK TIME controls can help achieve this
sound.
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If you are using low compression ratios and small amounts of gain reduc-
tion, setting the LIMITER ATTACK TIME controls as low as 50% can often in-
crease punch. This is the typical setting in the mastering-oriented presets.

L) Adjust the TRANSIENT ENHANCE control to taste.

This control allows you to insert an audio delay of up to 10 ms in the
sidechain of the five-band compressor. Delaying the gain control signal,
allows attack transients to pass through the multiband compressor un-
compressed, which can increase punch. There is a tradeoff between this
control and the amount of gain reduction in the peak limiter, which will
have to eliminate attack transients exceeding the peak limiter's thresh-
old.

M) Adjust equalization as necessary.

As discussed above, there is a versatile program equalizer available be-
tween the AGC and multiband compressor. There is also a five-band mix
control (functioning as a graphic equalizer) after the five-band compres-
sor. Note that any fixed equalization will be partially “undone” by the
dynamic re-equalization effect of the five-band compression.

You can use the individual band compression threshold controls and the
various BAND COUPLING controls to affect the amount of automatic re-
equalization performed by the five-band compression and the spectral
balance it produces. As you set the BAND CoupLING controls closer to 100%,
they permit progressively less dynamic program-adaptive equalization. If
you feel that the dynamic re-equalization is not producing enough
brightness when the program material lacks high frequencies, you should
turn the BAND 3>4 and BAND 4>5 COUPLING closer to 0%. Similarly, if weak
bass is not sufficiently boosted, turn the BAND 2>1 COUPLING closer to 0%.

N) Set the amount of peak limiting with the MB FINAL LimiIT DRIVE control.

In general, the less peak limiting you use, the better sounding the result
will be. However, if your client demands a “loud” result, the 1600's MX
peak limiter is a powerful tool for achieving this with minimum distortion
or other side effects. Moreover, when driven hard, the MX limiter can
add useful and attractive spectral components that can increase the per-
ceived detail in the master.

See Peak Limiter on page 3-23 for a further discussion of the peak limit-
ing technology available in OPTIMOD-PCn.

0O) Adjust the BAss CLIP THRESHOLD, BASS PRE-LIMITING, and BASS LIMITING controls
to complement the amount of final limiting. The values in the master-
oriented factory presets are usually satisfactory. The effect of these controls
will depend on the amount of peak limiter gain reduction, as set by the MB
FINAL LiMiIT DRIVE control. If you drive the MX limiter too hard, it will reduce
bass punch in an attempt to control IM distortion and to preserve essential
midrange information.

For an explanation of the MX bass limiting controls, see Peak Limiter starting
on page 3-73.

P) Save your preset using File/Save Preset.

Once you have created one “mastering” preset, you can edit it to create
others and save them under different names.
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Q) Process your audio file, following the instructions in Using Optimod-PCn for
Offline File Processing on page 3-81.

Creating Custom “Factory” Presets

You can create custom “factory” presets that support LESS-MORE functionality.
These presets will behave like the factory presets.

OPTIMOD-PCn’s software has the ability to interpolate all 19 available LEss-More
increments (1.0 through 10.0) from two or more LESS-MORE “anchor” preset files.
Additionally, you must create a “factory preset” file that corresponds to the default
value of LESS-MORE for your preset. The instructions below show you how to create
these files from user preset files that you have saved.

In the examples below, the specified file locations are based on OPTIMOD-PCn's de-
fault locations. Using Windows Explorer, check the factory preset file locations on
your computer to find out where these files are actually located. You must place
your new “factory preset” files in analogous locations.

To create a custom “factory” preset:

1. Make a working directory for your preset.

When you have finished making it the preset, you will copy it into the
OPTIMOD-PCn  folder in the Windows cC:\Program Files
(x86) \Orban\Optimod-PCn 1600 directory.

2. Choose a name for the preset.

You cannot use the name of an existing factory preset without damaging it. We
will use “My Preset” as the preset name in the examples below.

3. Create a folder for your presets.
Create a folder named “My Preset” within your working directory.
4. Choose the default LEss-MORE value for your preset.

5. Using 1600PC, create user presets for each LESS-MORE anchor point.
See Customizing Processing Presets starting on page 1-29.

Because LESS-MORE works only on the dynamics processing, you must choose a
set of equalizer settings for your new preset that is the same for all anchor pre-
sets. Table 3-8: Equalizer Controls on page 3-56 shows the controls that must be
set identically in all anchor presets.

You must create at least two anchor presets, one for LESS-MORE = 1.0 and one
for LEss-MORE = 10.0. Additionally, if the default LEss-MORE value you chose in
step 4 is neither 1.0 nor 10.0, you must create a third anchor preset for the de-
fault LESS-MORE value.
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You may add as many additional anchor presets as you wish to fine-tune the be-
havior of LESS-MORE.

From the OPTIMOD-PCn Control Application, save each preset as a user preset in
plain text (unencrypted) form, naming it My Preset LMxxx, where xxx stands for
the LESS-MORE setting that corresponds to that preset. For example, for LESs-
MORE = 1.0, xxx = 010.

6. Copy the user presets you made.

Copy these presets in the \ [working directory]\My Preset\ folder that you
made in step 3.

7. Edit the file extensions.
In Windows, change the extension of all of your presets’ file names to orb1600f
8. Edit the text within the preset files.

A) In turn, open each of your preset files in a text editor like Notepad or Word-
Pad. The editor you use must open and save files in plain text format.

B) Edit the second line of the file as follows:

Preset Name=<MY PRESET LMxxx> size=[yyy]

where Luxxx agrees with the file name.

, LESS- X y

Do not change the number after size. MORE
A) Edit the third line of the file as follows: 1.0 100 0
1.5 150 1
Factory Preset Name=<MY PRESET> 2.0 200 2
B) Edit the fifth line of the file as follows: 2.5 250 3
3.0 300 4
Preset File Name= <MY PRESET 3.5 350 5
LMxxx.0orbl600£f> 4.0 400 6
. 4.5 450 7
where MY PRESET LMxxx.orbl600f isthe same 5.0 500 8
as the file name. 5.5 550 9
C) At the end of the file, find the “LESS-MORE" gg ggg ::2
line and edit it as follows: 70 700 12
C:<LESS MORE>Cent:x;D:y; 7.5 750 13
8.0 800 14
Replace the “x” and the “y” with the LESss- 8.5 850 15
MORE data corresponding to the LESS-MORE 9.0 900 16
value that you chose for your new preset. See 9.5 950 17
Table 3-16. 10.0 1000 18

D) Save your edited file as a plain text file. (This
should happen automatically if you edited the
file using a text editor, not a word processor.)

Table 3-16: LEsSs-MORE Reference

E) Repeat steps (A) through (D) for each anchor file you created.
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9. Create the factory preset file.

A) Copy the LEss-MoRE file corresponding to your preset’s default LESS-MORE
setting, placing the copied file in

\ [working directory]

B) Edit the file name of the file you copied to remove LMxxx, including the
space before the “L.” The example file name is

MY PRESET.orbl600f
C) Open MY PRESET.orb1600f in a text editor.
D) Edit the second line of the file as follows:
Preset Name<MY PRESET> size=126
Do not change the number after size.

E) Edit the fifth line of the file as follows:

Preset File Name= <MY PRESET.orbl600f>

F) In Windows, give all of the files you just created the “read-only” attribute.
10. Copy your new preset to the OPTIMOD-PCn program file directory.

Copy both the my preseT folder and the my presET.orbi600f file to
C:\Program Files (x86)\Orban\Optimod-PCn 1600\presets.

Because this modifies files and folders within the Windows program file directo-
ries, you need Administrator privileges to do this.

Your new “factory preset” is now ready for use. When you recall a preset via the
OPTIMOD-PCn Control Application, the new preset should appear in the OPEN
PRESET window. After you recall it, LESS-MORE should be available.

The most common mistake is to put the incorrect LEss-MoRE value in the
My Preset.orb1600f file or its corresponding LEss-MoRre file. This will
cause LEss-MORE not to work.

Back up your new “factory” preset (i.e., the factory preset file and less-more anchor
files) elsewhere. If you install a new version of OPTIMOD-PCn, it will overwrite your
“factory” preset and you must restore it from a backup.
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Appendix A: Using the ITU BS.1770 and CBS Loudness
Meters to Measure Loudness Controller Performance

[Note: This Appendix is a reprint of a stand-alone white paper. For this reason, it
contains some explanatory material regarding the CBS and BS.1770 meters that is
also found elsewhere in this manual.]

ITU-R BS.1770

In 2009, the ATSC released a Recommended Practice: Techniques for Establishing
and Maintaining Audio Loudness for Digital Television (A/85:2009). This was later
up-dated as A/85:2011. A/85 specifies use of a long-term loudness meter based on
the ITU BS.1770 algorithm for measuring the loudness of DTV broadcasts.

In December 2011, the FCC adopted rules implementing the CALM Act, which, by
law, forbids commercials from being louder than non-commercial program material.
The new FCC rules incorporated ATSC A/85 (and, by implication, the BS.1770 meter)
as an objective means of verifying that the rule was being obeyed.

Because loudness measurement per BS.1770 uniformly integrates all program mate-
rial, quiet passages tend to lower the measured value. To prevent this, the ITU add-
ed gating to the BS.1770 standard, which was revised as BS.1770-2 in March 2011.
The gating causes the meter to ignore silence and to integrate only program mate-
rial whose loudness falls within a floating window extending from the loudest
sounds within the specified integration period to sounds that are 10 dB quieter than
the loudest sounds. This is because humans tend to assess loudness based on the
louder sounds in a given program. (The revision current as of this writing, BS.1770-4,
added the ability to monitor systems with more than 5.1 channels.)

The ATSC A/85 2011, ITU-R BS.1770-4, and EBU R 128 documents are available as free
downloads. A search engine like Google can locate them easily.

CBS Loudness Meter

For many years, Orban has used the Jones & Torick loudness controller and loudness
measuring technology* in its products for loudness control of sound for picture. De-
veloped after 15 years of psychoacoustic research at CBS Laboratories, the CBS loud-
ness controller accurately estimates the amount of perceived loudness in a given
piece of program material. If the loudness exceeds a preset threshold, the controller
automatically reduces it to that threshold. The CBS algorithm has proven its effec-
tiveness by processing millions of hours of on-air programming and greatly reducing
viewer complaints caused by loud commercials.

4 Jones, Bronwyn L.; Torick, Emil L., “A New Loudness Indicator for Use in Broadcast-
ing,” J. SMPTE September 1981, pp. 772-777.
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Since first licensing the CBS algorithm and using it in its Optimod-TV 8182 in the ear-
ly 1980s, Orban has continually refined and developed this technology. In the last
30+ years, audio processors from Orban and CRL using the CBS loudness controller
have processed millions of hours of on-air television programming — an unsur-
passed track record that no other subjective loudness controller technology can
claim.

Comparing the Meters

Because the ATSC recommends the BS.1770 algorithm, many broadcast and cable
engineers facing the problem of controlling broadcast loudness have wondered how
the CBS and BS.1770 technologies compare. An earlier version of this Orban white
paper compared the CBS and BS.1770-1 (non-gated) meter. The paper you are now
reading was revised in March 2012 to incorporate results from tests using the
BS.1770-2 algorithm and EBU — TECH 3342 “Loudness Range” algorithm. The new
measurements were performed using Version 2 of the Orban Loudness Meter>. This
revision compares the CBS and BS.1770-2 meters because we expect that the ATSC
will eventually update A/85 to specify BS.1770-2, which will more closely harmonize
A/85 with its European counterpart, EBU R128.

A/85 and R128 differ significantly in their philosophy and recommendations. Proba-
bly most important difference is that A/85 asserts that the loudness of a so-called
"anchor element” (which is typically dialog except in programs emphasizing music,
like live concert recordings) is most important, while R128 asserts that the integrated
loudness of the entire program is most important® and therefore, program loudness
should be normalized based on an integrated BS.1770-2 measurement. The philoso-
phy behind A/85 is similar to that of Dolby Laboratories, which for many years has
asserted that dialog anchors most film and television programs and that listeners set
their volume controls to make dialog comfortably intelligible’. (We agree more with
A/85 than with R128).

> This software is available for free download at http://orban.com/meter/.

6 EBU — TECH 3343, “Practical guidelines for Production and Implementation in ac-
cordance with EBU R128,"” version 1 (February 2011), p. 29

7 Riedmiller, J., Lyman, S., Robinson, C., “Intelligent program loudness measurement
and control: what satisfies listeners?” AES Convention Paper 5900, 115% Convention
(October 2003)
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Histograms sorting loudness measurements into 0.25
dB bins.
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Test Setup

A stereo recording of approximately 30 minutes of unprocessed audio from the out-
put of the master control of a San Francisco network station was applied to the 2.0
processing chain of an Optimod-Surround processor, set for normal operation using
its TV 5B GEN PURPOSE preset. The digital output of the processor was applied to
the digital input of an Orban 1101e soundcard, which was adjusted to pass the au-
dio without further processing and to apply it to a software-based loudness meter
that simultaneously computes the BS.1770-2 Integrated loudness and CBS loudness.
The first 750-second segment of the program material was a daytime drama with
commercial and promotional breaks, while the remainder was local news, also with
commercial and promotional breaks.

The BS.1770-2 meter was adjusted to produce a 10-second integration window in
which, per the BS.1770 standard, all data are equally weighted. The CBS Loudness
Gain control was set to —3.12 dB. Data were logged every 10 seconds and included
the maximum meter indication produced by both the BS.1770 and CBS meters in
each 10-second interval. This produced 165 data points, which were imported into a
scientific plotting application?.

Orban’s experimental long-term loudness measurement, based on the CBS meter
and first published in 2008, was also included in the measurements and is shown in
the bottommost charts. This algorithm attempts to mimic a skilled operator’'s mental
integration of the peak swings of a meter with “VU-like” dynamics. The operator
will concentrate most on the highest indications but will tend to ignore a single high
peak that is atypical of the others. This algorithm can be seen to share certain char-
acteristics with the floating gate first introduced in EBU R128 and later adopted in
BS.1770-2.

The Orban algorithm displays the average of the peak indications of the meter over
a user-determined period: 10 seconds for these measurements. The average is per-
formed before dB conversion. All peak indications within the period are weighted
equally with the following exceptions:

e If the maximum peak in the window is more than 3 dB higher than the sec-
ond highest peak, it is discarded.

e All peaks more than 6 dB below the maximum (or second-to-maximum, if
the maximum peak was discarded) are discarded.

Because the CBS long-term measurement discards a single peak if it is more than 3
dB higher than the second highest peak, the CBS long-term measurement tends to
be biased about 3 dB lower than a measurement that shows the maximum peak in-
dication of the CBS meter in a 10-second period. This depends on whether or not the
loudness applied to the meter’s input is well controlled. This bias can be seen in the
figures in the paper. Because the Orban meter allows control of the level applied to

8 PSI Plot: http://www.polysoftware.com/plot.htm
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the CBS algorithm via the “CBS Gain” control, setting it 3 dB higher could better
match the CBS long-term measurement to the BS.1770-2 Integrated measurement at
the expense of moving the “maximum peak loudness” indication 3 dB higher.

Results

Unprocessed Audio Input: To provide a baseline for discussion of the loudness-
controlled results, we measured the unprocessed audio that was applied to the
Orban processor’s input. Figure 3-18 and Figure 3-19 on page 3-95 show the loud-
ness of the unprocessed audio both as a function of time and as a histogram. The
histogram sorts the meter outputs into 0.25 dB or 0.25 Lk®-wide slices and shows the
number of measurements that fit into each of these slices. The histogram thus por-
trays loudness consistency — when the histogram is clustered tightly within a few
bins, the loudness is more consistent than it is when the histogram is spread out into
a larger number of bins.

With all meters, the histogram of the unprocessed audio shows a wide spread. This is
consistent with the EBU Loudness Range measurement for the entire clip, which was
16.5 Lk, while the LRA for the daytime drama alone was 19.2 Lk (including commer-
cials). The BS.1770-2 Integrated loudness was —20 LUFS, integrated over the entire
measurement period, although the inconsistencies between the loudness of pro-
gram material and commercials are large enough to make this 30-minute measure-
ment essentially meaningless.

In general, the loudest parts of the unprocessed audio are commercials and promos,
both network and local. These are anywhere from 5 to 10 dB (or Lk) louder than the
rest of the program material. This inconsistency was not a problem because the sta-
tion in question was using an Orban automatic loudness controller on-air, which
smoothed out loudness differences before its input.

While the general shapes of the CBS and BS.1770 loudness vs. time curves are similar,
there were some significant differences. For example at approximately 1250 seconds,
the CBS measurement shows a sharp loudness spike that was caused by a network
news report that was equalized to emphasize frequencies around 2 to 3 kHz, where
the ear is most sensitive. The BS.1770-2 measurement did not indicate this as being
louder than the surrounding program material although to our ears, it clearly was.

Loudness-Controlled Audio: Figure 3-20 and Figure 3-21 on page 3-96 show the re-
sults after automatic loudness control. (To present the data with optimum graphic
resolution, we made the loudness scales of Figure 3-20 and Figure 3-21 narrower
than the scales in Figure 3-18 and Figure 3-19.)

Both the loudness vs. time graphs and the histograms show the Orban processing
controls loudness well, although the details of the meters’ indications are different.

9 Unfortunately, two terms for the same loudness units have been used in different
standards documents. Lk and LkFS (used in ATSC A/85) are the same as LU and LUFS
(used in EBU R128 and BS.1770).
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Figure 3-22: Loudness-controlled audio without BS.1770
safety limiter active: output of the CBS and BS.1770 loud-
ness meters in each 10-second interval as a function of

Both the BS.1770 and CBS measurements indicate that most of the data points are in
a +1 dB/LU window.

The peak CBS readings fit within a +2 dB window. The BS.1770 readings also fit with-
in a £2 Lk window except for four short intervals, which appear as low-probability
outliers in the left side of the histogram. These intervals correspond to dialog with-
out background music and in the author’s opinion illustrate a weakness in BS.1770-
2: based on our extensive listening tests, we have concluded that the meter does not
effectively lock onto the A/85 “anchor element” (almost entirely dialog in the test
material used to prepare this paper) and instead indicates that loudness increases
when dialog level is held constant while underscoring or effects are added to the
mix.°

Problems with Low Peak-to-RMS Ratio Material

In the subjective testing to validate the BS.1770 meter, there were outliers as large
as 6 dB (i.e., the meter disagreed with human subjective perception by as much as 6
dB'".) The subjective testing to validate the CBS meter found outliers up to 3 dB, alt-
hough fewer items were used in this testing.
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Three Algorithms Overlaid
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% In the first published version of the paper, we observed the similar dips in the
BS.1770-1 (ungated) loudness and hypothesized that they were caused by lack of
gating on silence and low-level material. For this reason, we were surprised that
BS.1770-2 gating made little difference in the measurements of this material.

" Refer to the scatter plots in Figs. 11, 12, and 13 of the ITU-R BS.1770-2 standard.
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Figure 3-23: Loudness-Controlled Audio With BS.1770
Safety Limiter Active: Output of the CBS and BS.1770
Loudness Meters in each 10-second Interval as a Func-
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We hypothesize that the fact that the worst-case error of the BS.1770 meter was
substantially larger than that of the CBS meter is caused by the BS.1770’'s meter’s not
modeling loudness summation or the loudness integration time constants of human
hearing.

BS.1770-4 states: "It should be noted that while this algorithm has been shown to be
effective for use on audio programmes that are typical of broadcast content, the
algorithm is not, in general, suitable for use to estimate the subjective loudness of
pure tones.” We have noted that the meter tends to over-indicate the loudness of
program material that had been subject to large amounts of "artistic” dynamic
compression, as is often done for commercials and promotional material — in other
words, the meter over-indicates the loudness of program material having an unusu-
ally low peak-to-average ratio, which, at the limit, approaches the peak-to-average
ratio of a pure tone. We have encountered heated complaints by mixers'? and pro-
ducers who stated that such material, when “matched” to the loudness of the sur-
rounding program material via the BS.1770 meter, is considerably quieter in subjec-
tive terms. In turn, this has constrained the ability of producers to specify the type of
audio processing they had previously used to give this material excitement and
punch. We hypothesize that this problem is related to the fact that BS.1770 does not
accurately indicate the loudness of pure tones.

Some studies have indicated that when people are asked to assess the loudness of a
given piece of material, they state that it sounds louder when underscoring or ef-
fects are added to constant-level dialog. The EBU has used these studies to justify
the position taken in R128 that a listener’s impression of total loudness is more im-
portant than dialog level™. In our opinion, this misses the point. A more relevant
question is whether viewers would want to turn down their volume controls to
make dialog quieter when underscoring and effects appear. (In other words, wheth-
er effective TV commercial loudness control requires nothing more than applying
gain control to commercials such that the BS.1770-2 “short-term” loudness™ is al-
ways limited to 0 Lk.) Regarding this, Orban and Dolby Labs hold similar views. We
believe that dialog is the most important element in most television audio and that
listeners do not want to turn down their volume controls every time that underscor-

2 For example: "I did a -24 [LkFS] piece for Fox that was wall to wall singing and
music for two minutes. Because of the overall loudness and continued full audio sig-
nal | had to bring it down and when it aired, it was 3 db too quiet even though it
matched the magic LkFS number. | have no problem using these meters or meeting
specs but they are faulty.”

—"wheresmyfroggy,” AVID board, 3-28-2011

'3 Dash, lan; Bassett, Mark; Cabrera, Densil, “Relative Importance of Speech and Non-
Speech Components in Program Loudness Assessment,” AES Convention Paper 8043,
128th AES Convention (May 2010).

4 EBU R128 specifies short-term loudness as a BS-1770-1 (ungated) measurement
with a three-second integration time.
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ing or effects appear under the dialog. The popular Dolby LM100 Loudness Meter'>
in its current revision uses the same Leq(RLB) algorithm as BS.1770 but adds gating
to eliminate non-speech material, including silence.

The author has used the Dolby LM100 to measure the output of the Orban processor
with a wide variety of speech material, and has observed that this material is almost
always controlled within a +1 dB window as measured on the LM100. In the author’s
opinion, this demonstrates the benefits of a dialog-centric measurement. Moreover,
the author believes it is unwise to rely on a BS.1770 measurement to set the on-air
loudness of unadorned dialog because this can cause the dialog to be too loud with
respect to other material. The author has experimented with “inverse short-term
BS.1770 loudness control” and believes that it sounds unnatural, pumping dialog
loudness up and down in a subtly inartistic way as underscoring and effects come
and go.'

Moreover, the author believes it is unwise to rely on a BS.1770 measurement to set
the on-air loudness of unadorned dialog because this can cause the dialog to be too
loud with respect to other material. This is consistent with the Audio Engineering
Society’s “Recommendation for Loudness of Audio Streaming and Network File
Playback” (2015)", which takes "genre” into account in the context of BS.1770:

Within a given program, the largest perceived difference to be noted is
speech versus music. Speech normalized to the same Integrated Loudness
as a music stream inevitably sounds too loud. It is recommended to nor-
malize speech (dialog) segments within other segments 2 to 4 LU (or
more) below the loudness of the other segments

The author has experimented with “inverse short-term BS.1770 loudness control”
and believes that it sounds unnatural, pumping dialog loudness up and down in a
subtly inartistic way as underscoring and effects come and go. Nevertheless, because
some organizations require program loudness to be constrained to a given BS.1770
long-term meter reading regardless of how a human listener hears the loudness of

5 http://www.dolby.com/professional/products/broadcast/test-and-
measurement/Im100.html

6 See Begnert, Fabian; Ekman, Hakan; Berg, Jan, "Difference between the EBU R-
128 Meter Recommendation and Human Subjective Loudness Perception,” AES Con-
vention Paper 8489, 1315t AES Convention, (October 2011). This paper states, “These
loudness-equalized signals gave rise to a perceived maximum loudness difference of
2.8 dB.” This is very close to the 3 dB number that has come up in other discussions
(such as the one quoted in footnote 12 on page 3-89). While the authors of this pa-
per consider 3 dB to be insignificant, others do not necessarily share this view, par-
ticularly advertisers who hear their expensive commercials aired 3 dB quieter than
surrounding program material!

7 Audio Engineering Society: AES TD1004.1.15-10 “Recommendation for Loudness
of Audio Streaming and Network File Playback” (2015)



OPTIMOD-PCn OPERATION 3—103

such material, we deemed it wise to provide users with a “BS.1770 safety limiter” in
the loudness controller used in the studies in this paper.

The BS.1770 safety limiter is located after the J&T loudness controller in the signal
path; we call the combined J&T and BS.1770 algorithms “Orban Loudness Control.”
It provides “inverse BS.1770"” gain reduction for material that exceeds a preset
threshold, but it uses an attack integration time of 10 seconds and a release integra-
tion time of 3 seconds, so the gain reduction is not a strict inverse of the BS.1770
meter (which uses symmetrical attack and release integration times). The limiter’s
asymmetrical attack and release integrations times are intended to minimize down-
ward gain pumping on highly compressed material (like commercials) while still al-
lowing the gain to recover quickly when dialog reappears.

The limiter's temporal asymmetry can cause the BS.1770 indication to be slightly
higher than the preset target loudness, as can be seen in Figure 3-22 and Figure
3-23. Figure 3-22 and Figure 3-23 show the measured BS.1770 and J&T loudness with
and without inverse BS.1770 gain reduction (set to a threshold of —24 LUFS) as a
function of time, while Figure 3-24 and Figure 3-25 show the associated histograms,
measured with both the BS.1770-2 and CBS meters.

In the BS.1770 measurements in both Figure 3-24 and Figure 3-25, the BS.1770 loud-
ness histogram appear centered on the target loudness (-24 LUFS). However, Figure
3-25 shows that the BS.1770 safety limiter prevented the BS.1770 meter from indi-
cating more than 1 LU higher than the target loudness except for one bin, while
Figure 3-24 shows that defeating the safety limiter causes a significant number of
BS.1770 loudness events up to be up to 2 LUFS higher than the target loudness.
While it would have been trivially easy to make the BS.1770 safety limiter a literal
inverse of the meter (thus preventing the BS.1770 loudness from ever indicating
above the target loudness) this sounded substantially less natural than using asym-
metrical attack and release. Moreover, we still prefer the sound of the J&T loudness
controller without any BS.1770 limiting at all. (Note that the CBS readings showing
the effect of the BS.1770 Safety Limiter do not show as consistent an affect as the
BS.1770 readings. This is because of the differences between the two algorithms.

Studies indicating that BS.1770 is inaccurate at very low frequencies

Another weakness of BS.1770 is that, unlike the CBS loudness controller and meter
as implemented in Orban products, the BS.1770 algorithm does not take into ac-
count the loudness contributed by the LFE channel, for good reason. Nacross and
Lavoie' tried to extend the BS.1770 algorithm to include the LFE channel by sum-
ming the K-weighted LFE channel's power into the current BS.1770 algorithm,
where the gain is weighted for the fact that LFE channel receives a 10 dB gain boost
on playback, per Dolby’s standards. This modified BS.1770 algorithm failed to agree
with the judgments of a subjective listening panel unless a 10 dB attenuation

'8 Norcross, Scott G; Lavoie, Michel C.,” Investigations on the Inclusion of the LFE
Channel in the ITU-R BS.1770-1 Loudness Algorithm,” AES Convention Paper 7829,
127™ AES Convention (October 2009)
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“"fudge factor” was applied to the LFE channel prior to its power summation with
the other channels. Nacross and Lavoie concluded:

A problem exists however, should ITU-R BS.1770 be modified to simply
include an attenuated version of the LFE channel. Because the LFE chan-
nel receives a 10 dB boost on playback, the low-frequencies on this chan-
nel would contribute differently to a loudness measure if they were
moved to one of the other main channels, even though the perceived
loudness would not appreciably change. This suggests that while LFE con-
tent does contribute to the perceived loudness, Equation (2)' does not
sufficiently predict how that content should be included.

An Australian study may shed light on the failure of BS.1770 when program material
contains considerable energy at very low frequencies.?® The authors used octave-
band noise in subjective listening tests with the goal of verifying the K-weighting
curve used in BS.1770. The authors state:

Comparison of the test results with an image of the filter curve currently
specified in ITU-R Recommendation BS.1770 (Figure 13) shows good
agreement at 250 Hz and above 500 Hz, reasonable agreement at 500
Hz, but marked difference in the bottom two octaves.

The relatively good performance of the BS.1770 algorithm in ITU trials
suggests that, in partial loudness terms, there was probably not much
test content in the 125 Hz band or below. While the existing BS.1770 fil-
ter curve is probably a good choice in applications where the program is
dominated by speech, and it is certainly an improvement on the A and B
curves in that application, it is likely to give significant errors in measur-
ing the loudness of other programs with more partial loudness in the
lower frequencies, such as movie soundtracks and popular music. It is
therefore desirable to improve on this filter for more general measure-
ment of program loudness.

Discussion and Conclusions

Several studies have shown that the loudness “comfort range” for typical television
listening is +2, -5 dB?'. Beyond this range, a viewer is likely to become annoyed,
eventually reaching for the remote control to change volume (or worse from the
broadcaster’s point of view, to mute a commercial). Whether measured via the CBS
or BS.1770 algorithms, the CBS loudness controller algorithm in Orban’s current

2

_Leq(w)= {%GLFE :—dt +yk jOT dt},dB

ref

i=L,RC,L,R

20 Cabrera, Densil; Dash, lan; Miranda, Luis, “Multichannel Loudness Listening Test,”
AES Convention Paper 7451, 124" AES Convention (May 2008)

21 ATSC A/85:2009 Annex E, “Loudness Ranges”



OPTIMOD-PCn OPERATION 3—105

products effectively controls subjective loudness to much better than this +2, -5 dB
window.

In the original version of this paper, we had assumed that results using BS.1770 me-
tering would be more consistent if that algorithm employed gating to prevent una-
dorned dialog from reading low compared to music and dialog with substantial
background music or effects. However, this did not prove to be true with the pro-
gram material we used for testing—the results from the BS.1770-1 (ungated) and
BS.1770-2 (gated) measurements were similar when measuring material that had
been processed by the CBS Loudness Controller. It is likely that the loudness-
controlled material seldom caused the gate to act. (The CBS algorithm does not
need silence gating because it is a “short-term” loudness measurement that incorpo-
rates cascaded models of the “instantaneous” and “short-term” loudness time con-
stants of human hearing??, which the BS.1770 algorithm does not.)

Controlling loudness to a standard such as BS.1770 says nothing about the subjective
acceptability of the loudness controller’s action. We have found that a simple loud-
ness controller that uses the inverse of the BS.1770 short-term meter's output to
control loudness by gain reduction can cause unnatural-sounding gain pumping of
dialog when underscoring and effects appear under the dialog. More complex au-
tomatic loudness controllers can produce all of the well-known artifacts of dynamics
processing, including noise breathing, spectral inconsistency, gain pumping, and
harshness. Improperly designed multiband compressors can reduce dialog intelligi-
bility?. This is why it is important to carefully assess the audio quality and side ef-
fects that an automatic loudness controller produces so that one can choose a device
that controls loudness effectively without producing objectionable and unnatural
artifacts that can fatigue audiences. Different loudness controllers do not provide
equally good subjective results even if they produce identical measurements on a
loudness meter.

Based on extensive experimentation with typical broadcast material, we believe that
the CBS loudness meter locks onto dialog more effectively than does BS.1770, par-
ticularly when the dialog is accompanied by underscoring and/or effects. According-
ly, the CBS Loudness Controller in Orban products, which uses the CBS loudness me-
tering algorithm as its core loudness reference, produces consistent and naturally
balanced dialog levels regardless of the program material and mixing style. Unlike
the BS.1770 meter, the CBS technology does not unnaturally penalize material hav-
ing a low peak-to-RMS ratio, so it allows mixers and producers to freely use “artistic

2 For example, see Glasberg, B.R. & Moore, B.C.J. (2002) "A Model of Loudness Ap-
plicable to Time-Varying Sounds,” J.AES, vol.50:5, pp.331-342, May 2002.

3 Stone, Michael A.; Moore, Brian C. J.; Fullgrabe, Christian; Hinton, Andrew C.,
"Multichannel Fast-Acting Dynamic Range Compression Hinders Performance by
Young, Normal-Hearing Listeners in a Two-Talker Separation Task,” J. AES Volume
57 Issue 7/8 pp. 532-546; July 2009


http://www.aes.org/e-lib/browse.cfm?elib=14833
http://www.aes.org/e-lib/browse.cfm?elib=14833
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compression”?* and other well-established production techniques with the
knowledge that such material will be neither too loud nor too quiet when com-
pared to the surrounding program.

In the Orban Loudness Controller, the BS.1770 Safety Limiter (which follows the J&T
controller) can be used to any extent desired by setting its threshold higher than the
target loudness. We believe it is mainly useful for organizations that rely on logging
the BS.1770-4 loudness to verify compliance with international regulations, and that
setting its threshold 2 LU above the target loudness minimizes inconsistent subjec-
tive loudness caused by “genre” issues as discussed in AES TD1004.1.15-10.

—Robert Orban, revised February 2020

2 |t appears that the group that created R128 may be biased against this style of
production: “Again, this does NOT mean that within a programme the loudness lev-
el has to be constant, on the contrary! It also does NOT mean that individual com-
ponents of a programme (for example, pre-mixes or stem-mixes, a Music & Effects
version or an isolated voice-over track) have all to be at the same loudness levell!
Loudness variation is an artistic tool, and the concept of loudness normalisation ac-
cording to R128 actually encourages more dynamic mixing!” EBU TECH 3343, op. cit.,
p- 17
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Section 4

Software Summary

OPTIMOD-PCn Software Summary

The OPTIMOD-PCn software version number is
available through the Control Application Help TR EEE S
> About menu.

. . . Optimod-PCh 1600 Control - 0.9.10.4
Application Installation File Copright ©2017 Rorb, Inc.

Setupl600xxx.exe — Installer:

Thiz zaftware and/or program iz protected by copuright
law and international treaties.
e Installs the Control Application-

Optimod3.exe Ary reproduction or distribution of this software and/or

pragram, o any portion of it, may result in zevere civil and
criminal penalties, and will be progecuted ta the masinmum

e Installs the Agent — optimodAgent3.exe ol st e [

e Installs the Service — optimodService3.exe 2l rights reserved.

e Installs the factory presets Optimod i a regiztered tradernark of CRL Systemns, he.
and iz uzed under licenze.

e Installs run-time libraries S _
The product iz distributed and supported by kodulation

e Detects whether the computer’'s CPU sup- Irdes LLC.
ports the Intel AVX2 vector instruction set S —
and installs support for AVX2 if appropriate.

Service

e Implements the audio signal processing and provides hooks into the Windows
sound I/O system.

e Provides remote control security and access.

e Starts 120 seconds after Windows finishes booting. This delay allows Windows to
settle down so that it does not compete with the Service for CPU cycles. When it
starts automatically, the Service will load the same processing presets that were
active on the OPTIMOD-PCn Processors when the computer shut down, and will
start processing audio.

e Supports the API

e Supports SNMP.
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SNMP is not supported in v0.9 software.

e Authorization: If your version of 1600PCn requires a hardware key, the Service
will only start up if it can determine that the USB security key is plugged into an
available USB socket. The key is driverless; no driver installation is necessary.

If your 1600PCn requires CodeMeter software authorization, this must be cor-
rectly installed and authorized. See the document Instructions to create license
request file for Optimod PCn.pdf, which the 1600PCn installer copied to the ser-
vice computer.

Agent (Tray Icon)

e The OPTIMOD-PCn Agent is a tray icon that allows you to launch the OPTIMOD-
PCn Control Application from the Windows System Tray.

e If you right click the tray icon, a menu pops up with a checkable item named
AUTO-START THE TRAY ICON. (The “Auto-start the tray icon” item will be checked by
default.)

e If you uncheck AUTO-START THE TRAY ICON, the tray icon will not re-appear when
you re-start the PC.

e To re-engage the icon, go to start/Programs/Orban/oPTIMOD-PCn 1600 and select
OptimodPcAgent.

You do not need to open the OPTIMOD-PCn Control Application to tog-
gle the auto-start feature on and off.

1600PC Control Application

e Provides access to all OPTIMOD-PCn I/O Mixer controls, DSP processing parame-
ters, and presets.

e Can be used as a client to remotely access OPTIMOD-PCn Processors running on
computers other than those doing the audio processing.

e Is not copy-protected and can be installed on as many computers as you wish.

e It is not necessary (or desirable) for the Service to run on a computer that does
not do audio processing but only hosts 1600PC. (The OPTIMOD-PCn installer will
not install the Service if you tell it during the install process to install only the

remote client.)

Registry
e |/O Settings

e Active Preset
e Encrypted Security

o Application GUI Settings
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Section 5

Control API

OPTIMOD 1600PCn Control API

The OPTIMOD 1600PCn Service application hosts a TCP/IP terminal server to allow
external control of OPTIMOD 1600PCn processors from either a Telnet client or a
custom third party application. All commands are simple text strings. Upon receiving
valid commands, OPTIMOD 1600PCn will confirm by returning a simple text string
status message. By implementing external control this way, multiple OPTIMOD
1600PCn Processors can be controlled using standards-based network protocols (that
are not Microsoft Windows-specific) anywhere that network connectivity is availa-
ble.

To protect the Terminal Server from unauthorized remote access, the default setting
for the control “Use localhost only for Terminal Access” is enabled. In this case, only
Telnet connections from the localhost address 127.0.0.1 on the default port 12101
are accepted. Disabling this will allow Telnet connections via Ethernet from other
computers, using the IP address of the host computer. This control is located in the
OPTIMOD 1600PCn remote application in the TooLs>SERvICE SETUP dialog box and
is accessible only when the application is disconnected from a 1600PCn processor
(i.e. when controls and meters are not displayed). The default port can be changed
here too.

To control OPTIMOD 1600PCn externally, establish a Telnet connection and issue
commands and parameters, either by typing them directly into a Telnet client or by
placing them within batch files. Then process them with a scriptable Telnet client
that supports this operation, such as PuTTY, along with its companion command-line
interpreter, Plink. Both of these applications are available for free download. Search
"PUuTTY" with a search engine like Google to find a download site.

Automating control changes is possible by using the Windows Task Scheduler to
launch batch files at the desired time.

Custom third party applications can be developed to use this protocol. Additionally,
you can include this protocol in an existing application by using small subsets of the
standards-based Telnet protocols directly, or for simplicity, by using scripting or by
calling batch files with a Telnet client such as PuTTY along with its companion com-
mand-line interpreter, Plink. Scripting eliminates the need to develop networking
code or otherwise contend with complex, limited-function Microsoft Windows spe-
cific programming APIs. Developing a third party application or including the proto-
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col in an existing application eliminates having to install and configure additional
applications. Using small subsets of the standards-based Telnet protocol allows more
operational flexibility without a system performance hit and simplifies development
compared to proprietary OEM APIs.

Table 5-1 on page 5-2 describes the available top-level command strings and their
functions. To demonstrate this functionality, you may type the commands directly
into a Telnet client terminal and see OPTIMOD 1600PCn confirmation and status
messages. The lists of addressable controls are found in Table 5-2: Processing Con-
trols Available from APl on page 5-8 and Table 5-3: Settings Controls Available from
the APl on page 5-9.

Commands are case-sensitive and must be entered exactly as shown, including spac-
es. Replace “preset name” and “setting name” with the actual Preset name and Set-
tings name respectively. Replace Processor x with the name of the processor you
are addressing; for example, <Processor 1>. Note that if you have created an alias
name for a Processor, you cannot use this in the API; use the actual “Processor”
name instead.

The file processing commands fpinput and fpoutput are explained in Using the
API for File Processing starting on page 3-84.

Administering through Ethernet TCP/IP

Using a terminal program like PuTTY, you can control an OPTIMOD 1600PCn Proces-
sor through a network Ethernet TCP/IP connection to the computer that hosts the
1600PCn you wish to access. An ASCIl programmable GPIO device, such as a Broad-
cast Tools SRC-16, with an appropriate Serial-Ethernet server, can also be used for

Command Function
help Lists important APl commands
version Retrieves control application version information.
plist Returns a list of all processing controls available to the API.
slist Returns Iis_t of all controls available to the API in Settings
(configuration).
h Returns all control information formatted to be included ina C
eader X
program file.
fpinput [path] Spec_ifies a file or folder to be processed using file processing
functionality
fpoutput [path] Specifies the destination folder for file processing
disconnect Disconnects Telnet connection.
<Processor x> pstatus Returns values for each control in the active preset.
Returns values for each control in the active Settings configu-
<Processor x> sstatus .
ration.
<Processor x> AP ?2? Retrieves all available Presets.
<Processor x> AP ? Retrieves Active Preset.
<Processor x> RP preset name Recalls Processing Preset.
<Processor x> DP preset name Deletes a preset.
<Processor x> AS ?? Retrieves all available Settings files.
<Processor x> AS ? Retrieves Active Settings file.

<Processor x> RS settings name Recalls a Settings file.

Table 5-1: Top-Level Telnet Command List
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hardware control and status. Multiple connections and devices can be used. When
you are connected, you can retrieve information and change settings on the
1600PCn by using simple ASCIl commands as discussed in OPTIMOD 1600PCn Control
API starting on page 5-1.

e Valid commands are in either upper or lower case, not a combination.
e Only one valid command is permitted per line.
e OPTIMOD 1600PCn will not respond to unrecognized commands.

e The character code supported is ASCII.

Connecting via TCP/IP Using PuTTY on a PC

e You can use the 1600PCn with any computer or terminal that is compatible with
TCP/IP networking.

e The OPTIMOD 1600PCn Service Settings determine network connection security:

A) Using the OPTIMOD 1600PCn Control Application, select TooLs > SERVICE
SETTINGS.

B) Assign an available TCP/IP Port. (Default is 12101.)

Q) If you will be communicating from a computer other than the computer host-
ing the Service, uncheck “Use localhost only for Terminal Access.”

D) (Optional) Check “Use Network Accept List” and add allowed IP addresses to
list. (Step 8 on page 2-7 has more detail.)

Because the API does not use passwords in the individual commands, it is
important to use the “Use Network Accept List” feature to enforce secu-
rity if you wish to communicate from a computer other than the comput-
er hosting the Service.

Service Settings
Accept List x
— Application Control Settings |

Allow Metwork to

Port: I 12105 IV Access Local

Processars

™ |se Metwork

Metwork Accept List | Accept List

—Metwork Terminal Contral Settings
se localhost only
- I v )
Port 12101 b for Terminal Access

=g Mebwork
r Accept Lisk

add | Edt | Delete |

Cancel |

Metwork Accept Lisk |




5 —4 CONTROL API

ORBAN MODEL 1600

Connect your computer or terminal with an Ethernet cable:

A) Connect an appropriate Ethernet cable on your terminal, computer, or device
to either an Ethernet port on the XPM-AM'’s host computer or the Ethernet
network that will allow access the 1600PCn host computer.

e If connecting to a standard Ethernet network, use a standard Ethernet cable
and TCP/IP network connection.

e If connecting directly to another computer, use a crossover Ethernet cable.

When a crossover Ethernet cable is used, at least one computer must
have a static IP address. The other computer may have a static address or
may have DHCP enabled.

To enable DHCP in a given computer, its Internet Protocol (TCP/IP) Prop-
erties must be set to “Obtain an IP address automatically.” Internet Pro-
tocol (TCP/IP) Properties is also where you set a computer’s static IP ad-

dress.

In either case, when using a crossover cable, both computers should be
assigned the same IP subnet unless special routing has been configured.

B) Start PuUTTY

The CONFIGURATION dialog box appears.

_._f{ PuTTY Configuration

Category:
B+ Session Basic options for your PUTTY session |
L—_I Ten I_.oglging Specify the destination you want to connect to
Tm}é;arbnard Host Mame (or [P address) Port
Bl 192.168.1.79 | 12101 |
- Features Connection type:
- Window (JRaw (@ Telnet () Rlogin () 55H () Seqal
.ﬁppea_rance Load, save or delete a stored session
- Behaviour
- Translation Saved Sessions
- Selection | |
- Colours -
Default Settings
=} Connection 1600PCn =
- Data 8635 Fr
- Proy KPN-AM =
- Telnet Delete
- Rlogin
[#-55H
- Serial Close window on exit:
() Mways  ()Mever (@) Only on clean exit
About Help Cpen Cancel

C) Set the Host Address to that of the OPTIMOD 1600PCn Service host computer.
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D) Set the Port Number to that of the OPTIMOD 1600PCn Service host computer,
(Default is 12101).

E) Select TELNET as the CONNECTION TYPE.

F) (Optional) Type a name for your connection in the SAVED SESSIONS box and
click SAvE.

Q) Click OPEN.

The 1600PCn will immediately connect and the 1600PCn connect banner
will display:

Orban OPTIMOD 1600PCn Control vx.xX.X.XX

Press your computer’s ENTER key once. Commands may now be sent and status
received.

OPTIMOD 1600PCn Command and Status Reference is in OPTIMOD
1600PCn Control API starting on page 5-1.

# 127.0.0.1 - PuTTY

Using the API: Examples

These examples show how PuTTY and Plink can be used to control OPTIMOD
1600PCn using scripting files on a local or remote computer as the OPTIMOD
1600PCn to be controlled. Plink and all associated scripting text, PuTTY, and .cmd
files should be located together in the same user-defined directory unless the path is
specified in the .cmd files.

In the example, replace “127.0.0.1" with the IP address of the computer running the
Service that implements the controlled Processor and “12101" with the card’s port
number. 12101 is the default; see step 8 on page 2-7.

127.0.0.1 is "localhost” and is used if you are running the Service on the
same computer you are using to connect to the API.

Each control session requires two ASCII files and one optional Shortcut file:
e a.cmd file that calls Plink to establish a Telnet connection to OPTIMOD 1600PCn
e areference.txt file that contains the actual control script.

e an optional Windows Shortcut .Ink file calls the .cmd file with a suppressed
Command Box.

Recalling the CHR MX MED preset
These two files will recall the CHR MX MED preset.

The file “recall CHR MX MED preset.cmd” contains:
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plink -telnet -P 12101 127.0.0.1 < recall CHR MX MED preset.txt

The file “recall CHR MX MED preset.txt” contains:

<Processor 1> RP CHR MX MED
disconnect

Automated Batch-Processing of all Files in a Specified Directory

The two files described below will process all files in the d:\temp\music_source di-
rectory, placing them in the d:\temp\music_destination directory.

Because in this case the command file is run on the same computer that
hosts the Optimod Service, the file uses a “localhost” (127.0.0.1) connec-
tion to Port 12101. If you want to run the cmd file on another computer
on your LAN, refer to step 8 on page 2-7. To enforce security, it is wise to
exploit the Optimod’s Network Terminal Control Settings “Network Ac-
cept List” feature to limit access to computers having a specified IP ad-
dress [see step (D) on page 5-3].

The file “batch_proc.cmd” contains:

"C:\Program Files\PuTTY\plink" -batch telnet://127.0.0.1:12101<batch proc.txt
EXIT /b

The file “batch_proc.txt” contains the following. (Note that the empty lines ter-
minated with CR/LF are needed to handle the messages that the Optimod API re-
turns.)

[CR/LF character]

fpinput d:\Temp\music source
[CF/LF character]

fpoutput d:\Temp\music_ destination
disconnect

When you run batch_proc.cmd, the Windows Command Prompt box displays:

d:\Temp\Tone Source>"C:\Program Files\PuTTY\plink" -batch [line wrap added]
0< telnet://127.0.0.1:12101 O<plink test.txt

Optimod-PCn 1600 Control v0.9.11.7

FP_INPUT:source folder found

FP OUTPUT:destination folder found. File Processing started.

Because of the presence of EXIT /b in the .cmd file, the command file will ter-
minate before it can echo the Optimod’s message indicating that all files were
processed:

FP _STATUS:folder processed successfully

If you want to see this message in the command box, omit EXIT /b from the
.cmd file. However, you will then have to terminate the command processing
manually via CTRL C from your keyboard.


telnet://127.0.0.1:12101%3cbatch_proc.txt
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Processing Controls Available From the API

A vast majority of users will have no reason to adjust processing controls from the
API because it is much more convenient to do it from the 1600PCn PC application.
The processing controls APl is mainly useful for developers who wish to develop a
custom interface.

The valid values for a given control correspond to the available values of the control
as displayed in the 1600PCn’s GUI (PC application). You must use the identical for-
mat, including whether a decimal point is included, and if it is, how many decimal
places are displayed. For example, 12, 12.0, and 12.00 are not equivalent because the
values are parsed as strings and not as numerical values. You can tell if you have en-
tered a valid value because the API will return an acknowledgement. To fetch a list
of all valid values, type the control name followed a space and two question marks
(see the example below).

The HEADER command returns a list of all controls (both Processing and Settings) and
their valid values. To capture the header to a text file, refer to the PUTTY command
CREATING A LOG FILE OF YOUR SESSION in PUTTY help.

Example to change the control value:
Type the following, including spaces, exactly as shown below:

<Processor 1> ST AGC On
(returns)

ST AGC:On

Example to query the control value:
Type the following:

<Processor 1> ST AGC 7
(returns)

ST AGC:0n

Example to fetch the valid settings of a control:
Type the following:

ST _AGC ?7?
(returns)

ST AGC
Oon
Off
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As per the example above, all commands in the tables below must be preceded by
<Processor x>[space], where “x" is the name of the Processor you are addressing,
and [space] is one space without brackets. Valid Processor numbers are 1 through 16,
depending on the number of processors specified in the NUMBER OF PROCESSORS
field in TOOLS>SERVICE SETTINGS, which is limited by the number of available Proces-
sors authorized by your security key or CodeMeter authorization. You can view the
number of available Processors in the PROCESSOR CONFIGURATIONS AVAILABLE field in
TOOLS>SERVICE SETTINGS.

View/Set Audio IjO Routing

Edit |F'ru:u:essu:ur 1

Mumber of Processors: | 1 ﬂ

j Processor Configurations Available

Stereo Processors: 16 Surround Processors: 16

Table 5-2: Processing Controls Available from API

Processing Controls Available from the API (alphabetical order)

ORBAN MODEL 1600

ALLF PEQ IN OUT

ST B4 BREAKPOINT

ALL EQ IN OUT

ST B4 COMP KNEE

B1B2 XOVER SLOPE

ST B4 COMP RATIO

BRILLIANCE IN OUT

ST B4 COMP THRSH

COMPRESSOR MODE

ST B4 DELTA REL

COMP THRESH OFFSET

ST B4 DIFF GR

CROSSOVER MODE

ST B4 LIMIT ATTACK

HF ENHANCER IN OUT

ST B4 ON OFF

HF PEQ IN OUT

ST B4 OUTPUT MIX

LF PEQ IN OUT

ST B5 ATTACK

LF SHELF IN OUT

ST B5 BREAKPOINT

MF PEQ IN OUT

ST B5 COMP KNEE

MONO BASS

ST B5 COMP RATIO

MONO BASS XOVER

ST B5 COMP THRSH

MX BASS LIMIT ST B5 DELTA REL

MX BASS PRELIM ST B5 DIFF GR

MX BASS PRELIM MODE ST B5 DWNWRD EXP
MX CLIP DIST ST B5 LIMIT ATTACK
MX CLIP THR ST B5 ON OFF

MX OVERSHOOT LIMIT MODE ST B5 OUTPUT MIX

MX

SP B

ASS PRELIM

ST BAND 21 COUPL

MX

SWIT

CH

ST BAND 23 COUPL

PEQ ALL FREQ

ST BAND 32 COUPL

PEQ ALL GAIN

ST BAND 34 COUPL

PEQ ALL WIDTH

ST BAND 45 COUPL

PHASE CORRECTOR

ST BASS CLIP

PHASE CORRECT XOVER

ST BASS CLIP

SENSITIVITY TRIM

ST BRILLIANCE

SE AMOUNT ST BS1770 LDNES CTRL THR
SE IN OUT ST DE STEREO COUPL

SE RATIO WIDTH ST DJ BASS BOOST
STEREO SYNTH ALG ST DWNWRD EXP

STEREO SYNTH MODE ST FINAL LIMIT DRIVE
STEREO SYNTH SEPARATION ST HF ENHANCER

ST ACG RELEASE ST HIGH PASS

ST AGC ST HIGH PASS Q

ST AGC BASS ATTACK ST LDNES CTRL ATTACK
ST AGC BASS COUPLING ST LDNES CTRL BASS CPL
ST AGC BASS RELEASE ST LDNES CTRL THR

ST AGC BASS TH ST LESS MORE

ST AGC DIFF GR ST LOW BASS FREQ




OPTIMOD PCn

CONTROL API 5 - 9

Processing Controls Available from the API

(alphabetical order)

ST AGC DRIVE

ST LOW BASS GAIN

ST AGC GATE THRESH

ST LOW BASS Q

ST AGC IDLE GR

ST LOW PASS

ST AGC MASTER ATTACK

ST LOW PASS EQ

ST AGC RATIO

ST LOW PASS EQ Q

ST AGC WINDOW RELEASE

ST MB DRIVE

ST AGC_WINDOW RELEASE

ST MB GATE THR

ST AGC WINDOW THRESH

ST MB RELEASE

ST AGC WINDOW THRESH

ST MUSIC SPEECH

ST B12 CROSSOVER

ST PASSTHRU GAIN

ST Bl ATTACK

ST PASSTHRU SW

ST Bl BREAKPOINT

ST PEQ HIGH FREQ

ST Bl COMP KNEE

ST PEQ HIGH GAIN

ST Bl COMP RATIO

ST PEQ HIGH WIDTH

ST B1 COMP THRSH

ST PEQ LOW FREQ

ST Bl DELTA REL

ST PEQ LOW GAIN

ST Bl DIFF GR

ST PEQ LOW WIDTH

ST Bl LIMIT ATTACK

ST PEQ MID FREQ

ST Bl ON OFF

ST PEQ MID GAIN

ST B1 OUTPUT MIX

ST PEQ MID WIDTH

ST B2 ATTACK

ST PHASE ROTATOR

ST B2 BREAKPOINT

ST SPEECH HPF

ST B2 COMP KNEE

ST SPEECH HPF

ST B2 COMP RATIO

ST SP Bl ATTACK

ST B2 COMP THRSH

ST SP Bl COMP THRSH

ST B2 DELTA REL

ST SP B2 ATTACK

ST B2 DIFF GR

ST SP B2 COMP THRSH

ST B2 LIMIT ATTACK

ST SP B3 ATTACK

ST B2 ON OFF

ST SP B3 COMP THRSH

ST B2 OUTPUT MIX

ST SP B4 ATTACK

ST B3 ATTACK

ST SP B4 COMP THRSH

ST B3 BREAKPOINT

ST SP B5 ATTACK

ST B3 COMP KNEE

ST SP B5 COMP THRSH

ST B3 COMP RATIO

ST SP DWNWRD EXP

ST B3 COMP THRSH

ST SP HIGH PASS Q

ST B3 DELTA REL

ST SP MB RELEASE

ST B3 DIFF GR

ST TRANSIENT ENHANCE

ST B3 LIMIT ATTACK

ST TRANSIENT ENHANCE

ST B3 ON OFF

SUBHARMONIC INJECTION

ST B3 OUTPUT MIX

SUBHARM IN OUT

ST B4 ATTACK

THRESHOLD TRIM

Settings Controls Available From the API

The Settings API can be used to automate proof-of-performance tests.

Table 5-3: Settings Controls Available from the API

Settings Controls Available from the API

(alphabetical order)

ALGORITHM

OUTPUT PRE E

BS1770 LC FLAG

PHASE CORRECT DEFEAT

BYPASS GAIN

PROC PRE E

EXTERNAL AGC

RIGHT TONE

INPUT REF LEVEL

SQUARE FREQUENCY

LEFT TONE

STEREO SYNTH DEFEAT

MAX LOW PASS

TARGET LOUDNESS

METER DELAY

TEST FREQUENCY

ORBAN LC FLAG

TEST MOD LEVEL
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OUTPUT DITHER TEST WAVEFORM
OUTPUT LEVEL
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Section 6

Specifications

Specifications

SYSTEM

Audio Processors: Each Processor in OPTIMOD-PCn realizes a mono, stereo, or sur-
round audio processor. Except for mono, each processor consists of the following cas-
caded processing elements: Internal Processing: Input - Left/Right Phase Skew Cor-
rector - Mono Bass - Stereo Synthesizer > Stereo Enhancer - Two-Band defeatable
AGC with window gating > Equalizer/HF Enhancer - Multiband Compressor - Opti-
mix® upmixer > Peak Limiter > Automatic Loudness Controller - Output. In surround
processors, Optimix is located just before the AGC, and all dynamics processing oper-
ates on the upmixed signal when Optimix is active. See Figure 3-2: OPTIMOD-PCn Digi-
tal Signal Processing Simplified Block Diagram on page 3-13.

Number of Audio Processors: Software is priced according to the total number of Proces-
sors permitted to run simultaneously on a given computer. The number of Processors
realizable on a given computer depends on the processing features used and the power
of the computer’'s CPU. Plan your installation by using the information in CPU starting on
page 1-4.

Frequency Response: +0.1dB, 2-20,000Hz (Bypass software running).

Input/Output Delay: Typically 450 to 1000 ms. Varies according to the number of pro-
cessing features that are activated.

Internal Filters: 10, 11, 12, 13, 14, 15, and 20kHz can be used to provide additional anti-
aliasing for low sample rate services.

Internal Sample Rate: 48-256 kHz, as appropriate.

Input/Output Sample Rate: 44.1, 48, 96, or 192 kHz. 44.1, 96, and 192 kHz use high-
quality synchronous sample rate converters built into OPTIMOD-PCn and do not rely on
Windows’ built-in SRC.

Internal Resolution: 32-bit or 64-bit floating point, as appropriate for the processing being
performed.

Input/Output Resolution: 16-bit or 24-bit fixed point. If the output is configured for 16 bits,
First-order noise-shaped dither can be applied prior to truncation to 16 or 24 bits from
32-bit float.

Peak Control: Peak limiter is oversampled at 192 (non-MX mode) or 256 kHz (MX mode),
yielding a worst-case overshoot of 0.5 dB at the analog output and for all output sample
rates. (To achieve this performance at 32 kHz output sample rate, it is necessary to set
OPTIMOD-PCn'’s lowpass filter cutoff frequency to 15 kHz.)

Phase Response: Linear-phase (constant group delay) or allpass, user selectable.

AGC (Automatic Gain Control): +12dB/24dB gain range, Two-Band, Gate and Window
enabled.

Stereo Enhancer: Orban-developed L-R dynamic expansion triggered by L+R transients.
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Equalizers: Shelving Low Bass EQ, selectable 6 dB, 12dB or 18dB/octave. Four-band Par-
ametric EQ with analog-style bell-shaped curves. Program Adaptive HF Enhancer. Bril-
liance control uses Band 5 of the multiband compressor as a steep slope shelving equal-
izer (12 or 18 dB/octave for linear-phase or allpass crossovers respectively). Sweepable
lowpass and highpass filters with adjustable slopes, 6 to 24 dB/octave.

Multiband Compressors: 25dB gain reduction range, Five-Band. Inline and parallel modes
available.

Optimix® Upmixer: Upmixes stereo (2.0) to 5.0-channel (Lf/C/Lf/Lsur/Rsur) surround. (See
Optimix® Automatic Stereo 2>Surround Upmixer on page 3-15.)

LFE Channel: There is no upmixed LFE channel because Optimix places energy below
80 Hz in the Lf and Rf channels instead of in an LFE channel. This makes it maximally
compatible with home theater receivers’ bass management functionality—if Lf and Rf
speakers are “small,” the receiver will route bass to the LFE channel if present.

Phase Corrector: A defeatable multidimensional phase correction for the center channel:
can correct multiple, unequal delay skew errors among different program elements
common to the L and R input channels.

Upmix Modes: Provides two upmix modes: Wrap (puts the listener “in the middle of the
band”) and Frontal (puts the listener “in the audience.”)

Downmix Compatibility: In Wrap mode and with the phase corrector defeated, the stereo
LoRo mixdown of the upmix is identical to the original stereo input regardless of the set-
tings of other user controls (Front/Rear Balance and Center Width). Activating the phase
corrector improves the mono downmix compared to the mono downmix of the original
stereo. Frontal mode slightly increases ambience in the mixdown.

Auto-detection: In surround instances of OPTIMOD-PCn, Optimix can detect the pres-
ence of stereo input material and automatically activate Optimix via a smooth, delay-
matched crossfade.

Latency: 212 ms

Limiter: >12dB gain reduction range. Two modes available: low-IM look-ahead (to minimize
CPU usage) and MX (to achieve highest performance). Moreover, the MX limiter’s over-
shoot compensator can be operated in Soft mode (for lowest distortion) or Hard mode
(to achieve highest loudness without audible gain pumping).

Loudness Controller: Constrains subjective loudness to a user-adjustable threshold via
the 1981 Jones & Torick CBS Technology Center algorithm, as further refined and de-
veloped by Orban. The algorithm also drives a subjective loudness meter, which is dis-
played on the 1600’s GUI. In dual-mono mode, there are two independent loudness con-
trollers and meters.

BS.1770 Safety Limiter: Constrains Integrated BS.1770-2 (and higher) loudness to preset
value, with an attack time of 10 seconds and a release time of 3 seconds.

Pass-through mode: Delay-matched to active processing. Gain adjustable from -10 dB to
+10 dB.

Number of Factory Presets: More than 50, each with 19-step LESS-MORE control. Pre-
sets are fully customizable.

Number of User Presets: Essentially unlimited. User presets can be saved on the host
computer’s hard drive or on other storage devices.



OPTIMOD PCn SPECIFICATIONS 6-3

Audio I/0

OPTIMOD-PCn uses Windows built-in WASAPI sound kernel for audio input and output,
and is compatible with sound devices whose drivers support WASAPI. Compatible with
Windows 7 and higher.

COMPUTER

Minimum System Requirements: Recommend Intel CPU and Chipsets will change de-
pending on the current offerings from Intel. We recommend Intel i-series processors with
clock speeds of 3 GHz or higher.

Software:

1600PC Control application: provides subjective adjustment controls of the audio pro-
cessing and remote administration. It also allows factory and user presets to be recalled
from and save to a host storage device such as a hard disk drive. The control application
client addresses multiple OPTIMOD-PCn Processors.

API:

IP API: provides complete remote administration over TCP/IP. The OPTIMOD-PCn Service
application hosts a TCP/IP Terminal Server to allow external control of the OPTIMOD-
PCn cards from either a Telnet/SSH client or a custom third party application. All
OPTIMOD-PCn Presets and Mixer Controls are accessible and all commands are sim-
ple text strings.

Telnet/SSH: RFC 318 compliant basic subset. Compatible with Windows Telnet and PuTTY
Telnet clients.

TCP/IP Port: user assignable.

Serial API: provides complete remote administration over Serial port communication. The
OPTIMOD-PCn Service application hosts a Serial terminal server to allow external con-
trol of the OPTIMOD-PCn cards from either a terminal client or a custom third party ap-
plication. All OPTIMOD-PCn Presets and Mixer Controls are accessible and all com-
mands are simple text strings.

Terminal Programs: Compatible with terminal programs such as Windows HyperTerminal,
and PuTTY VT-100 clients.

COM Port: user assignable from COM1 to COM100.
Status Monitoring: SNMP RFC 1157 compliant. Monitors all Audio Input and Output pres-

ence, Mixer Control status, Active Preset, Control Application Connections, and Control
Client Connections.

1601PCn and 1602PCn Features

Models 1601PCn and 1602PCn are lower cost versions of 1600PCn software that remove
certain features. For a list of removed features, see 1602PCn Features on page 1-12
and 1601PCn Features on page 1-12.
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